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What's on the CD-ROM 
The companion CD-ROM includes artwork elements 
used in the sample exercises throughout the book, soft
ware, plug-ins, Shockwave movies, and completed GIF 
animations created by professional new-media artists. 

~ Art files from artists and Web specialists Frank DeCrescenzo, Curtis Eberhardt, Kleber 

Santos, Peju Alawusa, Jane Greenbaum, Alex Shamson, Greg Hess, and John Scott. 
(Note: For a detailed inventory of files, see the readme file on the CD-ROM.) 

~ Journalist Peter Chowka's interview with Nobel prizewinner Linus Pauling, 
styled with Microsoft's cascading style sheets (as defined by the World Wide 

Web Consortium). 

~ Scans of nineteenth century photographs of Coney Island Amusement Park for 
use as a texture map when creating a Coney Island VRML attraction. 

~ Shockwave movies and GIF an imations from artists Larry Rosenthal and 
Curtis Eberhardt. 

~ Software applications, browsers, and plug-i ns for creating and viewing 
Web artwork. 

See the readme fi les in each folder for acknowledgments, descriptions, copyrigh ts, insral
lation insnuccions, limita tions, and other imponam info rmation. 

Requirements 
Software: Macintosh OS, version 7.1 or later 

Browser-Netscape Navigator, 
''crsion 3 .0 or la ter; or Microsoft 
Internet Explorer, 
version 3.0 or later 

Photoshop, r;ersi011 3.0 or later 
Vir/us Wali~Through Pro, 

version 2.6 or later 

Hardware: 68K Macintosh or 
Power Macintosh 
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Preface 

Author: 
Mary Jo Fahey 

This is an exciting time for digital artists. Many new 

tools are available for creating digital artwork, and 

several are re lated to creating Web pages: HTML style 

sheets that make text formatting easier; NetObjects Fusion, 

a hot new Web page layout tool for artists who don't like 

HTML tags; c lient-side image maps, a superior way to cre

ate image maps that frees you from image map scripts on 

the server; frames; forms; VRML, the language that 

describes 3D space on the Web; shortcuts for creating art 

with Fractal Design Painter; GIF animation; background 

sound for Web pages; and streaming video. Even as this 

second edition of Web Publisher's Design Guide For 

Macintosh goes to press, numerous new trends and devel

opments are cominuing to emerge. Because the new trends 

are so numerous, Chapter l is now called Web Watching 

And Planning. Included in that chapter is information 

about resources that enable digital artists to follow these 

changes as they occur. 

Thjs second edition is more interactive than the first. Many 

of the artists who have contributed samples have also gener

ous ly provided art files , which can be found on the compan

ion CD-ROM. 

l hope you like the second edition of Web Publisher's 

Design Guide. Send me an email message and let me know 

how you like the book! 

Mary Jo Fahey 

mj fahey@ i nterport. net 

http://www.echonyc.com/-rut 

Preface ) v. 



Contents Chapter 1 
Web Watching And Planning 1 
Web watching: Internet magazines (online and print) and 

user group SIGs 3 

Web watching: Windows 95 and Webtv 4 

Options for running Windows 95 software on your 
Macintosh 5 

New trend to watch: CO-ROMs that augment a print publi
cation or a Web site 7 

The Net magaz ine 's director of CD-ROM development, 
Tom Hale, shares tips o n creating a hybrid CD-ROM 8 

New trend to watch: offline browser software that auto-
matically downloads Web content 9 

New trend to watch: Web site analysis software I 0 

The Reuters Web sites 1 I 

David Reinfurt's tips on planning a Web site 16 

Wayfinding principles in Web site desig n 22 

Chapter 2 
Navigation 27 
The Mobius Gallery 29 

Principles of Web site navigation 33 

Information design and Web site " map making" 4 1 

Create a table with HTML to ho ld navigation buttons and 
text links 42 

Internet cafe owner John Scott shares tips on creating 
frames 54 

Chapter 3 
NetObjects Fusion 69 
A new Web page layout tool for designers 7 1 

Contents I vii. 



viii. , Contents 

Chapter4 
Style Sheets And New HTML 

TextTags 95 
Microsoft style sheets o ffer formatt ing features such as po int 

size, page margins, and leading 97 

Formatting text in co lumns with Netscape's new 
<MULTI COL> tag I 19 

Controlling font color and family with the <FONT> tag 
(Netscape Navigator or Internet Explorer) 122 

Microsoft 's plan to add fonts to the Web: Free True Type now 
and Web page font embedding in the future 124 

ChapterS 
Online Tools 127 
Convert a Pan tone ROB value to a Web page color code with 

the B BS Color Ed itor 129 

Searching the Web on Yahoo! search 137 

Extending your Yahoo! search to other search engi nes 139 

NctS itc assistance from Netscape 140 

Add information about your site to Yahoo! and other search 
engines 142 

Locating, down loading, and decompressing shareware from 
the Web 144 

Chapter& 
Photography 147 
Mark Elbert's notes on Web graphics 149 

Pixel depth 155 

Saving your image: OfF or JPEO? 158 

OIF and the LZW compression patent 16 1 

HTML rags and page markup 162 

The moveable grid for pictures and text 165 

Using HTML to move page e lements horizontally 166 

Using HTML to move page elements vertically 173 

Creating a banner graphic or splash screen 

Linking a thumbnail O lF to an external JPEO 

Wrapping text around a photo 192 

178 

188 



Controlling text wrap with HTML 198 

Fading an image into the browser background 202 

Create a tiled background 204 

Create a full -bleed photo background with larger ti les 206 

Creating a silhouette on an image background 207 

Creating a drop shadow in Photoshop 2 13 

Jane Greenbaum's tips on creating a drop shadow in 
Painter 4.0 22 1 

Creating a blue duotone with Photoshop 232 

Creating a Super Palette with DeBabelizer 236 

Chapter 7 
Client.Side Image Maps 239 
A virtual walking tour ofNY's World Financial 

Center 24 1 

Findi ng coordinates for clickable regions with 
Photoshop 244 

Creating a client-side image map HTML file 248 

Use PhotoGlF with Photoshop to create a transparent 
GIF 258 

Use Fetch to upload tiles to a provider's server 262 

ChapterS 
Video 265 
Marc Thorner's tips on using VivoActive Producer to cre

ate streaming video 267 

Experiment wi th Apple's QuickTime P lug-in, and embed a 
QT movie on a Web page 269 

Use Premiere's Movie Analys is Tool to learn about data 
rate and compression settings 273 

Steven McGrew's tips on caplllring and compressing 276 

Creating a link to a movie on your Web page 278 

Pick the best palette for an 8-bit color QuickTime movie 
using DeBabelizer 's Super Palette, and create a script to 
remap your movie 284 

File conversion: Converting QuickTime Iiles to AVI 294 

Contents I ix. 



x. J Comems 

File conversion: Converting AVl movies to QuickTime 
movies 297 

File conversion: Preparing QuickTime Ii les for 
Windows 293 

Chapter9 
Sound 299 
Web sites with sound 30 I 

The compact MIDI file format 3 10 

Set Netscape's Preferences to download music files 311 

Greg Hess' ti ps on adding a background sound to a Web 
page 3 13 

Creating a link to sound fil es on your Web page 31 8 

Creating sound effects w ith clip media 324 

Fi le conversion: AU to AIFF or WAV to AIFF 326 

Mixing clip music with sound effects in Sound Effects 327 

Recording and mixing sound in SoundEffects 330 

File optimization: Resample and downsample sound files for 
playback on the Web 333 

File conversion: Preparing sound Iiles for other 
platforms 336 

Chapter 10 
GIF Animation And Shockwave 337 
Curtis Eberhardt's G IF an imation 339 

Animation and interactive Web games that use Shockwave, 
Java. live video, and QTVR 34 1 

Curtis Eberhardt 's Li ps on creating GIF animation frames in 
Photoshop 349 

Curti s Eberhardt's ti ps on assembling a G IF animation in 
GIFBui lcler 355 

Curtis Eberhardt's tips on creating an HTML fi le to test your 
GrF animation 358 

GlF Wizard at Raspberry Hi ll 360 

Create an interactive animation w ith Macromedia 
Director 364 

Creating a Director movie for use with the Shockwave 
Director Internet Player 38 1 

Compressing a Director movie with A fterburner 390 



Chapter11 
VRML World Building 391 
YRML on Lhe Internet 393 

The NYYRMLSIG 's Coney Island Project 406 

Alex Shamson's tips on creating a VRML model in Yirtus 
WalkThrough Pro 4 18 

Open your WRL file in a YRML browser 452 

Open a VRM L fi le in a word processor and alter the 
PerspectiveCamera 454 

Embed a VRML window in a Web page 458 

Chapter12 
Forms 461 
The Slappers Web site 463 

Using NetObjects Fusion to create a client-side image 
map 466 

Before you design a form for your Web site... 473 

Using NctObjcctsFusion to design a form (with a 
MATLTO for routing data) 476 

Index 485 

Contents I xi. 



Acknowledgments The Web Publisher's Design Guide, Second Edition was 
made possible thanks to a large number of people who 
contributed their time and thei r talents. Special thanks to: 

Keilh Weiskamp, president of the Corio lis Group and other mem
bers of The Corio lis Group, including Paula Kmetz, Project Editor; 
Nomi Schalit. Book Production Manager; Nicole Colon, Typesetter; 
and Michael Peel, Production Assistant. 

Peju Alawusa, Antonio Antiochia, Antonio Arenas, Elaine 
Arsenault, Don Barlow, Brian Behlendorf, Gavin Bell , Nick Bodor. 
Travis at Box Top, Richard Boyd, Cat11erine Bums. Peggy Burton, 
Teri Campbell, Mel issa Caruso, Harry Chesley, Peter Chowka, Tom 
Cipolla, Michael Clemens, Tom Cunniff, Frank DeCrescenzo, 
Diana DeLucia, Chris Dolan, Matt Dominianni, Juan ita Dugdale, 
Curt is Eberhardt, Frauke Ebinger, Mark Elbert, Ron Elbert, Kevin 
Ellis, Michael Erde, Merry Espana, Guillenno Esparm, John 
Fanar, David Filo, David Fry, Frank Gadegast, Gail Garcia, Steven 
Garson, Beth Gilbrech, Aaron Giles, Andrew Green, Jane 
Greenbaum, Lauren Guzak, OJ Hacker. Tom Hale, Maynard 
Handley, Patrick Hennessey, Stacy Hom, Tim Hunter, Grant 
Hurlbert, Regina Joseph, Trevor Kaufman, Rod Kennedy. Prit i 
Khare, Iva Kravitz, Fred Krughoff, Ken Krupka, Shirley Lew, 
Robert Liu, Robert Lord, Charles Marelli, Steve Margolis, Paul 
Marino, Greg Marr, Peter Marx, JimMatlhews, Steve McGrew, 
Kevin Mitchell, John Nardone, OkeyNestor, Pauline Neuwirth, Dan 
O' Donnell, Matt O' Donnell , John Olinyk, Patricia Pane, Tony 
Parisi, Jeff Patterson, Mark Pesce, Dave Pol a, Berta Ponzo. David 
Reinfurt , Alberto Ricci, Alicia Rockmore, Larry Rosenthal, Barry 
and Jackie Ryan, Kleber Santos, John Scott, Bill Scott, Brandee 
Amber Selck, Alex Shamson, Ashley Sharp, Alex Sherman, Chuck 
Shott on, David Smith. Christina Sun, Barbara Tanis. John Tariot, 
David Theurer, Marc Thorner, Jack Waldemaier, Robert Weideman. 
Heini Wilhagen, Jerry Yang, and Jon Zilber. 

Acknowledgemems 1 xiii. 



Digital media 
specialist featured 
in this chapter: 

Tom Hale is director of 
CD-ROM de11elopment 
at Imagine Publishing 
located in Brisbane, CA. 
Imagine publishes The 
Net, PC Gamer. Boot, 
Ultra Game Players, Next 
Generation, and Mac 
Addict magrdnes. 

cdrom@net-usa.com 

Artist featured in this 
chapter: 

David Reinf urt is a multi
disciplinm)• graphic 
designer with a B.A. in 
Visual Communications 
from the Uni11ersity of 
North Carolina. David 
specializes in interaction 
design. 

reinjitrr @ideo.com 

Cha 
·~ 

Web Watching And 
Planning 
Offl ine Web browsing facilitated by CO-ROMs is one of many new 

trends for Web designers to watch. This chapter highlights important 

resources f01· Web trend watching and includes several examples of 

new trends. 

The most significant new Web development that wi ll affect planning 

is the impending browser war between Netscape and Microsoft. 

Regardless of which company wins the browser war, Macintosh Web 

artists cannot ignore the software development that is taking place on 

the Windows platform. Because some software may never be devel

oped for the Macintosh platform, this chapter includes tips on how to 

run Windows 95 software on Macintosh hardware. 

Although it's tempting to begin your Web page creations with graph

ics, in this chapter David Reinfurt makes us aware of key project ele

ments to have in place before the graphics begin. 





Web watching: 
Internet 
magazines (online 
and print) and 
user group SIGs 

Summary: Graphic designers who keep 

up with changes on the Web will 

be better equipped to create content 

for their clients. 
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Above: Interactive Week, published by 

Ziff-Davis, is both a print and online 

publication (http://www.zdnet. com/ 

intweek). Above right: Web Week, pub

lished by Mecklermedia, is both a prim 

and online publication (ht!p:l!www 

. webweek.com). 

, •• ""' .... , u .... .,,, 

( ......... ) 
r.~ 
~ 

Above: Internet World, published by 

Mecklermedia, is both a print and 

online publication (http://www 

. iworld.com). 
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B y investigating new trends , graphic designers can 

assist the ir c lients in p lanning content strategy for 

their Web site. Resources include: 

1. Online publications. 
a. Webweek and Interactive World, published by 

Mecklermedia . 

b. Interactive Week, published by Zi ff-Davis. 

2. Print publications. 
Magazines that provide in-depth product reviews and iden

tify emerging u·ends on the [nternet include: 

a. The Net , published by Imagine Publishing , includes a 

hybrid CD-ROM with Web tools, software demos, 

movies, animation, and otJ1er large files which are diffi

cult to download (http://www. thenet-usa.com). 

b. WebTeclmiques, a Miller Freeman publication, con

ta ins an excellent HTML column written by Laura 

Lemay, author of Teach Yourself Web 

Publishing and HTM L in a Week, published by 

Sams.net. 

c. PC Novice, by Peed Corporation, contains a plain-lan

guage introduction to PCs. 

3. User group SIGs (special interest groups). 
User groups represent a tradition that has existed for two 

decades. Call a local computer store or univers ity computer 

center for information about local user group meetings . 

Web Watchi11g And Planning Jl. 



Web watching: 
Windows95 
andWebtv 
Summary: Macintosh artists shor.t!d be 

aware ojWeb-relared trends 011the 

Macintosh, PC, and the new Webtv 

boxes. 

Above: ActiveX animation on Spike Lee's 

sire available rhrough Microsoft's 

111/emet Explorer browser window. 

Above: New Webtv boxes are now 

available f rom Philips Magna vox ond 

Sony Electronics are priced from $329 

to $349. The Webtv lntemet provider 

service is $ 19.95 per month .for unlimit

ed access. 

4. j Choprer 1 

Graphic des ig ners cannot assume that Macin tosh 

Web pages are tbe same as PC Web pages. For 

example, Spike Lee's Web site (hllp://blackameri caon

line.com/bus/index. html) opens with ActiveX animation 

that cannot be seen on the Macin tosh platform a t this 

time. Rather th an wait fo r Macintosh software to be 

developed, graphic designers shou ld consider adding 

Windows 95 hardware to their studio. (Note: See 

"Options for 1'1/lllling Wi11dows 95 .wjiware 011 your 

Macintosh" in this chaptu) 

Webtv is an inex pens ive portable Web-v iew ing box, 

which makes Web viewing and email possible on a TV 

set. The small , lig htweight boxes are available from 

Philips Magnavox and Sony Elec tronics. (Nore: Local 

access phone nu1nbers are listed 011 rhe Webtv sire ar 

http://www. webtv.11et.) The $330-$350 unit uses a propri

etary browser, and Web viewing is made possible through 

Webtv Internet provider service. A 33.6 Kbps modem is built 

in, and an optional cordless keyboard is available at the e lec

tronics re tailers ror $50-60. The unit also contains a PS/2 

keyboard socket, a smartcard slot, and a 96-pin UO port 

which Webtv plans to enable for a printer (800-469-3288). 

Although the Webtv browser cannot see frames or VRML at 

this time, updates to the Web browser are expected. Graphic 

designers who create Web content for the home market 

should consult the HTML guidelines on the Webtv site 

(http://www. webt v.net). 



Options for 
running 
Windows95 
software on your 
Macintosh 

Summary: Running Windows 95 soft

ware on a Macintosh computer can get 

you acquainted with PCs and keep you 

up-to-date on important deve/oprnents. 

INS!GNIJ\ 
.S 0 L U 1· I 0 .~ S , 

B y addin g a board with a Pentium processor to your 

Mac intosh, your computer becomes a dual proces

sor that can run software for both platforms. The fiip 

between operating systems is contro lled with keys on 

the keyboard. In addition to a processor, the card must 

contain its own memory and its own sound. A port that 

hooks to a modem is optional on some cards because the 

PC card may share the Mac modem. 

Although a second computer is an option that should be 

considered. a dual processor sol ution is about half the 

price of new 166 MHz Pentium machines. A PC card is 

also several hundred dollars cheaper than reconditioned 

Pentiums that are now being sold through outlet stores 

for major hardware manu facturers, such as Dell and 

Micron. The companies that sell Wi ndows 95 enabling 

hardware and software for Macintosh include: 

1. Apple Computer. 
Apple's Power Macintosh 7200/120 PC compatible com

puter is equipped with a pre- installed Pentium 586/100 

MHz card. Industry benchmarks compare the speed of the 

586/100 MHz card to that of a Pentium 75 MHz. The card 

may also be installed in any PCI-based Power Macintosh 

system. 1 & R Computer World in New York City sells this 

system for $2,295 . 

2. Orange Micro. 
Orange Micro makes two varieties of O range PC cards: one 

for NuB us-based Macintosh computers and another for 

PCI-based machines. The cards come with one parallel port 

and two serial ports for adding PC peripherals. Windows 95 

must be purchased separate ly for $ 142. 

Web Watching And Planning js. 



Tip: PC cards built f or Macs have the 

following features: They do not require 

rebooting, PC-type CD-ROM disks may 

be read j i-om the Macintosh CD-ROM 

drive, files may be shared by both envi

ronme/lls, the Macintosh SuperDrive is 

used as Drive A:, there is read/write 

capability to Macintosh or PC 

diskelles, and there is a shared 

Clipboard between Macimosh and PC 

environments for cutting and pasting. 

David Lemer, who owns Tekserve, a 

well-known Macintosh repairfacility in 

New York Cit)\ uses a dual-pmcessor 

solution to run Federal Express tracking 

software (help@tekserve.com). 

6., Chapter 1 

Card Speed 8MB 16MB 32MB 

Model 320 

(NuB us) 133 MHz $738 $852 $ 1,080 

Model 340 

(PCI) 133 MHz $ 1,040 $ 1, 128 $1,356 

Orange Micro cards are available from Orange Micro at 

7 14-779-2772 and Mac Powerhaus at800-615-3 J 83. 

(Note: Look for Orange Micro's home page at http://www. 

orangemicro. i n.te1: net. ) 

3. Reply Corporation. 
Reply Corporation (800-955-5295) manufactures the PC 

cards that Apple adds to the 7200/120 MHz Power Mac. The 

card is slightly less expensive than Orange Micro's. Windows 

95 and sound are bundled, but the cards do not come with the 

ports necessary to hook up PC peripherals. A port adapter 

can be purchased separately. (Note: Look.for Reply 

Corporation's home page at http://www.reply.com.) 

Card 

NuB us 

PCJ 

Speed 

IOOMHz 

166MHz 

40MB 

$700 

$ 1, 11 5 

(Note: Smaller memory configurations at lower prices are 

also available for Reply Corporation's PC cards. A 40 MB 

memO!)' configuratiOil is lisred to give readers a1z approxi

mate idea o.f price. A card for the 6 /00, 7100, and 8100 

Power Macs is approximarely $800 to $900.) 

4. Insignia Solutions. 
Insignia has created a software emulation program that is 

the least expensive alternative for mnning Windows 95 

soft\'lare. Speed is entirely dependent on the Macintosh 

machine's processor. J & R Computing in New York City 

sells Insignia 's SoftWindows software for approximately 

$400. (Nore: Look for Insignia Solutions' home page ar 

h tIp :I !w1v1 v. i 11s i gn ia. com.) 



New trend 
to watch: 
CD-ROMs that 
augment a print 
publication or a 
Website 

Summary: CD-ROM is a convenient 

media for high-bandwidth content. 

Publishers at The Net magazine 

assume that anyone who is buying an 

Internet magazine also has a CD-ROM 

drive. The magazine editors have 

copied simple HTMLfiles to the 

CD-ROM, which can be opened in a 

reader 's Web browse1: 

Internet Explore,· 
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W ho said HTML files need to be "served" from a 

fi le server? Dig ital media experts at The Net 

magazine have created a clever CD-ROM disk that gets 

di stributed with thei r magazine and allows HTML files to 

be viewed online or offline (http://www.thenet-usa.com). 

1 . Steps t o open The Net's CD-ROM. 
a . Connect to the Web with your PPP connection. 

b. Open The Net 's CD-ROM. 

NETPO\VER 
1a. 
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c. If you do not have a Web browser software program, 

launch or install Microsoft 's Internet Explorer browser, 

which is included on The Net's CD-ROM. 

d . Select Open File from the File pull-down menu. 

e . In the dialog box that follows, select Start.htm, and click 

on Open. 

f . The Net magazine's CD-ROM interface will open in the 

browser window. 

lf. 

Web Watching And Planning )1. 



The Net magazine's 
director of CD-ROM 
development, 
Tom Hale, shares 
tips on creating a 
hybrid CD-ROM 

Summary: The Net magazine's 

CD-ROM disk is a valuable suppleme11t 

to the magazine, providing tools and 

helpful I inks for readers. 

s. j Chapter 1 

start.htm 

H ybrid CD-ROMs can be pl ayed on both Macin tosh 
and PC hardware. Although Tom Hale at The Net 

magazine admits that it 's challenging to create content 
that is identical for both platforms, one CD-ROM is 
more efficient than two separate disks. In this section, 
Tom has identified tips for Web deve lopers who are 
considerin g a CD-ROM supplement for their Web site. 

1. HTML files work cross-platform. 
HTML Iiles are perfect for a hybrid CD-ROM because the 
Web is a cross-platform digital medium. However, it 's still 
challenging to create content that will be useful for a variety 
of PCs and Macintosh computers. 

2. Put all large files on the CD-ROM. 
The Net magazine puts all art, movies, animation, and 
demo software on the CD-ROM and puts tex t on the Web 
site. This shift so lves all bandwidth problems, and the 
Web site becomes a vehicle to distribute fres h conten t 

that's easy to download. 

3. Web tools are a valuable addition. 
Web tools are distributed each month, so readers do not 
need to download the software themselves. Shareware and 
demo software programs are usually large, and download
ing is time consuming. Tools are valuable, and readers will 
want to keep the CD-ROM near their computer. 

4. Future add-ons to the CD will include chat. 
As The Net magazine's Web site and CD-ROM evolve. live 
interactive chat between editors and readers is an interesting 
addition that's planned. 



New trend 
to watch: 
offline browser 
software that 
automatically 
downloads Web 
content 

Summary: Offline browsers act as 

spiders or Web age/1/s that awomatica/

ly de/iverfresll Web pages to your hard 

drive by topic. 

SulfsoT 

WEB 

The Doorstep ~1 
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Several ne\v Internet utiliti es help co llect , o rganize, 

and save Web pages o r enti re s ites fo r o ffline view

ing or CD-ROM maste ring. 

1. Macintosh offline browsers. 
a. Web Buddy, by Dataviz, Power Mac and 68 K versions, 

$50 (http://www.daraviz.com). 

b. Freeloader, by Freeloader, Inc., free 

(http://www.freeloader.com). 

c. Web Whacker, by Fore front, requires System 7.1 or 

g reater, $69.95. 

d. BackWeb , by Back Web, Inc., Macintosh OS, free 

(http: //www.backweb.com). 

2. PC Offline browsers. 
a. Web Buddy, by Dataviz, Windows 3.x, Windows 95 , 

and Windows NT versions, $50 (http:l/www 

.dataviz.com). 

b. Freeloader, by Freeloader, Inc., Windows 3.x, 

Windows 95, and Windows fo r Workgroups versions, 

free (http://www.freeloader.com). 

c. Web Whacker , by Forefront, requi res Windows 95, 

$69.95 (http:l/www.Ffg.com). 

d. Surjbot 3.0, by Surflogic LLC, Windows 95 and 

Windows NT versions (http:l/www.surflogic.com). 

e. WSmart Bookmarks, by First Floor, Windows 3.x, 

Windows 95, and Windows NT versions, $24.95 

(http://www.firsttloor.com). 

f. NetAttaclze Light, by Tympani Software, Windows 3.x, 

Windows 95, and Windows NT versions, free for non

commercial, personal use (http:l/www.tympani.com). 

g. Milktruck, by Traveling Software, Windows 95 and 

Windows NT versions, free for noncommercial, 

personal use (http://www.lravsoft.com). 

h. BackWeb, by Back Web, Inc., Windows 3.x,Windows 

95, and Windows NT versions, free. A Back Web 

server is available for Unix, NT, and proxy servers 

(http:l/www.backweb.com). 
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New trend 
to watch: 
Web site analysis 
software 

Summary: Broke/! li11ks a11d image 

references are easier to 1//allage with 

Web site analysis tools. 

10. Chapter 1 

-II!!!!!!!- Adobe 
SITEmiL[ 

W eb site analyzers le t you see what 's working on 

any Web site and solve the problems associated 

with res truc turing a Web site, mov ing files, updating a 

Web site, renaming pages, or deleting fil es that are sti ll 

in use. 

1. Adobe SiteMill for Macintosh. 
Adobe SiteMill reads an ex isting Web site and automatically 

finds and summarizes the enors found. The software 

includes Web page authoring features found in Adobe 's 

HTML editor, Adobe PageMill. SiteMill can be run on any 

Macintosh running System 7 or higher with at least 3MB of 

free memory and a color display. Price is $199.95 

(http://www.adobe.com). Features include: 

a. automat ically fixes all links throughout a site when 

folders are renamed, moved, or deleted. 

b. shows warnings for unreachable or unused resources. 

c. displays all resources, page titles, and folders. 

2. lnContext WebAnalyzer for Windows. 
Like Adobe's SiteMill , lnContext WebAnalyzer identifies 

broken links and problem resources. However, unlike Adobe 

SiteMill , which fixes broken links automatically, 

WebAnalyzer must be integrated with an external 1-ITML 

editor to repair links. The software requires Windows 95 and 

at least 8 MB of RAM. Price is $ 129.95 (http://www.incon

text.com). Features include: 

a. identifies broken links and images. 

b. is compatible with popular Web browsers. 

c. can be integrated wi th popular 1-ITML ed itors for Web 

page repair. 



The Reuters 
Web sites 

Summary: In this chapter on planning, 

the Reuters sires provide an e.;rcellent 

Web site development model. Built by a 

prof essional graphic designer f or a 

client who understands online informa

tion technology, these sites represent 

pe1ject " Web craftsmanship." 

Note: Two Twelve Associates is a multi

disciplinmy design finn specializing in 

environmental graphics, print, and inter

active design. The .finn is located at: 

596 Broadway, Suite 1212 
New York, NY 10012-3234 

212-925-6885. 

I News(Z)Machine] 
'111111111-A 

F ew people wander around the Web without a purpose. 

Travelers usua lly search and navigate with the help of 

sig ns, j ust as they do on the stree t 

For several decades, sig ns in archi tectural spaces have been 

desig ned by a group of graphic desig ners known as environ

mental designers. Just as g raphic design has evolved in the 

pri nt medium, so have the visual aesthe tics and formulas 

used in environmental graphics. For example, environmen

tal designers have adopted the architect's phased approach 

to project development, which includes planning, schemat

ics, design, and production . 

Environmenta l g raphic desig ners now know a great deal 

about effective organization of space and use of environ

mental elements. In fact, o ne graphic design firm specializ

ing in environmental graphics is uniq uely positioned to 

offer advice on "planning a Web site ." The underly ing prin

ciples of he lping people "find the ir way" are as appropriate 

for virtual spaces as they are for real spaces. 

Two Twelve Associates. 
Using the principles of "wayfi nding," the graphic designers 

at 1\yo Twelve Associates have been designing spaces for 

a lmost 20 years. Wayfinding is the study of peoples' move

ments and the ir re lationship to space. It's also the process of 

reachi ng a destination, which involves problem solving. 

Two Twelve Associates has used wayfinding design to plan 

spaces for clients such as the South Street Seaport, the 

Cent ral Park Zoo, the Baltimore Light Rail S ubway, the 

Baltimore Waterfront Promenade, the City of New York 

Department of Parks and Recreation, and the Metropoli tan 

Transportation Authority. 

Recently, David Reinfurt, a graphic designer with Two 

Twelve, designed and buil t the two Web sites for Reuters, 

shown in th is chapter. David 's skill as an environmental 
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1 . 

graphic designer and his insight into how to plan a project wi ll 

help Web designe rs organize the ir own sites. 

1. Reuters News Machine. 
For business people suffer ing from " in formatio n overload," 

Reuters News Machine offers what might be ca lled an e lec

tronic clipping service call ed my.news. For a fixed monthly 

fee, a computer user can predefine the categories of news 

they wish to receive, and Reuters will deliver a ll re lated s to

ries. The service also o ffe rs general news, sports news, busi

ness news, o ffbeat news (alt.news), and an area called 

news. talk, dedicated to online discussions about current 

events. 

a. News content groups. Up-to- the-minute reports from 

the Reuters bureaus around the world are organized into 

four "content" groups. Users can cl ick on a category and 

then review a list of headline/synopsis items. Each news 

headline is a link to the full story. Content groups 

inc lude: 

• news, which contains general news items from 

around the world. 

• business, which includes stories shaping the eco

nomic and business news. 

• sports, which conta ins the latest spmt s stories. 

• a lt.news, which inc ludes "offbeat" news. 
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Tip: The Reuters Business Information 

Products site has full-bleed images, 

which have been ghosted to a light gray 

and white and used to cover the back

ground. This effect is achieved with the 

<Body Background= "filename.gif"> 

tag at the top of the HTML document: 

<body ba ckgrou nd

"filename.gif"><lbody> 

b. News functions. This consists of two unique "news 

tools" and a news ctiscussion area where you can pmtici

pate in news discussions wit11 people around the world. 

• News.search is a powerful search tool that responds 

to a keyword search, gathering news items on any 

topic you choose. 

• My.news is the Web equivalent of an electronic clip

ping service allowing you to predefine news cate

gories of interest. The news stories are automatically 

delivered to your computer several times a day. 

• News.talk is an area containing news "threads," 

which m·e followed by people all over the world. 

Users exchange their views by posting messages to a 

particulm thread in response to a news item. 

2. Reuters business information products. 
Reuters Business Information site was created to support two 

new Reuter's online business services : Reuters Business 

Briefing and Reuters Business Alert. These two online, user

definable news retrieval services offer news gathered from 

more than 2,000 sources and delivered up to 15 times a day 

to a subscriber's PC or server. 

Reuters Business Briefing is a server-based product that can 

assemble news in one central location and distribute it on an 

enterprise-wide basis via Lotus Notes. 

Reuters Business Alert is a smaller, workstation or LAN

based news-gathering service designed for PCs running 

Microsoft Windows. 

a. Products. A mouse click on the Products button will 

take visitors to pages that describe both of the Reuters 

business information products. 

2a. 

( Pr oducts) 
Introducing Reuters Business Bnef~a?ui'Reuters Bwiness 
Alert SeiVer-·-two ne'>r ways til llelp your company gain 1he 
competiti}'e edge \ ..... 
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Tip: Notice that the outline around but

tolls has been turned off Netscape 

ordinarily displays a heavy blue line 

around an image that 's a link (called 

an "active link" )and a purple line if 
the link has been clicked (called a "vis

ited link"). To turn off the otilline, 

enter: 

<img s rc-"f i l ename . gi f" 

border- 0> 
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b. Sales Contacts. The Sales Contacts butto n (Figure 

2 b1. 

2b2. 

2 b3. 

2b I) will branch to a map of the U nited States. Clicking 

on a state (Figure 2b2) will bring up a silhouette image 

of the sales rep for tha t state (Figure 2 b3), and, if the 

browser has a built-in sound player, the rep's "hello" 

will be heard. 

(S. fes C o n u ' c lS ) 
Con1aet a Reulll!B, sales representative near you 

c. Sources. If visitors are interested in knowing the 

sources for news, a Sources button will branch to a sec

tion that will display the information onscreen. 

2c. 

(S ou roe o s) 
'I1ie R~ute:rs globe! nen,-ork, plus more than 2 ,000 addilionel 
sources 



d. Feedback. The Feedback button (Figure 2d L) branches 

to a questionnaire. A multiple-choice format with 

checkboxes makes the form (Figure 2d2) easy to use. 

2d1. 

n... ...... "'~'~.--, 
:J* • ............... . 

8 S:::..00~=~:-o~t~~co""' 

2d2. 

e. The Network. The Network button takes visitors to an 

area that changes most frequently. It includes product 

announcements and a " faq"-or frequently asked ques

tions-section. 

2e. 

(T he Ne twork) 
Chat with us about the latest new;,, technll:el developmtlnts. 
database enhancements and other helpful items l:l ~~:et the JOOst 
from Heutel3 Business lnfonn.e.tion produc~ 
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David Reinfurt's 
tips on planning 
a Website 
Summary: The essential early steps in 

the Web site development process do not 

involve graphics; they require the cre

ation of an underlying stmcture. 

16. [ Chapter 1 

~tJ_g;J~~~_ru~u 
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1. Assemble the team. 
For a graphic design firm , the Web development team 

includes c lient members as well as members from Lhe 

graphic design firm , including: 

a. A manager, client. This person bas the authority to 

make decisions and is most likely a member of the firm 's 

marketing team. Idea lly, this team member is very rami l

iar with the Web and can be re lied upon for contelll 

ideas. 

b. Writer/mat·keting specialist, client. [n Reute rs' World 

Wide Web terminology, this person is known as an editor. 

Analogous in some ways to a managing editor, this mem

ber contributes content ideas and has an on-going role in 

the life of the Web project. Ideally, this team member is 

very familiar wit11 the Web. 

c. A technical specialist, client. This member is responsi

ble for making the Web pages and the server work. The 

team might look to an Inte rnet provider to li ll this role. 

Ideally, this person is fami liar with the Macintosh. PC, 

and Unix platforms. 

d. Graphic designers, graphic design firm. Depending 

on the size of the project, two designers may be involved. 

A senior designer directs in artistic areas, and a j unior 

designer is involved in production. 



e . Information Designer, graphic design firm. This 

member has a writing background and will review the 

marketing content to see if it is appropriate for the Web. 

For example, marketing content created for print is often 

too wordy; an info rmation designer wi ll know how to 

edit the content for Web pages. This member should be 

very familiar with the Web. 

2. Develop a concept. 
Developing a concept usually involves a brainstorming ses· 

sion, which may last an entire week. At this stage, a rough 

content list consisting of bullets should be developed. This 

in formation will be refi ned and organized in a schematic 

process, as outlined next. To help facil itate the fl ow o f ideas 

in brainstorming sessions: 

a. Tour the Web. Analyze what's possible, and examine 

well-implemented sites. Because the Web is large and 

changes frequently, each team member should have a 

connection and be able to search the Web independently. 

b. Consider sources for content. Although a firm 's exist

ing collateral materials may be repurposed for a Web 

site, ideally the site should have new content. 

c. Develop an underlying paradigm or metaphor. 
One of the most i mp01tant elements to consider 

during initial brainstorming sessions is the underlying 

paradigm: 

• Is it a bookstore? 

• Is it a record store? 

• Is it a catalog? 

• Is it a public re lations vehicle? 

The Reuters development team decided the News 

Machine site would be an online news source, some

where between newspaper and te levision, and the 

Business Information Products site wou ld be a public 

relations vehicle. 
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Level 1 

Level 2 

Level 3 

3a. 

~~ 
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3b. 
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3. Develop a schematic (on paper). 
W hile the write rs develop copy, the graphic designers 

develop a minimal schematic . Copy. in the form o f diagram 

labe ls, is used to identify the components o f the Web site 

(Figure 3a). 

Functional Schematic 
Reuters News Machine Web Site 

4.3.95 

Front 
Page 

Business[:] 

Story 
Related 
Story 

/ 8 Encyclopedia 

Level I conta ins the site's components as described in 

wayfi nding design. (See Wayfinding principles in Web site 

design later in this chapter.) In th is model. the components are 

the four news content areas and three news functions. 

Although these are not shown on the minimal schematic, they 

show up as text in the schematic prototype and as glyphs, or 

identify ing icons, in the graphic design phase (Figure 3b). 

Level 2 conta ins the destinations described in wayfinding 

desig n. rn th is model, desti nations include types of news. 

(News, sporL<;. business, and othe r fie lds arc page names, 

which were modified and rearranged later in the project.) 



Mental Map+ Structure 
Reuters Business Information Products Web Site 

I 
Questionaire I Product Info +Feedback 

If t F 
I 

Reuters Reuters Business Business Alert 
.... t Briefing 

.... t 

t =Home Button 
.... =Back Button 
• =Image Map 
F =Form 

4a. 

4.3.95 

Home 

I I I 

Sales I Force Sources Help 
t t t 

I I I I 

Full Source FAQ US Map Info +- t • t 
I US Map 

.... t • ....t 

I I 
I Photo/Sounds 
... t Sales Rep Telephone #s 

.... t 

4. Plan navigation. 
The arrows on the schematic diagrams roughly describe navi

gation. Later, sets of glyphs arc developed to help users navi

gate (represented schematically in Figure 4a and 

implemented in Figure 4b). Other navigation aids include 

links to a help screen and a site map. 

[News0Machine] 
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Tip: Make sure text copy is proofread 

carefully. Fun, "amateur" Web pages 

are 110t harmed nwch by typos, but pro

f essional business sites riddled with 

typos can have an wlpro.fessional 

appearance. 

20.1 Chapter I 

5. Create a schematic prototype (no graphics). 
A schematic prototype consists of text-only Web pages. 

Although text is boring to look at, it focuses a team's attention 

on content before graphics enter the picture. For the graphic 

design finn. a schematic prototype can be used to get client 

approval before moving on to the next phase. The prototype 

shOLIId follow the earlier schematic and contain easy-to-read 

copy developed for quick consumption. 

a. Easy-to-read chunks. The content should consist of 

plain language organized into chunks of four to five 

items. For example, in the News Machine project, the 

graphic design elements on the Reuters " front page" 

evolved much later in the project. Early in the project, 

the front page was represented with text items, such as: 

• News 

• Sports 

• Business 

• Other 

b. Analyze the information. Carefully plan how informa

tion is presented. Web visitors should: 

• Understand where they are at all times. At the pro

totype stage, locations were ident ified with text 

labels. Much later, matchjng graphic design clements 

were created as location identifiers on every page. In 

the Business Information pages, the page back

grounds identi fy a visitor's location. 

• Understand the "destinations" built into a site. 

Although the decision to provide visitors with some 

facility to see all destinations at all times was made at 

the prototype stage, the tool bar did not take shape 

unti l later in U1e graphic design stage. In the News 

Machine site, a tool bar on every page includes all the 

destinations available to a visi tor. 

• Understand what action will take them to a desti

nation. At the prototype stage, text li nks were used as 

navigation links. Buttons and other graphic design 

elements were added later. For example, in the News 



Machine site, a cl ick on a small icon will give a larger 

icon at the top of the next page. This reinforces that 

the action is correct. 

c. Streamline the copy. Because it is likely that Web visi

tors will do more scanning and glancing than reading 

from left to right, the content should be refined to contai n 

essential information, conveyed in keywords. 

6. Begin the graphic design process. 
If planning is phase one, then graphic design is phase two. 

During this second phase, the deve.lopment team meets reg

ularly to review the design direction. As in print, the design 

cycle is an interactive process. During this phase, the graph

ic designers carefully review the visual elements and con

stantly ask themselves, How can I improve th is? Does this 

work? Are the visual elements easy to understand? 

The work that goes into the planning phase does not end 

when graphic design begins. During the graphic design 

phase, the designer must constantly look back at the planning 

work accomplished in phase one and ask, Does the project's 

design match the original project plan? Is it clear? Are the 

ideas easy to understand? 

Web Watching And Planning 121. 



Wayfinding 
principles in Web 
site design 

Summary: Wayfinding principles, used 

to help people "find their wa)~" offer 

import all/ guidelines/ or Web site devel

opers. These ideas will become even 

more valuable as Web sites develop imo 

3D spaces. 

22.J Chapter I 

Por more tMn e century, our bU5U\e3.5 tw betn 10 cather 
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1. What is wayfinding? 
Introduced to envi ronmenta l des ign in the late 70s, the 

term wayfinding describes spatial behavior. It inc ludes the 

decision making, decision execution, and information 

processing involved in reaching a destination. Although the 

renn initia lly re fe rred to the process of reaching a physical 

destination, waylinding princ iples may also be used for 

navigating Web sites. At the most basic level, wayfinding 

consists of cognitive mapping and spatial problem solving, 

defined next. 

a. Cognitive mapping. The process of forming a mental 

image of a physical layout. 
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b. Spatial problem solving. Behavior, usually decis ion 

maki ng, needed to make a journey or reach a 

destination. 

2. Wayfinding decisions . 
Wayfinding decisions are hierarchically structured in a deci

sion plan, which consists of one or more wayfinding deci

sions broken down into smaller decisions. For example: 

a. Decision to use Reuters news.search. If the 

news.search page in the Reuters News Machine site is a 

destination, smaller waytinding decis ions required 

would include: 

• Get on the Web. 

• Use a bookmark or open the URL associated with 

the Reuters News Machine site. 

• Select news.search from the Reuters home page. 

You would then see the screen shown in Figure 2a. 

If news.search were no t an option available on the 

Reuters home page, the list of decisions would include 

whatever actions would be necessary to get to the desti

nation o r the news.search page. 

b. Decision to contact a Reuters Sales Representative. 

If the Sales Contacts page in the Reuters Business 

Information Products site is the destination, the smaller 

wayfinding decisions would be: 

• Get on the Web. 

• Use a bookmark or open the URL associated with 

the Reuters Business Information Products site. 

• Select Sales Contacts from the Reuters home page. 

• Scro ll to the map of the United States. 

• Click on a state. 

• Record the name and phone number of the Reuters 

salesperson, as shown in Figure 2b. 

3. Wayfinding conditions. 
Wayfinding conditions result in a Web visitor's arrival at 

your site. Different visitors wi ll have different reasons for 

viewing your site. 
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a. The Web visitor is exploring. The visitor has no partic
ular goal or desti nation in mind. 

b. The Web visitor has an objective. The Web visitor is 

seeking specific information. 

4. The wayfinding design process. 
Although wayfinding principles are applied throughout the 

entire planni ng and graphic design process, it is interesting 

to examine the details of the wayfinding design process. 

a. Identification of' components. In the News Machine 

project, identifying components was an essential part of 
the design process because it meant namjng the four con

tent areas and three functions. Identi fying the types of 
news (news, business, sports, and alt news) took place in 

the planning phase and agrun in the design phase. Notice 
the change in the names from the schematic to the graphic 

design phase. 

b. Grouping of components into destinations. In the 

News Machine site, Web visitors move from a front 

page to a destination page with news headlines and a 

news synopsis under each headline. Although it may 

contain further links, a page that contains news is con
sidered a destination. 

c. Linking of components. A tool bar with elements small 

enough to fi t on every page means a Web visitor can 
branch to every section from every page. 

5. Wayfinding design. 
Wayfinding design involves themes that can be adapted and 

applied to Web site development. 

a. Decision diagram. A decision diagram is a I ist of deci
sions a vis itor has to make Lo navigate a s ite. Although 

this step was not used in the two Reuters projects, there 

was a conscious effort to review the number of steps a 
visitor needs to take to get to a destination. As in space 
planning for physical sites, visitors should take as few 

steps as possible to get to Web destinations. 
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Sc. 

b. Graphics as landmarks. Web site pages should have 

related g raphics that act as a masthead, but multiple 

mastheads shou ld not be identical. In the Reuters 

Bus iness Information site, t11e masthead graphic varies 

slightly from page to page. The backgl·ounds also act as 

visual landmarks. 

~~~~~~~~~~~~~~~~~~~~~~~ 
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c. Redundancy. In the Reuters News Machine site, the 

glyphs, or identifyi ng icons, are repeated to remind 

Web visitors where they are at all times. Although the 

size varies, this reoccurring graphic assures that a Web 

visitor is not los t. In the Reuters Business Information 

Product exampl e, notice how David repeated the ide nti 

fy ing button image in the background graphic. 

d. Color. Although color was not used as a landmark in 

either Reuters site, it can be used as an effective identi 

fier to help a Web visitor navigate. 

e . Iteration. Web designers should anLicipate from 5 to 20 

cycles of change in the developmem of a Web site. 

Focus groups. alpha testers. beta testers, and a ques

tionnaire on the Web site are all vehicles for gathering 

feedback from the people who travel the site. 

Web Watching And Planning 125. 
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6. Conclusion. 
Although n planning phase can be rigorous, it represents a 

time-tested model that adds a solid foundation to a project. 

Experience has shown that the projectmodel lhnt includes 

thorough planning wi thstands change much more than a 

project with little planning. 
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Navigation 
[n th is chapter on navigation, Merry Esparza introduces us to both 

20 and 30 navigation on lhe Web. Although 3D "worlds" are rela

tively new, the technology does exist, and it's changing the way 

Web visitors move around. For example, text links and inline links 

on a Web page are replaced hy new navigation controls in 30 

space. The new 30 browsers include network anchors, rubber 

bands, and node pointers that help Web travelers move by hyper

linldng through 30 worlds. 

John Scott, an Internet cafe owner, demonstrates how frames can 

be used to navigate a Web site. Follow step-by-step instructions on 

how to assemble a frame document using art from the cafe's Web 

site. (Note: Look for John Scott 's images in an alt.coffeefolderon 

the CD-ROM in the back of this book.) 





The Mobius 
Gallery 

Summary: An art galle1y in cyberspace 

provides a mode/for learning how to 

plan and develop navigation conrrols 

for your Web site. 

1. The Mobius Gallery site. 
Designed by computer artis t Me rry Esparza 

(merry@ inte rport.net), the Mobius Gallery s ite 

(http://www.users.interport.nell-meny/mobius.html.) provides 

a showcase for Me rry's artwork and Guillermo Esparza 's 

paintings and sculpture. A We b site is a un ique and advanta

geous space for arti sts to set up their own exhibit-it's inter

national, art does not need to be physically transported, and 

the s ite can be easily updated. 

a . Sculpture. To display Guillermo 's work, Merry pho

tog raphed his paintings and sculpture and scanned the 

images into Photoshop. La Magdalena, shown on this 

page, is a cast stone high-relief fi gure, created by 

Guillenno in 1994. The origina l is in The National 

Museum of Catholic Art and History in New York C ity. 

b. Painting. Although images of Guillermo Esparza's 

paintings can be seen on the Web, e lectronic duplicates 

can never totally render his miginal work, which c~m be 

fo und inside many New York City churches. His projects 

have included wall murals, domes, sanctuary paintings, 

and sanctuary statues. Geographically spread out, they can 

be easily brought toge ther in one place-a Web site. 

Navigation J29. 



Above: Meny E.1parza's splash screen for the 

Mobius Gallery site. 

Above: Men y created a 3D cube for her logo. 

Above: Three-dimensiollalmrtral created for 

Empyrean. till interactive compwer strategy 

game. 
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c. Graphics is the section of t11e Web site containing 
Merry's computer illustration. One of her specialties is 

optical illusion art, reflected in tlle site's splash screen. 

Merry explains that the Mobius Gallery's opening screen 
is designed to "reflect the relationship between the view

er and tlle work of ru1." In the image, Merry superimpos

es inverted perspective on linear perspective. Linear 

perspective establishes dept11 by using actual or suggest
ed lines that intersect in the background. This creates a 

space where objects diminish in size relative to distance 
from the viewer's eye. Combined are elements of invert

ed perspective, a concept used in Byzantine art. In invert

ed perspective, objects mat are farthest away appear 

larger than elements in tlle foreground. 

MerTy's work in three-dimensional art has also led 
to a series of murals she created for Empyrean, her 

computer strategy game. Merry built a prototype game 
in Macromedia Director and is currently talking with 

game developers about building an interactive game for 
tlle Web. As Merry explains, ''by 1996, cable modems 

wi II provide enough bandwidth for game developers to 
by-pass CD-ROMs and develop exclusively for t11e Web." 

2. Future 3D graphics on the Mobius site. 
Merry's work in 30 graphics overlaps new developments in 
Web technology. As a result, she sees the Mobius Gallery as 

a test site for interesting new software programs. Examples 
include: 

a. VRML and 3DMF. Merry plans to develop a 3D version 

of the Mobius Gallery, which Web visitors could navigate 
with 3D browsers such as tlle Duet Development 
Corporation's Walkabout 3D World Browser (Figure 2a). 
TI1ree-dimensional spaces also have the potential for 

typed conversation between visitors or between 

Guillem1o, Men·y and visitors. In June I 996, Black Sun 
Lnteractive (hllp://www.blacksun.com) announced 
Cyberi-Iub, a server software program tllat adds 

multiuser capabilities to any Web site. The software is 

highly scalable and can support virtual communities 
ranging from I 0 to thousands of simultaneous users. 



2a. 

A bove: Duet Development 

Cmporation 's 3D World browser and 

Model is a QuickDraw 3D sojiware 

application that allows you to navi

gate and walk about in 3D worlds. 

Below: Realtime voice commwrica

tion is available over the Internet 

from Electric Magic (/rllp:llwww 

. emag ic. com). A mouse click on a 

virtual phone fink inside a 3D space 

could place a realtime (voice) phone 

call over the lntem etfrom anywhere 

in the world. 

NetPhone 1 .2 .1 t 

For more djrect chat with sound, realtime voice commu

nication over the Internet is available from Electric 

magic (http://www.emagic.com). With a mouse click 

on a "vi11ual" phone link inside the Mobius Gallery, a 

reallime phone call could be placed to e ither Guillermo 

or Merry Esparza from anywhere in the world. Although 

still relati vely crude compared to telephone teclmology, 

parties can converse by alternately talking over the 

computer's micropho ne. (Note: On the IBM PC, a 

product ca/fed lntcmct Phone from Vocaltec works in 

a similar way.) 

30 "walkthrough" environments can be built with 

Strata's new Strata Studio Pro and Virtus Corporation's 

Virtus Walkthrough Pro. The developments that make 

walkthrough worlds on the Web possible are two new 

cross-plarform 30 fi le formats with built-in features 

designed for Web travel. VRML (Virtual Reali ty 

Modeling Language), sponsored by Silicon Graphics, 

and 3DMF (30 Meta File), from Apple Computer, w ill 

soon become as fam iliar to Web artists as GlF and JPEG. 

Software application programs that are VRML- and 

30MF-savvy will have a selection on the File menu for 

saving a 30 image as a VRML or 3DMF file. Applica

tions wi ll also have built-in features that enable artists to 

speci ry the location of a network andror or hotspot. 

Network anchors are c lickable spots in a 30 world that 

hold URL informatjon. When clicked, the Web visitor 

hyperlinks or travels to a re lated Web site. 

b. Apple's QuickTime VR. For Web visitors to see gallery 

rooms from a 360-degree perspective, Merry is planning 

QuickTime VR (virtual reality) movies for the Mobius 

site. 30 panels can be rendered for a 360-degree 

panoramic image and stitched together using Apple 's 

QuickTime VR Authoring Tools Sui te. Using Apple's 

QuickTime VR Player, visitors can twist, turn. twirl , 

zoom, and pick up 30 objects in a 3D environmenl. In 

the future, the QuickTime VR experience will include 

Navigation 131. 



Tip: Image maps, with clickable 

regions in all inline image, may also be 

thought of as a Web navigation device. 

Client-side image maps, covered in the 

Client-Side Image Maps chapte1; are 

easier to build than server-dependent 

image maps. 
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music and hyperlinks to other Web sites; 

Apple has only j ust begun to develop the QuickTime 

VR fonnat. 

c. Animated 3D graphics for the Director Internet 

Player. Merry sees potential for animated tours with 

music, sound effects, and interactivity using shockwave, 

Macromedia 's Director Internet Player technology. 



Principles of 
Website 
navigation 

Summary: For the past few decades, 

print. radio, and television have been 

considered the three mass market media. 

Recently, the Web has been described as 

the fou rth mass market111edium. This 

vel)' different new medium a/lows view

ers to interact and "navigate." 
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Graphic designers who have starred to design Web pages 

have the privilege of shaping the newest media-the 

media predicted to innuence the way we work, pl ay, think, 

and learn. Because of its rapid growth, the Web w ill evolve 

in ways we cannot anticipate. A lthough many changes are 

expected to occur in the next few years, several underlying 

principles are likely to remain. 

1. Hypermedia. 
The Web is a hypermedia system developed in 1989 by 

Tim Berners-Lee, a software engineer at the Center for 

European Particle Physics. Hypermedia is interactive infor

mation that has no beginning and no end. A lthough home 

pages are starting points, Web pages should be thought of as 

non-linear. Links found on each page jump to other Web 

pages, providing a random sequencing or infonnation . 

Viewers can navigate through an information base in a vari 

ety o f ways, depending on the links they follow- and the 

information base can be spread out all over the world. 

Navigation 133. 
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Hypermedia is a term invented in the 1970s, but the concept 

dates back to 1945. Read on for a bit of history. 

a. Vanoevar Bush and the Memex system. Jn 1945, 30 

years before anyone thought of a personal computer, 

computer scientist Vannevar Bush described a 

Memex-a system that provided associative indexing, 

or the ability to string together information mean ing

ful to an individual user. Bush envis ioned a system 

with text and graphics that could be viewed either 

sequentia lly or by following a user's trail of associative 

thinking. 

b. Ted Nelson and the word hypermedia. ln the 1970s, 

Ted Nelson, author of Dream Machines, in troduced the 

term hypermedia. He saw hypermedia as a two-way 

medium in which computer users are creators as much 

as they are consumers. Apple Computer has promoted 

this idea since their 1987 introduction of HyperCard, a 

user-friendly hypermedia "authoring" toolkit. 

c. 1\\•o-way communication is attracting b ig business. 

Although CO-ROMs and kiosks have hypermedia char

acte ristics, most are read-only. The potential for two

way communication is much stronger on the World 

Wide Web. As a result, commercial interests are 

focused on the Web's marketing potential. From a mar

keting point of view, tomorrow's vin ual worlds can 

attract the curious Web explorers, and dynamic data

base engines can measure and track a visitor's every 

response. 

2. Active explorer vs. passive observer. 
An underly ing theme in every form of hypermedia is the 

viewer as an act ive explorer. As a travel ing partic ipant in the 

media, the viewer is given the option of deciding where to go 

and how to get there. Viewers move around to navigate and 

interact with an information base. 

a. 1\vo-dimensional HTML. The two-dimensional Web 

page formed from HTML tags is becoming less of a 

page and more of a background for multimedia player 

windows and new animation technologies built into the 



browser's page. Examples include the Director Internet 

Player, the new 3D browsers, and Hot Java, an interac

tive 3D animation technology that can enhance a brows

er page wid1 multimedia presentations or launch small 

applers in the form of interactive floating windows. All 

of these new developments have been built with viewer 

participation in mind. 

b. Three-dimensional VRML and 3DMF. In VRML and 

3DMF worlds, there are no passive observers. 

Navigation in 3D implies moving through a space or 

handling objects. Software engineers involved in the 

development of 3D worlds have invented built-in 

anchors, or hotspots. This means a c lick on an object in a 

3D world will hyperlink a Web visitor to another world . 

3. The home page. 
Regardless of how a Web site is organized or how many 

pages a site has, the starting point is referred to as the 

home page. Although Web visitors can travel d irectly to 

any page o n a Web site, it's the home page address that 

usually gets published or promoted. 

4. Navigating with URLs. 
URLs, or Uniform Resource Locators, are addresses 

used to locate information o n the Web. URLs can be used 

to locate Web documents, FfP fi les, Gopher fi les, news 

Iiles, or other Web resources as they're developed. 

Navigation on the Web means opening a link that con

tains a URL. This can be accomplished by using a 

browser's Open command and typing in the URL or by 

cl icking on a link that contains a URL. A URL stores 

information in three ways. 

a. Protocol information is the fu·st part of the URL. For 

example, Stanford Uni versity's Sumex-aim M acintosh 

software archive has two public mirror sites at Apple 

Computer. Accessing one requires the FfP protocol 

Navigation l 3s. 



Tip: Browser software programs can 

download a file ftvm an FTP site with a 

click on an FTP link on a Web page. 

However, browser software cannot 

"upload." Fetch, by Jim Matthews, is a 

popular Macintosh shareware FTP 

wility that can upload and download 

.files over the Internet. (Note: Fetch ca11 

be found on the CD-ROM in the back of 

this book.) 
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typed into the Open Command's dialog box, and the 

other requires an http protocol, as follows: 

ftp: //miiTOr.apple.com/mirrors/Tnfo-Mac.Archive/ 

http://mirror.apple.com 

In Italy, the Sumex-aim Macintosh software archive is 

mirrored on a Gopher site, as follows: 

gopher://gopher.cnuce.cnr.i t/ I 1 /pub/info-mac 

The protocol provides a clue concerning what type of 

information request is sent fTomthe client (browser soft

ware) to a server (any computer on the Internet). HTTP 

(H.ypertext Transfer Protocol) is the most common proto

col found on the Web because it is used to request Web 

documents from HTTP servers. FTP (File Transfe r 

Protocol) is used to access fi les on an FTP server, and a 

Gopher protocol is used to access a Gopher server. 

b. Domain name information is the part of the URL that 

fo llows the protocol. For example, the Yahoo! search 

engine created by David Filo and Jerry Yang can be 

found at http://www.yahoo.com, where www.yahoo 

.com is the domain name. 

Early Inte rnet addressi ng assigned addresses to 

machines, or hosts. Later, Domain Name Service (DNS) 

addressing was implemented, and addresses 

now refer to domains and not physical machines. 

A domain is considered to be an enti ty that can be a per

son or an organization. 

Although it 's implied that the domain name reflects the 

name of the organization managing the physical Web 

server, or host, many Inte rnet providers allow their 

clients to use their own domain names on server space 

they lease. On behalf o f a client, a provider can apply 

to lnterNIC, an organization that registers and maintains a 

database of domain names used on the Internet 

(hnp://www.internic.net/ds). InterN IC is the result o f a 

cooperative agreement with the National Science 

Foundation. AT&T, and Network Solutions, Inc. The 

registration process takes about a week, and the 
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application procedure is handled through email 

(http://www.internic.net/ds). Once lnterNIC approves a 

domain name, the provider receives a notification via 

emai l. 

c:. Directory and file name information follows the 

domain name and provides additional information about 

the location of a file or directory. Ir a fi le name is present 

in an URL, it has a three or four letter extension and will 

occur in the position furthest to the right. The names to 

the left of the file name, separated by slashes, are direc

tmy names. For example, the Arizona Macintosh Users 

Group in Phoenix Arizona runs a Sumex-aim Macintosh 

mirror archive at: 

ftp://ftp.amug.org/pub/mirrors/info-mac 

Info-mac is the name of a directory. The User's Group 

has an index document to the mirror site available at 

http://www.amug.org/index.html 

lndex.html is the name of a document. 

5. 2D navigational structures. 
a . Linea1· slide shows. The simplest Web s ites are 

developed as linear slide shows in which one page is 

equivalent to the next, without a top-down structure. For 

example, small sites with one or two dozen pages can be 

arranged with simple navigation buttons to move ahead 

or back. 
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b. Hierarchical tree. Large sites should be organized into 

branches, or grouped areas. Visitors can choose to follow 

a branch that interests them, which may bring them to a 

fork and then to a related group of pages. However, 

hypermedia experts have known for some Lime that when 

a llowed to cross from one branch to another without first 

going back "up the tree," viewers get lost. In Figure 5b, 

notice there are no interconnecting lines between 

branches. In order to navigate from one major branch to 

another, a visitor must follow a branch back to the start

ing point. 

D 
I 

r:.::::..~------------------r..::...~-------------------r..::...~ 

I I 
I I 

---------,---j-----T--------~ ---------,---J-----T--------, 

0---0--0---0 0---0--0---0 

6a. 

~--------,----~----T--------1 

0---0--0---0 
6. 2D navigation controls. 

a. Text links. Text links are the most common form of 

links on a browser page. The color of the text link indi

cates the type of link. 

Link text is blue by default in the Netscape browser, 

indicating that a diffe rent Web page can be accessed 

with a click on the highlighted text. Link text is not 

necessarily underlined because viewers may tum 

underlining on or off in the Preferences dialog box. 



Meny Esparza's button link with a 

border. 

6b1. 

The same graphic with the border 

turned off. 

6b2. 

The color of text links can be changed by Web page 

designers by using a hexadecimal RGB value added 

to the <BODY> tag. (Note: See Convert a Pan lone 

RGB value to a Web page color code with the BBS 

Color Editor in the Online Tools chapte1:) 

• Visited link text is purple by default in the Netscape 

browser, indicating that the link has been followed. 

• Active link text is red by default in the Netscape 

browser, indicating that the link is open. 

b. lnline graphics as links (buttons or arrows).lnline 

graphics are graphics that are loaded on the browser page 

along with text. When in line images are defined as links, 

the Netscape browser outlines the graphic with a border 

coded with the same colors as text links (Figure 6b I). By 

default, a blue border indicates the link has not been fol

lowed, purple indicates the link has been followed, and 

red indicates the link is open. This border can be rumed 

off with a BORDER=O attribute added to the image 

<lMG> tag (Figure 6b2). For example: 

<IMG SRC-"buttonl.gif" BORDER-0> 

7. Creating 2D navigation controls with HTML. 
HTML text links and in line graphic links are both created 

with the HTML link tag <A> ... <JA>.lnside the link tag, 

you' ll need: 

a. The name of a file or U RL to link, which will be speci

fied with the HREF attribute inside the link. 

For example: 

<A HREF- "toc.html"> 

b. The text or graphic that will act as the hotspot. 

Examples: 

<A HREF-"toc.html ">Sculpture 
<A HREF-"toc.html"><IHG SRC-"optica.gif"> 

c. An ending link tag. 

Following are some examples of completed links: 

<A HREF- "toc.html">Sculpture<IA> 
<A HREF-" toc.html "><IMG SRC-"optica.gif"><IA> 
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8. 3D navigation controls. 
a. VRML's network anchors are encountered in a VRML 

3D browser window when the viewer's mouse passes 

over a link which, when clicked, will hyper! ink the view

er to another Web site. 

b. Wall{about rubber bands were invented by the Duet 

Development Corporation when they built the 
Walkabout 3D World Browser. The mbber bands pro

vide a means to move forward and control navigation 

speed. Stretching the rubber band a small amount pro

vides slow navigation; stretching it a large amount pro

vides greater speed. 

c. QuickTime VR's node pointers are encountered in a 

QuickTime VR movie player window when the viewer's 

mouse passes over a link which, when clicked, will move 

the viewer to another movie node. 

9. Creating 3D navigation controls with 
VRML and 3DMF. 
Because VRML and 3DMF are both file formats, 3D soft
ware applications that support VRML and 3DMF export or 

save 3D rendered images as VRML or 3DMF Iiles. 

An extra feature that will be important for creating 3D worlds 

is the ability to add network anchors in a VR.MLor 3DMF file. 

These are in the form ofURLs, which, when clicked, will 

hyperlink a Web visitor to another part of the Web. 



Information 
design and 
Website 
"map making" 

Summary: PreliminaJ)' structural 

sketches are 011 imporiC/nt part of the 

hypermedia development process. 

Above: 3D murals created for 

Empyrean, Men )l Esparza 's interactive 

computer strategy game. 

.- . EMPYr.- ~. ~ 
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.··i OFFICIAL GAME STRATEGY GUIDE ·~ 
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1. Flowcharting. 
Flowcharts, or program maps, are essential to the hyperme

dia design process. Merry used a sketchbook to create ideas 

for her interactive computer game. Sketches can lead to new 

ideas, which the infom1ation designer or illustrator can refer 

to in the schematic. 

2. Interactive storyboarding. 
For large projects with production teams, storyboards pro

vide a convenient means to communicate development ideas 

to an enti re team. Some companies find it helpfu l to create 

wall maps, which show the funct ion and approximate layout 

of al l the graphic components. 

2. 
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Create a table 
with HTML to hold 
navigation buttons 
and text links 

Summary: Tables created with HTM L 

tags can form an invisible grid that can 

hold text or graphics. 
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11111!11 £di1 Mode 
New... lllN 

l'lece... "'\" 

\aue lls: ... 
\nue t1 Copy ... 
neoert 

R'qulre 
[IIJlOrt 

fiii• IMo ... 

t•agc \e tutL .. 
l' t lut ... 

Preference' ., 

Qull lllQ 

la. 

Which tour would you like to take first? 

G o.mtnt.Oont 

T able tags are an important part of Netscape's extensions 

to HTML. Table cells can be used to form columns of 

text, which are otherwise impossible to create wi th HTML. 

For the Mobius Gallery home page, Men·y discovered that a 

table offers a convenient way to line up button graphics and 

text links-each is in a separate table cell with the borders 

tumedoff. 

1. Use Photoshop to crop button graphics. 
Because the button graphics will occupy table cells, crop 

them into identical-s ized rectangles, using Photoshop's Info 

pale tte. 

a. Open Photoshop. and select Open from the File pull

down menu. 
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1b. 

I~ UJt l> uank lh perzo •I ~ 1\P\ Ofl•tf~ .. , 

ronno l: PUI IU" 

0 \how lhumbnell 

~ 
~ 

~ 

0 Show flll l~l:~ c:::EE:'J 

" " Polc ttc Options ... II 

" /, ~ 

1d. 

I 

b. Select a graphic in the dialog box that appears, and 

click on Open. 

c . Select Show Info from the WindowiPalettes pull-down 

menu. 

Nf'U• IlhndOIII 

l uom In 
luom Ou t :r--
/uom Fur1 or· . .. 

Sl\ou• Orus hes 
Sllow Options 

r- ----
show Plck:er 
Show Swatches 
Show Scr otc ll 

llil1e l D!JCf$ 
Slloto Chhnncls 
Shorn Paths 

Show Comm o Hlf 

1c. 

d. The Info Palette will appear as a floating palette in the 

Photoshop work area. Click on the Info Palette 's pop-up 

menu to select Palette Options. 

e . Click on the Mouse Coordinates Ruler Units pop-up 

menu to select Pixels. Click on OK. 

Info Options 

r- rlrst Color Readout II OK 1 
18] Show first Color Oeodout 

( Concel ) 
Mode: I nctunl Color • I 

1 Setond Color Readout 

[8} Show Second Color ncodout 

Mode: ] AGO Color ·I 

,-Mouse CoonJinntcs 

~ Show M ouse Coor dina tes 

l nchc' 
Ccn llrnctcrs 1-
Points 

1o. Plcns 
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;, 

1g. 

Uil1ll Modo Image 
Undo Marquee liZ 

Cut IIH I 
Copy XC 
r11HI [' "'" flos tr lnln 
I'll~ tr tolJt•r ... 
Clenr 
Fill... 
Stroko ... 

" 
( n•uh• Publisher ... 
fltJIJil sller OptiOn\. ... 

Ueflnc l'o Hem 
Take Snnpshol 

11. 

44. , Chapter 2 

f. Select t.he rectangle marquee in the Photoshop Toolbox. 

g. Drag a selection rectangle around your graphic. 

h. Note t.he Width and Height measurements in the Info 

Palelle-you'Il need these measuremems to crop your 

other button graphics. 

Info 

R: 
/, G: 

8: 

C: 
, 11: 

g ·• Y: 
K: 

1h. 

118 
89 

i. When you' re satisfied with the selection rectangle, 

select C rop from the Edit pull-down menu. 

j. You wi ll need to repeat t.hese steps for a ll of your button 

graphics. 

1j. 



"' llprn. . .'II 

f'oge te htp ... 
f>fUI1 .. . 

2a. 

l oplice .gll 

c::::) IU"S ()k.-.e-•1 

~ 
~ 
I Nttll.l CJ l 

f ormal : I f'I CJ f ile • I 

2b. 

Simplt?Tex t 

5 . 

2. Save the graphic. 
a. Select Save As from the F ile pull-down menu. 

b. Type in a fi le name and add GIF as an extension. 

c. Press on the Format pop-up box, and select CompuServe 

GIF. Click on Save. 

Photoshop 2.5 c:::::J nPS Dr~.~e·••s: J 

Photothop 2.0 ( I lcct l Rmlgn 1rr 
( l DMr Desktop 

EI'S Nom CJ ) 
I illll~lril• 
.wn .. Concel 
Koc lllk CM\ Photn [II 
M aCPC'Ihll Snuc 
PC II 

PI CIIlc sourcc 
1'111011 

2c. PilteiPnlnt 
RDIIJ 

Scttcu (1 
Tnrgo 
Tlrr 

3. Open SimpleText. 
Use SimpleText or a word processor. If you use a word 

processor, be sure to save the document as Text Only. 

4. Create a new HTML document. 
Start a new document with the fo llowing markup tags: 

<HTI1L> 
<HEA D> 
<TITLE>Hobi us Gall ery</ TI TLE> 
<!HEAD> 

5. Add a BODY BACKGROUND tag. 
Merry used a small tile with a paper texture for the Mobius 

Gallery background. When you list a GIF or JPEG image in 

the BODY tag with a BACKGROUND attribute, Netscape 

and Internet Explorer will automatically tile it to fi lithe 

background . 

<HTML> 
<HEAD > 
<TITLE>Mobi us Gal lery</TITL E> 
<! HEA D> 
<BODY BAC KGROUND-"paper. j peg"> 
<!BODY > 
<I HTML> 
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6. Add an image tag. 
The IMG tag contains a source, or SRC parameter, which 
contains the name of an image file. In this example, the 

image is the splash screen that Merry designed for the 

Mobius Gallery (Figure 6) . 

<HTt1L> 
<HEAD> 
<TI TLE>Mob ius Gal l ery<ITITLE> 
<!HEAD> 
<BODY BACKGROUND- "paper. j peg''> 
<JMG SRC-"Gallery3 . jpeg"> 
<!BODY> 
<IHTML> 

7. Add a table tag. 
The <TABLE> .. . <!TABLE> tag is the principle tag used to 
begin and end a table. 

<HTML> 
<HEAD> 
<TITLE>I·1obi us Gall ery<IT ITLE> 
</HEAD> 
<BODY BAC KGROUND- "paper. j peg"> 
<l MG SRC- "Gal le ry3 . jpeg"> 
<TABLE> 
</TABL E> 
<!BODY> 
<I HTML> 

8. Add a table row tag. 
Use a table row tag <TR> each time you define a new row. 

(Note: Merry used this tag twice in her HTML document 

because her table has two rows.) 

<HTI1 L> 
<HEAD> 
<TI TLE>Mobi us Gal l ery</TITLE> 
</HEAD> 
<BODY BACKGROUND- "paper . j peg "> 
<I MG SRC-"Gal l ery3 .jpeg"> 
<TAB LE> 
<TR> 
<!TABL E> 
<!BODY> 
<IHTM L> 



Tip: An HTML specification is currently 

under development that will add typo

graphic controls to HTML IVitlr style 

sheets. For more information, stay tuned 

to http:!!IVIVW. w3.orglltypertext/ WWW 

I Arena!wy/e.htm/. 

9. Add table header tags. 
The table header tag <TH> . .. <fl'H> is used to define text 

or graphics that will appear in data cells. In this sample, 

Merry used the table header tag to define a row of images 

fo llowed by a row of text. (Note: The table header tag 

<TH> ... <ITH> is ve1y similar to the table data tag 

<TD> ... <lTD>. Although both function the same, the table 

header tag has a default BOLD FONT and a default 

ALIGN= CENTER, which was useful in this sample.) 

<IHI-1L> 
<HEAD> 
<TITLE>Mobius Gal l ery</T ITLE> 
<I HEAD> 
<BODY BACKGROUND-" paper . j peg"> 
<It-IG SRC-"Gallery3.jpeg"> 
<TABLE> 
<TR> 
<TH><A HREF-"toc .html ">< IMG SRC-"optical.gif"><IA><ITH> 
<TH ><A HREF-"toc2. html "> 

<IMG SRC-"optica2.gif"><IA><ITH> 
<TH><A HREF-"toc3. html"l ><HIG 

SRC-"optica3.gif"> 
<IA><ITH> 
<ITR> 
<TR> 
<TH ><A HREF-"t oc . ht ml">Scul pture<IA><ITH> 
<TH><A HREF-"toc2. html ">Painti ngs</A></TH> 
<TH><A HREF-"toc3. ht ml" >Graphi cs<IA><ITH> 
<IT AB LE> 
</BODY> 
<IIHM L> 
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Which tour would you like to ak~ flrR? 

l Oa . 

Which tour would you llkt to ake fll'll? 

lOb. 

48.1 Chapter 2 

10. Use the WIDTH attribute to widen cells. 
The default width of each of the table cells caused the entire 

table to look too nan ow (Figure J Oa). By experimenting with 

the WIDTH attTibute in the table header tag, Merry was able to 

widen the table across Lhe page (Figure lOb). 

<HTML> 

<HEAD> 

<TITLE>Mobius Galle r y<ITITLE> 

</HEAD> 

<BODY BACKGROU ND- "pa pe r. j peg" > 

<I MG SRC- "Ga l leryJ . jpeg" > 

<TABLE> 

<TR> 

<HI WIOTH-160><A HREF- "toc . html "> 

<IMG SRC- "optical.gif"><IA></TH> 

<TH WI DTH- 160><A HREF- " toc2. html "> 

< IMG SRC- "opti ca2 . gi f " ><l A><I TH> 

<TH WI DTH- 160><A HREF- " tocJ. ht ml "> 

<IMG SRC- "opticaJ.gif" ><IA><ITH> 

</TR> 

<TR> 

<TH WTDTH- 160><A liREF- " toe. html">Scu 1 pture</ A><ITH> 

<TH WIDTH- 160><A HREF- " toc2 . html ">Pa i ntings</A><ITH> 

<TH WI DTH- 160><A HREF- " toc3. html ">Graphi cs<l A><ITH> 

</TR> 

<!TABLE> 

<!BODY> 

<I HTML> 



Which tour would you lite to !:Ike first? 

!~~ ~~ 
=···:wul.ll - ~~ 1 - ntttAka -- - j 

11a. 

11b. 

11. Use the BORDER attribute to turn borders off. 
By default, the table header tag and the image tag add bor

ders that Merry needed to turn off (Figure I I a). Use the 

BORDER attribute in both tags to make the borders disap

pear (Figure II b). 

<HTM L> 
<11EAD> 
<TlTLE>Mobius Gall ery</TITLE> 
</ HEAD> 
<BODY BAC KGROUND-"paper.j peg"> 
<lMG SRC- "Ga1 1ery3 . jpeg"> 
<TAB LE BORDER- 0> 
<TR> 
<TH IHDTH- 150><A HREF-" toc .html" > 

<HIG SRC- "optical. gif" BORDE R-O><IA><ITH > 
<TH WIDTH-150><A HREF-"toc2 .h tm1"> 

<lMG SRC-"optica2 .gif " BORDER- O><IA></TH> 
<TH WIDTH-1 50><A HR EF- "toc3.htm1"> 

<l MG SRC- "opt i ca3.gif" BORDER-O><IA></TH> 
<!TR> 
<TR> 
<TH WIDTH-150><A HREF- "toc.html ">Sculpture<IA><ITH> 
<TH WI OTH- 150><A HREF- "toc2 . html">Paintings<IA><ITH> 
<T H W!DTH- 150><A HREF- "toc3.html" >Graphics<IA><ITH> 
<ITR> 
<!TAB LE> 
<I BODY> 
<IHTML> 
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12. Add line breaks. 
The line break tag <BR> adds space below the table. 

<HTML> 
<HEAD> 
<T ITLE>Mobius Gal l ery</TI TLE> 
</ HEAD> 
<BODY BACKGROUND• " paper . j peg"> 

< Jt.1G SRC•"Ga 11 ery3. j peg'' ) 
<TABLE BORDER·O> 
<TR> 
<TH WI DTH•l50><A II REF• " toe . html "> 
<IMG SRC•"optical.gif" BORDER· O><IA><ITH> 
<TH WIDTH• l50> <A HREF•"toc2 .ht ml"> 

<IMG SRC•"opti ca2 . gif" BORDER·O></ A><ITH> 
<TH WIOTH• l50 ><A HREF•"toc3. html "> 

<ITR> 
<TR> 

<IMG SRC•"optica3 .gif" BORDER·O><IA><ITH> 

<TH WI DTH•150><A HRE F• "toc.html ">Scul ptu re<IA><ITH> 
<TH WIDTH•l50><A HREF• "toc2 .ht ml">Paintings<IA><ITH> 
<TH WIDTH-150><A HREF• "toc3. ht ml "> 
Graphics<IA><ITH> 
<ITR> 
<!TABLE> 
<BR> 
<BR> 
<! BODY > 
<I HH1 L> 



Tip: Providing a signature area aids in 

interactive design by encoumging view

ers to send commems, questions, or sug

gestions about your Web site. 

13. Add the signature area. 
IL's customary to add a signature area at the bottom of each 

Web page. This area contains contact information separated 

from the rest of the page with a horizontal rule <1-ffi>. 

<HH1L> 
<HEAD> 
<TITLE>Mobius Gal l ery</TITLE> 
</HEAD> 
<BODY BACKGROU tlD- "paper. jpeg"> 

<IMG SRC-''Gallery3 .jpeg"> 
<TABLE BORDER-0> 
<TR> 
<TH WIDTH- lSO><A HREF- "toc . html"> 
<IMG SRC-"optical.gif" BORDER-O><IA><IT11> 
<Tit WI DTH-lSO><A HREF-"toc2. html"> 

<It~G SRC-"optica2.gi f" BORDER-O><IA><ITH> 
<TH WIDTH-lSO><A HREF-"toc3.html"> 

<IMG SRC-"optica3 . gif" BORDER-O><IA><ITH> 
<ITR> 
<TR> 
<TH WIOTH-lSO><A HREF- "toc.html ">Sculpture<IA><ITH> 
<TH WIDTH-lSO><A HREF-"toc2.html">Paintings</ A><ITH> 
<TH WIDTH-l SO><A HREF-"toc3 .html ">Graphics<IA><ITH> 

<ITR> 
</TABLE> 
<BR> 
<BR> 
CIIR> 
<A DDRE SS> 
Merry Esparza can be contacted at:<BR> 
Merry Esparza Design<BR> 
<!ADDRESS> 
<A HREF- "mail to: webmas ter@ref . com"> 

webma ster@ref. com< IA> 
<!BODY> 
C/HTHL> 
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14. Summary of HTML tags used in this section. 
The tags you sec in this list (in alphabetical order) reflect the 

HTML3.2 specificmion. 

<A> ... <IA> 

Refe1Ted to as an anchor, this tag uses the HREF atuibutc to 
link to an external fi le. For example: 

<A HREF• "toc. ht ml">Scul pture<IA> 

(Note: The HTML.file name must include the path name ({ 

the.fi/e is located in another directory. ) 

<ADDRESS> ... </ADDRESS> 
The address tag provides a means of signjng your Web 
page. The information inside is specially formalled 

and provides Web visitors with information about who 
created the page and who they can contact. This tag 

occurs at the borrom of a Web page, in a section known 
as the signature. 

(Note: It is Cttstomal)' to add em email address to the 

signalllre and to use a MAILTO URL. By building a/ink 

with an email address and by adding the MA ILTO URL 

to the HREF attribute, viewers get an empty emailfonn 

111itli the address already filled out whenever they click on 

the link.) 

<BODY> . .. <!BODY> 
A tag used to open and close the body of a documelll. 

<BR> 
A tag used to break a line. This tag does not require an 
ending tag. 

<HEAD> ... <!HEAD> 
A tag used to open and close the header portion of a 
document. 

<HTML> ... <IHTML> 
A tag used to open and close an HTML document. 

<HR> 
A tag used to create a horizontal rule. This tag does not 
require an ending tag. 



Tip: Derrick Smith, a Visual Basic pro

grammer/ rom Provo, Utah, collabo

rated with artist Frank Decrescenzo and 

built a popup navigation menu f or the 

Slappers Web site using Microsoft's 

ActiveX. Look fo r details about 

Slappers, a new, .flat drumstick in the 

Fonns chapte1: 

<IMG> 
Used to refer to an image, this tag uses the SRC=" .. . " 

all.ribute, which represents the the URL 

(location) of the image. For example: 

<IMG SRC- "optica3 .gif"> 

This tag also uses the BORDER attribute, which can be 

used to turn off the border around a graphic used in a link. 

For example: 

<IMG SRC-"opt ica3 . gi f BOROER-0> 

<TABLE> .. . <ITABLE> 
A tag used to describes the beginning and end of a table. 

This tag uses the BORDER attribute to control the width of 

the border. For example: 

<TABLE BOROER-0> or 
<TABLE BOROER-1> 

<TD> .. . <ITD> 
A tag used to describe the contents of a table cell . (Note: 

In Netscape, the contenls oj1he Table Data cell are 

ALIGN=LEFT. ) 

<TH> ... <ITH> 
A tag used to describe the contents of a table header cell. 

(Note: The con tel/Is oft he table header cell are bold and 

center-aligned by default.) Both the table data <TO> and 

the table header <TH> lags accept the WIDTH attribute. 

For example: 

<TO WIDTH-160> 
<TH WIDTH- 160> 

<TITLE> .. . <!TITLE> 
A tag used to describe the title o f a document, which 

shows up inside a browser's title bar. 

<TR> ... <ITR> 
A tag used to describe a table row. 
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Internet cafe 
owner John Scott 
shares tips on 
creating frames 

Summary: Use a two-frame layout to 

create a table of contents window and a 

window to display linked documents. 

By organizing a Web site's content in 

this way, frames become a navigation 

device. 

54. , Chapter 2 

The frame layout has become very popu lar o n the 

Web. Much like panes in a w indow, th is layou t 

a llows you to divide a page in to rectangular frames . You 

can: 

• specify a unique HTML document to fi ll each frame 

• c reate independent links in a frame 

• c reate links in o ne frame to change content in 

another frame 

John Scott, who own s an Internet cafe in New York's 

East Vil lage, used a two- frame layout on the cafe's Web 

s ite. The first frame acts as an index or table of contents 

contai ning links to conte nt that is displayed in the sec

ond frame. 



Above: Jolm Scott used small JPEG 

images as links in thefirst.frame. With 

irs OW/I scmll bar and links to content in 

the second fram e, this frame acts as an 

index or table of contents. 

1. Overview. 
To create his document, Jo hn created three separate 1-JTML 

documents. 

a. Defining frame document, o r compound document 

b. First frame document 

c. Second frame document 

The nextthree sections provide step-by-step examples of how 

each of these component documents are assembled. (Note: If 
you wish to f ollol\lthe steps in this section, you may use the 

images pmvided in the alt.cojfeefolder on the CD-ROM in the 

back of 1 his book.) 

First frame 

1a,lb, 1c. 
Second frame 

Defining frame document 

2. Create the defining frame document. 
The defining document, or compound document, uses the 

<FRAMESET> tag to open and close a set of frames. This tag 

replaces the <BODY> tag in an HTML document and defines 

the number and size of frames on a page. Web designers will 

notice that a frame document never has a <BODY> tag. 

Ins ide the <FRAMESET> tag, John used the <FRAME> tag 

to define each frame. Following the < FRAMESET> tag, he 

added the <NO FRAMES> tag to disp lay content viewable by 

browsers that do not support frames. 

a. Open SimpleText. Use SimpleText or your word 

processor. If you use a word processor. be sure to save 

the document as Text Only. 
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Above: The "Links" graphic inside the 

alt. coffee table of contents frame. 

B elow: A click on the Links graphic dis

plays a "Links" content page. Designed 

for Web newbies, "Links" contains a 

sampling of interesting places to visit. 

56. , Chapter 2 

b. Create a new HTML document. Start a new document 

with the following markup tags: 

<HTHL> 

<I·IEA D> 

<TITLE>alt . coffee ... coffee . computers. comfy 

chairs . 

</TITLE> 

</HEAD> 

c. Add a <FRAlVillSET> tag. Inside a <FRAMESET> 

tag, a COLS attribute may be used to create columns, or 

a ROWS attribute may be used to create rows. Although 

both can be used in the same <FRAMESET>, it is best 

to keep the number of frames to a minimum. (Note: 

Frame documents IVith too manyframes have a histOI)' 

of making broiVsers crash.) In this example, John used 

the COLS attribute to create a two-frame layout. 

Column width may be set with an equal sign followed 

by an absolute pixel value, percentage values between I 

and I 00, or a relative scaling value where an asterisk 

represents the remaining space. 

Examples: 

<FRAHESET CD LS-"3D'.t .70%> 
<FRAHESET COLS-"120.*"> 

In the following source code, John Scott used an 

absolute pixel value for the first frame followed by an 

asterisk that causes the second frame to fi ll the remain

ing space. (Note: There is no space after the comma. ) 

<ftni L> 

<HEAD> 

<T ITLE>alt . coffee ... coffee. compu te rs . comfy 

chairs . 

</TITLE> 

</ HEAD> 

<F RAMESET COLS-"120,*"> 



Rrst frame (and other 

content frames) contains an 

<A HREF='"doc.htm' BASE 

TARGET = "name"><IMG 

SRC= "image.jpg"> 

</A> tag 

d. Add a <FRAME> tag. A <FRAME> tag defines a 

single frame. For his two-column frame layout, John 

needed two <FRAME> tags. Inside a <FRAME> tag, 

he added: 

• NAME attribute, which lets you assign a unique 

name to a frame. Name a frame and then refer to it by 

name with the BASE tag and TARGET attribute in 

content frame documents. This direc ts content into a 

frame. (Nore: See Create the fi rst frame document 

for an example of how the BASE tag and TARGET 

auribLile are used.) 

• SRC att ribute, which refers to the source HTML 

document. 

• NORES lZE attribute, which prevents visitors from 

dragging the divider bar ro resize a fra me. 

• MARG lNWIDTH and MARGlNHEIGHT attributes, 

which allow you to specify the distance from the edge 

o f a frame to the content inside the frame. 

• SCROLL attribute a llows you to control whether the 

scro ll har appears in a frame. Set this to either auto. 

yes, or no. The default for this attribute is auto. This 

means the scroll bar appears if the content extends 

beyond the edge of the frame. 

Second frame 

Defining frame document 

contains a <FRAME NAME="name"' 

SRC="doc.htm"> tag 
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• 
Above: The Info graphic inside the 

alt. coffee table ofcontentsframe. 

Below: A click on the Info graphic 

displays all llljonnatioll content page. 

This page is desig11ed to hold detailed 

information about the cafe. 

58. Chapter 2 

Notice John 's two <FRAME> tags reside within the 

<FRAMESET> tag: 

<HTML> 

<HEAD> 

<T ITL E>a l t .coffee . . . coffee . compute rs . comfy 
chairs . 

</TI TL E> 

</ HEAD> 

<FRAMESET COLS•"l20.*"> 

<FRAME NAME• "menu " SRC• "menu.h tm" 
UORES IZE MARGUIWIDTH-"0" 
MARGINHEIGHT• "O" SCROLL• "yes"> 

<FRAME NAME• "main" SRC• "home.html- ssi" NORES I ZE 
MARGINWIDTH• "O" 
MARGINH EIGHT- "0" SCROLL• "yes "> 

</ FRAMESET> 

e. Add a <NOFRAJ\IIES> tag. For "frames-challenged" 

browsers, John added a <NO FRAMES> tag. His mes

sage inside this tag directs visitors to the Netscape site 

for a Navigator download. 

<tm1L> 

<HEAD> 

<TI TLE>al t. coffee . .. coffee . computers . comfy 
chairs . 

<!TI TLE> 

</HEAD> 

<FRAHESET CDLS•"l20 ,*"> 

<FRAt~ E tiAME• "menu" SRC•"menu. htm" 
NDRESIZE MARGINWIDTH- "0" 
MARG I NilE I GIH• "O " SCROLL• " yes"> 

<FRAH E NAME• "main" SRC• "home .ht ml " 
UORES I ZE MARG lfiW I DTH• "O" 
MARGIUHEI GHT•"O" SCROLL• "yes "> 

<I FRAt~ESET> 

<tlOFRAMES> 



Above: The Flotsam graphic inside the 

alt. co.ffee table of contentsjrame. 

Below: A click on the Flotsam graphic 

displays a list of/inks to Shockwave and 

other entertainment pages created by 

Lan)' Rosenthal, owner of Cube 

Productions, Inc. 

<Hl ALIGN-CENTER<BL INK>F rame 
ALERT! <I BLINK><IHl> 

<P> 

This document is designed to be viewed using 
<B>Netsca pe 2.0 </ B> ' s 

Frame feature. If you are see ing t hi s message, you 
are us ing a frame <I>challenged<II > browser. 

<P> 

Please. try our <A HREF- "http: //www . a 1 tdotcof 
fee .com/ 
home.html-ssi ">un-framed<IA> page or . .. 

<P> 

a <B>Frame-capab l e<IB> browser can be downloaded 
from 

<A HREF- "http://home. netscape . com/ ">Uetscape 
Communications<IA> . <IP> 

<I NO FRAMES> 

f. Add a n ending tag. Complete the HTML document by 

adding an ending tag. 

<I IHM L> 

g. Save the file. Save the document in SimpleText or your 

word processor. If you're using a word processor, save 

the text as Text Only. Give the fi le an .HTM extension. 

3. Create the first frame document. 
The fi rst frame document or table of contents page may 

coma in either text or graphic links to content on the rest of the 

site. John used small images as links. 

a. Open Simple Text Use Simple Text or your word 

processor. If you use a word processor, be sure to save 

the document as Text Only. 

b. Create a new HTML document. Start a new document 

with lhe following markup tags: 
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Above: Premiere World is the cosp01tsor 

o.fCyberc!till, a monthly flll em et social 

evemt!tat meets at aft.coj}"ee. alt. coffee 

is also a sponsor and tlte event is f ree to 

interested cafe-goers. For details about 

upcoming Cyberclti/1 meetings, check 

tlte Premiere Word link on tlte alt. coffee 

home page at 

It ttp:IIIVW\11. a/ tdotcoff'ee. COlli. 

60., Chapter 2 

<HTHL> 

<HEAD> 

<TITLE>icon menu for alt.coffee<ITITLE> 

</ HEAD> 

c. Add background color and text color. (Note: See the 

Online Tools chapter.for details concerning color 

codes.) 

<HHIL> 

<HEAD> 

<TI TLE>icon menu for alt. coffee</TIT LE> 

</HEAD> 

<BODY BGCOLOR•"#OOOOOO" TEXT•"OOB27F" 
VL lllK• "i/00827 F" All tl K• "IIFF006E"> 

d. Add a center tag. To make sure the links in the table of 
contents column are centered, use a <CENTER> tag. 

<HTHL> 

<II EAD> 

<TJTL E>icon menu for alt. coffee</TI TLE> 

<I HEAD> 

<BODY BGCOLOR• "i/000000" TEXT• "00827F" 
VLI NK•"IIOOB27 F" All tlK· "iiFF006E"> 

<CENTER> 

e . Add an anchor tag. In this example, John's fi rst image 
in the first frame is a link to the alt.coffee home page. 

Whenever there's any other content displayed in the 

second frame, a click on this link will display the home 

page content. To create th is link, add: 

• an 1-1 REF attribute and the name of the external lile. 

• BASE and TARGET attributes to direct content in to 
a named frame. (Note: See Creating a defi ning frame 

document for an example of naming a frame. ) 

• an image Lag with a SRC attribute referencing an 

icon, a BORDER=O attribute to turn off the border 

around the icon, and an ALT attribute referencing 
text for browsers that cannot see images. 
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Above: !HUNK, a digi1al enterwinment 

sile on !he Web, is produced by Cube 

Productions, Inc., a New York-based 

new media finn. Cube owner Larry 

Rosenthal is a 3D world builder and 

new media designer who also chairs the 

NYVRMLSIG, which meels a! all. coffee. 

For details about !he NYVRM LSIG, 

check the tHUNK link 011 the alt.coffee 

home page. 

<Hm L> 

<HEAO><T ITLE>icon menu for alt . coffee</ TI TLE> 

</HEAD> 

<BODY BGCOLOR- "11000000" TEXT- "IF00827F" 
VLI~K-"IF00827F" ALIHK-"IFFF006E" > 

<CE NT ER><A HR EF- "home .h t ml" BASE 
TARGET- "ma in" >< IMG SRC-"home_icon.j pg" BORDER-0 
ALT-"HOHE"><IA><ICENTER> 

f. Add line breaks. 

<HH1L> 

<HEAO><TITLE>icon menu for al t.coffee</TI TLE> 

<! HEAD> 

<BODY BGCOLOR- "#000000" TEXT-"#00827F" 
VLI NK-"II00827F " ALINK- "f/FF006E" > 

<CE NTER>< A HREF-"home .html " BASE 
TARGET-"main">< IHG SRC-"home_i con .jpg" 

BOROER-0 ALT- "HOHE"><I A> </ CENTER> 

<BR><BR> 

g. Add centered, decriptive text beneath the icon. (Note: 

Add more line breaks beneath the new text.) 

<HT11 L> 

<HEAO><TIT LE >i con menu for alt. coffee< /TITLE> 

<!I·IEAO> 

<BODY BGCOLOR-"#000000 " TEXT-"II00827F" 
V Ll NK-"I/00827 F" ALI NK-"fiFF006E" > 

<CENTER>< A HREF-"home.html" BASE 
TARGET- "main">< IHG SRC- "home_icon.jpg" 
BOROER-0 ALT- "HOHE"><IA></CENTER> 

<BR>< BR> 

<CE NTER >h o m e< / CENTER>< BR><BR><BR> 
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Above: 3D world builder Lany 

Rosemhal crea1ed lhe 3D scenes 

for alt. coffee's Palace site at 

toulouse.jlotsam.com. In addition to 

virlual scenes of the real cafe, a back door 

leads from the alt. coffee back room to an 

elaborate underground lounge accessible 

through a door 011 a virtual subway plat

form (lookfordragons). 

62., Chapter 2 

h. Add more images and text to the first frame. By con

tinu ing to add small image links with line breaks to the 

fi rst frame document, the docume nt will form a vertical 

table of contems. (Note: Due to space constraints, only 

two oflhe seven alt. coffee ico11links are listed. If you 

are creating your own frame document with the images 

provided 011 the CD-ROM in the back of this book, you 

may follow these sample links to create the remaining 

links in the table of contents frame. Notice that the 

HTML in each new li11k is the same, except for the ico11 

.file name and the descriptive le.xt.) 

<HTML> 

<HEAD><TITLE>icon menu for alt.coffee</TITLE> 

<!HEAD> 

<BODY BGCOLOR-"1/DOOOOO" TEXT-"I/00827F" 
VLI NK-"I/00827F" AL!tiK-"I/FF006E" > 

<CENTER><A HR EF-"home. html" BASE 
TARGET-"main" >< IMG SRC-"home_icon.jpg " BORDER-0 
A LT-"HO~\E" ><I A><ICENTER> 

<BR><BR> 

<CENTE R>h o m e</CENTER><BR><BR><BR> 

<CENTER ><A HRE F-"ta l k. htm" BASE 
TARGET- "main"><I MG SRC-"ta l k.j pg " 
BORDER-0 AL T-"AL T. COFFEE TALK"> </ A><ICE NTER> 

<BR>< BR> 

<CE ~TER>alt.co ffee talk</CENTER><BR><BR><BR> 

i. Add the ending tag. 

<!HTML> 

j. Save the file. Save the document in SimpleText or your 

word processor. If you're using a word processor, save 

the text as Text Only. Give the file an .HTM extension. 



Above: Ln1e in 1996, a11.coffee was the 

.fir.st stop on Blar.kSw1 lntema1iona/'s 

virrual scavenger hum. 8/ackSun built 

VRM L versions of severa/ Jn1eme1 cafes 

across the country and contesta fll s were 

asked to search for "cyberium c1ystals" 

hidden in each ofthe caf es. The .first 

contes1ant 10 find crys1als at a lithe 

cafes won a trip 10 Spain. 

4. Create documents for the second frame. 
A content document is similar to any ordinary HTML docu

ment. The document described below is the all.coffee home 

page, which links to the icon at the top of the table of contents 

frame. (Note: This documefll is saved as ASCi! text on the 

CD-ROM in the back of this book. ) 

a. Open SimpleText. Use SimpleText or your word 

processor. If you use a word processor, be sure to save 

the documem as Text Only. 

b. Create a new HTML document. Start a new document 

with the following markup tags: 

<HHIL> 

<HEAD> 

<TITLE>a l t . coffee ... coffee. computers. comfy 
chairs . 

<!TITL E> 

<! HEAD> 

c. Add a background color and a text color to the 

document. 

<HTHL> 

<HEA D> 

<T ITLE>alt.coffee ... coffee. computers. comfy 
chairs . 

<!TITL E> 

(/HEAD> 

<BODY BGCOLOR-"(IDDOOOO " TEXT- "IIFFFFFF" > 

d. Add text and images. ln this example, John used the 

fo llowing elements: 

• Font tag to change text size using the SIZE attribute, 

setting the font size relative to the base font size. 

Example: 

<FONT SIZE-+1 > 

This sets the font one size larger than the base fonl. 
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Above: 3D world builder Alex Shamson 

has been creating VRML models since 

1994. His Virtual Reality Mall at 

http://www. vrmill.com/Shopping.htm 

resides on the alt. coffee sen1e1: 

64. I Chapter 2 

• Anchor tag with a BASE TARGET="-TOP" 
attribute to make a linked page open in a new browser 
window. Alternatively, you can make a browser open 

a new window if you make the TARGET the name of 
a frame that doesn't exist. 

Examples: 

<A HREF-"h ttp://www.bl acksun . com/cybe rroute96 

. html '' BASE TARGET-" _ TOP"> 

or 

<A UREF-"http://www.blacksun . com/cybe r route96 

. html" BASE TARGET-"new" > 

A new window will open in front of the current page, 
which will be left on the screen. 

o Paragraph Lag with an ALIGN=CENTER attribute 
making text centered on a page. Options are LEFT, 
CENTER, and RfGHT. 

o MAfLTO URL, which is used in an email link and 
usually placed at the bottom of a page. Viewers who 
click on a link containing a MAIL TO URL will get 
an empty email fo1m with the address filled out. 

<HHIL> 

<HEAD> 

<TI TLE>alt.coffee ... coffee. compu te r s . comf y 

chairs. 

<!TITLE> 

</HEAD> 

<BODY BGCOLOR- " fJOOOOOO " TEXT-"f/FFFFFF"> 

<P ALIGN-CENTER> 

<ING SRC-"wor ds. jpg" BORDER-0> 

<P ALIGN-CE tiTER> 

< IHG SRC-"dance. gif" BORDER-0> 

<P ALIGN-CENTER> 

<FONT SIZE-+l>Are you <I>SHOCKED<II>? 



Above: 3D world builder Lany 

Rosemhal is chairman of New York's 

VRM LSIG, which mee1s at alt. coffee. His 

1HUNKWORLD VRML may be accessed 

tluv ugh links onlhe alt.co.lfee serve~: 

Play alt . coffee ' s <A HREF- "http://www .altdo t 
coffee .com/shock .htm">a nimated 
homepage<JA> ... </ FONT> 

<P ALIGN- CE NTER> 

<FONT SIZE-+l>There's a lo t go ing on t his 
mon th . .. hit our <A HREF-" /CALEIWE R. HTM" >ca 1 en
der of events<IA> for a comp lete l isting. 

<P ALIGN-CENTER> 

<FONT SIZE-+l>Get wi red wi th the regulars at our 

<AHREF-"http://www. al tdotcoffee .com/palace . htm" > 

Palace<JA> site i</FONT> 

<A HREF- "http://www.blacksun.com/cyberrouteg6 

.html " BASE TARG ET-"_TOP" >< IMG SRC-"l ogo.gif" 
ALT-"cyberroute 96" 
BOROER-O><IA> 

<P ALIGN- CENTER> 

<FONT SIZE-+2>Enter t his <A 
HREF- "http://www.blacksun .com/cyberroute96 .ht ml" 

BASE TARGET- "_TO P">vi r tual scavenger hunt<JA> 
and <FOIIT COLOR-"UFFFFOO">IHN</FONT> a t rip 
SPAIN !</FONT> 

<P AL IGN- CENTER> 

<A HREF-"/altcoffe .wrl">vrml . coffee<IA> 

<A HREF-"/pa1ace.htm" >Pa1ace<IA> 

<A HREF-"/1inks .htm">Links<IA> I 

<A HREF - "/rea 1 ity. htm">Rea 1 ity</ A> 

<A HR EF- " /info.htm">Info< /A> 

<P All GN-CE NTE R> 

<A HREF - "http:/ / www. f lo tsam.com" BASE 
TARGET-"_TOP">Visit flotsam.com<IA> I 

Navigation jss. 



Above: An anchor tag with a BASE 

TARGET= "_TOP" attribute, created in 

an HTML document intended to be frame 

content, makes a linked page open a new 

windou1. An example is the link shown 

above, which opens a page containing 

information about 8/ackSun '.1· Scavenger 

Hunt. 

66. \ Chapter 2 

<A HREF- "http: //www.premiereworld.com" 
BASE TARGET-"_TOP">Go to Premi ereWor l d<IA> 

<A HREF-"ht tp://www.th un k.com" BASE 
TARGET-"_TOP">Tune into tHUIIK !WORLD<IA> 

<P ALI Gti-CENTER> 

You are vict i m number 45 today and number 25408 
since Tuesday , Octobe r 29 . 1996 11: 52 : 23 ! 

<P ALIGII-CEIHER> 

Any questions? Comments? E-mail me ... <A 
HREF-"MA l L TO: j etsam@fl ots am. com">webma ster 
@altdotcoffee.com</A> 

<P All Gti-CEtH ER> 

<FOIIT SIZE-·2>All Rights Reserved . llo commercial 
usage of any part of this Website permitted 
without the wri tten permission of al t . coffee. 
Inc. &copy ; l995</FONT> 

e. Add the ending tags. 

<!BODY> 
<IHTML> 

f. Save the file. Save the document in Simple Text or your 
word processor. If you're using a word processor, save 
the text as Text Only. Give the file an .HTM extension. 

g. Test the frame document. Open Netscape or 

Microsoft 's Internet Explorer browser. Open your 
document by selection Open File from the File pu ll
down menu. 



:., ....... _...,~ 
" '" 

Above: A link to the Word. com site 

accessed on the alt. coffee "Links" ji-ame. 

5. Summary of HTML tags used in this section. 
The tags you see in this list (i n alphabetical order) reflect the 

HTML 3.2 specification: 

<A> ... <lA> 

Referred to as an anchor, this tag uses lheHREF attribute to 

link to an external file. For example: 

<A HREF- "ht tp://www.blacksun.com/cybe r route96 

.html " BASE TARGET-·'_TOP '' >< IMG SRC-"logo.gi f" 

ALT-"cyberroute 96" BORDER-O><IA> 

(Note: The HTML.file name must include the path name (( 

the file is located in another directory. See Create the first 

frame document for details concerning the a/tributes used 

in John's anchor tag.) 

<BODY> ... <!BODY> 

A tag used to open and close the body of a document. 

This tag uses the BGCOLOR auribute to add color to the 

browser background, using standard color names and 

hexadecimal RGB triplet information in the forn1: 

<BODY BGCOLOR-Blue> 
<BO DY BGCOLOR- "#fffff f" > 

<BR> 

A tag used to break a line. T his tag does not require an 

ending tag. 

<FONT SIZE=VALUE> .. . <IFONT> 

A tag uecl to change the default font size. Values range 

from 1 to 7. T he tag can also be written wi th a preceding 

+or- to indicate a size that is relative to the base font. 

<FRAME> ... <lFRAME> 
A tag used to de line a single frame. For example: 

<FRAME NAHE- "menu" SRC-"menu.htm" NORES IZE 
11A RG INWIDTH- "O" HARGJ NHEIGHT-"0" SCROLL- "yes "> 

(Note: See Create the de lining frame document/or 

details concerning the attribmes Jolm used inside the 

<FRAME> tag.) 
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Above: A link to the Seattle CAM 

accessed 011 the all. coffee Li11ksjrame. 

This view of Seattle is live a11d is updated 

eve1y minllle. 
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<FRAMESET> .. . </FRAMESET> 
A tag used to de fine a set of frames. For example: 

<FRAMESET COLS-"120 , * " > 

(Note: See Create the defining frame document for 

details CO/lcem illg the attribwes Jolmused i11side the 

<FRAMESET> tag.) 

<H2> ... </H2> 
<H3> ... <1H3> 

Tags used to enlarge text, as to indicate a heading. Lower 

numbers indicate larger type, and the options range from 

<H I> through <H6>. 

<HEAD> ... <IHEAD> 
A tag used to open and c lose the header portion of an 

HTML document. 

<HTML> ... </HTML> 
A tag used to open and close an HTML docume nt. 

<IMG> 
Used to re ferto an image, this tag uses the SRC=" ... " 

attribute. which re presents the URL (locatio n) of the 

image. This tag also uses the BORDER attribute, which 

can be used to turn ofT the border around a g raphic used in 

a link. For example: 

< H1G SRC-"home_ icon. j pg" BORDER-0> 

<NOFRAMES> . .. <INOFRAMES> 
A tag used to add text that viewers can see if they are 

using a browser that can't read frame code. 

<P> ... <P> 
A tag used to indicate a new paragraph. U nl ike the <BR> 

tag, this tag adds line spacing. A n e nd ing tag is optional. 

<TITLE> ... <ITITLE> 
A tag used to describe the title of a document, whic h 

shows up inside a browser's tiLie bar. 



Artist featured in 
this chapter: 

Peju Alawusa is a 
graphic designer at 
Simon & Schuster in 
New York City and has a 
degree in Advertising 
and Design f rom the 
Fashionlnstiwte of 
Technology. 

peju_alawusa@ 
prenhal/.com 

ltttp:/l!nembers.aol.conll 
alawttsalintro.hrntl 
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NetObjects Fusion 
NetObjects Fusion is a new Web page design tool for graphic 

designers who wish to avoid HTML tags. Page elements 

may be imported and placed on a page much like they' re 

placed in a page layout software program. 

NetObjects Fusion builds HTML tags in the background 

(tables). The software is particularly useful for creating large 

sites because it provides centralized contro l over links as 

they 're updated. 

In this chapter, new media artist Peju Alawusa bui lds her 

own site and demonstrates NetObjects Fusion features by cre

ating her resume. Additional Net Objects Fusion features may 

be found in Chapter 12. Artist Frank DeCrescenzo uses 

NetObjects Fusion to bui ld a site with image maps and a form. 





A new Web page 
layout tool for 
designers 

Summary: A Web page layout tool is 

now available for artists who really 

don't /ike HTML tags. It 's called 

NetObjects Fusion, created by 

NetObjects, Inc. (hup/lwlvllwetub

jects.com). 

NetObjects 
FUSION~ 
Version 1.0 

~1 996 NetObjects, Inc. Al l Hlght s Heserved 

NIY~ 

N etObjects, Inc. was founded in November 1995 by 

Rae Technology and Studio Archetype (formerly 

Clement Mok Design). NetObjects Fusion is a unique new 

Web page layout tool that provides the ability to create Web 

pages wi thout HTML tagging. 

1. 30-day software trial. 
Download a 30-day lTial version ofNetObjects Fusion from 

http://www.netobjects.com. Documentation is available as 

an optional download. The software is only available for 

one 30-day trial and cannot be reinstalled. 

2. Hardware and software requirements. 
NetObjects Fusion is available for Power Macintosh or 

Windows 95/NT. To run the software on a Macintosh, you 

must have: 

• A Power Macintosh with a CD-ROM drive. 

• LOMB of d isk space for a minimum installation, or 60MB 

of disk space for a complete installation. 

• 16MB or RAM (24MB is recommended). 

• System 7 .1.2 or greater (System 7.5 is recommended). 

• Web browser software (an HTML 3.x complient browser). 

NetObjects Fusion I 71. 



Peju Alawusa's 
tips on creating 
Web pages with 
NetObjects Fusion 

Above: Peju Alawusa 's home page coll

taills a11 image map .l'he created in 

NetObjects Fusion To see her site on 

the Web, visit 

http :1/mem be rs. aol. com/a law usa/in tro 

.html. 
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NetObjects Fusion 
1a. 

Nelscape: resume 

~"ei ll ( 

1231.ofayetle avenue.113d 
brooklyn ny 11211 118·6Z5·6819 

Objective 
To farther obtain profusional expmence m the. field of mulwntdle. 
and othtc related vtsu.61 ens medJa 

Expoience 
S1mon & Sc.husttr 
Oraplue dwiiJitt 
1230Avenut ohht Al'E\uieas, Ne"' York 
ttl: 212 691H29:l 
Auguot 1995 • Pre se.~t 

Scholastic, lnC'. 
Graphic dtSIIIJitr 
400 Lafaytne Strttt, New York 
Mar<h,199S·Jol-t1995 

Amistad. Pren, Inc:. 
Grapluc Dts1gnu 
1271 Avwue of the Americas, New Yolk 
ttl 212 522 5270 
JaniW)' 1994·Januezy 1995 

Peju's resume is one of the pages she created for her Web 

site at http://members.aol.com/alawusa!illtro.html. ln 

much the same way a designer creates a page in a page 

layout program, Peju positioned the page elements as 

draggable elements, and NetObjects created the HT ML 

tags. (Note: ({you wish to follow this example step-by-step, 

look for Peju'.1· art files 011 the compa11ion CD-ROM.) 

1. Start NetObjects Fusion. 
a. Start NetObjects Fusion. 



... , 

1b. 

b. A New site dialog box will appear on your screen. 

(Note: If rhe New Sire d ialog box did not appeQJ; select 

New Site from the File pull-down menu.) 

c. Click on Lhe Select bullon. 

d. In the dialog box thnL follows, select a folder where you 

would like to save your site, and c lick on Save. (Note: If 

you do nor selecl your own folder; NerObjecrs Fusion 

will srore rhe site in a User Siresfolder inside the 

NerObjects Fusion folde l:) 

\lll fl f111 11.11lle r. 

1c. 

1d. 

0 1ll l i 0{J 

~ 
~ 

e. The path name to the folder you selected will be dis

played in the Save Site fie ld on the New Site dialog box, 

as shown in Fig ure I e. A set o f Autosites and Page 

Templates accompany the NetObjects Fusion software. 

A list of AutoSites, Tutoria ls, and Page Templates are 

displayed on the New S ite dialog box. 

f. Type a name for your site in the field labeled Site Name 

at the top of Lhe New S ite dialog box, and click on OK. 

The site name wi II serve as a file name, which is given a 

.NOD extension. The site name will also be used as the 

sub folder name Lhat stores the NOD file and the site's 

assets . 

....... ",., 

... 

1 e ,1f. 
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2a. 

" .. 

g. A NetObjects Fusion Site screen will be displayed. 
(Note: The Site view will be where you create pages and 

a structure .for your site.) 

2. Review the default preferences. 
A review of the NetObjects Fusion default preferences will 
help you understand how the software works. 

a. Select Preferences from the Edit pull-down menu. 

b. A Preferences dialog box will appear, with the General 
Preferences tab selected at the top of the dialog box. 

2b. 

c. The default settings on this tab section include: 

• Autosave. Your site will be saved automatically. 

• Window maximized at Startup. Your opening 
screen wi ll be a consistent size when you launch the 
software. 

• Preview Entire site. Pressing the Preview button will 
launch your selected Web browser and display the 
entire site. 

• WYSIWYG layout in Netscape browser: This opti
mizes your site in the Netscape browser. 

d. Click on the Layout Preferences tab at the top of the 
Preferences dialog box. 



2e. 

3a. 

Select Browser 

3b. 

e. The Layout Preferences page will be displayed. The 

default settings on this tab section include: 

• Times. The default proportional font. 

• Courier. The default monospace font. 

• Background Image Offset. Although this is not 

selected at startup, setting the background image off

set in pixels wi ll add a border to the page display. 

Leave this unchecked. 

• Snap to Grid. The defau lt setting is off. Click to add 

a check.mark, and page elements wi ll align with the 

page grid. 

3. Select a browser for Web page previews. 
Select your Web browser in the Preferences dialog box. With 

a browser selected on your hard drive, NetObjects Fusion 

will be able to preview your page. 

a. Click on the General Preferences tab at the top of the 

Preferences dialog box. 

b. Click on the Select Browser button. 

c. In the dia log box that follows, locate the folder that 

contains your browser software, and click on Open. 

d. In the dialog box that follows, select your browser soft

ware, and click on Open. 

c::::) uu • .:' "'' 

~ 
( Drdctop I 

Pufereun 

3c. 3d. 

e . The browser will be li sted below Current Browser in the 

Preferences dialog box. 

Onvser 

Current OrG.,..,.r: 

3e. 
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4. Create Web pages and label them. 
a. Jn NetObjects Fusion's Site view, locate the New Page 

bull on at the top of the screen. Notice that the home page 

icon is highlighted. indicating that it is selected. 

Highlighted home page icon New Page button 

L 

4a. 

b. Click on the New Page button four times. 

c. This wi ll create four "child" pages beneath the home 

page, as shown in Figure 4c. (Note: A triangle will 

appear at the boll om oft he home page icon, indicating 

rhat it is n parent. Triangles on the side of a page icon 

indicate the page is a sibling. Pages may be repositioned 

at any time by dragging them.) 

....... LJ I ----..................... triangle 

Unlitled Unl ded Ur lded Un':ll'ed 

4c. 



-....... 

EJ ~ T 0:::::0 

4d. 

-Home 

....... 
Uri Ued 

............ i....._....._ 
resume poltl~llo ln!eresl I nu 

4e. 

d. Click on the word Untitled in the first child page you 

created, and type: 

resume 

Press the Tab key to move the highlighted outline to the 

second child page you created, and type: 

portfol io 

Press the Tab key to move the highlighted outline to the 

third child page you created, and type: 

interest 

Press the Tab key to move the highlighted outline to the 

fourth page you created, and type: 

1 inks 

e. Click to select the page labeled portfolio, and click on 

the New Page button twice. Peju labeled the two new 

child pages advertising and misc. 

f . Click to select the page labeled interest, and click on the 

New Page button three times. Peju labeled the three new 

child pages muzik, poet!)', and literature. 

........... 
fH U:nt pOif'Oikl 

aOVI!Itl t!.. rruc 

4f. 

-Homo 

T 

...... _ 
rmr1t.. poetry 

NetObjects Fusion !11. 
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-lfl lro 

--lrterest Urt.s 

g. Peju changed the label on the home page to Intm . (Note: 

When you're building a large site, the display of page 

icons may be collapsed by clicking on the small triangles 

beneath the parent page icons.) 

_.... ....... ............. 
rasumo porllollo Interest links 

4g. 

5. Change views, and add art to a page. 
The NetObjects Fusion Page view is the layout area where 

Web pages are created. 

a. In the Site view, double-cl ick on the page labeled 

resume. 

b. NetObjects Fusion's Page view will be disp layed. Notice 

that the screen contains a defau lt page banner labeled 

resume. 

Sb. 



Sc. 

Sd. 

Sf. 

c. Select the Selection Tool. 

d. Click to select the page banner, and press the Delete key 

to delete it. 

e. Click to select the set of default navigat ion bars, and 

press the Delete key to delete the row. 

se. 

f. Drag the page divider that separates the header from the 

body, and move it up to make more room. 

g. Select the Picture Tool. 

h. Draw a picture box at the top of the page, as shown in 

Figure5h. 

sg. 

Sh. 

NetObjects Fusion J79. 
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i. When you release the mouse button, an Open File dialog 

box wi ll appear. 

j. Use the File List window in the Open File d ialog box to 

locate your art or Peju ' s image called resname.gij: Click 

on Open. Interesting features related to how NetObjects 

Fusion handles images include: 

• The software supports a wide variety of image for

mats, including BMP, PICT, PCX, Photoshop, TGA, 

and Uncompressed TIFF. NetObjects Fusion will con

vert these alternative formats to GIF or JPEG. The 

software wi ll present a dialog box where you may 

select JPEG or GIF. 

• Pictures may be cropped by changing the shape of the 

bound ing box. 

• GIF images may be converted to tranparent GIFs 

inside the NetObjects Fusion software. The software 's 

Transparency Tool may be used to select the color to 

make transparent. 

k. The att wi ll lill the p icture box you've drawn, as shown 

in Figure 5k. 

I. Repeat Steps 5g through 5k to impo1t Peju's other 

image, calledfiml.:y3.jpg, as shown in Figure 51. 

51. 



&a. 

7a. 

7b. 

6. Use the Draw Tool to create a rule. 
a. Select the Draw Too l. 

b. Draw a vertical rule a long the length of Peju's second 

image, as shown in Figure 6b. 

c. (Option) Use the Properties dialog box to alter the color 

or weight of the rule. 

6b. 

7. Add text to a page. 
a. Select the Text Tool. 

b. Draw a text box, as shown in Figure 7b. 

c. When you release the mouse button, you wil l see a blink

ing cursor in the upper-left corner of the text box. Type: 

Obj ective 

7c. 
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d. Drag-selec t the word Objective. 

e . Click on the bo ld button in the Properties dialog box. 

7e. 

1-

7d. 

f . Press Return, and type: 

To f urther obta in profes si onal experi ence in the fie l d 

of mult i medi a and other rel ated vi sual ar t s medi a . 

g. Press Relllrn, and type: 

Exper ience 

Notice a Return adds a line break and line spacing. 

h. Drag-se lect this word, and add boldfacing. 

i. Hold down the Shift key, press Return, and type: 

Si mon & Schus ter 

Notice that a Shift + Return adds a line break without 

line spacing . 

j. Hold down the Shift key, press Re turn, and type: 

Graphic des i gner 

k. Hold down the Shift key, press Re turn, and type: 

1230 Av enue of the Amer icas . New Yo rk 

I. Hold down the Shift key, press Retum, and type: 

t el: 212-698· 1293 

m. Hold down the Shi ft key, press Return , and type: 

August 1995- Present 

n. Peju added the remaining text. 
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9a. 

8. Preview the Web page. 
a. Click on the Preview bullon. 

b. A preview status bar wi ll be displayed. 

c. NetObjects Fusion will launch your selected browser 

and display your page. (Note: For details on how to 

select a browser in the Net Objects Fusion Preferences, 

see Steps 3a through 3e.) 

d. Select Quit from the Nctscape File pull-down menu to 

put the browser away. (Note: Leave the browser open (f 

you have p/enry of RAM memOI)'. ) 

Be. 
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9. Edit the text. 
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N.,W M nll ,..II!U8!JP. Ml't 
' 'I!UI DOtiiiTil'RI. 
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Sd. 

Remove the line spacing beneath the word Objective . 

a. Click before the le tter Tin the line of text below the 

word Objective. This wi ll insert your cursor in the text. 
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lOb. 

b . Press the Dele te key to close up the space. 

c. Hold down the Shi ft key, and press Return . 

d . A line break will be added with no extra line spacing. 
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9c, 9d. 

e . Repeat Steps 8a through 8d to re-preview the page . 

9o. 

......... 
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10. Remove the default links in the footer. 
a. Scroll to the bottom of the page. 

b. Select the Selection Tool. 

c. Click on the default text links in the Footer, as shown in 

Figure LOc. 

d. Press the Delete key to delete the text links. 
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12a. 

e. Click on the default NetObjects Fusion button link in the 

Footer, as shown in Figure 1 Oe. 

f. Press the Delete key to delete the button link. 

11. Lengthen the page . 
a. Click on the Layout tab at the top of the Properties 

dialog box. 

b. The Layout page of the Properties dialog box wi ll be 

displayed. 

c. Click on the up anow next to the field labeled Height. 

11a. 

Add 100 pixels to the height of the page by clicking on 

the up arrow. 

"'""' e:J(nt•xt" 
H~~rot~[ltovtb 

ea-....... a.~ 
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' ' "~" ' ··~ 
11b. 

12. Add a text link to the body. 
a. Select the Text Tool. 

b. Drag a text box inside the body of the page, as shown in 

Figure 12b. 

c. When you let go of the mouse, you ' ll see a cursor inside 

the text box. 

NetObjects Fusion Iss. 
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d. (Option) Select the Zoom Tool. 

e. (Option) Click on the new text box with the Zoom Tool 

to zoom in. 

f. Type: 

Top Page 

12f. 

g. Click on the Text tab at the top of the Properties dia log 

box. 

h. The Text page of the Properties dialog box will be 

displayed. 

i. Click on the Center button in the Prope1ties dialog box. 

121 . 
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12h. 

j. The text will be centered in the text box. 

? I 
12j. 

13. Create a link. 
Text and pic tures can be linked to any other point on the Web 

or any point within your site . Link segments of text, ele

ments you draw, pictures, or areas inside pictures in the form 

of an image map. Net Objects Fusion has three types of links. 



Unlc . ;:J 
13b. 

These include: 

• Page Links. This type of link leads to pages \vi thin your 

site. If you move the page within the site or change the 

name of the page, the link follows. Peju created this type 

of link at the bottom of her resume to link to the top of the 

page. 

• Smart Links. This type o f link is based o n the re lative 

position of a page, not a name. Use this type of link when 

there are many layers or branches in your site . Entire 

branches may be moved and the links wi ll be maintained. 

• External Links. This type of link points to other pages on 

the Web. A URL is required in this type o f link. 

a. Drag-select the words Top Page. 

I B 
13a. 

b. Click on the Link button in the lower- left corner of the 

Properties d ia log box. 

c. A Link dialog box w ill be displayed. 

d. Click in the fie ld labeled Page Name, and ty pe: 

resume 

llat. 

13c1 13d. 
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e. A status dialog box will be displayed, notifying you of a 

successful link. 

f. The words Top Page will have an underline, indicating 

the text is now a link. 

T l 
13f. 

14. Peju's Web site. 
Pejuused the techniques described in this section to complete 

the remaining pages on her site. Using NetObjects Fusio n's 

built-in commands for building the site's structure and links, 

Peju found that her site was easy to construct. 

When the pages were comple te, Peju staged the site, or tested 

the pages, on her local hard drive. When she was satisfied 

with the results, she published the site by using NetObjects 

Fusion's bui lt-in FTP software to transfer the files to her 

provider's server. The steps to stage and publish a site are 

described in the next sections. Look for Peju's complete Web 

site on the companion CD-ROM and at http://members.ao/ 
. com/a lawu sa/i 11 tro. h tm l. 

15. Stage your site. 
When you have completed your Web site, you 're ready to 

publish it or create the HTML pages you' ll need for the Web. 

Staging is considered to be a step prior to final publishing. 

Preview displays a page in HTML fonnat. Although staging 

or publishing is similar to previewing a page, an FTP client 

built into NetObjects Fusion may be used to upload your fi les 

to any remote server. 

During staging, NetObjects Fusion collects all the Iiles asso

ciated wi th your sire-both external and those generated by 

NetObjects Fusion. NetObjects Fusion refers to these Iiles as 

assets, which may include the fo llowing elements: 

• images 

• sounds 

• video 



15b. 

• applets 

• plug-ins 

a. Before you stage your site, bui ld a folder for the site 

somewhere on your hard drive or locate the host name, 

the directory name, your user name, and the password 

for the remote server where you'd like to stage your site. 

b. Click on the Publish button. 

c. The Publish site will be displayed. 

d. Click on Seuings. 

"'"""'"' 

15c,15d. 

e. A Configure Publish dialog box wi ll be d isplayed . The 

Local radio di al is the default selection in the Location 

section of the dialog box. In this sample, Peju used the 

local hard drive to stage a Web site. 

f. Click on the Select button in the Location section of the 

dialog box. 

I [ S~l~ct... 1j 
ronn uuruatlhll 

, .... ttt. 

----~ 
15f. 

15o. 
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\lltc l lllfol .. r: 
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16a. 

g. [n the dialog box that follows, select the folder on your 

hard drive where you would like to stage your site, and 

click on Open. 

h. Click on the OK button at the base of the Configure 

Publish dialog box. 

i. Click on Stage button on the Publish site. 

151. 

j. A status bar will be displayed. 

k. When the staging is complete, a Staging Is Complete 

dialog box wi ll be displayed. Click on OK. 

Sta• In• Silo 
Staging Is ComtJiotc. 

OK 

15k. 

15J. 

16. Test your site with your browser. 
a. Launch Netscapc or the Internet Explorer browser. 
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b . Select Open File from the File pull-down menu. 

c. In the dialog box that fo llows, locate the folder where 

your files have been staged, and click on Open. 

d. In the dialog box that follows, select your site 's home 

page, and click on Open. 

I~ Pe!u •I ~Mnc 2 
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18d. 

e. Your home page will be displayed in a browser window. 

f . Test your site. 

g. Select Quit from the File pul l-down menu to put away 

the browser. 
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17. Publish your site. 
When you m·e satisfi ed llull everything in your site functions 

properly, you're ready to publish it. 

a. Before you publish your si te, locate the host name, the 
directoty name, your user name, and the password for 

the remote server where you'd like to publish your site. 

b. Click on the Publish button. 

c. The Publish site wi ll be displayed. 

d. Click on Settings. 

17c,17d. 

e . A Configure Publish dialog box will be displayed. 

f. Click on the Remote radio button, and click on the 

Configure buuon . 

~LVII ... llllllllllllllllllllil GEJ 
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17e, 17f. 
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17g. 

g. A Remote dialog box will be displayed. (Note: If you do 

not know the following information to add to the Remote 

dialog box, contact the Internet service provider who 

manages your Web server.) 

h. In the field labeled Remote Host, type the name of your 

server. 

i. In the field labeled Base Directory, type the path name 

of the remote HTML folder where you wish to transfer 

your files. 

j. In the field labeled CG/ Directmy, type the path name of 

the CGJ directory. 

k. In the field labeled User Name, type your user identifi

cation. 

I. Click on Remember Password. 

m. In the field labeled Password, type your password, 

and click on OK. 

nemotc 

Rtme~ ft Host '---------__J 

CGI Drtc.ton, '------------' 

I Ustr """,----------, 

Pr6t~~1l r TP • I 

17h through 17m. 
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n. Click on the Publish button in the Site view. 

o. A status bar will be displayed with a message that reads: 

opening anftp connection 

trmlsferringfiles 

p. When the publishi ng is complete, a Publishing Is 

Comple te dialog box wi ll be displayed. Click on OK. 

rr.'l 
lj,;;,j 

17p. 

Publishing Is Cum111oto. 

I OK " 

(Note: You may also move your newly published pages ro 

your Web site wirh Jim Mathew's Fetch. Fetch is a 

Macintosh FTP shareware wilily. Publish to your hard drive 

and then move the collie/lis oft he Preview folde r to your 

directory 011 your provider 's Web serve1: Forfurther derails 

on how to use Fetch, see Use Fetch to upload your fi les to a 

provider's server in the Client-Side Image Map chapter). 
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Style Sheets And 
New HTML Text 
Tags 
In this chapter, writer Peter Barry Chowka shares information on 

how to use style sheets to simplify HTML tagging in text-heavy 

documents. Peter's 1994 interview with Linus Pauling is format

ted for viewing in Microsoft's Internet Explorer browser, the first 

browser to include cascading style sheets (CSS 1) as defined by 

the World Wide Web Consortium. The Internet Explorer browser 

broke ground with this powerful new feature, which is expected 

to be added to Netscape's Navigator in version 4.0. (Note: The 

World Wide Web Consortium, or W3C, is a standards organiza

tion that oversees the evolution of HTML.) 

Also covered in this chapter are Netscape's new <MULTICOL> 

tag, which formats text in newspaper-like columns, and the 

<FONT> tag's new attributes, which can control a font's color 

and typeface. 

In less than a year, Microsoft plans to introduce a new form of 

embedded font technology they've codeveloped with Adobe 

Systems. Pages with embedded fonts will include font data that 

travels with a page-freeing a Web viewer from the need to pre

install fonts. The technology will be implemented in the Internet 

Explorer browser, and the two firms will present an OpenType 

proposal to the World Wide Web Consortium. 





Microsoft 
style sheets 
offer formatting 
features such as 
point size, page 
margins, and 
leading 
Summary: By the Spring of 1997, both 

Microsoft 's Internet Explorer browser 

and Netscape 's Navigator version 4.0 

will provide extensive style sheets. 

With desktop publishing- like controls. 

Web authors will no longer need 

workarounds like the <BLOCKQUOTE> 

tag for margin indents. 
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Above right: Peter Barry Chowka 's 

inten1iew with Linus Pauling 

fo rma/led with style sheets built into 

M icrosoft 's Internet Explorer browse!: 

Above: Peter'sfile opened up in 

Netscape Navigator version 3.0. 

Netscape will not have style sheets 

added until version 4.0. 

J] linu' Paulin . Ph.D.: The Lu1 t lnterumm bl l'e l ... 
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Di11logue nillt flt e Experts 

Linus Pauling, Ph.D.: The Last Interview 
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L, 1979, w/1211 tl12 respec!ed 
Bnl!sl! ;oum al Ne w Sc!el!l!st 
!nc!ud2d Linus Pauling. Ph.D., 0 1! lis 

izst of the t>·.>ellty most InlpO!tant 
sc•e•1Nsts of all tim2, it was fo r 
Pauling another in a lo11g sen es of 
ad uevenum!s that uu;/uded a.J! 
W!precedel!led pair of unshared 
Nobel ?nu s and some startlmgly 

original conmbut•ons 111 biology. chemistry a!Jd physics. 

By the t:m! of tcs: d~th tn Au;ust 1994 at ait 93, Paulq v.oas probab:.y 
better kn:·Nn for tts more re~cnt w.::rk on r..utnluJml sci ::nee an;S V1tt::.ln 
C. rn be~-sel:ng b: oks on '-T..amm C. th! cr;;mmon coli! and cane a-, 
fte;ue:u talk sho·..- e.ppe.uan~es. and nume:-ous pubhshed pa~ers aru1 
sc1e:nlifk pre$mtalaons abou: a nutnttonll ~.Cllt:.g specnlty he n.ltned 
•o:·shcmoltc';lar mecbc:.ne, • Pauhll& was an unp.ll'8lleled. udquely 
credenual.ed ;poltesrr.an for the emerging Jcien:e of ruet ami he3lth. 
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F or type to look good on a page, text line length should 

not extend across tht: t:nlirt: width of a document. With 

a shorter line length, the reader does not have to \.vork to 

visually keep track o f type as he/she reads from left to right. 

Until now, designers who wanted to apply this principle to 

a Web page had to use tags that were never intended to 

indent text. Examples include the <BLOCKQUOTE> and 

<DL>tags. 

Style sheets built imo Microsoft's Internet Explorer browser 

now offer a designer powerful controls over formatting char

acteristics such as margins, point size, and leading. 

Netscape's Navigator wi ll soon have similar controls built 

into version 4.0 of the software. 

In this sect ion, Peter BaiTY Chowka-journal ist, medical

political analyst, and consul tant--demonstrates how to for

mat a page with style sheets built for Microsoft's Internet 

Explorer browser. The steps he uses to format his interview 

with the late Dr. Linus Pauling offer an ideal model for 
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Above: Peter's photograph of Linus 

Pauling during his .first inten 1iew with 

the Nobel laureate, who was then 79, in 

his office at the Linus Pauling Institute 

for Science a11d Medici11e in Menlo 

Park, California, i11 1980. Peter recalls, 

"It's always humbli11g to spend time 

with an individual of Pauling's stature. 

But / came away from that first of many 

encounters with Pauling enjoying a new 

respect for the man, based not only on 

his intellect but his highly engaging, 

accessible, down-to-earthJeisty, enthu

siastic, and energetic reaction to meet

ing me and to my many questions. The 

bright twinkle in his eye on that swmner 

day is, I hope, captured in the photo 

above." 

9s. J Chapter4 

designers to fo llow. (Note: Look for the Linus Pauling inter

view 011the CD-ROM i11 the back of this book and at 

II t tp :1/members.aol. com/medi umcool.) 

1. What is a style sheet? 
A style sheet is a system that lets you define formatting 

characteristics such as font size, font sty le, font color, font 

weight, leading, margins, and indents in summary form at 

the top of an HTML document or in a separate style sheet 

file. This eliminates the need for complex tagging 

throughout a document and provides an efficient method 

to make changes, because the formatting information is 

organized in one place. 

Although Microsoft is the first to build style sheets into its 

browser, the concept is not unique to Microsoft. Style 

sheets for Web browsers have been deli ned by the World 

Wide Web Consortium (W3C), and Microsoft's imple

mentation fo llows the cascading style sheet (CSS L) mech

anism found in the W3C proposal. (Note: For details 

about the WJC style sheet proposal, see hllp:!lwww 

.w3.org/pub!WWW!TRIWD-cssl.hllnl.) 

2. Frequently asked questions. 
Although style sheets o ffer a greater amount of control 

over page layout, many designers may be concerned about 

using HTML features that are new. Here are answers to 

popular questions: 

a. Are style sheets appropriate for every HTML 

document? As in print, style sheets make sense when 

documents have a large amount of text. The mecha

nism requires fewer tags in the text and greater control 

over changes. However, designers may also be inter

ested in style sheets for smaller documents because of 

the point size and leading controls. 

b. If I use style sheets designed for the Internet Explorer 

browser, what will the page look like in Netscape's 

Navigator? Handan Selamohlu, who wrote A User's 

Guide to Style Sheets for Microsoft's Developer 

Network (http://www.microsoft.com/workshop/author/ 



Above: A photo Peter lOok during a 

videotaped documental)' htterview he 

produced in 1989 with Pauling and 

Ewan Camemn (right), the Scottish 

physician whose promising work in the 

early 1970s with vitamin C and terminal 

cancer patients inspired Pauling to 

become more involved in the field of 

vitamin C, antioxidant nutrients, and 

nontoxic cancer therapies. Peter 

remembers D1: Cameron, who before his 

death was medical d irector of the Linus 

Pauling lnstitllle, as an iwelfectualfy 

impressive and highly engaging clini

cian. In 1979, the two doctors co-

a whored the popular book, Vitamin C 

and Cancer. 

howto/css-f.htm) has invented a trick for designers who 

are creating pages for multiple browsers. Until Netscape 

implements style sheets, embed your sty le defini tions 

within a comment tag. (Note: For details on how to imple

memthis step, see Creating the Linus Pauling interview 

in this chapta) 

c. WiU style sheets support the Postscript screen fonts 

popular among graphic designers? For in formation 

concerning the Adobe/Microsoft Open Type initiative 

incorporating Type I and True Type data for Web pages, 

see Microsoft's plan to add fonts to the Web: Free 

TrueT)pe now and Web page fon t embedding in the 

fillt.lre at the end of this chapter. 

d. If a Web viewer does not download and ins taU a font 

specified by a style sheet, what will the browser dis
play? A browser that cannot read sty le sheets or the 

<FONT FACE> tag will display the default typeface. 

e. Are there any tags that will override formatting cre

ated by a style sheet? Yes. [nline style tags override 

style sheet surrunaries atTanged at the lop of a docu

ment or in a separate sty le sheet file. 

The style sheet summary block arranged a t the top of a 

document is referred to as an ernbedded style sheet and 

a style sheet organized in a separate life is called a 

linked style sheet. Tn total, there are three forms of sty le 

sheets that follow precedence ru les: 

• inline style tags override embedded style 

definitions. (Note: For an example oflww an inline 

style IC/g can be used to override an embedded style 

tag. see Creating the Linus Pauling interview in this 

chapter.) 

• inline style tags override linked style definiti ons. 

• embedded style definitions override linked style 

defi nitions. 

f. Where can I learn more about Microsoft style 

sheets? See Microsoft's Style Sheet Sholl"case at 

http://www.microsoft.com/gallery!files/styles/default 

.htm, Style Sheets: A Brief Overview for Designers 
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A bove: In 1983, Pauling invited Peter 

to his remote ranch overlooking the 

Pacific Ocean near Big Sw ; Ca/({omia, 

for a day-long visit and another exten

sive recorded interview. Peter writes, 

" /was honored to be able to observe 

Pauling in hisfm•orite place, inspired 

by the maj esty of the Pacific, sltrround

ed by books and scientffic papers repre

seming the many high-level projects he 

ll'as involved in. Pauling graciously 

accommodated my many requests to 

photograph him, and one of my 

favorites (above) was taken thai after

noon on his deck with I he stormy ocean 

just yards away." 
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at hllp://www.microsoft.com/workshop/design/des
gen/ss/css-des.htm, and A User's Guide to Style Sheets 

at http://www.mjcrosoft.com/workshop/ author 

/howLO/css-f.htm. 

g. Can style sheets be transferred to another HTML 

document? A style sheet may be saved as a .CSS doc
ument and then linked to any number of Web pages on 

your Web site. (Note: Microsoft 's implementation of 

style sheets is nen1, and at the lime of this writing, I 

could not get style sheet/inking to work, As a result, 

this topic will no/ be included in this chapte1: ) 

3. Style sheet properties. 
The style sheets built into Microsoft's Internet Explorer 

browser offer a wonderful shift away from awkward 

workarounds such as the <B LOCKQUOTE> tag for mar

gins. In this system, style sheet properties such as margin

left and margin-right get added to famjJjar HTML tags. 

(Note: For details on style sheet tag syntax, see Adding 

style sheet properties to a tag in the next section.) The style 

sheet properties that have been implemented in version 3.0 

of the Microsoft Internet Explorer browser include: 

a. font-size may be set in points, inches, centimeters, 

pixels, or a percentage value that is evaluated based on 

the default point size (pt, in, em, px, or %). 

b. font-family sets a typeface name. Alternative family 
names or generic family names may be specified for 

systems that don't support a designer's choice of type
face names. Generic f"~unily names include serif, sans 

serif, cursive, fantasy, and monospaced. 

c . font-weight sets the thickness of type. Examples 
include extra light , light, de mi- light, medium, demi

bold, bold, ancl extra bold. Weights depend on the 

weights allowed in a user's system. 

d. font-style sets ita lic text. Although the W3C draft also 
includes small caps. fnternet Explorer only supports 

normal and italic. 

e . line-height sets leading or the distance between the 

baselines of type. Leading may be specified in points, 



Above: Included in Microsoft's Web 

Galle1y at http://wwHJ.microsoft. com/ 

galle1y are links to pages containing 

useful information a bow style sheets. 

inches, centimeters, pixels, or a percentage value (pt, 

in, em, px, or %).Internet Explorer adds spacing 

before lines and not after lines. 

f. color may be specified as a named color or as a 

hexadecimal red-green-blue triplet. 

g. text-decoration allows you to use underl ined and 

strike-through text. W3C also supports overline and 

blink, which have not been added to the Internet 

Explorer browser. 

h. margins may be specified in points, inches, centime
ters, or pi xels (pts, in, em, or px). Internet Explorer 3.0 

allows negative values for margin-left, margin-right, 

and margin-top for special effects or "outdents." 

i. text-align sets text as left, right, or center-aligned. 

j. text-indent sets, indentation in points, inches, cen
timeters, or pixels (pts, in, em, or px). Internet Explorer 

3.0 allows negative values for text-indent, providing 

for special effects or "outdents." 

k. background (color or images) may be used on any 

elements by specifying a color name, an RGB triplet, 

or an image's URL. 

4. Adding style sheet properties to a tag. 
There are two methods for placing style information with

in a document. 

a. Inline style tags are adaptations of familiar HTML 

tags. Style definitions get added to an HTML tag by 

using the STYLE attribute. 

Examples: 

<Hl STYLE-"margin -l eft : 0.5 in ; ma r gin- right: 

0. 5 in" > 

or 

<P STYLE- "marg in - l ef t: 0.5 in; ma r gin- r ight : 

0 . 5 in"> 
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Above: Microsoft is offering f ree 

True Type fonts on their site at 

http://www.microsoft.com/truetype/ 

fontpack/defauft.htm.for both 

Macintosh and Windows computers. 

(Note: For details conceming 

Microsoft's free True Type ojfe1; see 

Microsoft's plan Lo add fonts to the 

Web: Free True Type now and Web 
page font embedding in the future in 

this c!tapte1:) 

102. , C!tapter4 

b. An embedded style sheet gets added to the top of a 
document using the <STYLE> .. . <!STYLE> tag. Use 

this tag between the <HTML> tag and the <BODY> 

tag. The <STYLE> tag's TYPE attribute specifies the 

Internet Media type as "text/css." TI1is allows browsers 

that do not support this Media type to ignore style 

sheets. Use the comment tag to enclose the style defi ni
tions d1at get added inside the <STYLE> .. . </STYLE> 

tag as plain text. By enclosing the style definitions in a 
comment tag, browsers that do not support style sheets 

will not read style definitions as plain text. 

Example: 

<STY LE TYPE- " text/css " > 

<!- -

Hl (co l or : ftFF5200 : font-size : 40 pt; font-family: 

Ve r dana. Ari al, Helvetica , sans·serif) 

P (co l or: /tDlOlO l : fon t -size : 13 px; font-family: 

Verdana , Arial , Helvetica . sans - seri f) 

--> 

</STYLE> 

5. Option: Grouped formatting. 
a . If the formatting specifications are the same for sever

al tags, group the tags into one tag. In the following 

example, H I, H2, and H3 all have the same style 
defi nitions: 

Example: 

<STYLE TYPE-"text/ c ss"> 

<!--

Hl, H2 . H3 (col or: IFF5200; fon t -s i ze: 40 pt ; 

fon t -fami ly : Verdana. Arial, Helvetica. sans-s e r if ) 

--> 

</STYLE> 
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Above: Check hrtp:/!www.microsoft 

.com/truetype/ie;.p/or!quick.htmfor a 

useful three-step guide to adding typog

raphy to your Web pages. 

b. Fom1aning specifications may also be abbreviated. 

Notice in the following example that the word font 

occurs only once. 

Example: 

<STYLE TY PE-"tex t /css"> 

<! --

Hl {font: 40 pt Verdana. Ari al . Hel veti ca . 

sans-seri f} 

--> 

<!STYLE> 

6. Option: Classes. 
a. Use classes to create variations for a sing le HTML tag. 

Follow a rag name with a period and a class name. Any 

number of classes are a llowed. (Note: See Creating the 

Linus Pauling interview for details on how to create 

tags with classes.) 

Example: 

<STY LE TYPE- "text /css "> 

<!--

BODY (ma rgin - left: O. Si n: marg i n-top: O. Si n} 

BODY. main (font -s i ze: 12pt ; f ont -wei ght: l i ght : 

l i ne -hei ght: 14pt : margin-left: li n: marg i n-r ight: 

lin: ma rg i n-top : l i n} 

BODY.callout (font-si ze : 18pt ; font -weight : l ight: 

line-height: 22pt ; marg i n-left : 2in : margi n-right: 

2i n} 

BODY.references (fon t -size : l Op t : font-weight: 

lig ht; l i ne- heigh t: 12pt ; margin- left: l i n: ma rgin · 

right: l i n} 

--> 

<!STYLE> 
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b. It is not necessary to repeal d1e tag name. Classes may 
be abbreviated wi th a period and a class name. 

Example: 

<STYLE TYPE- " text/css"> 

<I -. 

BODY (marg i n-left: 0.5i n; margi n·top: O. Sin} 

.main (font-size : 12pt; font -wei gh t : l igh t ; l i ne

height: 14pt; margin -le ft: lin; margin · right: lin ; 

margin-top : lin) 

.callout (font-size: 18pt ; font-weigh t : light; line 

height: 22pt; margin·left: 2in; margin-right: 2in} 

.references {font-size: lOpt; font · weight : light ; 

l ine·height: 12pt; margin · l eft : lin ; margin-ri ght: 

li n) 

· -> 

</STYLE> 

7. Creating the Linus Pauling interview. 
a. Use a manuscript or create thumbnails to mark up text 

with tags you think you' ll need. In this example, Peter 

used: 

• H l , H2, H3, and H4 to mark the subheads in his 
manuscript. This provides an oppor1unity for quick 
changes in the style sheet header after the style 
block is in place at the top of the HTML docu

ment. 

• Two <BR> tags between paragraphs because the 
<P> tag adds too much leading. (Note: There 

should be no more than what appears to be a sin

gle line space between paragraphs.) 

• To create variations in body text, Peter used classes 
in the <BODY> tag using the words .normal and 
.opener. He Lhen used the <DfV> tag to djvide the 
document according to class. 
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Above: Check hup:!!www.micmsojt 

.com/truetype!faq!faqS.htmfor a list of 

}i"equently asked questions ( FAQ) con

cerning Microsoft 'sft-ee TrueTypefonts. 

Example: 

<DIV class-normal> 

and 

<DIV class-opener> 

Peter could then contro l the properties o f normal 

and opener text in lhe sty le block at the top o f the 

page to make changes in type style and weight. 

b. Open SimpleText. Use SimpleText or your word 

processor. ff you use a word processor, be sure to save 

the document as Text Only. 

c. Create a new HTML document. Start a new docu

ment with the following markup tags: 

<HTI-1L > 

<HEAD> 

<T ITLE>Li nus Pau l ing, Ph.D. : The last In te rview by 

Peter Barry Chowka 

</TITLE> 

<!HEAD> 

d. Create a style block at the top of the document. Use 

the <STYLE> . .. </STYLE> tag between the <l-ITML> 

tag and the < BODY> tag . Use the <STYLE> tag's 

TYPE attribute to specify the Internet Media type as 

"texllcss". 

<HTML> 

<HEAD> 

<TI TLE>li nus Pauli ng , Ph . D. : The last Interview by 

Peter Barry Chowka 

<!TI TL E> 

<!HEAD> 

<STYLE TYPE- "text/css "> 

e. Add a comment tag. Until Netscape implements style 

sheets, embed your sty le definitions in a comment tag. 

(Note: See Style sheet properties and Adding sty le 

sheet prope11ies to a tagfor details on style definitions.) 

<HTML> 

<HEAD> 
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Tip: In May 1996, Microsoft 
announced news of their Open Type 

Initiative. Also known as TrueType 
Open Version 2, Open Type is a11 exten

sion of Microsoft 's TmeType Open 
fo rmat, adding support for Adobe Type 

I data. This foil/ technology represents 

a merger of Adobe's and Microsoft 's 

follt tech11ologies, offering a unified 

systemfor.font handling across plat

forms. 
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<TITLE>Linus Pauling, Ph . D. : The Last In ter view by 

Peter Ba r ry Chowka 

<!TITLE> 

</HEAD> 

<STYLE TYPE-" text/css "> 

<! .. 

f . Add tags and style properties to the style block. 

<HH1L> 

<HEAD> 

<TITLE>Linus Pauling . Ph.D.: The Last I nt erview by 

Peter Barry Chowka 

<IT ITLE> 

</ HEAD> 

<STYLE TYPE-"text/css "> 

<!--

BODY (marg i n-left : l i n; margi n- ri ght : 1. 5i n) 

.opener ( fon t -size : 20 pt; font-weight: extra l i ght ; 

font-style: ita li c ; line- hei ght: 22pt : font-family: 

Times New Roman; margin- l eft : lin ; margin-right: 

.Bin) 

.normal (font-wei gh t: extra light ; font - styl e: 

normal ; font -size : 14 pt : l i ne-height : 16pt ; font

family: Ti mes New Roman) 

.references (font-wei gh t: ext ra light ; font-style: 

normal ; font-size: 14 pt ; l i ne-height : 15pt ; 

font-family: Times New Roman; margin-left: 1.2in; 

margi n- r i ght : .Si n] 

B (font- weight : ext ra bold ; font-sty l e : normal ; 

font-size : 14 pt ; line-height: 16pt ; font-fami l y: 

Arial) 

Hl !fon t -weight : ex t ra ligh t ; font-style : italic; 

font-size : 20 pt; l i ne- hei ght: 22pt ; fo nt- fami l y: 

Times New Roman) 

H2 (font-weight: extra bol d; font-style: norma l ; 

font-size : 24 pt ; line-height: 26pt ; fon t -family: 

Times New Roman) 



Tip: Adobe and Microsoft will submit a 

proposal for Web pagefollt embedding 

using Open Type to the World Wide Web 

Consortium committee on style sheets. 

The proposal suggests that f ont data 

should travel with a document,freeing 

the user from the need to download and 

install fonts. 

H3 [font -wei ght : extr a bold; font -styl e : normal ; 

fo nt-s i ze : 12 pt ; l i ne-heig ht : 14pt : fon t -family : 

Times New Roman) 

H4 {fon t -weig ht : ext r a bold ; font-style : normal ; 

f ont -size : 12 pt : line- height : 14pt: font- family : 

Times New Roman} 

g. Close the comment tag. 

<Hlf1L> 

<HEAD> 

<TITLE>Linus Pauling , Ph.D .: The Las t I nterview by 

Peter Barry Chowka 

<!TITLE> 

</HEAD> 

<STYLE TYPE- "text/css"> 

<! --

BODY {margin- lef t : l i n: ma r gi n- righ t : 1.5in) 

.opener {f ont -s i ze : 20 pt : f ont -weight : extra light : 

font - style : ita l i c ; line- hei ght: 22 pt : font - family: 

Ti mes New Roman: margi n-lef t : lin; margin-ri ght: 

.Bin ) 

.normal [f ont-we i ght : ext r a l i gh t; font-style : 

norma l: font-size : 14 pt : li ne- height: 16pt; 

font-fam il y: Times New Roman) 

. refe rences {font-weigh t : ex t ra l ight ; f ont- style: 

norma l: fo nt-size : 14 pt ; li ne- height: 15pt: 

f ont - fami l y : Ti mes New Roma n: ma r gi n-l ef t : 1. 2in : 

margin - ri ght: .Bin ) 

B {font -wei gh t : extr a bol d : font -styl e : no rmal; 

f ont -s i ze : 14 pt : line -heig ht: 16pt : font -family: 

Ari al] 

Hl {font-weight: ext r a ligh t: f ont -s tyl e: ital ic : 

f ont-s i ze : 20 pt : li ne- heigh t: 22pt : font-fami ly : 

Ti mes New Roman } 

H2 (font-weight: extra bold : font-s t yl e : no rmal : 

f on t -size : 24 pt : line- height: 26pt : fo nt-family : 

Times New Roman ) 
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Tip: The TrueType fonls Microsoft 

distributes on their site may be used in 

applications other than HTMLawlwr

ing programs. (!Vote: The foms have 

been optimized for on-screen display.) 
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HJ (font-weight : ex tra bold: font -style : normal; 

font -si ze: 12 pt ; line -hei ght : 14pt ; font-famil y : 

Times ~ ew Roman] 

H4 (font- weight : extra bol d; font-s tyle : normal : 

fon t -s i ze : 12 pt ; l i ne- hei ght : 14pt ; fo nt- fami ly : 

Ti mes New Roman] 

-- > 

h. Close the style block. 

<Hft.1 L> 

<HEAD> 

<TITLE> Linus Pau l i ng , Ph. D.: The Las t Interview by 

Pete r Ba rry Chowka 

<!T ITLE> 

<!liEAD> 

<STYLE TYPE-"text/css "> 

<!--

BODY (margin-left : lin; marg in- r ight : 1. 5in ] 

.opener (font - s ize : 20 pt; font -wei gh t : extra light; 

f ont-style : ita l i c : l ine -height : 22pt ; font- f amil y: 

Times New Roman : ma rg i n- l ef t : l in; ma rg i n-r i ght: 

.Bi nl 

.normal {font-wei ght : ext ra l i ght ; font-sty l e : 

no rmal ; font-size : 14 pt ; li ne-height: 16pt ; font

fami l y: Times New Roman} 

. re ferences [font- wei ght : extra l i ght ; font -style : 

no rmal ; font-size : 14 pt ; 1 i ne-height : 15pt; 

font-fami ly : Times New Roman; margin-left: 1. 2i n; 

ma rgin- right: .Bin } 

B (font-weight : ext ra bol d; font-style : normal ; 

font-size : 14 pt ; line-heigh t: 16pt ; fo nt - fami ly : 

Ar i al l 

HI (fon t-weight : ext ra li ght ; fo nt-styl e : ital ic : 

font-size : 20 pt ; line-heig ht: 22pt ; fo nt -fami l y: 

Ti mes New Roman i 



Tip: The True Type fonts available on 

Microsoft's site have enlarged character 

sets due to multi-language support. The 

character sets contain 652 characters 

covering Western, Central, and Eastern 

European writing systems. 

H2 (font-we ight : ex tra bo ld; font-style: no rmal ; 

font -size : 24 p t; line -height : 26pt ; font-family: 

Times New Roman) 

H3 (font-weigh t : extra bol d ; font-style: normal ; 

font-size: 12 p t; 1 ine - he igh t : 14pt: font-family: 

Times New Roman ) 

H4 {font-weight: extra bold ; font-style: normal; 

font-size : 12 pt ; 1 ine-height : 14pt ; font - family: 

Ti mes New Roman) 

--> 

<!STYLE> 

i. Add a back~:,...-ound color to the document. 

<HTML> 

<HEAD> 

<TITLE>Linus Pauling , Ph . D.: The Last I nterview by 

Pete r Barry Chowka 

</TI TLE> 

</ HEAD > 

<STYLE TYPE- " text/css "> 

<!--

BODY {margin- l eft : lin; margin-r ig ht : 1.5in ) 

. opener (font-size: 20 pt; font - weight: extra light ; 

font - style: italic : line-height: 22pt ; f ont-family: 

Times New Roman ; margin -l eft : lin ; ma r gin-right: 

. Bin ) 

. normal ( f ont-weight: extra l ight ; fo nt -s tyle : 

no rma l; font-size : 14 pt; l ine-hei ght: 16pt ; 

f ont-fami l y : Ti mes Ne w Roman ) 

.refe r ences (font-weigh t : ext ra l i ght; font - style : 

normal ; fon t -size : 14 pt : line-height : 15pt; 

font-family: Ti mes New Roman; margi n-left : 1.2in; 

margin - righ t : . Bin] 

B (font-weight: ext r a bold; font - style: normal: 

font-size : 14 pt; line- height: 16pt ; font -family: 

Aria 1) 
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Tip: The Ttmes New Roman and 

Courier New fonts Microsoft is supply

ing for Macintosh computers have dif

ferent character ow lines and metrics 

than Apple's True Type versions. 

Microsoft 's versions offer cross

platform compatibility. 

110. Chapter 4 

Hl {font·weight: extra light: font-style: italic: 

font·size: 20 pt: line-height: 22pt : font- family: 

Times New Roman] 

H2 {font ·weight: extra bold: font-style: normal: 

font-s ize: 24 pt: line-height: 26pt: fon t -family : 

Times Hew Roman] 

H3 [font -weight: extra bold: font-sty l e: normal : 

font-size: 12 pt : line · height : 14pt: fon t- f ami l y: 

Times New Roman) 

H4 (font-weigh t: ext ra bold: font·s t yl e: normal : 

f ont-size : 12 pt: line· heigh t : 14pt: font -fa mily : 

Ti mes New Roman] 

·-> 
<ISYYLE> 

<BOOY BGCOLOR-"i/ffffff"> 

j. Add text, an image, and HTML tags. (Note: The tex t 

slrown in this section is for demonstration pwposes 

only. Readers may find Peter Chowka 's full inten1iew 

in an HTML file 011the CD-ROM at the back ~ftlris 

book.) 

<IHM L> 

<HEAO> 

<T ITLE>Linus Pauling . Ph.O.: The Last Interview by 

Peter Barry Chowka 

</T ITLE> 

<! HEAD> 

<STYLE TYPE-"text/css"> 

<I--

BODY (margin · left: lin; margin-right: l . Sin ) 

.opener (font·size : 20 pt ; font·weight : extra l ight : 

fo nt-styl e: ita l ic; line-height: 22pt; font-family: 

Times New Roman : margin-left : lin: ma rgin · righ t : 

. Bi nl 

.no rmal (font· weigh t : extra light: font-sty l e: 

normal: font · size: 14 pt ; l ine -he i ght: 16pt: 

font·family: Times New Roman) 



Tip: The free TrueTypefonts available 

from Microsoft's Web site may be freely 

distributed. Howeve1; a Web.follt regis

trationform is required and may be 

found on the site. Designers may not 

supply the font outlines in a form that 

adds value to a commercial CD-ROM 

disk, a disk-based multimedia pro

gram, an application program, or a 

utility program. 

. references (font-weight: extra light ; font-style: 

normal ; font-size: 14 pt; line-height: 15pt; 

font-family: Times New Roman; margin-left: 1 .2in; 

marg in - ri ght: .Bin) 

B (font -weight: extra bol d; font -styl e: norma l; 

fo nt-s i ze : 14 pt ; 1 ine -height: 16pt ; fo nt-family: 

Arial) 

Hl (font- 1~eight: extra l ight ; font-style : ita l ic; 

font-s i ze: 20 pt; l i ne-height: 22pt ; f ont-famil y: 

Times New Roman) 

H2 ( font-weight: extra bold ; font-style: normal; 

font-size: 24 pt ; l ine-height: 26pt ; font-family : 

Times New Roman) 

H3 (font-weight: ext ra bold ; font-style: normal ; 

font-size: 12 pt ; line-height: 14pt ; font·family : 

Times New Roman) 

H4 [font-weight: extra bold ; font-style: norma l ; 

fo nt-size: 12 pt; line-height: 14pt ; font-family: 

Times New Roman) 

- -> 

<!STYL E> 

<BODY BGCOLOR- "#ffffff"> 

<Hl> 

Dialogue with the Exper t s 

<IH1><BR><BR> 

<H2>Linus Pauling, Ph. D.: 

The Last Interview 

<I H2> 

<BR> 

by <A HREF- "http://members . ao l . com/realmedia">Peter 

Barry Chowka</A><BR> 

&#169 ;1996 by peter bar ry chowka. all ri ghts 

reserved. <B R><BR> <BR><DI V CLASS-OPENER> 

<IMG SRC-"Pauling_2a.jpg" AL!Gil- LEFT><IMG SRC 

- · ca p5.gif" STYLE- "background: white">n 1979, when 

the respected British journal <I>Ilew Scientist 
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Tip: If you have problems download

ing the TrueTypefontsfrom Microsoft 's 

Web site, t1y ftp://ftp.microsoft. com/ 

developr/drg/truetype. 

112. I Chapter 4 

</ I> i ncluded Linus Paul i ng, Ph. D .. on its list of the 

twen ty mos t important scient ists of al l time , it was 

for Pauling ano t her in a l ong seri es of achievements 

tha t i ncluded an unp recedented pai r of uns hared Nobel 

Prizes and some start l ingl y ori ginal con t ribu t ions 

in biol ogy, chemistry and phys i cs . </DIV ><BR>< BR> <DIV 

CLASS-NORMAL> 

By t he time of his dea t h in August 1994 at age 93 , 

Pauling was probably better known for his mo re recent 

work on nutritional science and vitamin C. In best

selling books on vi ta mi n C. t he common col d and can

cer . f requent ta l k show ap pearances , and nume rous 

publis hed papers and sci ent i fi c presentations about 

a nutri ti onal heal i ng specialty he named "orthomole

cul ar medi cine ," Pauli ng was an unparalle l ed, 

uniquel y creden t ia l ed spokesman for the emerging 

sci ence of die t and health . 

<BR><BR> 

Accord ing to Pauli ng, hi s high- profi l e i nvol vement 

in un popul ar political controvers i es of t he 1950s and 

' 60s ( includi ng or gan i zing t he successful interna

tional campai gn t o ban nucl ear bomb t est ing, fo r 

whi ch he was awarded t he 1962 Nobel Peace Pr ize) pre

pa red him fo r t he equally ranco rous deba t es of the 

1970s and ' 80s when he became t he de fac t o leader of 

nutr i tional medicine at a time whe n ma i ns t ream medi

ci ne denigrated such i nter ests. Duri ng t he l ast t wo 

decades of hi s l ife , Paul i ng ' s focus on the sc i entif

ic ba sis of nu t r i t ion and hi s un stinti ng advocacy of 

megavitami n suppl ements regular ly made hi m t he cen

te r of controversy . 

<BR><BR> 

Even after hi s death, t he controver sies continued. 

Journal ist Lee Dembar t . r eviewing two new biog r a

phies of Pauling, ca l l s t he scient i st an "emba rrass

ment" and an "eccent ri c crank" for his inte res t in 

vitamin C. 



Tip: Adobe and Microsoft's OpenType 

technology represents a merging ofType 

1 and True Type follltechnologies that 

offers Web designers a cJvss-platform 

font standard. 

k. Add a superscript tag. (Note: Peter's style block con

taining style definitions has nol been repeated here. ) 

<HI> 

Dia l ogue with the Experts 

<IIH ><BR><BR> 

<H2>Linus Paul ing . Ph. D.: The Last Interview 

<IH2> 

<B R> 

by <A HREF-"http: //memb er s .aol . com/realmedia">Peter 

Barry Chow ka <IA><BR> 

<SUP>&#169 :</SUP>1996 by peter bar ry chowka . all 

ri ghts r ese rved. <BR> <BR><BR> 

<DIV CLASS-OPE~ER> 

<II1G SRC-"Paul ing_2a .jpg" ALIGN- LEFT> <IMG SRC 

- "cap5.gif" STY LE- "background: whi t e">n 1979 . when 

the respecte d Br it i s h journal <!> New Sc ienti st 

<! !>i ncluded Linus Pau l i ng . Ph .D .. on its li s t of t he 

twenty most important scien tis ts of all time . it was 

fo r Pau ling anothe r in a l ong series of achi evements 

that i nc luded an unp recedented pa i r of uns hared Nobel 

Pr izes and some sta rtl i ngly origina l contri bution s 

in biol ogy , chemist ry and physics.</DIV><BR><BR> 

<D IV CLASS- NORMAL> 

By the t i me of his death in Aug ust 1994 at age 93 , 

Pauling was proba bly better known for his more re cent 

work on nutritional science and vitami n C. In bes t 

sel ling books on vita min C. the common cold and can

ce r . frequent talk s how appeara nces . and numerous 

published pape rs and scientific presentat i ons about 

a nut ritional heal ing specia lty he named "or thomole 

cul ar medicine . " Pauli ng was an un paral l eled . 

uniquely credentialed s pokesman for the emerging 

science of diet and health. 

<BR><BR> 

According t o Pau l ing , hi s hi gh-profi le i nvo lvement 

in un popular poli tical cont rove rs i es of the 1950s and 
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Linus Pun ling. Ph.D.: T he LnM lt& ler\'lcw 

.,~_.._ 

·~~~~~··~•loG•~ .ane._..,...._ 

l o: /9,9. "'lic11 t~.t r~;'Yetr~ 
Brll! lhJOUm':ll li.!I'P :;.;/"rJ:S! 
:ncludcd Lmus A'illir'IZ· Ph.D., on Jt.r 
tw aftfo...: !wen.ty mOJf 1mpormo:t 
r.:tf!~l.ll.rcfcll !!"oJ. :r W!lsjo• 
F.Jul:'!l ~!J!I:.Ilr 111.: !C'!,Z x r:e3of 
a.clt.;o:w'1'rt:U r:r..:ttnf'.'L.ic.J :u. 
Wl.O'• a!Us'llOJdpJ~r ofw:fl<.nred 
NoUI Pn=:llJa.nd. W~r.i! nc,ll:•:gly 

ongm .. -:1 cx;,..Jrzbutlc.rJ 11'1 t'fclo.;;:;. ~Nm:utry ur.d p/1)'~!:'4. 

Above: Because the opener te.xf is italic, 

the New Scientist should be formatfed 

in a Roman or Normal style, emphasiz

ing that it is the name of a publication. 

Linus Pauling. Ph.D.: The La!,1 lul r n ·iew 

"~ •t'i'lo11ryyw ...,.,~ ..::~~ 

l 'l /979. wf"-"1! the n:I]Xcrca' Bntt:l, 
.'Ourr:.t/ HrwSc~.r.IJJt l'l.tlu::kti llrllLf 
P.::~ltr.g. Ph.D., m: :t:r l:s! oft lw 
h~"IIJ flt:>;t f ' '".fX)IIdr.J SCll1P111SfZ0} 
<:1: loi'N, J! MU:for P~itn.g ~c!o:.:r 
:r. a /oltgNne: cf .u~~ll!r.tl th.i.l 

u:c/Jui.-du•t :ntpr;;o;;C"icmcd.c.c/1 c.r 
oorul.a • ~d Job~: hzus an.1 S?m... 
.rt<utii11$1J ongmol cort! r:butwi!S tr. 

bl~!og:;. cJo,m~nry<Z!'.d.p:,js:.tz 

Above: The only inline tag that worked 

to transform the type style of the words 

New Scientist at this time was <B 

STYLE= "font-style: nonnal">. 
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' 60s (incl uding organ i zi ng the successful in terna

tional campaign to ban nuc lear bomb testing, fo r 

which he was awarded the 1962 Nobel Peace Pri ze) pre 

pared hi m fo r t he equally rancorous debates of the 

197 0s and '80s wh en he became the de facto leader of 

nutrit i onal medicine at a time when ma instr eam medi -

ci ne denigrated such i nt erests . During the l as t two 

decades of his l i f e . Paul i ng's f ocus on the sc i ent if 

i c bas i s of nu t rit i on and his unsti nt i ng advocacy of 

megavitamin supplements regula rly made him the cen 

t er of controversy . 

<BR>< BR> 

Even after his death, the cont roversies conti nued. 

Journ ali s t Lee Dembart, r ev iewing t wo new biogra 

phies of Pauling, cal ls the scientist an "embar rass 

men t" and an "eccent ric crank" for his i nterest i n 

vitamin C.<SUP>l <ISUP> 

I. Add the ending tags . 

<!BODY> 

<IHTML > 

m. Save the file. Save the document in SimpleText or 

your word processor. If you're using a word processor, 

save the text as Text Only. Give the file an .1-ITM 

extension. 

n. Test the style sheet document. Open Netscape or 

Microsoft 's In ternet Explorer browser. Open your 

document by selecting Open File from the F ile pull 

down menu. 

8. Style change: Override a style. 
In the opener text, the type sty le of the British journal New 

Scientist should be normal text to emphasize that it is a 

publication. This can be accomplished with an inline tag 

that will override the embedded style. 



<H2> 

<H3> 
BODY 

BODY 

.NORMAL 

<SUP> 

B 

Sa. 

I ,, . .. !<1. •• ,, .. 1 

....... .-..'"' .4·~.::...!.:;~;..:~~~: ... 
.,,, ... ._. .... ..., .......... v _ ......... , .... .. 
rt-0·'1,l .. 0 01~1 ~,.,.,,, .. .............. ~.-""""" .... .... ......... ~,... . ... ...,,, 
MJ,,·•· ... ·-·-~··· ··"' .. ft.~~~·· '<ct. '~·'I'·~ ...t, •.• , 

.. -··---··-••.,- ......... r- 1 _ ..... ...... ---·- ----
~?:Bf~~§~~-
-... ---· ,.-.--... .. 

-- ·---·- -- ··~ol- ..... . - .......... _ .... ····-- ·--___ "" .. --.. ~ .. -- -~··-... --·--·-· .......... -_____ , __ ... ·-· ......... .... .. _ . ..,_ ___ ·-· 

a. Locate the words New Scientist in the opener text. 

<HI> 

Dialogue with the Experts 

<!Hl><BR><BR> 

<H2>Linus Pauling . Ph.D.: The Last Intervi ew 

<IH2> 

<BR> 

by <A HRE F- "http : //membe rs .aol . com/realmedia">Peter 

Ba rry Chowka<IA><BR> 

<SUP>&#l69 ; </SUP>l996 by peter ba r ry chowka . all 

rights reserved. <BR> <BR><BR> 

<DIV CLASS-OPE~ER> 

<I MG SRC-"Pauling_2a.jpg" AL IG~-LEFT><IMG SRC 

- "capS.gif" STYLE- "background: white">n 1979, when 

t he respected British journa l New Scientist included 

Linus Pauling . Ph.D .. on its l i st of the twen ty most 

important scient is t s of all time . it was for Pauling 

another in a long series of ach i evements that includ· 

ed an unpreceden ted pai r of unshared Nobel Prizes and 

some sta rt l ingly origina l contributions i n biology , 

chemi stry and physics . </D IV > 

b. Add an inline tag. 

<Hl> 

Dialogue with the Experts 

<!Hl><BR><BR> 

<H2>Linus Pauling. Ph.D.: The Last Intervi ew 

<I H2> 

<BR> 

by <A HREF-"http://members.aol .com/rea l media">Peter 

Barry Chowk a<IA><BR> 

<S UP >&I/169 ; <ISUP>l996 by peter barry cho~1 ka . all 

r ights rese rved. <BR> <BR><BR> 
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Tip: For derails concerning Microsoft's 
.free True Type ojfer, see Microsoft 's plan 

to add fonts to the Web: Free TrueType 

now and Web page font embedding in 

the future in this chapte1: 

116., Chapter 4 

<DIV CLASS- OPENER> 

<IMG SRC- "Paul i ng_2a . j pg" ALIGN- LEFT>< IMG SRC 

- "cap5 . gif" STYL E- "backg round: whi te">n 1979 , wh en 

t he respec ted Bri t i sh j ourna l <B STYLE- "font -style : 

normal">New Sci entist<IB>included Li nus Pauling , 

Ph.D .. on its l i st of t he twenty most i mportan t sci 

entists of all time . it wa s for Paul i ng anot he r in a 

l ong ser ies of achi evements t hat i ncl uded an unprece · 

dent ed pai r of unshared Nobel Prizes and some s ta r 

t l ingl y ori ginal cont ri but ions in biol ogy , chemi s t ry 

and phys i cs . </ DIV> 

9. Style change: A font change in a headline. 
Changes in the sty le definitions inside your s tyle block are 

easy to make. In th is example, try changing Times New 

Roman to a sans serif face in the <H2> tag. Start by locat

ing the <H2> tag in the style block. 

a. Locate the tag and style definition you'd like to 

change in the style block. 

<HTML> 

<HEAD> 

<TITLE>Li nus Paul i ng , Ph. D. : The Las t In te rvi ew by 

Peter Barry Chowka 

<!TITLE> 

<!HEAD> 

<STYLE TYPE- "text/css "> 

<! .-

BODY (margin-l eft : lin : margi n-righ t : 1. 5in) 

.opener (font ·s i ze : 20 pt ; font-weight : extra li ght; 

f ont-s tyle : itali c ; l ine · height : 22pt ; f ont- f amily : 

Times ~ew Roman: margi n- l e ft : l i n; margin - right : 

. 8 i n } 

.normal (f ont ·weight : ext ra l i gh t; f ont- s ty l e : 

normal; f on t -size: 14 pt ; l i ne- hei ght : 16pt ; font · 

fami l y: Ti mes New Roman ] 



Tip: Microsoft's Open Type initia tive 

will include Adobe's CFC compression 

technology and Microsoft's AGFA com

pression schemes, allowingforfaster 

font downloading to Web pages. 

.references {font -weight: extra light; fon t-style: 

normal : font- size : 14 pt ; line- he ight: 15pt ; 

font-family: Times New Roman: margin-left: 1.2i n ; 

margin-right: .Sin} 

B {font-weight: ext ra bold ; font-style: norma l; 

font-size: 14 pt ; line - height: 16pt; f ont-family: 

Ar i all 

H1 {fon t-we ight: extra light; font-sty l e: italic; 

font -size : 20 pt; l i ne - height: 22pt ; fon t - family: 

Ti mes New Roman} 

H2 (font-weight: extra bold ; font -style: normal; 

font-s ize: 24 pt ; line - he i ght: 26pt ; font-family: 

Verdana .Aria l.Helvet ica} 

H3 {f ont-weight: ext ra bold; font-style: normal ; 

font-size: 12 pt ; line -height: 14pt ; fon t- family: 

Times New Roman} 

H4 ( f on t -weight: extra bold ; font-s tyle : normal ; 

font-size : 12 pt; 1 ine - hei ght: 14pt; font -family: 

Times New Roman} 

- -> 

</STYLE> 

b. Make a change in a style definition. Add sans serif 

font alternatives to the <H2> tag. For example, add the 

words Aria/, Helvetica, and sans serif Helvetica or 

some other sans serirrace wi ll be added if AriaJ is not 

avai lable on the end-user's system. 

<HTHL> 

<HEAD> 

<TI TLE>Linus Pauling . Ph.D.: The Last Interview by 

Pete r Oarry Chowko 

<! TITLE> 

<I HEAO> 

<STYLE TYPE-" textlcss '' > 

<!--
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BODY [margin-left: lin; margin-right: 1.5in) 

. opener [font-size: 20 pt; font-weight: extra l ight ; 

font-style: italic ; line-height: 22pt; font-family: 

Ti mes New Roman ; marg i n-left : lin; ma rgi n-right: 

.Bin) 

.norma l [fon t-weight : extra light; font-s tyle: 

normal ; font -s ize: 14 pt; line-height: 16pt; fon t 

famil y: Ti mes New Roman) 

.references [font -weight: ext ra light ; font -style: 

normal; font -s i ze : 14 pt; line- height : 15p t ; 

font -family: Times New Roman; margin- l eft: 1.2i n ; 

ma rgin-right : .Bin} 

B [font-weight: extra bold ; font-style: normal; 

f ont-size: 14 pt; line-height: 16pt ; fon t -family : 

Ariall 

Hl [ f ont-weight : ex tra light; font-style: i ta l ic ; 

fon t-si ze: 20 pt; line- hei ght : 22pt; font -fami l y: 

Times New Roman) 

H2 [font-weigh t : extra bold ; f ont-style: norma l; 

font -size: 24 pt; line- height : 26pt; font-family: 

Verdana ,Aria l,Helve t ica) 

H3 [font-wei ght: extra bold; font - style: normal; 

font-size : 12 pt; line-height : 14pt ; font- f ami ly : 

Ti mes ~ew Roman] 

H4 [font-weight: extra bol d ; font -style : normal ; 

font-size: 12 pt ; line -hei ght : 14pt ; font-fami l y : 

Ti mes New Roman) 

--> 

</STYLE> 



Formatting text 
in columns with 
Netscape's new 
<MULTICOL> tag 
Summary: Use Netscape's 11ew 

<MULTICOL> tag to.formatlarge 

amounts of text imo multiple column 

format. 

:J Hctscnpc: Llnu' Paulin • Ph.D.: The Last lnlcrutcw b Peter Barn Chowlca 

1.¢. I ~x:. .1 ~ II .. ~ l.!.l ! I ~ I ~ I w 
~~- !m. //hOI'Dtst..!lt~cldw•'ht,.,AnaiJXII'ao.!na~ti"11W'n 

Di:Uoruo with lh~ 
Ezp.-ru 

Lima Pauling, Ph.D.: 
The Lasl lolc rview 

by~~ 
• 1996!>1Jot1tt burycU>vb all,_hts 
~I\"'(1. 

Ll97'9.vtr..U:tt)t(~Br.u.'l 
pu.W He• Scleatbl !n:b!ed LtnJ 
Pa·.tuc. P~ D , Otlltl Uto!Tlle tvY.:I'.Y 
a..:.11 tm;o."'::il'.l xient.n of all amc, ~~ 
~ for f'ttt1C: )..''CI.t.e: b a kq :e:-n 
o! ~dUt'lt."tt-rtU ~t lr.::o:it:d Ill 
ID~U'ld ptit Of n.!blnc!. No 'XI 
Prt..I>Sar.Suur.e rtvttt lYon inti 

rr:aou.::ad ttndr-.t.l, 'Vhilll Ca:r•ror.'J 
f )"i(t.t~ Uvt<. l<lwttqt or •»".n ~u: 

'""' 

n..nNt~ttr-tfpt.QtMJ vhodMll't 
fol10v lloflet'.s rttltlen t:Mia 1'1l1Ytnl 
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N etscape's new <MULTICOL> tag adds newspaper- like 

columns to a Web page, which is a practical method of 

formatting very long articles. ln this example, Peter 

Chowka's Linus Pauling in terview fills tl1ree columns, as 

defined by the tag's COLS attribute. 

1. Add <MULTICOL> after <BODY>. 
Decide how many columns you need, and add a column 

number to the tag in the form of an attribute. 

Example: 

<MULTICOL COLS-3> 

a. Insert the <MULTICOL> tag. 

< HTt~L> 

<HEAD> 

<TITLE> Linus Pauling, Ph .D.: The Last Interview by 

Peter Barry Chowka 

<!T ITLE> 

<!HEAD> 
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Above: Peter Chowka 's Linus Pauling 

inten 1iew. Notice that the opening initial 

cap causes leading difficulties in the 

second column. 

120. , Chapter 4 

<BODY BGCOLOR- "Iffffff "> 

<~IU LTICOL COLS-3> 

b. Add two line breaks after the image. Linus Pauling's 

image now needs two line breaks inserted after the 

im age tags and the ALIGN=LEFf attribute deleted. 

Recalllhatlhe image aligned o n the left side of the 

text in Lhe sty le sheet example. 

<HH1L> 

<HEAD> 

<TITLE>Linus Pauling, Ph. D. : The Last Intervi ew by 

Peter Barry Chowka 

<!TITLE> 

<!HEAD> 

<BODY BGCOLOR- "Uffff ff" > 

<I·IULTI CO L CO LS-3> 

<HI> 

Di alogue with the Experts 

<IHl><BR>< BR> 

<H2 >Linus Pau l i ng. Ph.D .: 

The Last Intervi ew 

<!H2> 

<BR> 

by <A HREF-"h ttp : //members .aol .com/ real medi a">Peter 

Barry Chowka<IA><BR> 

&#169:1996 by peter barry chowka. all r ights 

reserved . <BR>< BR>< BR> 

<IMG SRC- "Pa ul1ng_2a.jpg"> 

<BR><BR> 



Above: The <MULTICOL> tag 

makes all columns the same width 

unless you set the overall width with the 

WIDTH attribute. Use a pixel value ora 

percemage. In this example, the WIDTH 

attribute is set to 300 pixels: 

<MULTICOL COLS=3 WIDTH=300> 

l ,hun l'•uli•J, 
l'h. U.: Ttle l .ut 
lm•M•• 

h II ., ..... ,~ ............. , ... " .. ,. ... ,._ 

Above: In this example, the WIDTH 

attribute is set to 85%: 

<MULTICOL COL5=3 WIDTH=85%> 

c. Add a closing <MULTICOL> tag. 

<I MUL TICOL> 

d. Add the ending tags. 

<I BODY> 

<IHTML> 

e. Save the file. Save the document in SimpleText or 

your word processor. If you're using a word processor. 

save the text as Text Only. G ive the fi le an .HTM 

extension. 

f. Test the three-column document. Launch Netscape, 

and open your document by selecting Open File from 

the File pull-down menu. 
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Controlling font 
color and family 
with the <FONT> 
tag {Netscape 
Navigator or 
Internet Explorer) 

Summ ary: Use the <FONT> tag's 

new attributes ro control type color 

and type .family. 

122. I Chaprer4 

Dialogue with I he Experts 

Linus Pauling, Ph.D.: The Last In ter view 

t.y~~~ 
•a996 t.:~~•er u...,.,.dJ:I~·~.a ~,_hUrtJtr.ot t 

I, /979. w!:tzll tlw respected British 
;ouma/ ucw Scientist mcluded Lmus 
Pauhng, ?h. D., Ollils list oft he 
/11\Znty II:DSI II!If.'Orlant SC!21111SIS of 
all tu,e, 11 was for Pauluzg a1:other 
Ill a lo•:g senes of acluevemen!s that 
mcluded aJl unprecedet:led paz r of 
wv;harr!d Nooel Pn::es and some 
stan!zngly or:gmal comrzb:l!IOIIS 111 

bzo!ogy, clzenustry and physzcs. 

T he <FONT> tags recent COLOR and FACE attributes 

may be used to control typography on your Web 

pages. In the Linus Pauli ng interview, the tag and its attrib

utes may be used to alter the font color and family in the 

ar1icle's headllnes. (Note: The <FONT> tag and a ttributes 

may be applied to any part of a line.) 

1. Alter the headline color. 
To change the color of the headli ne Dialogue with the 

Experts, an RGB hexadecimal triplet is needed for the 

<FONT COLOR=> tag. 

The Linus Pauli ng image is a Photoshop duotone that adds 

a violet shade to what was originally a black and white 

scan. The Photoshop eyedropper revealed that the shade 

corresponds to Pantone 667 CV, which the Best Business 

Solution Online Color editor translates into a hexadecimal 
triplet value of#584886 using the R=88, G=72, and 
B= 134 data taken from Photoshop. (Note: See Convert a 

Pantone RGB value to a Web page color with the BBS 
Color Editor in the Online Tools chapte1:) 

<HHIL> 

<HEAD> 

<TITL E> Linus Pauling . Ph .D . : The Las t In t e rv i ew by 

Pe ter Ba rry Chowka 



Tip: For RGB hexadecimallriplelval

uesfor your <FONT COLOR=> lag, 

vis if Besl Business Solulion 's Online 

Color Editor at hllp:!!IV\1'\V.bbsinc 

.COI/I. 

<!TITLE> 

<! HEAD> 

<BODY BGCOLOR-"#ffffff"> 

<Hl> <FONT COLOR-"/1 584886"> 

Dialogue with t he Experts 

<I FONT></Hl ><BR>< BR> 

<HZ>Linus Paul i ng, Ph.D.: 

The Las t I nterview 

</HZ> 

<BR> 

by <A HREF-"http://members.aol .com/ real media">Peter 

Barry Chowka</A><BR> 

&#169 ;1996 by peter barry chowka. al l rights 

rese rved.<BR><BR><BR> 

2. Alter the headline face. 
<HTML> 

<HEAD> 

<TITLE>Linus Pau li ng, Ph. D.: The Last Inte rview by 

Pete r Barry Chowka 

<!T ITLE> 

</ HEAD> 

<BODY BGCOLOR-"Uffffff"> 

<Hl><FONT FACE-"VERDANA,ARIAL .HELVETICA SIZE-"5" 

COLOR-/1584886"> 

Dialogue with the Experts 

<! FONT><!Hl ><BR><BR> 

<HZ>Linus Pau l ing, Ph.D.: 

The Las t In terview 

<! HZ> 

<BR> 

by <A HREF-"http : //members. ao l . com/ realmedi a">Peter 

Barry Chowka<IA><BR> 
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Microsoft's 
plan to add fonts 
to the Web: 
Free True Type 
now and Web page 
font embedding in 
the future 

Summary: The Microsoft/Adobe font 

technology 111erger represent.\· a 

unique contribution to Web-based 

typography. 

124. Chapter 4 

~ 
'llE'bfonts .sit .1 

Are you sick of designjng wilh Times Roman? 

Typographic enhancements to HTML are on the way. 

To solve the Web's font problems, Microsoft has developed 

a new font file format with Adobe Systems. 

1. Solution requires downloading (for now). 
Although Microsoft and Adobe have developed a publicly 

avai lable font specification that promises to improve Lhe 

quality of type on Lhe Web, their solution requi res develop

ers and end-users to have screen fonts installed in their com

puters. Microsoft is dist1ibuting free fonts from their Web 

site. These include the fonts cun·ently supplied with 

Windows 95 (Times New Roman, Courier New, and Aria!) 

and a set of fonts cun·ently supplied with the Windows ver

sion oflntemet Explorer 3.0 (Aria! Black, Impact, Comic 

Sans MS, and Verdana). Other fonts ava ilable on the site 

include Trebuchet and Georgia. 

The Open Type format supports both Type I and Truel'ypc 

fonts, and the format is backwardly compalible with all 

existingTrueType and Postscript fonts. 

2. Designing with fonts. 
Although there is a Truel'ype rasterizer built into Windows 

95. Windows NT, and the Macintosh, for now, screen fonts 

must be installed in an individual user's computer in order 

for lhe fonts to be displayed. Macintosh and Windows Web 
designers interested in using fonts need to distribute any 

fonts they use for Web viewers to download. Microsoft's 

free Truel'ype foms have been designed for this purpose 

and font downloads are provided on the Microsoft site for 

bolh platforms. 

Using fonts already bundled with Windows 95 and the 

Windows version oflnternet Explorer version 3.0 increases 

the likelihood that the fonts wj ll be displayed because the 

fonts are already installed. 



•.• ., ..?.. ~- ~- ~ !1, .E' •. !;. ~:. q 
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DieJo~ue wth lht Experh 

Linus P:1uli n{:. Ph.D.: The L:1s1 lnlenirw 

··~ •• ,..~,. .. ..,..,Jro; ......... ........ l 

Above: In this example, the headline 

Dialogue with the Experts was 
fo rmatted with : 

<FONT FACE- " VERDONA, ARIAL, HELVETI CA" 

SI ZE- "S" >Dialogue wi t h the 

Exper t s</FOIIT> 

Web page developers on both platforms may use font alter

natives in the <FONT> tag. Netscape's Navigator and the 

Internet Explorer browser will search through the fonts 

avai lable on ru1 end-user's system ru~d load what is available. 

If none of the fonts m·e available, the browser loads the 

default typeface. (Note: The <FONT> tag requires an end

ing <./FONT> tag.) 

Example: 

< FONT FACE- "VERDONA . ARIAL,HELVETI CA" SIZE- "4" > 

3. Embedded fonts (the future). 
Microsoft is currently developing an embedded font tech

nology that will free Web viewers from needing to install 

fonts on the ir compute r. Font information will travel with 

a documenl. Microsoft and Adobe have plans to submit a 

proposal for font embedding (using OpenType) to the 

World Wide Web Consortium. If the proposal is endorsed 

by W3C, the iniLiative wi ll become a standard method to 

use fonts on the Web. Even if the proposal is not endorsed 

by W3C, Microsoft plans to add this font compression 

technology to the Internet Explorer browser. 
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Online Tools 
This chapter introduces valuable resources for lhe Web artist 
who uses lhe Web as a CUITent and convenient source of infor
mation. The chapter begins wilh a color editor tool from a 
company in Houston called Best Business Solutions (BBS). 
Web artists who need hexadecimal codes for d1eir HTML tags 

to color a background or text can use lhis editor in conjunc
tion wilh Photoshop as a translation tool. 

Also covered in this chapter are search engines, which have 
become popular online tools for fmding information on the 
Web. Yahoo! search, originally created by David Filo and 

Jerry Yang from Stanford University, not only provides an 
easy-to-use search engine but it facilitates a way to extend the 
search to olher search engines. To promote your site, you' ll 
want to submit information about your pages to all of the 
search engines, and this chapter shows you how to begin lhe 
submission process at Yahoo!. 





Convert a 
PantoneRGB 
value to a Web 
page color code 
with the BBS 
Color Editor 

Summary: Visit Best Business 

Solutions' Web page, enter the RGB 

value of a desired Pan/one shade 

(gathered from Photoshop ), and IVatch 

the BBS Color Editor display the color 

and generate the required HTML code 

for your Web page. 

reopyriglt 1995 BBS, Jr.: 

Adobe Photos:hop n.1 
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B est Business Solutions' Web page is an essential tool 

for graphic designers who want to add color to a Web 

page. You can access the tool, called the BBS Color Editor, 

at htLp://www.bbsinc.com/bbs-cgi-bin/colorEditor.cgi. 

Adding color to a Netscape background or text requires 

placing a hexadecimal red-green-blue triplet in an HTML 

document tag. For example, to color a background white, the 

tag would appear li ke this: 

<BODY BGCO LOR-"f/ffffff"> 

The BBS Color Editor has an extensive list of color names 

that were created by BBS. When I wrote and asked them if 

RGB color infonnar.ion (Photoshop, 0-255) could be trans

lated into the HTML hexadecimal triplets needed for the 

HTML tags, they wrote back and said they had added an 

RGB fie ld to the ir Color Editor! Graphic designers can 

obtain an RGB value for any shade they use in Photoshop 
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1a. 

1b. 

Oook: I 

1d. 

1o. 
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(Pantone, Toyo, Trumatch), type the R08 values into the Color 

Editor, and the Editor displays the desired shade on screen and 

generates t11e hex code for an HTML document, as shown in the 
following table. 

The Pan tone shades used in this example are: 
Item Pan tone # RGBValuc Hex Code 

Background 3935CY R=255 #fff854 

0=248 

8=84 

Text 302 R=O #003850 

0=56 

8=80 

Linked text 1685CV R= ll 4 #722916 

0=41 

8 =22 

Visited link text 172CY R=246 # f62500 

0=37 
B=O 

Active link text 355 R=O #008c3c 
0= 140 

8=60 

1. Find desired shade(s) in Photoshop. 
Decide which Pantone you'd like to use for the background, 
text, link text, visited link text, and active link text. Locate 

the ROB values of these shades: 

a. Click on the Foreground color swatch in the Toolbox. 

b. Click on Custom. 

c. Click on the pop-up box in the 

Custom Color dialog box to 
select a color model. 

d. Scroll to select a shade. 

e. Click on Picker. 

RNPA Co lor 
D I C Co lor Guide 
FDCDLTDNE 
~I 

PRNTDNE Process 
PRNTDNE ProSim 
PRNTDNE Uncoat ed 
TDYO Co lor Fi nder 
TRUMATCH 

1c. 



0 R: !2551 
0 G: j2481 
o s: l84 1 

2. 

I@ Backgrowtd Color: DeJaub. 

3a. 

I 0 Input RGB \li\lue (0-2SS) 

3b. 

3c. 

3d1. 

3d2. 

R:0G:0 B:0 

Hn!J informotlon you submll Is 
Insecure and coultJ be ohscruell h!J o 
third pnrtu while In l rn nslt. 

H !JOU ore s ubmltllll!J posswords, 
crudlt tonJ numbers, 01 uther 
lntunnatiun you would like to keep 
ru1uote. It 111nuhl be sorer for you to 
cancel the submission. 

(oon' l Show lignin ) ( Concel J OCl} 

'This is the HTML cotle of ) 'OW' color selection: 

<:bcXIy b;Jcolor="Jifff854"> 

3&. 

joo Tnt: DeJaub. 

4a. 

This is th11 HThtL code of your nlor stlection: 

4&. 

I® Link tu.1: Defcwh 

Sa. 

2. Record the RGB value of your color(s). 
The Color Picker dialog box will display RGB values of the 

color you choose. Record this information. 

3. Find the hex code for background color. 
a. On the BBS Color Editor Web page, make sure the radio 

button next to Background Color is selected. 

b. Click to enter an "X" in the Input RGB value field. 

c. Enter the RGB values you recorded from Photoshop. 

d. Click on the Test It Now button (Note: The BBS Color 

Editor is illleractive, so you 'II see a warning dialog box 

conceming security. Click 011 Don't Show Agai11.) 

e. The BBS Color Editor wi ll change the background to 

your· desired color, and the hexadecimal HTML code 

wi ll be displayed at the top of the Editor (in this example, 

body bgcolor="#fff854"). 

4. Find the hex code for text. 
a. On the BBS Color Editor Web page, make sure the radio 

button next to Text is selected. 

b. Click to enter an "X" in the Input RGB value fie ld. 

c. Enter the RGB values you recorded from Photoshop. 

d. Click on the Test I t Now button. 

e. The BBS Color Editor wi ll change the text to your 

desired color, and tl1e hexadecimal HTML code will be 

displayed at the top of the Editor (in th is example, 

TEXT ="#003850"). 

5. Find the hex code for link text. 
(Note: Link text refers to highlighted hypertext that is 

activated with a mouse click.) 

a. On the BBS Color Editor Web page, make sure the radio 

bunon next to Link Text is selected. 

b. Click to enter an "X" in the Input RGB value field. 

c. Enter the RGB values you recorded from Photoshop. 

d. Click on the Test It Now button. 
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I ® Visited link text: Default 

6a. 

@ Act:iw link text: DeJcwk 

7a. 
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e. The BBS Color Editor will change the text to your 

desired color, and the hexadecimal HTML code will be 

displayed at the top of the Editor (in this example, 

LINK="#722916"). 

I 'This is the HTML code of your color selection: 

<body .bgcolor:"#fff854" t.ext.•"#003850" linlr-"11?22916"> 

5e. 

6. Find the hex code for visited link text. 
(Note: Visited link text refers to a link that has already been 

f ollowed.) 

a. On the BBS Color Editor Web page, make sure the radio 

bullon next to Visi ted Link Text is selected. 

b. Click to enter an "X" in the Input RGB value field. 

c. Enter the RGB values you recorded from Photoshop. 

d. Click on the Test lt Now button. 

e. The BBS Color Editor will change the text to your 

desired color, and the hexadecimal HTML code will be 

displayed at the top of the Editor (in this example, 

V Ll NK="#f62500"). 

'This is the HTML code of your color stlection: 

6e. 

<body bgcolor•"#fff854" text•"#003850 " linl:="#?22916" 

vlinl:•"#f62500" alini:•"#008c3c"> 

7. Find the hex code for active link text. 
(Note: Active link text refers to a link that's currently active 

or a link with a mouse button held clown.) 

a. On the BBS Color Editor Web page, make sure the radio 

button next to Active Link Text is selected. 

b. Click to enter an "X' in the Input RGB value field. 

c. Enter the RGB values you recorded from Photoshop. 

d. Click on the Test It Now button. 

e. The BBS Color Editor will change the text to your 

desired color, and the hexadecimal HTML code will be 

displayed at the top of the Editor (in this example, 

ALINK="#008c3c"). 



<'4)p_ 
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Simplt?Tt?xt 

8. Try creating a new HTML document using 
color tags. 

To test your color tags, create an HTML document on your 

hard drive, and open it in Netscape. 

a. Open SimpleText. 

b. Create a new document. 

c. Begin a new document with the following markup tags 

<HTML> 

<HEAD> 

<T ITLE>New Colors</TITL E> 

</HEAD> 

9. Add the color tags. 
<HTML> 

<HEAD> 

<T ITLE>Hew Colors</TITLE> 

</HEAD> 

<BODY BGCOLOR- "#fff854 " TEXT- "#003850" 

L I NK- "(/722916" VLI tlK- "(/f62500" All t~K"-II008c3c" > 

<!BODY> 

10. Test a background picture. 
The Color Edi tor can test any picture available on any server 

as a background image. All you need is the correct URL 

(Uniform Resource Locator) . If the image is smaller than the 

Netscape window, Netscape wi ll tile, or repeat, the image to 

form a wallpaper effect. 

Netscape's server has background samples (Figure I Oa) avail

able to you for download (http://home.netscape.com/assist 

/net_sites/bg/backgrounds.html). The Color Editor can dis

play a swatch as a test background. 

a. Go to Netscape's Background Samples page at 

http://home.netscape.com/ assistlnet_s ites/bg/back

grounds.html. 

b. Record the fi le names of any samples you 'd like to test. 
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D Netsca 

¢o l ~ 1 ~ I ® I '® I 
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Loe>otion. http :/ /wvw .infocom.not rbbs/cgi-bin/colorE 

What's tlov? I What's Cool? I Handbook I lltt Su 

10c. 

Tip: To replace a fi le name in the URL 

field, click in the text and use the right 

arrow key to move the cursor all tire 

way to the right. Press the Delete key 

lllltiltlrefile name is deleted, then re

type another name. 
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c. Click on Yes in the Use Background Picture field on the 

Color Editor page. 

d. Enter: 

http://home.netscape.com/assis t /ne t_sites/bg/fabric/ 

yell ow_fabric.gif 

e. Try a few of your selections by substituting another li le 

name in place of fabric/yellow _fabric.gif. 

11. Create a new HTML document. 
To test your background picture, create an HTML document 

on your hard drive, and open it in Netscape. 

a. Open SimpleText. 

b. Create a new document. 

c. Add the following markup tags: 

<HTHL> 

<HEAD> 
<TITLE>Background Picture</TITLE> 

</HEAD> 

12. Add the BODY tag. 
(Note: Step 12 requires that your PPP connection be open; 

howeve1; you can test step 14 0 11 your hard drive.) 

<HTHL> 

<HEAD> 
<TITLE>New Colors</TITLE> 
</HEAD> 
<BODY BACKGROUND- "http://home.netscape 

.com/assistlnet_sftes/bg/fabric/yellow_fabric.gif"> 

<!BODY> 



Tip: Try using 1he URLfora Nelscape 

background sample in 1he <fMC> wg. 

Inslead of riling rile swatch as a back

ground, only one .nvarch will appear on 

the page. 

_ Nctscope: New Colors "~ 

~~~~_J;J~~~ _j f J H:m-• R•lea.d h\.t9f'J' Optn Print fhf II 
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-t'• <lovl l llho t'•Cootl l HIOOi>~ I '"tS.oroll I Nt tD ... <t<"rl r~o .. <;rooos l 
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13. Copy a background sample (optional). 
Copy a sample to your hard drive, and use the file name in 

your <BODY> tag. 

a. Go to Netscapc's Background Samples page aL 

hUp:l/home.nelscape.com/ ass ist/net_s ites/bg 

/backgrounds.html . 

b. Press and hold down the mouse pointer on a sample. 

c. Select Save This Image As. 

d. Use the default name, or type in a file name. 

e. Click on Save. 

14. Create a new <BODY> tag (optional). 

Q 

G-

l!i 

(Note: the.fi/e na1ne you createfor your tag may vwy depending 

011 where the image is located. This example assumes rhefile 

ye/low_Jabric.gif is is in the same directOJ}' as the HTM L 

document. The file /Iaiiie together with o11e or more directo ry 

names is referred ro as rhe path.) 

<HHIL> 
<HEAD> 
<TI TLE>New Color s</TI TLE> 
<!HEAD> 
<BODY BACKGROUIW• "ye l l ow_fabric.gif" > 
</ BODY> 
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15. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) re flect the 

HTML 3.2 specification. 

<BODY> .•. <IBODY> 

A tag used to open and close the body of a document. 

This tag uses the following attributes: 

BACKGROUND specifies a URL to point to a background 

image that wi ll tile to the fu ll document image area. For 

example: 

<BODY BACKGROUND- "yellow_fabric.gif"> 

BGCOLOR controls the color of the background. For 

example: 

<BODY BGCOLOR- "ilfff854"> 

TEXT controls the color of normal text. For example: 

<BODY TEXT- "/1003850"> 

LINK conu·ols the color of link text. For example: 

<BODY Ll ti K-"11722916 "> 

VLINK controls the color of visited link text 

<BO DY VL!NK- "iff62500"> 

ALINK controls the color of active link text. 

<BODY ALINK-"il008c3c"> 

<HEAD> ... <IHEAD> 

A tag used to open and close the header portion of a 

document 

<HT!'YlL> ... <IHTML> 

A tag used to open and close an HTML document 

<TITLE> ... <!TITLE> 

Used inside the head, this tag describes the title of a docu

ment, which shows up inside a documem's title bar. 



Searching 
the Web on 
Yahoo! search 

Summary: Looking for links thar com

plimem yow· page? Doing research? 

Just broiVsing the Web? T1y using the 

search engine at http://IVIVIV.yahoo.com. 

IJ Netscape: Yahoo gj 
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I fyou've never used a search engine, you' ll be amazed at 

the power of th is tool , which w ill search the Web for a 

topic of your choice. There are several such search engines 

or robots on the Web. and Yahoo! (hllp://www.yahoo.com) 

is one o f the most popular. 

• 

.. 

of) 

Yahoo ! was created by David Fil o and Jerry Yang, both 

Electrical Engineering students at Stm1ford University, where 

th is tool was housed for the first nine months of operation. 

Yahoo! is now off-campus. It's an independent company, and 

the robot runs on three Si Iicon Graphics [ndy machines. For 

speed reasons, complex searches are not al lowed. However, 

the engine supports a simple boolean and search, and an 

optional fill - in form allows a visitor to specify a number of 

matches through a popup box on the form. 

1. Select a topic from Yahoo!'s top-level. 
The simplest way to use Yahoo! is to select f rom am ong the 

categories organized on the home page. Each category has 

l inks that will lead you to related home pages. 
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a. Select one o f the topics organized into top-level 

categories on the Yahoo ! home page. 

b. Click on a link. 

lb. 

o IJJ:IItUJ tJI( ~<11.1!"!17 Jl!t!JI 
tJ::• .1 ~~ ll:....•;:k 1 ~ 

• R'PrH'..l.f.IQD 

'"' l&lm!L~ l"!m:. 6Jm. 
a Rtlllr.AC.J. 
IJ!:B:.~~ 

c. The l ink wi ll take you to pages of other links to related 

Web pages. 

Compuwrs and lnwrnot 

lc. 

• MJo. 
e CJIIIIPllttl ~I•AH0. 
• ILIII!Il•~nl•tP. 
• CIIIIIP.JlllDK _Qu•l ii'Lil;l 
e !<!tJl(tJOD<;j!~ 
• Qt#llUP ~tbl13hJ-c 

2. Use the Yahoo! search form. 

a. Type in any topic on the Yahoo! home page. 

b. Click on the Search bullon. 

c. A page of related links will be displayed for you to 

explore. 

2a,2b. 

;:. Netscape: Ynhoo Search 
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Extending your 
Yahoo! search to 
other search 
engines 

Summary: The Yahoo! search engine 

provides links to other search engines 

at the bottom of the pages that are 

retumed. Use these links to extend your 

search without retyping your 

keyworr/(.1) 

.::1 ' . .2.] 2.1.~.1.:.1~1 ~] :.:J 
- 6:£!.~·-·- _._ ... _ ... .,...... 

lb. 

lc. 
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• ~tau.t • kltla 

T he page that returns the results of your Yahoo! search 

will have a group o f links to other search engines at the 

bouom of the page. These links allow you to extend your 

search to one or more of the search engines lisred without re

typing your search topic. (Note: The search topic you ~vped 

is referred to as a keyword.) 

1. Steps to extend a search. 
a. Follow the steps in the prev ious section to conduct a 

search on Yahoo!. 

b. A t the conclusion of your search, scrol l to the boll om o f 

the page that is returned. 

c. Click on a link to another search engine. 

d. A page o f related links on the search engine you chose 

wi ll be displayed in your browser window. 

'•' ::._ ... ,_ ....... __ ..,.._ .................. ';.~ .... . 
..,.._,,o .. . _..,. ___ ..... ,, ""••-••~ 
, .. ,.1'1 .. ~1111&•• 

ld. 

•""-"- 14(~.>-\,1 · ,lf•ttrl It'" J"lht IW -•to r.·11~f""'"l • 
t'-•...., "'"'•'-'-• A.-oL-Io ~..,...,.., 
·~ ···~ · ~::~, ..... u ... • · ........ uN..,. 

__:!-::: ... -·-- ---.J 
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NetSite assistance 
from Netscape 

Summary: Visit Netscape's home page 

to download Netscape plug-ins and 

updated reference material on changes 

in HTML. 

Tip: if you're not currenrly online. it is 

possible to load Netscape on your hard 

drive and compose HTM L documents 

locally. Create the HTMLdocuments 

using Teach Text, SimpleText, or your 

favorite word processor (be sure ro 

save the document in your word 

processor as Text Only). 

1a. 

~=,~.:%¥~~~;:;::- r.; ,.... - -- rm 
tt• ...::e-.tnatn 

--~~:.:...."-:,"!.""!!::::. 
·;...~d-lf~ ··-- • YJIOPt*.t-...t .u-cr_.,.,._ 

1 b. 

Link to download 

Netscape Navigator 

software and plug·lns 

140. Chapter 5 
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• 

• 

Netscape's Web site (http://home. netscape.com) 

is a valuable resource for downloading a current 

version of Netscape Navigator, plug-ins, and current refer

ence materia ls on HTML. 

1. Locating Navigator software and plug-ins. 
a. Click o n the Home bunon at the top of your Netscapc 

browser window to go to the Netscape home page. 

b. Scroll down the page to locate links to current 

Netscapc Navigator software downloads and plug-ins. 

(Nore: Plug-ins add funct ionality to the Netscape 

Navigator software.) 

2. Steps to find Netscape's Web resources. 
a. Click on the Assistance button in the Netscape splash 

screen at the lop o f Lhe Netscape home page. 

2a. 
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Help for Users 
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Help for 

Developers 

Link to Creating 

Net Sites page 

b. The Netscape Assistance and Customer Service page 

wi ll appear. 

c. Scroll down the page to view: 

Help for Users 

Help for Developers, Authors and Publishers 

d. Jn the section labeled Help for Developers, Authors 

and Publishers, click on links in the How to Begin 

Building Web Sites section . 

e. A Creating Net Sites page wi II be displayed, which 

includes the following sections: 

Authoring Documents 

Look for the latest reference materials on HTML. For 

example, this section provides A Beginner's Guide to 

HTML, Composing Good HTML, Extensions to 

HTML, and Guides to Writing HTML Documents. 

Adding Functionality 

Look for O.ffthe Web, a monthly newsletter and addi

tional directory listings of mai ling lists and news

groups to assist Web developers. 
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Add information 
about your site to 
Yahoo! and other 
search engines 
Summary: Promote your home page by 

adding your URL to one or more search 

engines. 

142. , Chapter 5 

B y adding your URL to a search engine, you' re provid

ing Web viewers with a way to find your page. 

Information may be added to each search engine individu

ally or to several search engines at once by visiting the 

Submit It page at http://www.submit-it.com. (Note: 

Changes to any o.fthe search engine Web pages may affect 

the multiple submission .functions on Submit It.) 

1. Steps to add your URL to Yahoo!. 
a. Go to the Yahoo! home page at http://www.yahoo.com . 

b. Use the Yahoo! search function to see if your page is 

already listed. 

c. After you've run a search and you know your site is not 

listed, retu rn to the Yahoo! home page at 

http://www.yahoo.com. 

1a,1b,1c. 

N t h C:b o: YllhUOI 

IJC:JI 
,,..,.,. c.J 

'!l'bf.'t"r @"~ft.,-~ M1; :d<Ulcll<U 

l··~o I SWeh )u•H Nt:..'Y ?~, 
:t.t; 'LL t .. t .l.•O.ot..l:kl - h·,~JJD: •I' -U ., ·It ,.a...c: 

• 1\m. ~"U1J~1Utt • Hln.t.lt..Mt4JI IIgn !. 
...-~. ~ ~,th,t, ~~tt.UI:"~ 

• brtJif.1LJ.ttlf\I~?:J8u!J • RuJUJI!QLUU,.J,V.I::l'il"' 
r 1.; - • )!r brz..~1!r.':11.UU. 

• aoauiW..I&Iil.l&tllltl ~ .. u • Rl.(rJ~kt 
a.n:=..· a..t.--IJ&Ibt :.JtCL~~ 

• IIP"Ilall< 
~:J,.;I\.l" 

• takl...,l lli.J[JW.!I 

• "'&t>~t.l c.c.r ..... v -".w 

• ":P"<t • 

d. On the Yahoo! home page, click on the catego ry where 

you'd like your s ite to appear. 

1d. 



1e. 

1f. 

~~~-~=!m~~.:~~'j?::~ 
~.':'" ,..., 1\a» W....., ,!IIo;tc•• .... ,...,. ....,,,..._,,,loll ~ r..-,,......,...,. a.~ 

• • .-..... '""_, ,,.., .. ,,_ ... ,. ....... t;l_lf,.....l"llr:'·~'""'"' 
· =.~~~~::..r=::~;..";,.~'::,~~;:'.!~"';:;~:= 
=~~-::~.:.=.~=~~t!::;.r"'""~·"""'' .... ,.r ....... Tb' 

. .............. .... 
.II~JI!'oJ-•M~lilt t .. U.llllll:<~JIIIIii'U!I!Cf1• ...... 111i".WC!Io•,...•• 
PIIMWtt<llaoi~W 

':Zu~t:=~=~ .. 1'\lll)f'Oirlp!'lfJM•~.,.~~~~~-""' 

Tl(lo·~·--,..-:::~-·'( .. ~ 
UIIL v.;-~'-'t.._,x .. -....~.,.,..llll;f •IIH~'t'¥tlfl~ a.-.... ,...,,_ll:<'a<I_.,..,...,.,OMQoW..,.,. .. O'I. .. MP 

........... ,,." ...... ~ ... ~l--~~V,ft,.n ... ~.),t .. .W.r..Q: 

._, .. 
c:::, •' i' 1"11 ' ,, 'J1 

1g, 1h,11. 

e . A page will be displayed that corresponds to thecate

gory you selected. 

f. Click on the Add URL icon at the top of the page in the 

Yahoo! banner. 

g. The Add to Yahoo! page will be displayed. 

h. Scroll to the form at the bottom of the page and type 

your page title, your URL, and 20 words that describe 

your site. 

i. Adding the following form information is optional: 

• Geographic location of your site 

• Your name and email address 

j. When you have completed the form, cl ick on the 

Submit button. 

Please ( Submit J it... 

1j. 

k. In the dialog box that follows, click on OK. 

1k . 

nnylnfonnollon you sullmlt Is 
Insecure ond could be observed b!J ,, 
third porty while In trunslt. 

If you ore submitting passwords, 
credit cord numbers , or other 
lnformotlon you would like to keep 
prtuote, 11 would be t o fe r tor you to 
cancel the submission . 

(Don' t Show Rgoin) 
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Locating, 
downloading, and 
decompressing 
shareware from 
the Web 

Summary: clnet's Shareware.com site 

is an excellent resource for shareware. 

l b. 

144.1 Chapter 5 

W ondeting if your ~oft ware is o~tdated? ~heck d net's 

Shareware.com stte. The archive con tams a very 

large collection of freeware and shareware programs that 

you can download. 

1 . Steps for locating and downloading 
software. 

a. Go to the Shareware.com site at http://www 

.shareware.com. 

b. Click on the Selections link. 

c. A Selections page will be displayed. 

la. 

lc. 
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!:.Jor Ill Internet 
The so~~or the honest browsers, viewers 
and players. 

1d. 

1e,1f. 

QulckSurch 
I - ~-

<~9 

~i~ 
Stufflt E>~pandeor-n·1 

2. 

d. Click on a Mac or PC icon in a desi red category. 

e. A list of software in the category you chose will be 

displayed. 

f. Click on a link to a desired softwar e program. 

g. A page displayi ng a download link w ill appear. 

h. Click on a download link to beg in downloading. 

"'"' ..•• ,u: .. ~I..'"•,..MW-l n, . • .,. .... .., 

1g,1h. 

2. Notes on decompression. 
Software available for clown.loading wi ll often be encoded 

in a Bini-lex format with an .HQX fi le extension. If you 

have Stufflt Expander installed as a Netscape helper appli

cation, Netscape will automaticall y decompress the file at 

the conclusion o f the download. 

If you do not have Stufflt Expander installed as a Netscape 

helper application, you will be asked if you want to save 

the ti le on your hard dri ve at the conclusion of the file 

down load. Save the file , locate Stuff1t Expander on the 

CD-ROM in the back of this book, and decompress the fi le 

manually. 

Stufi"It Expander will a lso expand fi les that have been 

encoded in MacB inary (.BIN) format. lf you have a lso 

insta lled DropS tuff wi th Expander Enhancer, you will be 

able to expand fi les that were compressed or encoded on 

PCs and Unix systems with Stufflt Expander. These 

include: ZIP (.ZIP), ARC (.ARC) a rchives, gzip (.GZ), 

Unix Compress (.Z), UUencoded (.UU), and Tar (.TAR). 
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Photography 
Images are the most popular multimedia elements on the Web. 

However, until browser software behaves like Quark XPress, there 

arc many subtle details involved in placing images on a Web page. 

Because o f bandwidth limitations-the objective is to keep graphics 

Iiles to a mjnimum- image manipulation has more in common with 

the computer game industry than it does with print. 

To intwduce readers to these new concepts, Mark Elbert's notes on 

Web graphics summarize details such as Web page size, color scan

ning, bit depth, file naming conventions, and advice on testing a Web 

page before it's launched into cyberspace. 

New media artist Jane Greenbaum introduces readers to Painter's 

Create Drop Shadow command, which provides a quick method of 

creating drop shadows. The command can be used for crealing a drop 

shadow around text or an image. (Note: Creating a dmp shadow 

around type involves veryfew steps.) 

In remaining sections, Mark Elbert's Web projects will give readers 

c lues about how to assemble their own pages, plus a section on creat

ing a Super Palette with DeBabelizer, which offers color palette 

manipulalion tticks from DeBabelizer's author and game industry 

expert, David Theurer. 





Mark Elbert's 
notes on Web 
graphics 

Summary: Mark Elbert relays tips on 

Web page size. color palettes, dithering, 

and file formats. 

Graphic designers can leverage everything they know 

about print and often reuse g raphics that have been 

created for print. In this section, Mark Elbert's no tes o n 

graphics will help g raphic designers make a transition from 

print to Web graphics. 

1. Plan the size of your images. 
Because most microcomputer color monitors are 14-inch 

color screens, you should plan your graphics to fit this aver

age-sized window. When Netscape launches, the browser 

window does not fil l a 14-inch screen, but the Web visitor 

can resize the window to see wider images. The available 

space in a single Netscape window (resized to fill the screen) 

on an average monitor is as follows: 

Dimension Pixels 
(or pts) 

Horizontal measure 604 

Vertical measure 304 

Picas Inches 

50.33 8.38 

25.33 4.22 

Although Netscape 's defaul t window has an inside horizontal 

dimension of486 pixels on a Macintosh monitor, images are 

always offset 8 pixels from the edge of the browser window 

by default. As a result, the banner graphic should be no more 

than 604 pixels. (Note: Pixels are dots, or screen elements.) 

When planning the height of your graphic, decide whether 

you'd like the average visitor to experience the graphic in 

"pages," or if you want the graphic to fit within the first 

viewable window. Set a graphic's height to 304 pixels to 

limit the graphic to one screen. Although Netscape's default 

window has an inside vertical dimension of 320 pixels, there 

wiJI be an offset of8 pixels a long the top of the browser win

dow by default. 
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Tip: Before resampling or changing the 

bit depth in your image, make a duplicate 

of the image. Select Duplicate.from the 

Image pull-down menu in Photoshop, and 

give the file an altemate name. 
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2. Color scanning: The transition from print. 
The 24- and 30-bit scanners that graphic designers use for 

print provide information for the printed page, far in excess 

of what you' II need or want for Web graphics. 

The 24-bit linage you edit in Photoshop should be reduced to 

a second, smaller image of 8 bits or fewer. Half of your image 

manipulation steps will be to reduce file size because fi le size 

is critical on a Web page. Look for examples in this chapter 

that demonstrate how to reduce bit depth in Photoshop or 

DeBabelizer. 

a. Scan to a particular size. Most scanning software 

programs a llow you to scan to a particular size. Rather 

than resizing the image in Photoshop, it's best to scan to 

your desired size on the scanner, as resizing in 

Photoshop causes blurriness. 

b. Scan to a larger resolution. In spite of the fact that you 

wi ll ultimately not need more than 72 pixels per inch, 

graphic designers generally agree that the best images 

are those that are oversamplecl, or scanned at a higher 

resolution and then resampled. 

3. Correct the color of your image. 
Improve the color of an image by redistributing the color 

tones. This can be accomplished by setting the whi te point 

and black point or by manually selecting the lightest and 

darkest areas in a scanned photo. (Note: See Creating a ban

ner graphic or splash screen in this chapterfor steps on how 

to set the white point and black point.) 

a. Histogram before color correction. A histogram from 

Photoshop reflects the tonal distibution in an image or 

tl1e brightness and darkness values. Note that the x-ax is 
rctl ccts the colors from darkest (left) to brightest (right). 

They-axis reOects the number of pixels with each value. 

b. Histogram after color correction. After setting the 

while point and black point to color-correct the image, 

the color is more evenly distributed. 



Tip: Set your monitor to 256 color.':.· when 

you're working on imagesforthe Web. 

Most computers on the Web have an 8-bit 

color depth, so this will give you a close 

idea of how your images will look. 

If you have a 24-bit monitor and you 'd 

like to switch to 8-bit col01; select Comrol 

PcmelslMonitorsfromthe Apple pu/1-

downmeml, and choose 256 colors (in 

System 7.5x, the Apple pull-downmenu 

has a cascading pop-up menu that allows 

you to see and select any Contml Panel). 

Tip: Figure 5a, 5b, 5c, and 7 are avail

able on the CD-ROM in the back of this 

book. Open the photos on a Macintosh 

with a color monito r to see the diff .. er

ences in bit depths. 

5a. 

4. Changing the bit depth. 
By reducing bit depth, you reduce fi le size. Conversion to a 

smaller bit depth is accomplished through a mode change in 

Photoshop. When converting from RGB Mode to Indexed 

Color Mode, a dialog box will appear and allow you to 

select a bit depth and a dithering option. 

By reducing the bit deplh in an image, you also reduce lhe 

number of colors. When you convert an RGB image to 

Indexed color in Photoshop, the program builds a color table 

or palette for the image. Although an RGB image can contain 

16.7 million colors, an indexed color image comains 256 

colors. Photoshop simulates a larger RGB palette using lhe 

available 256 colors. (Note: For more information and exam

ples, see the secton on bit depth in this chapte1:) 

Photoshop al lows you to control the foUowing palette types 

when you convert to Indexed Color Mode: 

• Exact Palelle. Photoshop uses the sa me 256 co l

ors present in the original RGB image. 

• System Paleue. Photoshop uses the system's default 

color table. Dithering is an option. 

• Adaptive Palelle. Photos hop creates a color table of col

ors more commonly used in the image. (Note: When 

converting to Indexed Color Mode in Photoshop, the 

Adaptive Palelle is the best option.) 

• Custom Palette. Photoshop displays a Color Table dialog 

box, aJiowing you to edit the color table using the Color 

Picker. The palette can be saved for later use. 

• Previous Paleue. Photoshop makes this option avai lable 

when you have already converted an image using the 

Custom or Adaptive Palette option. 

5. Dithering. 
Dithering adjusts the color of adjacent pixels to fool the eye 

into thinking there is a third color present Greg MarT, a color 

manipulation expert at Equilibrium, recommends selecting 

dithering whenever it is an option. 

a. 24 bits, millions of colors, no dithering. A 24-bit 

image on an 8-bit monitor has some dithering due to 

Color QuickDraw's intepretation of the color palette. 
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b. 4 bits, 16 colors, dithering. Photoshop's dithering 

applied in a mode change from RGB to Index Color 

Mode camouflages a reduction in the number of colors. 

c. 4 bits, 16 colors, no djthering. Without dithering, there 

are too few colors in a 4-bit image to approximate skin 

coloring. 

6. Add type after reducing the bit depth. 
Don' t subject the type in your image to dithering. Add type 

after you have settled on a bit depth you like. 

7. Color duotone and grayscale options. 
Color duotone and grayscale images look better at smaller 

bit depths than do full color images. For instructions on 

how to create a duotone, see Creating a duotonefi·om a 
grayscale image later in this chapter. 

Image Color Duotone Grayscale 

8 bit, GlF J60K 148 K 144 K 

8 bit, JPEG 60 K 44K 52K 

(med.) 

4 bit , GIF 92K 100 K 80 K 
- - - -
4 bit, JPEG 32 K 15248 K 52 K 

(med.) 

8. File naming conventions. 
Your Web documents should have proper extensions, 

to help the Web server identify the fil e type. 

Format Extension 

HTML .html (Unix) .htm (DOS) 
- - --

GlF .gif 
- --- ------------------------

JPEG .jpg .jpeg 



Tip: Shonening a file name 10 eight char

acters can be a challenge for Macimosh 

users. Jiy removing the vowelsfivm the 

file name. The file name can often be 

detenninedfivm the remaining conso

nallts. 

Tip: B!Vw.l'e1:1· are constantly evolving like 

other .I'Ojiware p1vgrams. Jiy to stay 

familiar with new developments by down

loading new venions occasionally. 

Curre/11 infor711mion about updates to 

HTML can be obtained 1vithin Netscape's 

own system of Web pages at http://www 

. netscape.com. 

Tip: Even though many users now have 

modems that operate at 28.8 Kbps or 

highe1; it 's o.fien the case that use1:1· 

cannot connect to their Web sites at these 

optimwn speeds. Always asswne that 

average connection speeds are about 

14.4 Kbps. 

Use very short ftle names without spaces (eig ht characters 

or less). and avoid using the fo llowing characters in ftle 

names: 

Character 

<> 

[] 

= 

I 

+ 

Name 

angle brackets 

back s lash 

vertical bar 

brackets 

colon 

comma 

equal sign 

forward slash 

plus sign 

quotat ion mark 

sem icolon 

9. Test the download speed of your Web page. 
HTML documents may be built o n your hard drive using a 

text editor such as SimpleText or TeachText. Use Netscape 

off line to check your work. However. the download speed 

you' ll experience when you load a fil e from your hard drive 

will be much faste r than the average Web visitor's 14.4 or 

28.8 Kbps modem . 

As soon as you've developed a large graphic for your Web 

page. you should test the download speed over a 14.4 Kbps 

modem. If the graphics are slow to load, you'll have trouble 

attracting Web visitors. Web visitors wil l be re luctant to 

retum if they have to wait several seconds for downloads. 

10. Test your Web page on other browsers. 
Images developed on a Macintosh may appear slightly 

stretched on an IBM PC browser window due to a d iffer

ence in the aspect ratio. Pixels on an ffiM PC are taller than 

pixels on a Macintosh. 
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In addition, different systems use diiTerent melhods for ending 
a line. The text you've formatted wilh the <PRE>, or prefor
maned, tag on a Macintosh may change if you move your files 
to a Unix or IBM server. 

ff your finn does not own an IBM PC, consider getting on the 
Web through another platform at a public computer rental 
facility, which rents time on the Internet by the hour. 



Pixel depth 

Summary: Learn how pixel depth or bit 

depth, a critical color characteristic, 

will affect the pe1jormance of your Web 

pages with graphics. 

T;p: Equilibrium, the company that 

created DeBabeliz.e1; is continually 

addingfimctionality to their software. A 

recent addition includes a Windows edi

tion oft he DeBabeli~er software. Look fo r 

.further information m Equilibrium 's Web 

site located at http://www.equil.com. 

G raphic designers who have worked with Photoshop to 

produce mtwork for print may not be acquainted wilh 

pixel depth or bit depth. Bit depth is defined as the number 

of bits used to make up a color pixel. 

Bit Depth Number of Colors 

2 bits 4 colors 

3 bits 8 colors 

4 bits 16 colors 
--- -

5 bits 32 colors 

6 bits 64colors 

7 bits 128 colors 

8 bits 256 colors 

16 bits 65,536 colors 
---

24 bits 16 million colors 
-----

For print graphics, the objective is to increase the bit depth ; 

for Web graphics, as in game software development, the 

objective is to reduce bit depth. 

The critical objective for a Web page artist is the same objec

tive shared by game developers: combine what looks like the 

largest amount of color and the smallest possible fi le size. 

Web pages have a critical performance issue. Web visitors 

will grow impatient and won' t want to return to a Web page 

if there's a long delay while images download. 

1. Plan "target" size and physical dimensions. 
Spend time traveli ng the Web. and get acquainted with the 

file sizes and physical dimensions of the graphics you see. 
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The images you see that download quickly wi ll be the ones 

you' ll want to examine closely. You can discover a fil e's 

format, the fi le size, and the physical dimensions by down

loading the image to your hard drive, as follows: 

a. Position your mouse pointer on a Web page graphic. 

b. Hold down the mouse button, and select Save This 

Image As. 

c. Let go of the mouse button, select a 

folder or your desktop for saving, 

enter the name o f your fi le, and cl ick 

on Save. The fi le name extension wi ll 

tell you if the image is a G1F or a 

JPEG fi le. 

· DeBabelizer ' 

~~1~1!1 I 
hom• .jpg 

Qr;gW>al Clrrftlt 

d. Open the image in Photoshop, and 

select Image Si ze from the Image 

pull-down menu. Note the image reso

lution and the physical dimensions. 

e. DeBabeli zer w ill display the number 

of colors beneath the tool box. 

2. Compare image file sizes. 

Yide :450 450 
Hi : 400 400 
Color : 17Mil 17Mil 
DP 1: 72 72 
RGB: 
liS Y: 
XV I: 
~ -------------... ., 
~- -- ------- ---*- ~ 

le. 

a. 40 K, JPEG. At40 K, the Conde Nast image downloads 

very quickly. 

b. 108 K, GIF. A t I 08 K , the Disney M oviePiex image 

downloads rather slowly. 

2b. 



4a. 

4b. 

4c:. 

3. Browsers have a 256 color per page total. 
The palette you plan for one image may affect d1e palettes 

of other images o n the page because browsers limit the 

total number of colors to 256 per page. 

DeBabelizer's Super Palette feature selects the best 8-bit 

palette for a group of images by "po lling" the images and 

determining the best colors for the images as a group. For 

instructions on how to create a Super Palette for a group of 

images, see Creating a Super Palette with DeRnhelizer in 

thi s chapter. 

4. Experiment with lower bit depths. 
Images respond different ly when you lower the bit depth . 

For example. an image with a large variety of colors will 

not respond well to a lower bit depth because palette colors 

get "used up" qui ckly. 

a. 8 bits, 256 colors, dithered GIF. This image of chil

dren wai ting to climb into a school bus has a wide vari

e ty of colors. This image begins to look patchy even 

a t 8 bits. (Note the little g irl's back pack and the head

lights of the bus.) As a 200 K GIF fi le, this image will 

download slowly. 

b. 7 bits, 128 colors, dithered GIF. The image of a 

teacher and student starts to look patchy at 7 bits. As a 

11 2 K GIF file, this image will download slowly. 

c. 4 bits, 16 colors, dithered GIF. The image of the 

teacher and student holds up well in grayscale at a lower 

bitdepd1. As a 28 K GIF file, this image will download 

faster than the full -color versio n. 

Both images look superior and download faster when saved 

as JPEG. However, there are tradeoff's. For a comparison of 

GIF versus JPEG, see the next section in this chapter. (Note: 

Figure 4a, 4b, and 4c are available on the CD-ROM in the 

back of this book. Open the photos on a Macintosh with a 

color monitor to see the differences in bit depths.) 
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Saving your image: 
GIForJPEG? 

Summary: Learn about the differe!lces 

betwee11 G/F a11d JPEG, two popular 

graphicsfileformatsfound on the Web. 

Tip: Most HTML tags work in the 

Netscape brvwser as weff as Microsoft 's 

lntemet Explorer browset: Howeve1; both 

brvwsers use a few unique HTML tags. 

Micmsoft's Web Caffery at lrllp://www 

.micrvsoft.comlgaffery conrains notes 

abow !me met £1plorer-~pecijic tags and 

Netscape-speciflc tags. 
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T he decision to save an image as G IF or JPEG may 
depend on the image. Although GrF images are popular 

because of the special effects that can be used, detai led images 
and flesh tones oft en look better when saved as JPEGs. 

1. GIFs are read by more browsers. 
GTF is the predominant image fi le fonnat used by Web page 
designers because it can be read by more browser programs as 

an in line image. lnline images appear on the browser page with 
text. Extemal images are those that must be loaded and dis
played with an add-on viewer program, referred to as a helper 

application. 

Netscape and Internet Explorer can read JPEG images as inline 
graphics, but some other browser programs wil l ignore JPEGs 
tagged as inline images. AJPEG image referenced with a link 
will be displayed in a viewer application's floating window 
when the link launches the viewer software. 

2. GIFs can be used for special effects. 
GIF images are 8-bit images that may also be stored as trans

parent G!Fs. This type of GrF is popular for special effects 
such as fading and siJhouettes. Interfaced G/Fs are anod1er 
popular option because they appe.'lr to download faster d1an 
non-interlaced GrFs. The image is quickly drawn in low reso
lution and then gradually fills in with pixels as the image is 
downloaded. 

3. GIF images sometimes have banding. 
Because GLF images are 8 bit, the image may contain banding, 

or look posterized. This is due to the way the browser reads the 
image and usually occurs with blends and flesh tones. An 
image with a large amount of detail will look better if saved as 

a JPEG image. Banding, which will often be seen in an 8-bit 



Tip: Equilibrium, the company that creat

ed DeBabelizet; also makes a 

DeBabelizer "Lite" pmduct. Unlike the 

.fit/1 package, which supports scripting 

and batch pmcessing, DeBabelizer Lite 

is a translation too/that contains a large 

number of" readers and write1:1·." (Note: 

Animation file fonnats, such as 

Quicklime, FLC, and FLI, are not 

supported in the Lite version of 

DeBabelizer:) 

GJF, wi ll be smoothed in the JPEG formal with some dither

ing. A summary of file format characteristics fo llows: 

Format Plus/Minus 

GIF 

JPEG 

Plus GIF files can be read by a majority of 

browsers as an inline image. 

Plus GIF images can be saved as interlaced 

GJFs, a format that appears to download 

fas ter than non-interlaced GIFs. T he image is 

quickly drawn in low resolution and is gradu

ally filled in with pixels. 

Plus GfF images can be saved as transparent 

G[Fs. This GfF drops out whatever color is 

assigned as tnmsparenl. This may be accom

plished with Aaron Gile's Transparency soft

ware and DeBabeli ze r. 

Minus GJF images may appear posteri zed in 

some browsers. (See next page.) 

Plus Photographs do not appear posterized. 

Minus .I PEG ti les look somewhat dithered and 

are not read as inline images by many browsers. 

4. JPEG was designed for 24-bit color. 
The JPEG compression algorithm (invented by the Joint 

Photographic Experts Group) is really intended for 24- or 32-

bitcolor. When an image is compressed, this " lossy" algorithm 

throws information away. 

Should a Web designer reduce an image to 8 bits and then save 

it as JPEG? Because most of the color monitors used on the 

Web are 8-bit color, 24-bit color images on Web pages are 

unnecessarily large and a waste of color information. An 8-bit 

JPEG image stores what appears to be a lot more than 8 bits of 

information and although the loss of data may be visible on a 

printed page, it is not visible on screen. (Note: Do not save a 

JPEG image twice as JPEG, or your image will be noticeably 

pixelated.) Reduce your Web graphic to 8 bit, save it as a JPEG, 

but store an original 24-bit RGB image for future editing. 
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Tip: Posterization is a tenn that refers to a 

jlallening of the brighmess values in an 

image (Note: The image 011 this page is 

from the Pacific Coast Software collection 

ofstock photography at http://www 

.pac(fic-coast.com.) 
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The differences between GIF and JPEG images is most obvi

ous in skin tones, where the poste rization that occurs is very 

pronounced. Notice the difference in the two photos on this 

page. The top photo is a JPEG image, and the photo below is 

a GIF image. 



GIF and the LZW 
compression 
patent 

Summary: Eventlrouglr there have been 

rumors that the Gl F file format may dis

appear due 10 the legal dispute between 

Unis.vs and CompuSe1ve, the 8-bit.file 

form m, which may someday be upgrad

ed to 24-bit, is not going away any time 

soon. Graphic designers who develop Web pages appreciate 

the GIF file format for the transparent GIF, which 

makes silhoueLtes possible, and the interlaced GJF, which 

appear to download quickly to the browser screen in waves. 

Although the J PEG fi le format is superi or to GfF for dis

playing color deta il , a JPEG image can't be saved wilh a 

transparent background, nor can it be interlaced. 

1. Unisys and the compression patent. 
The GfF file format, owned by CompuServe, uses LZW 

compression. LZW (Lempel, Z iv, We lch) is a lossless, 8-bit 

compression-decompression scheme that was originally 

developed by the Lempei-Ziv team. but later improved by 

Terry We lch when he worked for the Sperry Corpora tion. 

Unisys took over d1e LZW patent when Sperry became part 

of Unisys in 1986. The LZW scheme. unlike a "lossy" com

pression schme. doesn ' tlhrow away information when it 

compresses. Ever since Unisys took over the patent. they 

have been licensing the compression algorithm to online ser

vices and modem manufacturers. They have also been quiet

ly enforcing the patent in d1e software market. as the scheme 

is popular among companies who make image editing soft

ware programs. 

2. Grandfathering the license. 
In pursuing the ir right to the patent , Unisys grandfathered 

the license to any software product that used LZW compres

sion prior to January 1995. However. as of January I I ,996, 

any new produc t. or any software product update. requires a 

license. 
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HTML tags and 
page markup 

Summary: Understanding HTML, or 

the Hypertext Markup Language, is 

essentiaf.!or Web page development. 

162. 1 Chapter 6 

Netscnpe: Color III 

Newcm~tle 
Prod 1ll«:tl©rrns 

T he term markup is a publishing term used to refer LOa 

tradition in print. When pages are produced in publish

ing, typesetting instructions, known as rags, are added to a 

typewriuen manuscript. In print, tags tell typesetting soft

ware how to display a page. 

Unless a graphic designer works in book publishing, he or she 
may not be aware that Quark XPress, PageMaker, and other 

page layout programs can read and interpret plain text or 
ASCU text with tags containing style infmmation. Quark's 

system of text tags are similar to HTML, the tagging system 

used on the Web. 

Although Quark XPress is a powerful page layout program, 

its system of tags is not ideal. For example, Quark's tags can 
describe text very accurately, but the tagging system does not 

offer rags that describe images. Publishers who use XPress 

tags to assemble books or newsletters with pictures. use 

supplementary tagging software such as Xtags from Em 

Software. 

In contrast to Quark's sophisticated text tagging system, the 
HTML tagging system has very crude tags for describing tex t. 

However, unlike XPress tags, HTML includes image tags as 
well as powerful tags that can create hypertext links across 

computer platforms and to multimedia resources such as 

sound, animation, and video. 



Tip: The best way to team how to use 

HTML tags is to visir pages on the Web 

and select Source from the Edit pull-down 

menu. (In lntem et Explorer. this com

mand is View Source. ) The HTML tags 

used to compose the Web page will be dis

played. The source code you'll see can 

either be saved or printed. 

The following chart shows how the Quark XPress tag sys

tem is simjlar to the HTML tag system. Xpress tags have 

been widely adopted in the book publishing industry. 

HTML X J>rCSS Meaning 

< B> ... <IB> < b> Turn bold on/off 

< I> .. . </1> <i> Tum ital ic on/off 

<U> ... <IU> <u> Turn underline 

on/o ff 

<P> <\n> New paragraph 

< BR> <\d> New line 

<CENTER> </Center><*C> Center a p<u·agraph 

... </CENTER> 

<BODY1EXT="#rrggbb"><c"color "> Change tex t color 

... </BODY> 

<FONT SIZE=value> <z###.##> Change font size 

<NOBR> <\!s> No break 

1. Special characters. 
HTML and Xpress tags both have a set of special charac

te rs. For example, both need a method of indicating charac

ters that would otherwise be interpre ted as part o f a tag, 

such as an angle bracket. In HTML. special characters are 

referred to as cltaracrer entities or numbered entities. 

HTML X press Meaning 

&It; <\<> < 

&gt; <\>> > 

&amp; n/a & 

&quot; n/a 

Besides providing a means to generate characters that wou ld 

otherwise be interpre ted by a browser as a tag symbol, charac

ter entities also exist to generate characters from the ISO 

Latin- I alphabet, which do not exist in the ASCU set of char

acters. These characters a re generated with different key 

sequences on different computer platfonns; making them spe

cial characters in HTML solves translation problems. 
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Tip: Although the <PRE> ... <JPRE> tag 

preserves prefomwtted text, a browser 

changes the font of prefonnatted text. 

164. , Chapter6 

2. Starting tags and ending tags in HTML. 
Most HTML markup tags require that a set o f tags be used. 

The starting tag acts much like an on switch, and the ending 

tag acts like an off switch. Together, the set of markup tags 

act on the text that lies between the tags. (Note: You can mix 

upper and lower case leuering when you create tags.) 

Meaning 

Anchor 

Bold style 

Starting Tag 

<A> 

< B> 

Ending Tag 

<lA> 

<IB> 

3. FormaHing inside <PRE> ... </PRE> in HTML. 
Although browsers usually ignore re turn characte rs and 

spacing, line breaks and blank spaces are left undisturbed 

inside the preformatted text tag. 

4. Nesting tags in HTML. 
Nested tags are tags inside of other lags. Most lags can be 

nested, except for anchors inside of other anchors or head

ings inside of preformatted text. 



The moveable 
grid for pictures 
and text 

Summary: Can a graphic designer 

develop a grid for a Web page? Not real

ly. HTML tags describe how elements 

should be placed in relationship to each 

othet: Placemem is not described in 

relationship to the page, because the 

page size can vwy. 

MM !.1 ('•.l!n!ntl)' :r: ~'W' pi"'O""".;.13 of ~ooi~ ~ 'Vbolt re,- t.,s:t., o! rot~nal 
vllli:b Vlll too ... ..u.~lo tn u.r Poll or '95 

W hen a graphic 

designer uses 

Quark XPress for page 

layout, he or she has a 1001 

that offe rs very precise 

page geometry for a print

ed page. 
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this page, the Mesh Records image 
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ALIGN=RJGHT au ribute, which 

wi ll align the image o n the rig ht 

side of the text regardless of how 

the browser window gets resized. 

Note there is a small amount of ho r

izontal spacing o n e ithe r side o f the 

image to push the text away from 

the edge, which is the result of an 
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') 
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HTML attri bute called HSPACE shown later in this chapter. 

If horizonta l space gets added, you will only be able to con

trol the space on both sides o f the image, but not on one side 

or the otl1er. This page offset around the edge appears to be 

8 points or pixels. 
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UsingHTML 
to move page 
elements 
horizontally 

Summary: In the absence of a grid, ir 's 

valuable to understand how HTML can 

be used to move elements horizonta fly 

or verticafly. In Quark X Press or 

Microsoft Word, these commands would 

be referred to as paragraph-based. 

Tip: Mosr HTMLrags place images in 

relarionship to the left margin. Veiyfew 

tags are available that place images on 

the right or anywhere in between. The 

examples on the next few pages demon

strate a few tags rhea can be used like tabs 

ro move elements varying distances 

aCIVSS the page. 

166. , Chapter 6 

I mages and text that are "tagged" into place horizontally 

on a Web page maintain their position relative to other ele
ments when the page is resized. 

1. Open SimpleText. 

Use SimpleText or a word processor. If you use a word proces
sor, be sure to save the document as Text Only. 

2. Create a new HTML document. 
Start a new document with the following markup tags: 

< IH~IL> 

<HEAD> 
<TITLE> ~ ew Side Band</TITLE> 
<!HEAD> 
<BODY> 

3. Add the name of a GIF file to the <BODY> tag. 
Background images can be used in Netscape. Add the name 
of the G IF li le that you'd I ike to use as the background image 
to the <BODY> tag. 

<HTML> 
<HEAD> 
<TITLE>New Side BandC/TIT LE> 
<lfiEAD> 
<BODY BACKGROUIID - "tlew_Band. gi f" > 



J::J _ Netscape: Netu Side Oand 
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4. 

4. Add an image tag. 
The <IrviG> tag contains a source, or SRC parameter, which 

contains the name of the image file. 

<HTH L> 
<HEAD> 
<T I TLE > ~ ew Side Band</TITLE> 
<!HEAD> 
<BODY BACKGRO UND - "New_Band. gi f"> 
<I MG S~C-"Mes h Wave .gif"> 
</ BODY> 
<IHHIL> 

The result is shown in Figure 4 . 

5. Add text after the image. 
Unless the browser is instructed ho•v to handle text, it will 

flow the text immediately after the image. 

<HTML> 
<HEAD> 
<TITLE> ~ew Si de Band</TI TLE> 
<! HEAD> 
<BODY BACKGROUtW- "New_Band . gi f"> 
<HIG SRC- "Hesh Wave . gi f" >MM i s cur rent ly in the process 
of recording a wh ol e new batc h of mate r i al wh ich will be 
avai l able i n t he Fall of ' 95 . 
<!BODY> 
<IHTHL> 
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5. 

6. Add a paragraph tag after the image (optional). 
A paragraph tag <P> will flow the text on the line below the 

image and open up paragraph spacing. 

<HTML> 
<HEAD> 
<TITLE >"ew Side Band</TITLE> 
<! HEAD> 
<BODY BAC KGRO UND - "New_Band.gif"> 
<I MG SRC-"Mesh Wave. gif"><P>MM is currently i n the 
process of reco rdi ng_ 
</BODY> 

</ HH1L> 

- Net scope: New Slllo Dnnd 
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Tip: Although the definition list <DL> 
tag is intendedforglossaty text, it can be 

used to indenttexr or images incremenral

ly aCIVSS a page. 

7. Use the ALIGN attribute to move an image. 
The ALIGN attribute, which is part of the <IMG> tag, is the 

simplest way to move an image across the page. Use the 

ALIGN=RIGHT attribute in an < fMG> Lag. 

<HHIL> 

<li EAD> 
<T ITLE>New Si de Band</T ITLE> 

<! HEAD> 
<BODY BACKGROUND _ .. New_Ba nd . gif ,.> 
CIMG SRC-,. Mesh Wave.gif,.ALIGN-RIGHT> 

<!BODY> 
C/ HTML> 

13 Netsccpc: New Side Band 
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7. 

8. Use the <DL> tag to move an image or text. 

Because the <DL> tag formats an indented list, nesting 

several <DL> Lags works to fu11her indent pictures, text, or 

both across the page. 

a. Nest two < DL> tags with text and the ALIGN=LEFT 

attribute in the <IMG> tag. (Nore: The <DL> rag 

works to move m1 image.) 

<HHIL> 

<HEAD> 
<T ITLE>New Side Band </T TTLE> 
<!HEAD> 
<BODY BACKGROUIW _ .. New_Band . gi f .. > 

<OL><DL><IMG SRC-"Me sh Wave.gif ,.A LIGN-LE FT><!DL><IDL> 

MM is currently in the pr ocess of recording a whole 
new batch of material which wi l l be available i n the 

Fa ll of ' 95. 

</BODY> 

<IHHIL> 
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b. Nest f(mr <DL> tags with text and the ALIGN=LEFT 

attribute in the IMG tag. 

<HH1 L> 
<UEAD> 
<TITLE>New Side Band</T ITLE> 
<!HEAD> 
<BODY BACKGROUND - "llew_Band .gi f "> 
<DL><DL><DL><DL>< Ir1G SRC-"Hesh 
Wave.gif"ALIGN-LEFT><IDL><IDL><IDL></DL> MH is cur· 
rently in the process of recording a whole 
new batch of materia l_ 
<!BODY> 
<I HTML> 

c:r-- NotscorJe: Now Side Oond li!J 
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Bb. 

9. Add space around an image with HSPACE. 
The HSPACE auribute added to the Image tag wi ll push the 

text away from the image but i t will add space on both sides 

of the image at once. 

Using the HSPACE attribute may be a problem if you're uy

ing to l ine up the left edge of the image with text further down 

the page. rr this is the case, tex t offset may be created with 

extra Canvas in Photoshop which you can then make trans

parent wiU1 Transparency or DeBabelizer. 



Tip: HSPACE adds space on both sides of 

an image, and VSPACE adds space above 

and below. 
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9. 

Nest four <DL> tags (with text) and add I-IS PACE. 
<HTHL> 

<HEAD> 

<TITLE>New Side Band<ITITLE> 

<!HEAD> 

<BODY BACKGROUND - " New_Band . gi f " > 

<DL><OL><DL><DL> 

<IMG SRC- "Mesh Wave.gi f"ALIGN-LEFT HSPACE-20 > 

<IDL></DL></DL><IDL>MM is currently_ 

</BODY> 

<I HHIL> 

<:' 

~ 

~ 

1<1 

10. Use <BLOCKQUOTE> to move page elements. 
The <BLOCKQUOTE> tag will indent an image or text the 

same amount as two nested <DL> tags. 

Use the <BLOCKQUOTE> tag. 
<HTI1L> 

<HEAD> 

<TITLE>New Side Band</TITLE> 

</HEAD> 

<BODY BACKGROUND - " New_Band . gif" > 

<BLOCKOUOTE> 

<fi.IG SRC- "1·\esh Wave.gif''ALIGN- LEFT> 

MH is currently in the process of r ecording a whole new batch 

of material which will be available in the Fall of ' 95. 

<IBLOCKOUOTE> 

<!BODY> 

<IHHIL> 

/'ooc stope: New c rm 
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Tip: The <CENTER> ... <ICENTER> 

tag can be used to move page elements 
horizomal/y. See the lmage Map chap

terfor an example of how to use this tag. 
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11. Use <BLOCKQUOTE> to move a column. 
Depending on where you place the lag, the <BLOCK

QUOTE> tag will indent an image and several paragraphs. 

Use the <BLOCKQUOTE> tag. 

<HTML> 
<HEAD> 
<TITL E> New Side Band</T ITLE> 
<!HEAD> 
<BODY BACKGROUtW - "New_Band. gi f"> 
<BLOCKO UOTE> 
<IMG SRC-"Mes h Wave.gif "><P> 
<FONT SIZE-+2>Clubs , New Yo rk</ FONT><P> 
<B>C helsea<IB>< P> 
Tra mps< BR> 
51 West 21st Street<BR> 
727 . 7788<BR><P> 
<B>East Village<IB><P> 
Brownles<BR> 
169 Avenue A<BR> 
420.8392<BR> 
CBGBs<BR> 
315 Bowery<BR> 
9B2.4052<P><IBLOCKOUOTE> 
</BODY > 
<IHTML> 

2. Use the <BR> tag to add line breaks. 
In the example in Step II , notice how the <BR> tag adds a 

line break. 



UsingHTML 
to move page 
elements 
vertically 

Summary: HTlvJL tags that 111ove page 

elements vertically are ve1y jew in num

ber: (Note: For new developments in 

style sheets designed for the Web, see 

the Style Sheets And New HTML Text 

Tags chapte1:) 

t:J Netscope: New Side onnd 
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I ntegratjng inline pictures and text is challengi ng. For 

example, align does not refer to text alignmenL, as in word 

processing. Here, align refers to the position of an image. 

1. ALIGN=BOnOM. 
In th is example, AUGN=BOTTOM lines the text up with 

the bottom of the image. 

Use theALIGN=BOTTOM attribute in an < IMG> tag. 

(Note: The <FONT SIZ£=+2> Lag has been used ro make 

the words Clubs, New York slightly larger Llwn the body 

type. The value can be a numberjro111 1 through 7. The num

ber 3 is considered the base font, or the default size). 

<HH1L> 

<HEAD> 

<T !TLE> New Side Band</T!T LE> 

<! HEAD > 

<BODY BACKGROUtW - "New_Band. g i f " ) 

<BLOCKOUOTE> 

< lt-1G SRC- " Hesh Wave . gif " AL!Gti- BOTTOM> 

<FOtiT SIZE-+2>Clubs. tle1v York</FONT><P> 

<B>Chelsea<IB><P> 

Tramps <BR> 

51 West 21st Street <BR> 

727.7788 <P> 
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2. 

<B>East Vi llage<IB><P> 
Browni es<BR> 
169 Avenue A<BR> 
420. B392<P> 
CBGBs<BR> 
315 Bowery<BR> 
982.4052<P><I BLOCKQUOTE> 

UC!ubs, New York 

c 
CheiHa 

'l'rlmjJI 
51 Wtlll!JIS~e• 
727 7?66 

But VIlle&• 

Bm.,., 
lo9 Ave~ut A 
420.11392 

CBOBI 
315llo..,ry 

2. AUGN=TOP. 
In this example, ALIGN= TOP really doesn' t line up the 

image with the top of the text. 

Use the ALIGN=TOP attribute in an <ilvlG> tag. 

<ltn1 L> 
<HEAD> 
<TITLE >New Side Band</T ITLE> 
<! HEAD> 
<BODY BACKGROUND - "New_Ba nd. gi f" > 
<BR> 
<BLOCKQUOTE> 
<IMG SRC- "Mesh Wave. gi f" AL IGN-TOP> 
<FONT S I ZE-+2>C1 ubs. New Yor k</ FOIH><P> 
<B>Chelsea<IB><P> 
Tramps<BR> 
51 West 21st Street<BR> 
727. 778B<P> 

II 
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Handbook 

Clubs, New York 

Cbebea 

4. 

<B>East Vil l age<IB><P> 

Bro~m i es<BR> 

169 Avenue A<BR> 

420.8392<P> 

CBGBs<BR> 

315 Bowery<BR> 

982.4052<P></BLOCKQUOTE> 

3 . The <BR> and <P> tags. 
ln the previous example, the break line tag, or <BR> , breaks 

the line but does not add extra line spacing. 

The pmagraph tag, or <P>, also breaks the line but adds para

graph or line spacing. 

4. The VSPACE attribute. 
The YSPACE allribute wi ll immediate ly push the text fur

ther from the image but will add space on both sides of the 

image at once. 

<HTML> 

<HEAO> 

<T ITLE>New Side Band</TITLE> 

<!HEAD> 

<BODY BACKGROUND - " New_Ba nd . gi f " > 

<BR> 

<BLOCKQUOTE> 

<HIG SRC- " Mes h Wave . gif" ALIGN- BOTTOM VSPACE-25> 
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Tip: For information and instructions 

on how lo uploadjile.\· to your lntem et 

provider's serve 1; see the Image Map 

chapte1: 

176. , Chapter 6 

5. HTML tags used in the two previous sections. 
The tags you see in this list (in alphabetical order) reflect the 

HTML 3.2 specification. 

<B> .. . <IB> 

A tag used to apply boldfaci ng to text. 

<BLOCKQUOTE> ... <IBLOCKQUOTE> 

A tag used to create a paragraph indent on one or more 

paragraphs. 

<BODY> ... <IBODY> 

A tag used to open and close the body of a document. This 

Lag can be used to refer to a background image in the form: 

<BOOY BACKGROUNO- New_Band.gif"> 

<BR> 

A tag used to insert a line break. 

<DL> ... <IDL> 

The defin ition list tag is usua lly used for definitions or 
short paragraphs with no bullets or numbering. In this 

section, this tag is nested several times to indent the Mesh 
Records logo. For example: 

<DL>< DL><DL><DL>< DL><DL><DL>< I MG SRC- "t1esh 
Wave . gif"><IDL> 
</DL><IDL></DL><IDL><IDL></D L> 

<FONT SIZE=VALUE> ... <IFONT> 

A tag used to change the default font size. The value can 

be any number fTom I through 7 or it can be represented 
+-any value from I through 7. The value 3 is considered the 

basefont, or t11e default font size. 

<HTML> .. . <IHT!VIL> 

A tag used to open and close an HTML document. 

<HEAD> ... <!HEAD> 

A tag used to open and close the header portion of a 
document. 



Tip: The SimpleText text pmcessor sup

plied with System 7.5x is more jlexible 

than the older Teach Text supplied with 

previous versions oft he Syste111. 

For example, Simple Text allows you to 

have multiple documen/s open. at one 

time. 

<IMG> 
Used to refer to an inline image, this tag uses the SRC 

attribute, which represents the the URL (locatio n) of the 

image. For example: 

< IMG SRC- "Mesh Wave . gif"> 

This tag uses the AUGN attribute (or parameter) to indi

cate the placement of an inline image. Options include 

TOP, BOTTOM, LEFT, and RIGHT. For example: 

<IMG SRC- "Mesh Wave . gi f " ALI GN- LEFT> 

This Lag a lso uses the HSPACE attribute, which adds 

space on both sides of an image. For example: 

<IMG SRC- "Mesh Wave . gi f" ALIGN-LE FT HSPACE-20> 

<P> 

A tag used to indicate a new p<u<tgraph. This tag does not 

require an ending tag. 

<TITLE> ... <!TITLE> 
A tag used to describes the title of a document, which 

shows up inside a document's title bar. 
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Creating a 
banner graphic or 
splash screen 

Summary: Learn how to create a ban

ller graphic or splash screen- the first 

image Web visitors will see when they 

visit your Web page. 

Tip: Wlten you capture a screen image 

with Conunand+Sh(ft+3, the SimpleText 

file can be opened as a PICT image in 

Photos hop. The file size of this image will 

be small if the monitor is ser ro 256 colors 

and large if the monitor is set to millions 

of colors. 

178.1 Chapter 6 

:JJ :=-. Ne1scope: Color :W 
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With the preparation of a banne r graphic, Mark Elbe rt 

demonstrates how to size , scan, edit, and adjust the 

palette of a banner image. (Note: See Convert a Pantone 

RGB value to a Web page color with the BBS Color Edi tor 

in the Online Tools chapterfor steps 011 how to assign color 

to the browser background and text.) 

1. Plan the size of your banner. 
To calculate the maximum width available for a banner 

g raphic, Mark opened Netscape on a 14-inch monitor, 

resized the browser window to the width of the monitor, 

and captured the contents of the screen wi th Command+ 

Shift+3 . This command created a TeachText fi le, which 

could then be opened as a PICT document in Photoshop. 

In Photoshop, Mark selected WindowiPaleuesiShow Info and 

dragged a rectangular marquee to select the inside browser 

area. The Show Info palette gave Mark a width measurement 

of 620 pi xels and a he ight measurement of 320 pixels. Using 

the same technique, he also measured the offset dis tance 

between the edge of the browser window and the art on 

screens he captured as Teach Text images. Mark discovered 

this off set is 8 pixels. These c lues he lped him determine the 

maximum width available for artwork. 

Rather than fill the entire screen, Mark chose 504 pixels for 

the width o f hi s banner, I 00 pixels less than the maximum 

measurement. The he ight he chose was 144 p ixels . 



Tip: Browser software reads one palelte 

~{256 colors per page. lfyou 'rebuilding 

a page with more !han one image, consid

er creating a Super Palellc, or a palelle 

thai consists of/he best 256 colorsfor a 

group of images. 

lfyouneed ro transfer the image with !his 

pale11e infonn(lfion via modem, always 

tran\fer i1 as binmy infomrmion so this 

information is not los/. ( No1e: For infor

mal ion on/row 10 crea/e a Super Pale11e, 

see Creating a Super Palette wi th 

DeBabelizer in this chapter). 

I mote Size 

1 cunout Size: 2 13K-------, 

IUid th: ·12 pita\ 

!Ieight: 12 pltM 
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1
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2. Scan your artwork. 
Using a 24-bit flatbed scanner, Mark scanned more infor

mation than he needed (higher resolutio n) but to the exact 

dimensions. After opening the image in Photoshop, he 

resampled the image to 72 pixels per inch and used the 

Unsharp Mask Iiller to correct the slig ht fuzziness that 

results when Photoshop inte rpolates p ixel information. To 

duplicate Mark's methods, follow these steps: 

a. Select Image Size from the Image 

pull-down menu. 

b. Type 72 in the pi xels per inch 

fie ld. 

c. Click on OK. 

d. Select FiltcriSharpeniU nsharp 

Mask. 

e. With Preview selected, 

Photoshop will d isplay what the 

filter wi ll do to your image. Choose 

Unshorp Mosie 

CE:J 
~ 
~ Preulew 

(!)11(!) 

nrnounl:~ '1. 

nndlus: 0 ph1o1s 

Threshold: D lcuelt 
~ 

2e. 

25%, a Radius value o f 1.0 pixels, and a Threshold 

value oro. 

Click on OK; the result is shown below. 

3. Correct the color. 
After color scanni ng, Mark checked to sec how the brightness 

:mel darkness tones were distributed. By mapping the lightest 

and darkest parts of the image to a white target and a black 

target, Mark corrected the color, which made a significant 

visible difference in the image. 

a. SelectAdjustiLcvels from the Image pu ll-down menu . 
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b. Set a white target by double clicking on the white eye 

dropper and typing 5, 3, 3 in the C, M, Y boxes. 

(Note: Use 7, 3, 3for irnages that have more dark 

values than light. ) Then click on OK. 

c. Set a black target by double c licking on the black eye 

dropper and typing in 95, 85, 85, and 80 in the C , M, Y, 

K boxes. C lick on OK. 

d. Investigate which area of your image is the lightest. 

3d. 

Remove the "X" from Preview in the Levels d ia log 

box, hold down the Opt.ion key, and slowly drag the 

white triangle on the top slider to the left. The area that 

turns white fi rst is the lightest portion of your image. 

Remember this location. 

e. Investigate which area of your image is the darkest. 

3e. 

Make sure the "X" is removed from Preview, hold 

down the Option key, and slowly drag the black u·ian

gle on the top slider to the right. The area that turns 

black first is the darkest area. 

r oslle lnfiO, I: II 

f. Set the eyedropper tool at a 3-pixel sample. Double

click the eyedropper, and select 3 by 3 Average from 

the pop-up menu. 
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g. Map the white target on the area that appeared as the 

lightest portion o f your image by selecting the white eye 

dropper and cl icking on that area . 

h. Map the black target on the area that appeared as the 

darkest portion o f your image by selecting the black eye 

dropper and cl icking on tha t area. 

i. You ' II notice a change in most scanned images immed i

ately. You' ll a lso notice a change in the histogram 

(Figure 3i I). The x-axis reflects colors from darkest 

(left) to brightest (right), and they-ax is reflects the nu m

ber of pixels wiU1 each value. The castle photo that 

resul ts is shown in Figure 3i2. 

312. 

4. Create your type in Adobe Illustrator. 
Type that originates in TIIustrator and gets " rasterized" 

in Photoshop has neater, less jagged edges than type c reated 

in Photoshop. When you open an EPS fil e in Photoshop, 

you' II need to enter a desired resolution. Rasterized type will 

s till look jagged unless this resolution 

is sufficiently high. For best results, open your EPS fi le at a 

resolution that is three to four times the screen resolution 

(288 ppi or 360 ppi). 

Rather than place Illustrator type, open the type as an EPS 

image into another file, copy it, and paste it into your banner 

artwork. (Note: If the resolution of the source artwork [type 1 
and destination file I banner artwork] are not the same, the 

type will change si:e.) 

Either work at high resolution for both your image and your 

type, or rasteri ze a type size that is in proportion to the 

changes that you wi ll know will occur \.vhen you paste the 

type into the image. If your banner artwork is already created, 

the size type you crea te in illustrator will be a function of the 

Photography 1181. 



Tip: In this example, Mark reduced pixel 

depth after he created type for his ban11e1: 

If you use black type or some other solid 

color, add the type to your image after you 

reduce the pixel depth of your graphic. 

(Note: See Steps 9 and 10 for instm ctions 

0 11 how to reduce pixel depth.) 

All\le.r1ze Adobe lllu\lfalor ronna t 

-Image Size: 2lK --------, 

Sa. 

Sb. 

Width:~ I plcos ... 1 

ll elghl: ~I ptcu • I 
Ac\o lullon: ~I phtl!lt./ lnth ..-) 

Mode: I GrtUJ\tnlc .... ) 

Window 
XR 

None X D 

Sc. 

Sd. 
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resolution you choose for rasterizing the type. In the following 

example, I 0 point (Illustrator) type is opened as an EPS image 

in Photoshop at 360 ppi, or 5 times the resolution of the banner 

artwork fi le where it wi ll be pasted . When the type gets pasted 

into the banner artwork, it will be five times as large. 

Desired Size To Create 

Type Size E PS M ultiplication in Illustrator 

(Finished Resolution} (or Division) (To P~e into a 

Graphic) Photoshop Factor 72 ppi Banner) 

32 288 ppi 4 8 pt 

40 288 ppi 4 I Opt 
---- --
48 288 ppi 4 12pt 

40 360 ppi 5 8 pt 

60 360 ppi 5 12 pt 

70 360 ppi 5 14 pt 

a. Mark's banner artwork was a 72 ppi image. He 

created I 0 point type in Illustrator in order to open it into 

Photoshop (or rasterize) at five Limes the the resolution of 

his banner artwork. He did this to demonstrate how the 

type size would change if the type's resolution was differ

ent than the artwork's resolution. 

b. After creating his type in nlust:rator, Mark Elbert saved 

the type as an Illustrator fi le. 

5. Rasterize the EPS type, then copy and paste it. 
a. In Photoshop, Mark opened the Lllustrator document and 

typed in 360 ppi as a resolution in the EPS rasterize 

dialog box. 

b. To select the type for copying, Mark selected the white 

background with the Magic Wand tool. 

c. He then selected Inverse from the Select pull-down menu. 

d. Mark copied the type and pasted it into his banner 

artwork. 



Tip: When you place type from an EPS file 

on a Photoshop page, it gets rasterized at 

the same resolution as your Photoshop 

image. If you're working on a 72 ppifile 

and you don 't want "jaggies," rasterize 

the lllustratorfile by opening the entire 

Illustrator document into Photoshop and 

typing in a resollllion that is three to four 

times the screen resolution. Copy and 

paste your type into your Photoslwp art

work, but plan ahead on a change in size 

(see chart 0 11 the previous page) ({the res

olutions are differellt. 

Newcastle 
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6. Create a channel. 
Mark wanted a channe l to have a record of the type 's selec

tion, because he planned to paste an image into the type 

selection and the n add a stroke to outline the type. Before cre

ating a channel, the opacity needed to be set to ze ro so the 

type's black pixels would not become part of the background. 

a. With the type s till selected , Mark selected PaletleslShow 

Layers from the Window pull -down menu. 

b. Whe n the pale tte appeared, he 

dragged the opacity sl ider to zero 

before c reating a channe l. 

c. Mark clicked on the channels tab and 

selected New Channel from the 

options pull-down me nu. 

d. He labeled this channe l type. 

" L• •n'\.O.WWll 
j Po)f'rflll • I Opa.cl l 

Qf'r•r~u Tr~d~tr. ~ 
11'1 ~,.1('oilfln2_1l'fl'flfon e 'iiii=:::J Bllrl(qrnund 

In I" 

8b. 

e. To return to the RGB layer, he clicked on the 

RGB channel. 

Channel Options 

Name: Llt~y_p_e ____________________ ~ 

Color Indica tes:--------------, 

@ Masked Areas 
0 Selected Areas 

8d. 

IP I ·-''':r:·::::r .., __ r.;:-, 

' Iii I 
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7. Copy an image and paste it into the type. 
a. Leaving the banner art open, Mark opened another 

image of film
strip art and 

copied the 

entire image to 

the clipboard . 

7a. 

b. Mark returned to the banner artwork, then loaded the 

selection of the type from the channel he had created by 

selecting Load Selection from the Select pull-down 

menu. 

c. He chose Type from the pop-up menu that followed, and 

clicked on OK. 

d. Next, he chose Paste Into from the Edit pull-down menu. 

e. Mark positioned the filmstrip art inside the type by drag

ging the selection with the mouse.The filmstrip art 

moved inside the type each time he dragged the mouse. 

To drop the selection, he selected None from 
the Select pul l-down menu (Command+D). 

8. Add an outline to the type. 
a. Mark reloaded the type selection by choosing Load 

Selection from the Select pull-down menu. 

b. He chose Type from the pop-up menu that followed. 

c. He selected Stroke from the Edit pull-down menu. 
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d. With black selected as a roreground color. he selected a 

width of I pixel, to be centered on the type selection at 

I 00% Opacity and Normal Mode. 

e. Mark found the combination or Stroke settings through 

trial and error. By selecting Undo from the Edit pull

down menu, he was able to u·y alternate paint colors in 

the outline and vary the location. 

9. Reduce pixel depth (using Photoshop). 
When Mark fi nished editing the image in RGB Mode, he 

ex perimented with Photoshop's Indexed Color Mode to 

see how far he could reduce the pixel depth without altering 

the color. (Note: See the next section for instructions on 

ho iV to reduce the bit depth in DeBabelizu ) 

a. Select Indexed Color from the Mode pull-down menu. 

b. Experiment by selecting smaller bit depths with and 

without dithering to sec how the color in your image 

holds up. Each time you try a selection, select EditlUndo 

or press Command+Z if you do not like the color. 

Mark was able to reduce the image to a 6-bit color depth 

(Figure 9b) wilhout a noticeable change in the color. 

This made a significant change in the fi le size. 

Bit Depth 

24 bil 

8 bit 

6 bi t 

6 bil 

File Size 

203 K 

7 1 K 

44K 

33K (DcBabelizer) 
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Tip: See the Online Tools chapterfor 

more information about how to download 
Macintosh shareware programs. 

Tip: The cost of this book doesn't include 

the use of the shareware programs on the 

CD-ROM. If you continue to use the soft
ware programs provided, please register 
those that you use. 
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10. Reduce pixel depth (using DeBabelizer). 
a. Open your RGB image in DeBabelizer. 

b. Select Change Pixel Depth from the Palette pul l-down 
menu. Equilibrium Technologies recommends that you 

always select dithering when you reduce the number of 

colors. Although you can change the amount of dither

ing by selecting OptionsiDithering Options & 

Background Color from the Palette pull-down menu, 

DeBabelizer's default setting is the amount Equilibrium 
has determined to be the best amount. 

c. Start by reducing your image to 128 colors and look at 

the image. If you don' t like the change, select Undo 

from d1e Edit pull-down menu or press Command+Z. 

Keep stepping down to fewer colors to determine when 

Lhe color change becomes visible. Mark was able to 

reduce the palelle to 64 colors without a noticeable 
change in the image. 

11. Save the image. 
a. Select Save As from the File pull-down menu (in 

Photoshop or DcBabclizcr). 

b. Select CompuServe GIF or JPEG from the pop-up menu. 

(Note: Photoshop 3.0 does not add interlacing to GIF 

images. Interlacing gives the Web visitor the impression 
of a faster download by quickly painting the image in 

low resolution and gradually filling ir in.) 

To add interlacing to a Photoshop GIF image, you' ll 

need GTFConverter by Kevin Mitchell. DeBabelizer 

has an option to save a ri le as an Interlaced GTF. (Note: 

GIFConverter is available on the CD-ROM in the back 
of th is book). 

c. Give your image a name. Try to keep your file name to a 
minimum of eight characters (no spaces) wi th a file 

extension such as .GlF, .JPG or .JPEG. (Note: File exten

sions must be limited to three characters on the Windows 

J.X pla({orm.) Removing vowels from the fi le name 

helps to reduce the number of characters. Mark used 
DeBabelizer and chose Interlaced GIF as the lilc format 
for saving. 



12. Create an HTML file to test your image. 

a. Open SimpleText. Use SimpleText or yow· word 

processor. If you use a word processor, be sure to save 

the document as Text Only. 

b. Create a new HTML document. Start a new document 

with the following markup tags: 

<HTML> 

<HEAD> 
<TIT LE >Newcastle Productions</TITLE> 

<!H EAD> 
<BODY> 

c. Add the image tag. Reference your G!F (or JPEG) 

image wi th the addit ion of an <lMG> tag. 

<HTML> 
<HEAD> 
<TI TLE>Newcastle Productions</TITLE> 

<! HEAD> 
<BODY> 
<lNG SRC - "tlewcst l e .gif" > 

d. Close with an ending <!BODY> and <IHTML> tag 

and save the file. Save the document. If you're using a 

word processor, save the text as ASCII or Text Only. 

Give the lile a name, and add an .HTML extension 

(.HTM if the Web server you're using is a DOS 

machine). 

e. Test the HTML document in Netscape. Open 

Nctscape, and then open your document by selecting 

Open File from the File pull-down menu. Make sure 

your GIF image and your HTML document are in the 

same directory. 

To test a number of altemate images, create several 

HTML files and save them under different file names or 

open SimpleText and Netscape at the same time and 

vary between the two applications. Each time you edit 

your HTML document, save it, and click on Reload in 

Netscape's Tool bar to retesL 
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Linking a 
thumbnail GIF to 
an external JPEG 

Summary: By creating a small GIF 

thumbnail 0 11 your Web page, your 

image can be viewed with most 

bmwsers. The thumbnail loads quickly. 

and a large1; JPEG image download 

can be optional (a .!PEG vie wer helper 

application will be required with 

bmwsers other than Netscape). 

1. 
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By reducing an image to a thumbnai l-si ze GIF and 

making the thumbnail a link to a larger, JPEG version 

of the same image, Mark Elbert created a Web page that 

can be v iewed by most browsers. At the same time. he also 

provided an optional image format for a detai led photo. 

1. Save an original image in Photoshop. 
a. When you have finished editing your image in RGB 

Mode, select Indexed Color from the M ode pull -down 

menu. Select Adaptive Palette and D i ffusion D ither. 

Try selecting smaller bit depths unril you notice an 

unsatisfactory change in the image. (Select Undo from 

the Edit pull -down menu if you're unhappy with a 

selecti on.) 

b. Select Save As from the Fi le pull -down menu. 

c. Choose JPEG from the Format pop-up box. 

d. Choose an image quality. 

e . Name the fi le using eight characters and no spaces. 

Add .JPG as a file extension at the end of the name. 

2. Reduce your photo to thumbnail size. 
a. Open your original RGB image (without the .JPEG 

extension) in Photoshop. 

b. Select I mage Size from the i mage pull -down menu. 

c. Type in a small number for the width value (such as 2 

inches). and Photoshop will proportionally size the 

height for you. (Note: Record what the height and width 

values are in pixels as you will need this infonnation.for 

your <IMG > tag.) Click on OK. 



Tip: For injor111ation and i11structions 

on holV to upload files to your Internet 

provider's servet; see the Image Map 

chapte1: 

d. Select Fi lte riSharpeniUnSharp Mask to correct the 

fuzziness that resul ts when you resize an image. Use 

25%, 1.0 Radius value, and a Threshold of 0. 

3. Save the thumbnail. 
a . Select Save As from the File pull-down menu . 

b. Choose CompuServe GIF from the Format pop-up box. 

c. Name the file using eight characters and no spaces. Add 

.GIF as a file extension at the end of the name. 

4. Create an HTML document. 
a. Open SimpleText. Use SimpleText or your word 

processor. If you use a word p rocessor, be sure to save 

the document as Text Only. 

b. Create a new HTML document. Stan a new document 

with the fo llowing markup tags: 

<HHIL> 

<HEAD> 

<TITLE> To ronto</TIT LE> 

<BODY> 

c. Add an Image tag. In this example, the thumbnail GfF 

image as well as the text, Toronto, 1995, will be a li nk to 

the external JPEG image li sted inside the anchor tag <A 

HREF><IA>: 

<HTML> 

<HEAD > 

<TI TLE>Toronto</TITLE> 

<I HEAD> 

<BODY> 

<A HREF- "toronto.jpg">< It1G SRC-"Tor_sm.gif"> 
Toronto . 1995</ A> 

</BODY> 

<IHHIL> 
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d. Add image sizing to your image tag (optional). rmage 

sizing is a Netscape feature that adds speed to the down

loading of images. When Netscape encounters an in line 

image, it bui lds a bounding box to display the image. 

With the height and width information in the <IMG> 

tag, the bounding box can be built without delay. 

The height and width in pixels can be obtained from the 

lmage Size dialog box in Photoshop. In this example, 

the width is 144 pixels, and the height is 123 pixels: 

<A HREF- "toron to .jpg">< IMG SRC-"Tor_sm.gif" 
WI DHI- 144 HEIGHT- 123> Toronto, 1995<1 A> 

e. Control the width of the image border (optional). 

When you make an image an anchor, or a link, the 

browser wi ll display a colored border to act as a clue for 

visitors. For menu buuons that are obvious links, the 

border can be turned off by adding BORDER=O to your 

<IMG> tag. Tn this example, this would be wriuen: 

<A HREF- "toronto.j pg">< IMG SRC- "Tor_sm. gi f" 
WI DTH- 144 ll EIGHT-123 BORDER- 0> Toronto , 1995</ A> 

(Note: For the formatting of this book, the lines are 

broken.) 

f . Save the file. Save the document in SimpleText, 

Teach Text, or your word processor. If you ' re using a 

word processor, save the text as AS C IT or Tex t Only. 

Give the file a name and add an .HTML extension 

(.HTM if the Web server you're using is a DOS 

machine). 

g. Test the HTML document in Netscape. Open 

Netscape, and then open your document by selecting 

Open File from the File pull-down menu. Make sure 

your GlF image, your JPEG image, and your HTML 

document are in the same directory. 

h. Test the HTML document in other browsers. In 

browsers other than Netscape, a JPEG viewer will be 

launched when you click on either the thumbnai l or the 

text link. The JPEG image 'vvi ll be displayed in a sepa

rme floating window. 



5. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) reflect the 

HTML 3.2 specification. 

<A> .• . <IA> 

Referred to as an anchor, this tag uses the HREF attribute 

to link to an external fi le or anchor. For example: 

<A HREF-"Toronto.jpg">Toronto. 1985<1A> 

(Note: The file name must include the path name if the fi le 

is located in another direct my.) 

<BODY> .. . <IBODY> 
A tag used to open and close the body of a document. 

<HTML> .. . <IHTML> 
A tag used to open and close an HTML document. 

<HEAD> . .. <!HEAD> 
A tag used to open and close the header portion of a 

document. 

<IMG> 
Used to refer to an inline image, this tag uses the SRC 

attribute that represents the the URL (location) of the 

image. For example: 

<I MG SRC-"To r_sm. gi f "> 

In this section, image sizing was added to the image tag 

wi th the WIDTH and HEIGHT attributes. For example: 

<IMG SRC- "Tor_sm.g if" WIDTH-144 HEIGHT-12> 

To tum off the image border, the BORDER=O atttibute 

can be used in the image tag. For example: 

<IMG SRC-"Tor_sm.gif" WI DTH-144 HEIGHT-123 

BORDER-0> 

<TITLE> ... <ITITLE> 

A tag used to describe the tit le o f a document that shows 

up inside a document's title bar. 
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Wrapping text 
around a photo 

Summary: Prepare a Photoshop image 

with extra background to simulate a 

text offset for a text "ru/laro1111d." Use 

a11. <IMG> tag in an HTMLdocume11t 

with a11 ALIGN allribute to get the text 

to wrap. 
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Although space can be c reated around an image with the 

HSPACE attribute, which is used in the <TMG> tag, 

Mark didn ' t want the browser to add horizontal spacing on 

both sides of the image he planned for his Web page. 

Mark created additional background and filled it with a gray 

that matches most browser backg rounds. He then used soft

ware that assigned the background a transparent value. 

1. Create a text offset. 
Text offset is the distance between an image and the text. Add 

a background equal to your desired offse t distance with the 

ImageiCanvas S ize command in Photoshop. This "extra" 

edge around the photo can be assigned a transparent value 

using Tra11sparency, by Aaron Giles (available on the CD

ROM in the back of this book), or DeBabelizer, a sophisti

cated color pale lle manipulation and file convers ion tool 

li·om Equilibrium Techno logies. 

a. Working in RGB Mode, select Canvas Size from the 

Image pull-down menu . 

b. In the Canvas size d ia log box , c lick on the box-map to 

indicate where your image should go when you add can

vas. Add backg round by increasing the values in the 

width or height box. 



2b1. 

2b2. 

Palette 

:: I 

Open Channels ... 
Rc uirP 

3a. 

Tip: See the Page Layout Tools chapter 

for instructions on using PhotoG/ F, a 

Photoshop plug-inthatll'ill make CIF 

flies transparent. 

c. Before you save, select Indexed Color from the Mode 

pull-down menu. Experiment to see how much you can 

reduce the bit depth without altering the image. Ahvays 

select Adaptive Palette, and Diffusion Dither. 

When you're satisfied with the dimen ions of the back

ground, choose Save As from the File menu, and select 

CompuServe GIF from the Format pop-up box. 

d. Be fore you open your fi le in a program that can write a 

transparent GIF file . co lor the background a shade that 

is not in the photo. 

Mark chose a blue-gray (Note: Pick a shade that has 

a color and tonal value close to the background because 

both Transparency and DeBabelizer leave a tiny trail of 

pixels around the edge of the image.) 

2. Make the background transparent 
(Using Transparency). 

a . Use the Fi lelOpen GIF 

command in the Transparency 

software to open the GIF fi le . 

b. Press and hold the mouse 

pointer on the background 

shade. When you let go of the 

mouse, the background wi ll 

change to a gray color. This 

shade is now transparent. 

c. Choose Save As from the File 

menu, and select GIF89. 

2a. 

IDillll 
Open GIF . .• 
Close 

i :twrtl:l: • 

Quit 

2c. 

'i€11 

~0 

~w 

·t 
~Q 

3. Make the background transparent (using DeBabelizer). 

a. Use the FileiOpen command in DeBabilizer software to 

open the GrF file . 

b. Select OptionslDithering & Background Color from the 

Palette pull-down menu. 

3b. 
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c. Click the RGB radio button at the bottom of the screen. 

d. Use the Eyedropper tool to select the background shade 
you'd like to be transparent. 

e. Choose Save As from the File pulJ-down menu. 

f. Select GIFI(nterlaced & Transparency from the pop-up box. 

Non- interlaced 
Interlaced 
Non- Int erlaced 0' Transparency 

' I 'I le • 

3f. 

Dr. llalo CUT 
IMG 
JPEG, JFIF 

g. DeBabelizer wi lJ give your file name a .GIF extension. 

Save the lile. 

4. Use SimpleText to create an HTML file. 
SimpleText from Apple Computer is a useful tool for creat
ing HTML files. fl's smalJ (77 K), it's distributed with 

System 7.5, and it saves HTML text Ii les in the ASCII form 
that's required by browser programs. Microsoft Word users 
can save a text lile as Text Only or as ASCII. 

a. Open SimpleText. Use SimpleText or a your word 
processor. If you use a word processor, be sure to save 

the document as Text Only. 

b. Ct·cate a new HTML document. Start a new document 

with the fo lJowing markup tags: 

<IHNL> 

<HEAD> 

<T ITL E>Wra ppi ng Text<IT ITLE> 

</HEAD> 

<BODY > 



Tip: An AOL account is now ve1y simi

lar to an Internet PPP account with an 

/ntem et provide1: Any Internet client 

software may be mn over an America 

Online connection. Launch your AOL 

sojiware, and then launch an lntem et 

client. (Note: Windows users should 

minimize their AOL software before 

launching Internet client software.) 

c. Add an image tag. 

<HTML> 

<HEAD> 

<TITLE>Wra pping Text</TITLE> 

</HEAD> 

<BOOY> 

<IMG SRC - "MarkT.gif"> 

d. Add an ALIGN attribute to your <IMG> tag. 

The ALIGN attribute in an <JMG> Lag controls the way 

the image aligns with text. Tn this next example, 

ALIGN=LEFf moves the image to the left edge of the 

page and the text wraps around on the rig ht. 

<IMG SRC - "MarkT . gif" ALIGN- LEFT> 

e. Add headlines and HTML headline tags. The HTML 

tugs for headlines range from <H 1> ... <IH L> through 

<1-16> ... <IH6>. < I-I I> is the largest headline size avai l

able , and <H6> is the smallest. The actual size of this 

type wi ll be relative to whatever the Web visitor has set 

as a default font size in his or her browser. For example, 

if a Web visitor has never altered the font size in 

Netscape 's Preferences dialog box, the default size for 

body text wi ll be 12 poi.nts. 

Al l of the headline or tit le sizes will be re lative to 

this basefont size. l n this example, Mark Elbert and 

Bassist have been tagged with headline tags <H2> 

and <H 3>. 

<HTM L> 

<HEAO> 

<TITLE> Wr apping Text</TITLE > 

<!HEAD> 

<BOOY> 

<IMG SRC- "MarkT.gi f" ALIGN-LEFT> 

<H 2>Mark El ber t >< IH2><P> 

<H3>Bas si s t </ H3 >< P> 
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Mark Elbert 

Bassist 

2f1. 

lVIark Elbert 

Bassist 

2f2. 

19&. j Chapter 6 

f. Use the font size tag (optional). Font size can be 

controlled with the <FONT SIZE=value> tag where values 

range from I through 7. l n this system, the base font has a 

va lue of 3. 

This tag can also be written with a preceding+ or - to indicate 

a size that is re lative to the basefont. The enti re headline or 

just the initial capita l can be controlled, depending on the 

placement of the tags. 

Notice the tag is placed inside the headline tag and the end

ing </Font> tag is requ ired. 

<H2>< FOIH SIZE-+3>Mark El bert</ FONT> <I H2><P> 

<H3><FOtH SIZE-+3>Bassi st</FONT></H3><P> 

l n this example, the font size tag is used to make the initia l 

capital larger: 

<H2>< FOIH S I ZE-+3>M</FOIH >a rk 
<FO NT S!ZE-+3>E</FONT>l bert</ H2><P> 

<H3><FONT SIZE-+3>B</FONT>assist</H3><P> 

g. Add comment lines to your document (optional). 

Comment lines are ignored by the browser and will never 

show up on your Web page. They provide a means of docu

menting the details of how the document was constructed. 

Use<! .... --> to create comments. For example: 

<! ··Thi s tex t changes the first week of each mon th . - -> 

(Note: Avoid using special characters such as<, >, &.and 

! in COI11111entlines.) 

h. Add the body text and ending tags. 

<HTM L> 

<HEAD> 

CTI TLE>Wrappi ng TextC/T ITLE> 

<BODY> 

C/ HEAO> 

<IMG SRC- "MarkT.gi f" ALI GN-LEFT> 

CH2>Mark Elber t>C/ 11 2><P> 

<H3>BassistC/H3><P> 

Mark. co -founder of t1other Ma ry. hail s originall y 
from Bowie . Mary land_ 

<!Body> 

< /IITHL> 
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Mark Elbm 

3f. 

i. Test the HTML document in Netscape. Open your doc

ument in Netscape to test the appearance of your Web 

page. 

3. Flip the image, and try an ALIGN attribute. 
Text can wrap differently if you use the ALIGN attribute in 

the dMG> tag. In this example, to get text to wrap on the lefL 

side of the image, Mark used the ALIGN=RfGHT in the 

<lMG> tag. 

a. Open the image in Photoshop. If the image needs to be 

reversed, nip it in Photoshop (or DeBabelizer). 

b. Flip the image. Select Fl ipiHorizonLal from the Image 

pull-down menu. 

c. Resave as a GIF image. Select Save As from the File 

pull-down menu, and g ive the image another name. 

d. Make the background transparent. Use Transparency 

or DeBabelizer to make the image transparent. (Nore: 

Because Pl!otoshop cannot write the rransparent GIF 

information into the document header; this i11jormation is 

lost if you edit and save your docwnem in Phoroshop.) 

e. Add the ALIGN attribute to the HTML file. 

<HTM L> 

<HEAD> 

<T ITLE> Wra pping Tex t</T ITLE> 

<!H EAD> 

<BODY> 

<IMG SRC- "MarkT. gif"AL IGN- RIGHT> 

<H2>Mark El bert ><IH2><P> 

<H3>Bassist</H3><P> 

Mark. co- founder of Mo t he r Mary . ha i l s ori ginal l y f rom 
Bowi e . Ma ryland_ 

<!BODY > 

<IHTML> 

f. Resave the document, and test it in Netscape. Although 

the other ALIGN attributes (RIGHT, TOP, BOTTOM, 

and MIDDLE) are not appropriate for Mark's image, you 

may want to test others with smaller images. 
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Controlling text 
wrap with HTML 

Summary : Use HTML <IMG> tag 

attributes VSPACE and HSPACE as a 

way to control text wrap around an 

image. 

1a. 

198. , Chapter 6 
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I n this example, Mark used attributes HSPACE and 

VS PACE with an <IMG> tag. By assign ing each a value 
in the HTML document, a text offset cou ld be controlled. 

1. An image with no extra background. 

a. Open the image in Photoshop. Crop any extra back

ground off the image Lhal wi ll have a Lextmnaround. 

b. Save as a GIF image. Select Save As from the File 

pull-down menu, and save the image as a CompuServe 

GJF fil e. 

2. Use SimpleText to create an HTML file. 
a. Open Simpletcxt. Use SimpleText or your word 

processor. If you use a word processor, be sure to save 
the document as Text Only. 

b. Create a new HTML document. Start a new document 

wi th the fo llowing markup tags: 

<HTHL> 

<HEAD> 

<T IT LE>Wr app ing Text</TITLE> 

<!HEAD> 

<B ODY > 



Tip: With Netscape and SimpleTe.xt 

both open, tl)l varying the numbers 

assigned to VSPACE and HSPACE, re

save your text file, switch to Netscape, 

and reload the Simple Text file to see the 

results. 

_:j~~ ;;J~J;j];J_ru _j 1i 
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c. Add an image tag. 

<HTM L> 

<HEAD> 

<TITLE>Wrappi ng Text</TITLE> 

<!HEAD> 

<BODY> 

<IMG SRC- "Mesh Wave .gi f"> 

d. Add the alignment tags. 

<HH1L> 

<HEAD> 

<T ITLE>Wrapping Text </T ITLE> 

<! HEAD> 

<BODY > 

<IMG SRC- "Mesh Wave.gif" ALIG~-LEFT VSPACE-5 
HSPACE-10> 

e. Add the body text and ending tags. 

<HTML> 

<HEAD> 

<TITLE>Wra ppi ng Text</TI TLE> 

<! HEAD > 

<BODY > 

<IMG SRC- "Mes h Wave .g if" ALIGN-L EFT VSPACE-5 
HSPACE-10> 

This four -song tape is one of the bes t new hard rock 
offerings I ' ve heard s ince Mother Love Bone' s Apple ... 

<! BODY> 

<I HH1 L> 

f. Test the HTML document in Netscape. Open 

Netscape, and d1en open your documenL by selecting 

Open File from d1e File pull -down menu. Make sure 

your HTML document and your image are in the same 

directory. 
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Tip: For information and instructions 

on how to upload files l'O your Internet 

provider's serve1; see the fmage Map 

clwpte1: 

200. , Chapter 6 

3. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) renect the 

HTML 3.2 specification. 

<BODY> ... <IBODY> 
A tag used to open and close the body of a document. 

<FONT SIZE= VALUE> . .. <!FONT> 
A tag used to change the default font size. Values range 

from I lhrough 7. The tag can also be written with a 

preceding+ or- to indicate a size that is relative to the 

basefont. 

<H2> .. . <1H2> 
<H3> .. . <1H3> 

Tags used to enlarge text, as to indicate a heading. Lower 

numbers indicate larger type. The options range from 

<H I> through <H6>. 

<HTML> .. . <IHTML> 

A tag used to open and close an HTML document. 

<HEAD> . .. <!HEAD> 
A tag used to open and close the header portion of a 

document. 

<IlVIG> 
Used to refer to an in li ne image, this tag uses the SRC 

atu·ibute that represents the URL (location) of the image. 

For example: 

<IHG SRC- ""clear.gif""> 

This tag uses the ALIGN attribute (or parameter) to indi
cate the placement of an in line image. Options include 

TOP, BOTTOM, LEFT, and RIGHT. For example: 

<IHG SRC- ""Mesh Wave .gif"" ALJGN•LEFT> 



Tip: C/arisWorks includes an HTML 

i111port and e.1portjeature that is built 

into !he sojill'are 's XTND functions. The 

software also includes lelllpfales.for cre

ating Web docu111enls. (htlp:!!www.cfaris 

. co111/prod uc/ sic fa ri sic/ a ri spage 2 0/cf a r

ispage20.htlllf) 

The <IMG> tag also uses the HS PACE allribute, which 

adds space on both sides o f an image. For example: 

CIMG SRC- "Mes h Wave.gif" ALIGN-LEFT HS PACE-20> 

<P> 
A Lag used to indicate a new paragraph. This tag does not 

require an ending tag. 

<TITLE> . .. <!TITLE> 

A tag used to describe the title of a document that shows 

up inside a document 's ti tle bar. 
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Fading an image 
into the browser 
background 

Summary: Photoshop 's gradient tool 

and Quick Mask option can be used 

to "fade" an image to the gray that 

matches most browser backgmunds. 

1a. 

go ···:" "' · · ·mm;;;mE'ili!!;;• · .... m!!.,::m'!!!'!!!m'" :mgg ru . 
I Bru~ Gradient Tool Options~ ""-T~ 

.. '.. ... r:~~.~~:.~ ............. :J .... ~~.~~.~~~ .. : ... ~ ............ ~~~ ... . 
Sty lf? : I F orf?ground to Background "" l 
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Midpoint : 50% Radial Offs~?t : 5 0% 

.. ji:jrJI i®liw~ ........... ........ ~ ..... [gj.~;·~·~~·~ 
1a, 1b, 1c, 1d. 

!
:Color I ndicates: 
® Mndted Areas 
0 Seler ted nreos 

~~~Color L Opacity: [gj "J. 

2b. 

2c. 
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Photoshop's s trength is image editing. In th is example, 

Mark Elbert discovered a method to fade an image into 

the browser background. A similar technique can also be 

used to create a " fuzzy" drop shadow. 

1. Adjust Photoshop's gradient tool . 
Open your image in Photoshop, and adjust Photoshop's 

gradielll tool setting. 

a. Double click on the gradient tool (Figure I a), and select 

Radial from the Type pop-up menu. 

b. Drag the Opac ity slider to 50%. 

c. Drag the Radia l Offset slider to 50%. 

d. Drag the fvtidpoint slider to 50%. 

2. Work in Quick Mask Mode. 
a. Double click on the Quick Mask icon 

at the base of the Toolbox. 2a. 

b. Select Color Indicates Masked Areas, 

and type 50 % in the Color, Opacity field. 

c. With the Quick Mask icon still selected, use the crosshair 

pointer provided in this mode. and draw a radius line 

from the center of your image outward and re lease the 

mouse button. 

d. Switch to Selection Mode by c licking 

the icon to the left of the QuickMask 

Mode icon at the base of the Toolbox. 
2d. 



4 . 

3a. 

O R:~ 
Q G :~ 
QB:~ 
3b. 

3. Set the background color. 
a. Double c lick on the background color swatch at the base 

of the Toolbox. 

b. Type 201 into the R, G, and B fie lds. C lick on OK. 

4. Subtract the "unmasked" part of the image. 
When you mask the middle of your image with a radial gra

dient mask, you protect the shaded area from further image 

manipulation in the Selection Mode. 

WitJ1 a background shade equivalent to the gray you find in 

most browser backgrounds, press the Delete key. 

The image will appear to fade in to the gray co lor. By vary

ing the Midpoint setting in the Gradient Tool Options 

paleuc, you can make the mask stronger or weaker in the 

midd le. 

5. Create an HTML file to test your image. 
a. Create an HTML document with a n <IMG> tag. 

<HTNL> 
<HEAD> 
<TITLE>Castle</TITLE> 
</HEAD> 
<BODY> 
<ING SRC - "Castle.gif"> 
<!BO DY > 
</HTML> 

b. Save the file. Save the document in SimpleText, 

TcachText, or your word processor. If you 're using a 

word processor, save the text as ASCII or Text Only. 

Give IJ1e [i lea name and add an .HTML extension. 

c. Test the HTML document in Netscape. Open 

Netscape, and IJ1en open your document by selecting 

Open File from Lhe Fi le pu ll-down menu. Make sure 

your HTML document and your image are in the same 

directory. 
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Create a tiled 
background 

Summary: Using Netscape extensions 

to HTML, an image cmr be tiled in the 

browser windom 

la. 

j fill 

~Content s u OK d 
I · I - "'"' I tUhlt" ~ 

, otcnolng 

Opacity: §J-t 
Mod": I NOiflli11 ·I 

Qf'ri'\Pitl{' llrtO\IhUPilfiJ 

2a, 2b, 2c, 2d, 2o. 

2f. 
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T o create a wallpaper effect, Mark used a small photo 

and ghosted it with a white fill at an opacity level of 

85%. By keepi ng the background very light, rypc can be 

loaded on top and sti ll be readable. Using the Netscape 

extensions to HTML, he created an HTM L document that 

tiled the image across the browser's background. 

1. Create a tile. 
When you're planning a tile pattern , any size image may be 
used. Nctscape wi ll repeat the image to fill the background. 

Working in RGB Mode, reduce the size of your image to the 

desired size of your tile. 

2. Ghost the image. 
a. Choose Select All from the Select pull-down menu. 

b. Select Fill from the Edit pull-down menu. 

c. Select White from the Use pop-up menu. 

d. Type 85% in the Opacity field. 

e. Select Normal from the Mode pop-up menu. 
Click on OK. 

f. The resulting image is shown in Figure 2f. 



4. 
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3. Reduce the bit depth. 
Before you save, select [ndexed Color from the Mode pull

down menu. Experiment to see how much you can reduce 

the bit depth without altering the image. Always select 

Adaptive Palelle, and Diffusion Dither. 

4. Save this image as a GIF file. 
Choose Save As from the File pull-down menu, and select 

CompuServe GIF from among the choices on the Format 

pop-up box. 

5. Create an HTML file to test your image. 
a. Create an HTl\IIL document with an <lMG> tag. 

<HTML> 
<HEAD> 
<TITLE>Mes h< /TITLE> 
</ HEAD > 
<BODY > 
<IMG SRC - "Mesh.gif"> 
<!BODY> 
<I HTML> 

b. Save the lile. Suvt: the document in SimpleText, 

Teach Text, or your word processor. If you' re using a 

word processor, save the text as ASCH or Text Only. 

Give the fi le a name, and add an .HTML extension 

c. Test the HTML document in Netscape. Open 

Netscape, and then open your document by selecting 

Open File from the F ile pull-down menu. Make sure 

your HTML document and your image are in the same 

directory. 
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Create a 
full-bleed 
photo background 
with larger tiles 
Summary: Netscape will tile any size 

image. Larger images will appear to be 

full-bleed images. 

Motb<rMary 

JAn:tl,C'!-.k.ir.m.dft.....

Sk-MI.Jocc:b.. pll.u, ¥QA._ 

P.au l Jar, dnww 
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To create a full-bleed photo background, Mark filled in a 

black-and-white photo with white, in order to ghost the 

image. Using the Netscape extensions to HTML, he c reated 

an 1-ITML document, which causes the full image to fi ll the 

browser's background . 

1. Follow steps for creating a tiled background. 
When you' re planning a tile pattern , any size image may be 

used. Netscape wi ll repeat the image to fi lllhe background. 

Follow the steps for creating a tiled background, presented 

earl ier in this chapter and shown here: 

a. Create a tile. 

b. Ghost the image. 

c. Reduce the bit depth. 

d. Save the image as a GIF fi le. 

e. Create an 1-ITML file to test your image. 

2. The background tiles as you add content. 
You will not be able to scroll and look at the tiled back

ground until you've added content to your HTML fi le. 



Creating a 
silhouette 
on an image 
background 

Summary: Silhouettes are created using 

a transparent GIF image. In this exam

ple, the background loads first when the 

Web page opens, and the silhouelle can 

be loaded on top as an interlaced or 

non-interlaced image. 

Tip: See the Page Layout Tools chapter 

f or instructions on how to use 

PlwtoGIF. a Photoshop plug-i111hat will 

make Gl F files transparent. 

Paul Jny, drum'l 

I n this example, the positioning of the s ilhouette images 

was a greater cha llenge than the creation o f the transpar

ent GIF images. To position the transparent GIF images 

down the page, Mark Elbert experimented with the 

YSPACE attri bute in the second image tag. 

1. Make your image background transparent 
(using Transparency). 

a. Use the FilelOpen GIF command in the Transparency 

software to open the GIF file . 

b. Press and hold the mouse pointer on the background 

shade. When you let go of the mouse, the background 

will change to a gray color. This shade is now transparent. 

c. Choose Save As from the File menu, and select GIF89. 

2. Make your image background transparent (using 

DeBabelizer). 

a. Use the FileiOpen command in DeBabelizer software to 

open the GIF file. 

b. Select Optio nsiDithering & Background Color from the 

Palette pull-down menu. 

c. C lick the RGB radi o button at the bottom of the screen . 
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Tip: MacLink!P/us, a well-known trans

lation utility from Dataviz now converts 

Mac and Windows formats to and from 

HTML (http:l!lvlvHJ.dataviz.com/Upgrade/

upgmlp_home.html). 
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d. Use the Eyedropper tool to select the background shade 

you 'd like to be transparent. 

e. Choose Save As from the File pull-down menu. 

f. Select GIFIInterlaced Transparent from the pop-up box. 

g. DeBabelizer will g ive your fi le name a GIF extension. 

Save the file. 

3. Use Simple Text to create an HTML file. 
a. Open SimpleText. Use SimpleText or your word 

processor. If you use a word processor, be sure to save 

the document as Text Only. 

b. Create a new HTML document. Start a new document 

with the following markup tags: 

<HTM L> 

<HEA D> 

<TITLE>Wrapping Text</TITLE> 

<!HEAD> 

c. Add a body background tag. 

<Hlf1L> 

<HEAD> 

<TITLE>Wrappi ng Text</TITLE> 

<!HEAD> 
<IMG SRC- "Mar kT . gi f "> 

<B ODY BACKGROUN D- "Toront o_Lg.gi f "> 

d. Add an image tag. 

<HH1L> 

<HEAD> 

<TITLE>Wrapping text </T ITLE> 

<BO DY BACKGROUND- "To ronto_Lg. gi f "> 

<IMG SRC-"MarkT.gif"> 

e. Add a headline tag. 

<IHI1L> 

<HEAD > 

<TJTLE>Wrapping Text</T ITLE> 

<!HEAD> 

<BODY BACKGROUNO-"Toronto_Lg.gif"> 

<I MG SRC- "MarkT.g i f"> 

<H2>Hother Mary<IH2> 



Tip: Microsoft providesfree copie.1· of 

their lmem et Assistant soft ware for 

Microso.fi Won/ and Micoso.fi Excel 

users. The Assistant tools convert 

Word and Excel docwnents into 

HTML-equiva/ent documeltls. Visit 

f! I I p ://WIV IV./11 i C rosoft. COIII/ I vord/.fs _ wd 

.h/111 and hllp:llwww.microsoft. com 

/lnsexcel/ inten letlia. 

f . Add a group of nested definition List tags. 

<HTI1 L> 

<HEAD> 

<T ITLE> Wrapping Text</ TITLE> 

<! HEAD > 

<BODY BACKGRO UN D-"Toronto_Lg .gif"> 

<I HG SRC- "Har kT .gif"> 

<H2>Mother Mary</H2> 

<DL><DL><DL><DL><OL>< IMG 
SRC-"Hand50_bbT . gi f "><IDL><IDL><I DL><IDL><IOL> 

g. Insert the ALIGN=RIGHT attl'ibute in the image tag. 

<HTNL> 

<HEAD> 

<T ITLE>Wrappi ng TextC/TITLE> 

</HEAD> 

<BODY BACKGROUND- "Toron to_Lg.gi f "> 

<IMG SRC- "MarkT.g if"> 

<H2>Moth er Hary</H2> 

<DL><DL>< DL>< DL><DL>< IHG 
SRC-"Hand50_bbT .gi f"AL IGN-RIGHT><JDL>< IDL><IDL> 

<IDL></ DL> 

h. Add four more headlines. 

<fiHI L> 

<HEAD> 

<T ITLE>Wrappi ng Text<ITITLE> 

<lfiEAD> 

<BODY BACKGROUND- "Toronto_Lg . gif"> 

<IHG SRC- "MarkT. gif"> 

<H2>Mother Mary</H2> 

<DL>< DL >< DL> <DL ><DL>< ING 
SRC-"Ha nd 50_bbT . gi f "AL!GN- RI GHT><JDL> 
C/ DL ><I DL><I DL><J DL> 

<H3>Jaret t . guita r. mai n vox</H3> 

<H3>Steve Licori ce . gu i ta r. vox</H3> 

<H3>Mark El ber t , bass , occas i onal keys<I H3> 

<H3>Paul Jay , drums</ H3> 

I 
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Tip: NetObjects Fusio11 is a hor new 

page layout software too/for graphic 

designers who wantro create Web docu

ments. Founded in November 1995 by 

Rae Technology Inc. and Studio 

Archerype (formerly Clement Mok 

Design), NetObjects, Inc, has intro

duced NetObjects Fusion f or Windows 

95/NT and the Power Macintosh. 

Tip: Download a 30-day trial version of 

NetObjects Fusion from http://www 

.netobjects.com 
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i. Add a second image tag. 

<HH1L> 

<HEAD> 

<T ITLE>Wrapping Text</TITLE> 

<!HEAD> 

<BODY BACKGRDUND-"Toron to_Lg. gi f"> 

<IMG SRC- "MarkT .gi f"> 

<H2 >Mot her Mary</ H2> 

<DL><DL><DL>< DL><DL> <IMG 
SRC-"HandS O_bbT. gi f "ALI GN- RIGHT></DL> 
<IDL><IDL><I DL><IDL> 

<H3>Ja ret t, guitar , ma in vo x</H3> 

<H3>Ste ve Li co ri ce. guitar . vox</H3> 

<H3 >Mark Elbert . bass . occasional keys</H3> 

<H3>Paul Jay, drums</ H3> 

<IMG SRC-"Ba ckT2 .gif"> 

j. Add the VSPACE attribute to the second image tag. 

<ltTML> 

<HEAD> 

<TITLE> Wr apping Text</T ITLE> 

<!HEAD> 

<BODY BACKGROUND-"Toronto_Lg .gif"> 

<IMG SRC- "~1arkT. gif"> 

<H2>Mot her Mary</H2> 

<DL><DL><DL><OL>< DL><IMG 
SRC-"HandSO_bbT . gi f " ALI GU-R I GHT></ DL> 
</ DL ><! DL ><IDL><IDL> 

<H3>Jaret t , guitar. mai n vox</H3> 

<H3 >Steve Licori ce, gui tar . vox</H3> 

<H3>Mar k El bert, bass, occasional keys </H3> 

<H3> Paul Jay. drums</ H3> 

<IMG SRC-"BackT2 . gi f " VSPACE- 120> 

k. Add ending tags. 
<!Body> 

</HTML> 



Tip: For informa/ion and ills/rue/ions 

on how to upload.files /o your flll emet 

provider's se1Ve1: see rite Image Map 

cltapte1: 

4. HTML tags used in this section. 
The tags you see in this list (in alphabetical order) reflect the 

I-ITML 3.2 specification. 

<BODY> ... <!BODY> 
A tag used to open and close the body of a document. This 

tag can be used to refer to a background image in the form: 

<Body BACKGROUtW• "Toronto_Lg. gi f"> 

<DL> ... <IDL> 
The definition list tag is usually used for defin itions or 

shon paragraphs with no bullets or numbering. In this 

sect ion, this tag is nested seven times in order to indent 

the Mesh Records logo. For example: 

<DL><DL><DL><DL>< DL><DL ><DL>< IHG 
SRC• "Ha nd50_bbT. gi f "><ID L> 

<IDL><IDL><IDL><IDL><IDL><IDL> 

<H2> ... <1H2> 
<H3> ... <1H3> 

Tags used to enla rge text, as to indicate a heading. Lower 

numbers indicate larger type, and the options range from 

<1-l I> through <1-16>. 

<HEAD> ... <IHEAD> 
A tag used to open and close the header portion o f a 

document. 

<HTML> ... <IHTML> 
A tag used to open and close an HTML document. 

<IMG> 

Used to refer to an in line image, this tag uses the SRC 

allribu te that represents the URL (location) of the image. 

For example: 

<IHG SRC•"Hes h Wave . gi f "> 

This tag uses the ALIGN attribute (or parameter) to indi

cate Lhe placement of an in line image. Options include 

TOP, BOTTOM, LEFT, and RIGHT. For example: 

<IMG SRC• "Hand50_bbT.g i f" ALI GN• RIGHT> 
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This tag also uses the VSPACE attribute, which adds 

space above and below an image. For example: 

<lf-1G SRC-"I~esh Wave.g i f " VSPACE-120> 

<TITLE> . .. </TITLE> 
A tag used to describe the title of a document whkh 

shows up inside a document's tit le bm·. 



Creating a 
drop shadow in 
Photoshop 

Summary: Use Photo shop's selection 

tools and channels to record the outline 

of an image. Next, create a dmp slwdow 

by blurring the edge of the shadow's 

channel image with tile Gaussian Blur 

filter and filling the selection with 50% 

black. 

• 1a. 

1c. 

® n:~ 
.:.) G:~ 
...; u:~ 

1b. 

~ Netscope: Wnllpnper ~ 

Lc.r tt;t~, .lfta. ///APS'a~•--I'Vtb"&~252fH [ 'tlft"1/'SNd.;,-.,.hl.'nl 

'wN:#s t .. v" l 'ln':•t •s ccou l ~.• I ti•t S.W"'Coh I ,,., E>'nt-~ 1 l\tvr~OI.J9' I 

Mother Mary 

Jar<tt, ~tnltor, ololln ><>X 

s~ uoor~o<. ~ • ...., 

11-.lark Elbert. u ..... o>OCIUi>ll41 lt.e7• 

I n this example, Mark created " fuzzy" drop shadows for 

photo silhouettes in Photoshop by using channels . 

Because he planned to make the background of each silhou

ette transparent, Mark minimized the amount of"fringe" 

from the fuzzy drop shadow by starting with a gray back

ground that was very similar to the gray in the browser 

background. 

1. Set the image background color to gray. 
a. WiLh the Magic Wand tool, select the background of the 

object that will have a drop shadow. 

b. Double cl ick the background color sample in the Toolbox 

and type 20 I, 20 I , 201 as an RGB value. This gray is very 

close to the browser background. 

c. Wilh the background sti ll se lected, press the Select key 

to fill the background wi th the speci fied shade of gray. 
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Wind ow 

2b. 

llllllil!l!l!ll 
New Window 

Zoom In •· Zoom Out ·-Zoom Foclor •.. 

Show Ruler~ ICR 

Sho tu Orushcs 
Show Optmns 

./Bock .PICT 11 : 11 
!.hOW J'I[kt:l 
Show Sw a tch es 
Show Scrn trh 

Show l otten 

Sho w P ft lh\ 

l llldo ln ru 
ShoiU Commnnds 

2c. 

• 
IP Pale tte Options ... 

• 
~ 

Oupll,ote t honnrl •.. 
Oel l1tc Ch annel 

.. Channel Option\ ..• 

•'' Uldt>O Olp hD ••• 

9 ------
Split Ch nnnel s 
Men te Ch atulel 'l .•• 

j -
[] @ [:" il 

2d. 

1-'-L Pale tt e Up lio ns ••. 

NeUJ Chnnnc l. .. 

Oele l o Channel 

Channe l Op11ons ... 

Ulde o Alph a •.. 

- Spill Channeh 
• "'1e1ge Chonneh ... 

2f. 
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2. Create two channels. 
a. If it is not sti II selected, select the backg round of the 

object that will be shadowed. 

b. Choose Inverse from the Select pull-down menu. 

c. With the object selected, se lec t Pale ttesiShow Channels 

from the Window pull-down menu. 

d . Press on the Channels pop-up menu, and select New 

Channel 

e. Give the channel the same name as your object. 

Cllonnel Options 

Nome:J~h_a_n~q~---------------
Color lndlcot os: ----------, 

®Masked Rreos 
0 Select ed nreos 

Opoclty: ~'7. 

2e • 

001 
( Concel ] 

f. To create the second channel, whjch wi ll be the shadow 

channel, select Duplicate Channel from the Channel pop

up menu. 

g. Name this channel shadow. 

2g. 

Oupllco te Channel 

Duplica t e: hond 
As: rJs_h_o_d_o_w __________________ __ 

,- lleslinollon --- -------------, 

llocument: I BockT2.gtr ,.. I 
Name: IL-______________ __,1 

D lnuert 



3a. 

lli1IJII Select Win!low 
Lest Filter :!Cf 

Olur ~ 

Distort ~ 

Noise ~ 
l'iuelote ~ 
Render ~ 
Sharpen ~ 
Styli ze ~ 

Uideo ~ 
I Custom 

I 
lligh Puss .. 
Mammum 
M ini111um . 

3b. 

lli1IJII Selec t 
Offset X F I 

I lllur 
Distort ~ Blur More 
Noise ~ ; : 
Phrela te ~ Motion Olur ... 
Render ~ Radial Blur ... 
Sharpen ~ 
Stylize ~ 
Uideo ~ 

Other ~ 

4a. 

Gaussian Blur ~~-

~ OK JJ 

Cancel 

!8J Preulew 

Radius: ~ phrels 

4b. 

I 

3. Use the Offset filter. 
The shadow will need to be offset to the right and down at 

least 20 pixels in each direction. The offset filler will make 

this change. 

a. Select the Shadow channel in the Channels palette. 

b. Select OtherlOffset from the Filter pull-down menu. 

c. Select Repeat Edge Pixels. Fi ll in 20 for Horizontal Pixels 
Right and Vertical Pixels Down. 

d. Click on OK. 

- Offset 

Hor izontal: ~ phcels righ t 

Ucrticol: ~ phcels down 

r- Undefined Areas-

0 Se t to Decl<ground 

® Repea t Edge Pluels 

0 llJrep nround 

3c, 3d. 

fl OK JJ 

Cancel 

!81 Preuiew 

4. Gaussian Blur creates the "fuzziness." 
a. With the Shadow channel still selected, choose 

BluriGaussian Blur from the Filter pull-down menu. 

b. Type in 6 pixels, and click on OK. 

4. 
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~WindOIU 
Rll ICR 

Color Rnnge .. . 

r ••• u ... , .. I 
Mmiii!J ~ 

~n!J __ ~ 

GtOIII ""j ~tm •ltu 

1---·---
l~~fli~•'U 

5a,5a, 7a. 

-= Load ~e let lion 

r- ~ourc c CEJ) 
Document: I Boct.PJCI .., ) 

Channel: ( hand ... , ( Cnncct j 

O lnuerl 

1 llt•e• ntlon 

@ N f>IU ~C IUI l iOn 

Q Add to Selecllon 

Q Sublroc t from Selection 
0 l nlenetl with Sclecllon 

Sb,7b. 

Lood Selection 

r- Source CEJ Ducumcol : I nnck.PICT .., I 
Ummli!J . ..... tusnd • 

( Cancel ) 

~~·I·HII: 

r- 01JCf OtiOII 

@ NCIU Sclet lion 

0 IHid 10 \l'll•r Unn 

O \ ullt rutt lrom \Nerllnn 

Q lntrn('CI Wtlh \iPIP(\1110 

6b. 

UackB.I' ICT l lnliOII, I: I t 

7c. 
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5. Copy the hand to the Clipboard. 
Usc the Hand channel to select the hand and copy it to the 

Clipboard. 

a. Choose Load Selection from the Select pull-down menu. 

b. Select Hand from the pop-up menu that foll ows. 

c. Select Copy from the Edit pull -down menu. 

6. Load the Shadow selection and do a fill . 
a. Choose Load Selection from the Select pull-down menu. 

b. Select Shadow from the pop-up menu that follows. 

c. Choose Fill from the Edit pull-down menu. 

d. Select Black from the Use pop-up box on the Fill 

dialog box . 

e. Type 50% in the Opacity box, select Normal in the Mode 

pop-up, and click on OK. 

-~ Fill ---

I Contents 

I Usc: 'l"""'o""'t-oc-:-k-----... -,1 

r- Blending - -------, 

Opocily: 0 % 
Mode: r1 --..N~or=m=a"t -:-,---= ... =-1 

0 Pr e~erue lransrro r entrJ 

6c,6d,6o. 

H OK D 
( Concet ) 

7. Paste an original of the hand on-top. 
a. Reload the Hand channel by choosing Load Selectio n 

from the Select pull-down menu. 

b. Select Hand fro m the pop-up menu that follows. 

c. Choose Past from the Edit pull-down menu. The result is 

shown in Figure 7c. 



l§@tj I mage 
Bitm ap 

..1 RGB Color 
CMYK Color 
l ab Color 
Multichannel 

_ Lo l_or la-ble ... ____,l I 
CMYK Preuiew 
Gamu t Warniu y 

So. 

8. Reduce the pixel depth (in Photoshop). 
When Mark finished editing the image in RGB Mode, he 

experimented with Photoshop's Indexed Color Mode to see 

how far he could reduce the pixel depth without altering the 

color. (Note: See the 11ext section fo r instructions on how to 

reduce the bit depth in DeBabeli:e1:) 

a. Select Indexed Color from the Mode pull-down menu. 

b. Experiment by selecting smaller bit depths with and 

without dithering to see how the color in your image 

holds up. If you don' t like the color, select Edi t! Undo or 

press Command+Z. 

Sb. 

Mark was able to reduce Lhe image to a 6-bit color depth 

without a noticeable change in the color. This made a 

significant change in the file size. 

l ndeHed Color 

- Resolution ([ OK n 0 3 bits/ p iHe l 
0 4 bits/ piHe l ( Cancel J 
0 5 blts/ piHe l 
® 6 bits/ piHel 
0 7 bits/ piHe l 
0 B bits/ piHel 

0 Other: r=J colors 

- Pa lette - Dither 

0 Euact ONone 
0 Uniform 0 Pa ttern 
® Adapti ue ® Diffusion 
0 Custom ... 
0 Preuio us 

9. Reduce pixel depth (using DeBabelizer). 
a. Open your RGB image in DcBabelizcr. 

b. Select Change Pi xel Depth from the Palette pull-down 

menu. Equilibrium Technologies recommends that you 

always select dithering when you reduce the number of 

colors. Although you can change the amount of dithering 

by se lecting OptionsiDi thering Options & Background 

Color from the Palette pull-down menu, DeBabelizer's 

default setting is the amount Equil ibrium has de te rmined 

is best. 
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~Mht Sulph 
Option\ 
P&letl e Info 
Po le lie 

Conucr t to BOUUGruy\Cele • 
Remo11tt unu1t>d o Dupllte lu 
Reduut Colors... Ml 

I bit • 2 CIUIII\ Clltllll!red 
~el Pnlelle 0 Remep Phteh... I bit • 2 rolnl\ 

2 bl11 • I (Ofan 011hllfPO 

Bac t:gJountl Remoun t... 2 hlh • ·I t olou: 
Moc:lnii.ZO l'nle l lc 3 bit~ • 0 I n101 S llilhCIIlll 
Sort l'olc lt e 3 lllh • 0 cui.,,. 
Super f'nlet l t 

BOW Ordered 0111111!1 
Mef'ge flale lles ... 
EttuDIIZt' Pnletl e 
llh i Oflltllll ... 
HSU Con h oi. •• 
tnuell Colon 
Gun Control ••• 
'fS( Hot Pltcel riNer ••• 
Chenuch 
tnten\l ltJ I) Contro,t, .. 
Sheue-Outllne 

9b. 

Non-lntertored 

-t blh • 16 tOIOI'\ Ulll ll'l ti'U 

4 blh • 16 colu o' 
S bltl • 32 colon ounrrro 
5 blh •l2 toluu 

,. 6 hlh • 6 1l fOifi1S llllhCIUII 

11•11\ I'~ 1 ol•lt\ ~ lhlllf! 1 
lfuh i;Jf ., 

•h r.,., 
8 blh • 25C.IOiuu 

)> Ito nth ~n: Ht.B ro"u .... ,,, 
16 hll\ • l2K RGO coluo' 

,. 24 blh • I 7 Million R(jll I OHJI 

l2 blh • 17 Million AGB • niD 

O!.llalo CUI 
Non- lnterl ace ll O· Tran1par~nt IM(i 
ln tertn red I) Trnni tln r ent 11 JPCG, ,Jr If 

10b. 

Soue As GIFU9 ..• Jt~ 

Quit 3€0 I 
11a. 

11b. 
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Stan by reducing your image to 128 colors and look at 

the image. Tf you don't l ike the change, select Undo from 

the Edit pull-down menu or press Command+Z. Keep 

stepping down to fewer colors to determine when the 

color change becomes vi sible. Mark was able to reduce 

the palette to 64 colors (as shown in Figure 9b) without a 

noticeable change in the image. 

10. Save the Image. 
a. Select Save As from the Fi lc pull-down menu ( in 

Photoshop or DeBabelizcr). 

b. Select CompuServe GIF or JPEG from the pop-up menu. 

(Note: Photos hop 3.0 does 110t add i11terlacing to GIF 

images. fllterlaci11g gives the Web visitor the impressio11 

of afasrer doiVIlload by quickly paillfing the image in 

low resolutio11 a11d gradually filling it i11.) 

To add interlacing to a Photoshop GIF image, you' ll 

need GIFConve1ter by Kevin Mitchell. DeBabelizer al so 

has an option to save a ti le as an Interlaced GIF. (Note: 

GIFCom•erter is available on the CD-ROM in the back 

of this book.) 

c. Give your image a name, and try to keep your fi le name 

to a minimum of eight characters (no spaces) with a file 

extension such as .GIF. .JPG. or .JPEG. (Note: File 

exrensio11s IIIllS I be limited to three characters on the 

DOS/IBM platform.) Removing vowels from the fi le 

name helps reduce the number of characters. M ark used 

DcBabel izer and chose Interlaced GTF as the file format 

for saving. 

11. Make the background transparent 
{using Transparency). 

a. Usc the Fi lciOpen GJF command in the Transparency 

software to open t11e G IF fi le. 

b. Press and hold the mouse pointer on the background 

shade. W hen you let go of the mouse, the background 

wi ll change to a gray color. This shade is now transparent. 

c. Choose Snvc As from the File menu, and select GlF89. 



Open Gl F... :l€0 
Clo se :l€W 

Quit 

11c. 

Edit Palette 

:l€N 
:.:r 

Open Channe ls .. . 
Ac uire 

12a. 

Dither Orltlons 0' UoctgruuncJ Color 

Otf•Jit 

Ollhcr 1.: 0 0 0 0 0 0 0 ® 0 
0 ........ 25 ....... 50 ....... 75 ...... 1 00 

Dither Method: I Olffu\IOn ·I 
0 Don't dither llnr:kground Color 

0 Remtlp nctr•ljiOUnd tolut I O r olor lflll(•ll D 
Dnckground Color: 

0 llnckground ne rno uol's "fill Color· 

0 Most populnr color 

0 Color lndeH:{!!J 

® AGO ualue: 1• 116 lz·nj-:co1or Pl!ker ... ) 

II OK ~ ( Contcl l ( ltclp ... l 
12c. 

12d. 

12. Make I he background transparent (using DeBabel izer). 

a. Use the FileiOpen command in DeBabcli zer software to 

open the G IF fi le. 

b. Select OptionslDithering & Background Color from the 

Palette pull -clown menu. 

Scripts 

12b. 

c. Click the RGB radio button al the bottom of the screen. 

d . Use the Eyedropper tool ro select the background shade 

you 'd like to be transparent. 

e. Choose Save As from the File pull-down menu. 

f. Select G I FITnterlaced & Transparency from the pop-up 

box. 

Non-int erl oc~e'dd _______ JalJ•·•······ 
Interlaced Or. Ha lo CUT 
Non - interl oced ll' Transparency IMG 

• •• i • • •• JPEG, JF IF 

12f. 

g. DeBabelizer will give your file name a G IF extension. 

Save the fi le. 

Photography j 219. 



Tip: VisiJthe Submit It site and fill out a 

fonn Jhat is part of a free service to list 

your sile with 17 online directories

simultaneously ( lltfp://submit-it.penua

link.cmlvsubmit-it). 
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13. Use Simple Text to create an HTML file. 
Simple Text from Apple Computer is a useful tool for c reat

ing HTML fil es. Tt's small (77 K), it 's distributed wi th 

System 7.5, and it saves HTML text files in the ASCIT form 

that's required by browser programs. Microsoft Word users 

can save a text fi le as Text Only or ASCll. 

a. Open Simpletext. Use SimpleText or a your word 

processor. If you use a word processor, be sure to save 

the document as Text Only. 

b. Create a new HTML document with an <lMG> tag. 

Start a new document with the following markup tags: 

<HTHL > 

<I·IEAD> 

<T ITLE>Wr applng Text </TITLE> 

<! HEAD> 

<BODY > 

< 1116 SRC-"Back. gi f"> 

<! BODY> 

</HTHL> 

c. Add an image tag. 

<HTHL> 

<HEAD> 

<TITLE>Wrapping Text</TITLE> 

d. Save the tile. Save the document in Simple Text, 

TeachText, or your word processor. If you're using a 

word processor, save the text as ASCH or Text Only. 

Give the file a name and add an .HTML extension . 

<BODY> 

e. Test the HTML document in Netscape. Open 

Netscape, and then open your document by selecting 

Open File from the File Pull down menu. Make sure 

your HTM L document and your image aare in the same 

directory. 



Jane Greenbaum's 
tips on creating 
a drop shadow in 
Painter 4.0 
Summary: Use the Create Drop 

Shadow command in Painter to create 

an a11tomatic drop shadow. 
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D rop shadows arc a one-step procedure in Painter if an 

image is a floater. Floaters are e lemems created in a 

Painter document that behave li ke objects. They are d is

creet images that will not interfere with other design ele

ments. Text e le ments created in Painter are considered to be 

vector-based objects or shapes and are therefore considered 

to be a type o f floater. Image floaters behave like objects, 

but unlike shapes, they have pixel information stored as a 

mask instead o f vector-based stroke and fill informatio n. 

In this section, Jane creates text with a drop shadow and 

then uses similar steps to create a drop shadow around an 

image that has been saved in a Photoshop layer. An image 

saved in a Photoshop layer w ill automatically be treated 

as a fl oater in Painter. (Note: lfyoll wish to follow the steps 

in this section, look for Jane 's image on the companion 

CD-ROM.) 
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Painter 4 .0 .3 

1a. 

1d. 

222. , Chapter 6 

1. Create text with a drop shadow. 
a. Open Painter. 

b. Select New from the File pull-down menu. 

c. In the dialog box that follows, type 600 (pixels) in the 

fi eld labeled Width, 600 (pixels) in the field labeled 
Height, and 12. o (pixels per inch) in the field labeled 

Resolution. Click on OK. 
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1b. 

d. An untilled document wi ll open. 

e. Select the Text tool. 

f. Select Controls from U1e Window pull-down menu. 

g. fn the Controls Text dialog box that follows, select 

Other Font from the Font pop-up menu. 

1e. 
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1 k. 

h. [n the Choose Font dialog box that follows, select a font, 

and cl ick on OK. 

i. Once you have selected a font in the Controls Text 

dialog box, use your mouse to move the Font Size slider 

to set the fon t size to 24 points. 

j. Put the Contro ls Text dialog box away by clicking on 

the close box with your pointer arrm.v. 

11. 1). 

k. With the Text tool still selected, c lick on the untitled 

document, and type Hari lyn. 

I. As Painter c reates ind ividual text shapes in the untitled 

document, each letter will be represented as a separate 

fl oater in the Objects Floater List as shown. 

m. Click o n the Group button in the Objects Floater List. 

n. The list will collapse to one· Object Floater labeled 

Group I. The object should be shaded, indicating that it 

is selected. 

o. Jf the Group I object in the Object Floater List is not 

selected, click to the right of the object's name to 

select it in the list. 

1m. 

11. ln. 
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p. Select ObjectsiCreate Drop Shadow from the Erfccts 

pull-down menu . 

q. In the dialog box that follows, type 10 in the fie ld 

labeled X-Offset, 15 in the field labeled Y-Offset, and 45 

in the field labe led Opacity. Click on OK. 

0 (011111\fl 10 OIUI II )Ier 

1q. 
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r. A drop shadow will appear. 

Marilyn 

1r. 

2. Save your image. 
a. Select Save As from the File pu ll -down menu. 

b. In the dialog box that follows, se lect GIF fro m the Type 

pop-up menu. 

c. Type a name in the fi eld labeled Save Image As, and 

click on Save. 
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2d. 
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d. In the din log box that follow s, c lick on OK. 

e. In the Save As GIF Options dialog box that follows, 

accept the defau lt settings by clicking on OK. 
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3. Create an image with a drop shadow. 
]mages saved in a Photoshop layer are automatically treated 

as a floater in Painter. Although Painter has selection tools 

that may be used to create a floater, the selection tools are 

not as easy to use as the comparable tools in Photoshop. 

a. Open Photoshop 

b. Select Open from the File pull-down menu. 

c. Select a graphic in the dialog box that follows. and click 

on Open. 
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d. Your image will open in a Photoshop window. 

e. Select the Magic Wand tool. 

f. Click on the solid background. 

g. The background wi II be enclosed with "marching ants," 

indicaling that it is selected. 
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. . 
3f. 3g. 

h. Select Inverse from the Select pull-down menu . 

i. The image will be selected instead of the background. 

3 1. 

j. Select Copy from the Edit pull-down menu. 

k. Select Paste Layer from the Edit pull-down menu . 

~'11CM imo;e l I v • uO Cepy X l 

hi •• 
Copy X C 

' '"'I! x u Po tltlnto 

ut.,.,,._.,"'lr 
r\10 ' LI ~ ' "'' 

3k. 



"i()tet•l er 

P.. nlnt: lcatn t:::!!:J 
Op11111: ~ .. f1 Modr! P.,Oultl l • I ( I IDU~I ) 

31. 

QGr·•up W.llt P'rrl'lotl\ I I'll!' 

IIIIIJIIthl MoGI 

"""'··· " Ol'lt'A .. , •• .......... 
(11\f' .. 

• 
\"llnll[ll py ..... 
NPI•t•tl 

fll l' lflfiM. 

1"1111\t iU;t .... 

' ''"'··· ., 

"ainter· 4 .0 .3 

6a. 

I. In the dialog box that follows, type a name for the new 

layer, and click on OK. 

4. Save your image. 
a. Select Save As from the File pull-down menu. 

b. In the dialog box Lhat follows. select Photoshop from 

the Format pop-up menu. 

c. Type a name for your image. and click on Save. 

d. In the dialog box that follows, click on Replace. 

4b. 
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5. Quit Photoshop. 
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a. Select Quit from Lhe File pul l-down menu. 
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6. Open your image in Painter. 
a. Open Painter 
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b. Select Open from the File pull-down menu. 

c. Select your graphic in the dialog box that follows, and 

cl ick on Open. 

d. Your image w ill open in a Painter window. 
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7. Enlarge the canvas size in Painter. 

I 

II 

a. Select Canvas Size from the Canvas pull-down menu. 

b. In the dialog box that follows, type 100 following the 

word Add in each of the fields used to increase the 

canvas size. 
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8. Zoom out. 
a. Select the Magnifying Tool. 
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b. Hold down the Option key, and click on the image. 

c. The image will be reduced from LOO percent to 50 

percent. 

9. Select the image in the Floater List. 
a. If the Objects Floater List is not in view, select Objects 

from the Windows pull-down menu. 

b. In the Objects Floater List, c lick on the image as shown. 

c. A rectangular selectio n will nppear around the image. 

9b. 

(OIH I,IIr · ~ • 

9c. 

10. Create a drop shadow. 
a. Select ObjecLsiCreate Drop Shadow from the EtTects 

pull -down menu . 
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11a. 

• 

b. Tn lhe dialog box that follows, type 10 in the fie ld 

labeled X-Offset, 15 in the field labeled Y-Offse t, and 45 

in the field labeled Opacity. Click on OK. 

c. A drop shadow will appear. 
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10c. 

11. Deselect the selection rectangle. 
a. Select Deselect from the Edit pull-down menu. 

b. The selection rectangle will disappear. 

11b. 
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12. Save your image. 
a. Select Save As from the File pull-down menu. 

b. In the dialog box that follows, select GIF from the Type 

pop-up menu. 

c. Type a name in the field labeled Save Image As, and 

cl ick on Save. 

d. In the dialog box that follows. click on OK. 

e. In the Save As GrF Options dialog box that follows, 

accept the default settings by clicking on OK. 

IMatlhJa,gll 

ttP«t ' " • I 

12c. 

\ave Jh 1011 ••• to•• 
,.~titbit 1111 Ca ton: IIUIII'I ing "11'tltod : 

O ·ll ttiU" (Jlauaoll u t tONil nl€1\l [ 1)1(11 

Q u IOIOn 0 Oil her l oton 
Q t6Colon 
OU IO'on h .n•••••nc•: 
® •• c nton ;) luiJUI lrarnpnrt!'ftf• 
O t 11 Cotort @n•llltO•u•di\IJ'•J•III,rll•l 

O:»~• rol ar\ Q t· "·ltquum.I"II•IH··u 
lto . .. ;'c l 

Mt U OIIIIOA$; 

Q lntetlttf'Gtr lllf' 

t•upO~II .. I\: 

0-KU"'1l l'llle 

12e. 

I "' 

12d. 

ltiP ROlli I I'!" In tl'li \ lllt•q~ lfe 
f'ftCHglti iL'Itl'l !be (IP"I\ IIIJir 

ti'llfn ,.ut"IJ I I i t'll' t~r mat •• 
Ullfiii\AIH I OUUI! IIIft 

UftUIII\ftAci iJOGf t'I\ IU 

lntl~p,ndut oll)el l \ . 

Photography j 231. 



Creating a blue 
duotone with 
Photoshop 
Summary: Use Photoslwp 's duotone 

presets to create a blue duotone. 
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232. 1 Chapter 6 

I n pri nt, a color duotone is a prim made from a mono

chrome original with a second color added for greater 

detail. The technique is a way to add color to an image wi th

out using full color. For the Web, this means a smaller file 

size and faster downloading. 

1. Discard color from a color original. 
a. Open your image in Photoshop. 

b. Select Grayscale from the Mode pull-down menu. 

c. Cl ick on OK when a dialog appears that asks if you're 

sure you want to discard the color information. 

2. Select a duotone. 
a. Select Duotone from the Mode pull-down menu . 

b. Select Duotone from the pop-up menu. 

c. Click on Load to load the Photoshop duotone presets. 
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d. Find lhe Goodies folder inside the Photoshop software 

folder, and c lick it open. 

e . Click open lhe Duotone Presets folder. 
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f. C lick open lhe Duotones folder. 

g. C lick open the Pan tone Duotone folder. 

h. Mark selected Blue 286. When he applied this by clicking 

on the OK button on the Duotone Options dia log box, he 

decided he wanted the blue to look more saturated. 
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i. To adjust the amount of b lue, Mark clicked opened the 

duotone curve. 
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j. By pushing the curve up (shown at left) and to the left 

with the mouse, Mark altered the amount of blue in the 

duotone. 

k. He reapplied the duotone informalion by clicking on OK 

in the Duotone options dialog box. 
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3. Save the image as a JPEG. 
a. Choose RGB from the Mode pull -down menu. 

b. Select Save As from the File pull-down menu. 

c. Select JPEG from the Format pop-up menu in the Save 

dialog box. 
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d. 1Ype in a file name, and use a .JPEG or .JPG extension. 

e. Select an image quality in the dialog box that 

fo llows. 

4. Create an HTML file to test your image. 
a. Open Simple Text. Use SimpleTexl or your word 

processor. J f you use a word processor, be sure to save 

the document as Text On ly. 

b . Create a new HTML document. Start a new document 

with the fo llowing markup tags: 

<HTML> 
<HEAD> 
<TITLE>Duotone<I TITL E> 
</HEAD> 
<BODY> 

c. Add the image tag. Reference your JPEG image with 

the addition of an <IMG> tag. 

<HTML> 
<HEAD> 
<TIT LE>Duot one</TITLE> 
</ HEAD> 
<BODY> 
<IMG SRC - "Posterl.jpeg"> 
<!BODY> 
<!1Ht1L> 

d. Test the HTML document in Netscape. Open 

Netscape, and then open your document by selecting 

Open File from the File pull-down menu. Make sure 

your JPEG image and your HTML document are in the 

same directory. 
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Creating a 
Super Palette 
with DeBabelizer 

Summary: For 8-bit images that you 

plan to put on the same Web page, create 

a Super Palette in. DeBabelizer because 

browsers can only read a total of256 

colors. 
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D eBabclizer's S uper Palette fealllre is desig ned to cre

ate the best palette o f 256 colors for a group of images. 

Although Equilibrium didn ' t specifically design this feature 

for Web graphics, it he lps Web arti s ts find a palette that can 

be used for a group of photos because browsers will only 

read a total of 256 colors per page. (/Vote: This sample 

demonstrates how to manually create a Super Palette. For 

information on how to use DeBabe/izer's batch mode and 

scripting f eature to process several images at once, see the 

steps in the Video chaptel:) 

1. Organize your images. 
a. Create one folder for the images d1at have not had the 

Super Palette applied. 

b. Create another folder for images that have the Super 

Palette applied, and invent a naming convention that wi ll 

remind you d1at the Super Palette has been applied. 
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Gun Control... 
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Shoue· Outllne • . 
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Creele fa ttr Palette 

5. 

2. Initialize the Super Palette. 
To reset the Super Palette, select Super Pa leuelfnitialize 

from lhe Pa lelte pull-dow n menu . 

3. Open the first image. 
a. Select Open from lhe File pull-down menu, and open Lhe 

li rsl image. 

b. Select S uper Pa le tte! Factor In This Picture from lhe 

Pale lte pull-down menu. 

4. Create a Super Palette. 
Select Super Pa1elle1Creatc Super Palette from the Pa lette 

pull -down menu . 

~Mise ~cript s 

4. 

Op lion i 
Pnh•ltt• Info 
Pnltt lt,. 

Co nam rt to OO' IU/ Graystnle 
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l oad & Mcn1•' Pnll.. 
Snuo l,oll ... 

5. Name the Super Palette. 
a. Remove Lhe "X" fro mlhe box labe led On Creation Of 

Super Pa/eue. Macintize ft. 

b. Cl ick on Lhe radio buuon labeled Call It, and fill in a 

name. 

c. C lick on Create It. 
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6. Factor in your other images. 
a. Open each one o f the other images that will be part of 

the Super Palette. 

b. Select Super PaletteiFactor In This Picture from the 

Palette pull-down menu. 

7. Apply your Super Palette. 
a. Open each one of the images to be part of the Super 

Palette. 

b. For each image, select Set Palette & Remap Pixels fro m 

the Palette pull-down menu. 

c. Select the name of your Super Palette from the pop-up 

menu on the Set Palette & Remap Pixels dialog box. 

d. Click on OK. 

8. Save your images. 
a. Select Save As from the File pull-down menu. 

b. Select GIF or JPEG from the Type pop-up menu. 

c. Locate the folder designated for the completed images. 

d. Click on Save. 



Artist featured in this 
chapter: 

Kleber Santo~· is a senior 
graphic designer with 
Straigluline International, 
a New York-based firm 
specializing in strategic 
marke1ing communica
tions. fn addition 10 prilll, 
Kleber specializes in the 
deFelopment of elecllvnic 
programs mul multimedia. 

samos@slinyc. com 
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Client-Side 
Image Maps 

r 

Image maps have become an important fea LUre in the Web interface 

a llowing users to navigate a Web site by clicking d ifferent areas in an 

image. Up until recently, image maps required server transactions. 

The HTML code required to create the image map was difficult to 

write because it needed a reference to the image map sclipt the 

provider had running on his/her Web server. Now, client-side image 

maps work entirely on the client side-or on the browser. 

In this chapter, Kleber Santos sorts out the details related to image 

maps, including finding coordinates for cl ickable regions in a map fi le 

and creating a client-side image map HTML file. 

If you' re a Web traveler, you've probably used an image map to 

navigate. Image maps are inline images that have special regions 

" mapped" to URLs. Anyone who clicks on one of the predefi ned 

regions (or hotspots) will be taken to the page referenced in the URL. 

Well-known sites with image maps include: The Spot, a Web site of 

episodes (http://www.lhespot.com); Sony (http://www.sony.com); 

IUMA or the Internet Underground Music Archive (http://www 

.iuma.com); and Hot Wired (http://www.hotwired.com). 

If you' re renting space on an Internet provider's server, this chapter 

will also lead you through the steps on how to upload your files from 

your studio or oflice to your provider's computer. 





A virtual walking 
tour of NY's World 
Financial Center 
Summary: In this chapte1; Kleber 

Santos provides thorough details on the 

steps required to create image maps. 

The first image map was invented by 

Kevin Hughes (kevinh@eit. com) while 

he was Webmaster at Honolulu 

Community College. 

A bove: In the vl'orld Financial Cente1; 16 

palm trees, each 45feet high, line the 

glass-enclosed Wiwer Garden 

• . - .... 4"1'1 • • _i 

HI 1 , .. , '·! ''• ' 
l'.h J...: 1'\hl 

_: -~ I 

Se~c1 uw.hV111ual elementS of O:te abo'le ~e 
10 co on a. Vl:IUb1 row. 

K leber Santos, a graphic designer with 

Straightli nc I11te rnational in New York 

City, likes to challenge himself with com

puter projects to satisfy a curiosity about 

how things work. 

To learn how image maps wo rk, K leber c re

ated a "virtual walking tour" of New York's 

World Financial Cente r. Image maps are 

in line images wi th hotspo ts. C licki ng on a 

hotspot links the user to another document 

with more ho tspots. (Note: ff you want to 

work on th is chapter's image map example 

step-by-step, look for Kleber 's art on the 

companion CD-ROM. ) 

Client-Side Image Maps 1241. 



Above: Arm Taylor is one ofseveral 

retail tenants in the World Financial 

Center (WFC). Created on a landfill 

adjacent to New York's.financial district, 

the WFC contains more than eight mil

lion square feet of office, retail, and 

recreational space. 

Above: When a clickable image map 

exists on a Web page, the mouse pointer 

will turn into a hand. 
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Client-side vs. server-de.,endent image maps. 
Client-side image maps are much easier to create than the 

original image-map implementation, which is server-depen

dent. The word client refers to the browser. As a result , a 

client-side image map means the browser processes, or 

parses, the map information, remembers the content, and 

links to a URL if a user c licks on an active area. 

The components of Kleber's map project. 
Although Kleber Santos' studio is re latively close to ECHO 

in New York City, he never had to physically go to the ECHO 

site because he uploaded his project components throug h a 

dial -up PPP connection. (Note: Although you don't have to 

be in the same city as your provider. it is recommended that 

you and your provider be located o11the same coast because 

cTvss-count1y Internet traffic can be unreliable.) To com

plete his project, Kleber needed the items shown in the fol

lowing table. 

Item 

An image 

Space on 

an HTTP 

server 

Notes 

Kleber used Pbotoshop to create his 

photo montage of the shops and restau

rants surroundi ng the World F inancial 

Center's Winter Garden. T his step will 

be fami liar to designers. Photoshop is a 

popular image ed itor. For one of his 

image maps, Kleber needed transparent 

GIF images for sil houetted buttons 

(Sfuzzi). He used the PhotoGIF plug-in 

shareware software from Box Top soft

ware. (Note: PhotoG IF is available on 

the CD-ROM in the back of this book.) 

Kleber's image map project resides on 

ECHO's Web server in New York City. 

T he serv ices a designer can obtain fro m 

an Internet provider vary a great deal. 

M inimally, Kleber needed a dial-up PPP 

account, which provided access to the 

Internet and server space. 



Curtis Eberhardt, 
New York, NY 

Above: A 3D illustration containing 

SltockiVave movies. 

Above Right: Curtis' home page at 

hltp:/lwww.new-kewl. comlcttrliscape. 

Above: A GIF animationfrom Curtis' 

Web site. 

A s an an imator, Curt is Eberhardt (CurtisAE@aol.co m) 

is very conscious of bi t depth and re lated file sizes. 

He recommends that Web artists reduce bit depth as much 

as possible to maintain a reasonable bandwidth. 

Curtis' design tips: 
1 . GlF Wizard at http://www.raspberryhill.com/ 

gifwizard.html is an onl ine tool that reduces the size 

of your G IF images e ither on a Web server or on your 

compute r's hard drive. 

2. Use one-bit (black and white) cast members in 

Director movies. Instead of importing color cast 

members into a Director mov ie, colorize one-bit cast 

members on Stage to make very small movies for down

loading. 

3. GIFBuilder can be used to create individual GIF 
animation frames. Use the GlFBuilder Grabber Hand 

tool. move your art , and save the frame. 



Larry Rosenthal, 
New York, NY 

Above: A VRML animation adve/1/ure. 

Above Right: Lany's Srarbase C3 page 

at hrtp:l/wwHI.CIIbe3.comlstarbase. 

Above: A Java-based 3D chat area on 

Lrmy 's Starbase sire ll'riuen by Dan 

and Matt O'Donnell ofCicada Web 

Development (http://1v1vw.cicadaweb 

.com). The 3D char envirownelll opem 

in afloaring window. The rop half is a 

VRML window conraining Larl)' 's 3D 

models. (Note: Look for Dan and Mat/ 

0 'Donnell's VRM L tips on the com

panion CD-ROM inrhe Windows 

edition.) 

L an y Rosenthal (larryr@cube3.com) is an industrial 

designer, a new media artist, and chairman/founder of 
New York's VRMLS IG. 

Larry's design tips: 
1. When creating VRML models, usc 20 models 

whenever possible. Use a plane instead of a box for 
representing walls, floors. bird wings. etc. If a VRML 

object is not meant to be examined up close and if your 

modeler can handle polygon-level manipulation, turn a 

solid object into a surface by removing any unneeded 
faces. This relieves the renderer from culling faces that 

are redundant or unnecessary. 

2. VRML 30 chat engines may be customized with 

your VRML models. Cicada Web Development and 
Black Sun Interactive have both developed 3D chat 

engines that may be used to create your own chat 

environment. 

3. Web servers need to be 

configured with the 
proper MIME settings 

to display VRML mod
els. lf you wish to display 
VRML models on your 

site, check wi th your Internet service provider and 

inquire whether the MIME settings have been set to 

display VRML models. 



Jane Greenbaum, 
New York, NY 

---

~~·~·~·~ . - ' 

Above and Above Right: Sample pages 

from Jane '.1· Web site at hllp:l!members 

. aol.coml!fonva ref/image I. 111111. 

I := 1,.:::.1 !. II .. ~ I .. '! I ! I ~~ I ! I ~ 
LkttiM: In .. :/ //""I"INII0'2.HTH 

fhl• ~ wat cr.oted tor an lniwatttw 
porttoflo .tth 3D Studlo on a PC platform. 
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Jane Greenbaum (IFonvard @aol.com) is a new media 

anist and vice president of lhe New York Graphic 

A11ists' Gui ld . 

Jane's design tips: 
1. Using a Web site to display portfolio samples. If 

you're using your Web site to display your portfolio, 

keep it o rganized and simple. 

2. Publish your Web site offiine. Co nsider publishing 

your Web site offline by writing the files to a CD-ROM. 

The CD-ROM may then be mailed or d istributed as a 

self-promotion piece. 

3. Web visitors will expect fresh materia l. Web design

ers wi ll be expected to update the ir Web graphics at 

least once a mo nth. As a result, try to think of ways 

to update your images without starting from scra tch. 

For example. updating can be accomplished by 

rearranging the art or fl oating new objects on the 

same background. 



Frank 
De Crescenzo, 
New York, NY 

Above: A rotating 3D logo cremed as a 

GIF animation. 

Above Right: The Slappers home page. 

http://members.aol.conllj1atsticksl 

splash.html 

l.oo.t.honl l filt ·///ZfalO t 00/SIW:WJ/Pruttwlhtml/thff!!!.MII"'I 

!~··•Htw? J I~,·sc..s1 ll o.nn..w J f ,..t~ !~I • ft>.r.-. I 

... Ill 

Graphic designer Frank De Crescenzo (frank_ 
dccrescenzo@prcnhall.com) designed the Slappcr 

Web site for fellow percussionist Billy Amendola, who 

developed the Slappers nat drumsticks. 

Frank's design t ips: 
1. Client-side image maps are easy to create with 

NctObjects Fusion. No HTML tagging is required 

when you use NetObjects Fusion to create a Web 
site. Download a 30-clay trial copy from hup://www 

.nctobjects.com. 

2. Use a MAIL TO command to route form data. Avoid 
the usc of difficult CGI scripts by using a MA ILTO 

command to route form data to an emai l address. 



Peju Alawusa, 
New York, NY 

Above: Peju 's ho111e page. 

Right: Pejtt 's resu111e page jro111 her Web 

site. 
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Graphic designer Peju Alawusa (pej u_alawusa 

@prenhall.com) des ig ned her Web site using 

NetObjecls Fusion. 

Peju 's design tip: 
1 . Avoid HTML tagging. Use NetObjects Fusion to c re

ate sophisticated Web pages with forms, frames, image 

maps, and multi media e lements. 



Alex Shamson, 
New York, NY 

Above: The Home Storeftvm Alex's 

Virtual Mall. 

Above Right: Alex Shamson 's home 

page at hllp:/lwww. vrmill.com. 

Above: A wooden chair in the Home 

Store m tates and has an embedded link 

to another Web page containing manu

facturer and price information. 

I ndustrial desigr~er ~lex Sl~m.nson (alex@vrmill.com) has 

created a Web srte full of lrnks to valuable VRM L 

resources on the Web. Visi t his site at http://www. vrmill.com 

for information about browser software, VRML nrtoria ls. 

and updates on the VRML specification. 

Alex's design tips: 
1. The rotating millstone at the 

upper-le ft corner of Alex's Web 

site is an example ofVRML ani

mation. Simple animation can be 

added to VRML 1.0 models using 

a word processor. 

2. T he VRML models on Alex's site were created with 

Virtus WalkThrough Pro. Vi rtus WalkThrough Pro is 

an inexpensive 3D visualization tool popular with 

arch itects and Hollywood directors. The software is 

ava ilable on both the Macintosh and Windows plat

forms and can ex port a VRML 1.0 model in the form of 

a WRL fi le. 



Marc Thorner, 
New York, NY 

Above and Below: Close-ups oft he 

VivoActive digital video stream. 

Right: Marc's WvoActive page on the 

PGI site at hllp:/hviVw.pgi.net/video 

./lim/. 

Marc Tl10mer (mthorner@pipeline.com) is a d ig ital 

video specialist who is pa11 of New York-based 

Premiere Graphics International. 

Marc's design tips: 
1. Vivo Active Producer software compresses a video file 

into a tiny video stream. Compress your video tiles into 

video stremn s at a ratio of200: I using VivoActive 

Producer. A video stream starts p laying immediately 

when a page loads in to a Web browser. 

2. No extra hardware or software is necessary. 

YivoActi ve requires no extra hardware or software on the 

Web server. 

3. V~'eb ser vers need to be configured with the proper 

MIME settings to display VivoActive (V IV) liles.lf 

you wish to display VivoActive streami ng video mod

els on your site, check with your Internet service 

provider and inquire whether the MIME settings have 

been set to display YIV ti les . 



Diana DeLucia 
Design, 
New York, NY 

Above: A sample Web page from the 

Diana DeLucia Design Web site 

designed by Frauke Ebinger and art 

directed by Diana DeLucia. D iana DeLucia (ddclnyc@ interport.nct) sees the ro le o f 

the graph ic designer changing, and the changes arc 

being driven by technology. As D iana explains, .. Today, a 

graphic designer is as much a marketing consultant as an 

artist . A graphic designer who is fami liar w ith the Web is in 

a better position to help a client solve b ig-picture issues 

than a designer who l imits himself/herself to print .'" 

Diana's design tips: 
1. Don' t forget your role as a marketer. Create an incen

ti ve on a Web page for visitors to return . Examples 

include a flow o f updated information and possibly art 

or multimedia fil es to down load . 



1. 

2 . Web pages should be easy to read. Web visitors spend 

very lit tle time reading pages. Make pages easy to read 

for quick scanning. 

Frauke's design tips: 
1 . Work out a schematic bel'o•·e creating pages. Even if 

it"s rough, a schematic helps to focus your ideas before 

you start designing Web pages (Figure I). 

2. Watch l'or improvements in HTML. HTML has 

already improved in just a few short months. Watch for 

new developments tha t will make Web page construc

tio n eas ier. 



Christina Sun, 
New York, NY 

http:l!wwlv.echonyc.collll-artl 

slltl_stud i o!sutl_SIItd io. h 1111 I 

Christina Sun (chrissun@interport.net) is an illustrator 

who specializes in watercolor and collage for books. 
magazines, newslellers, posters, and fabric design. 

Christina's design tips: 
While working with Photoshop, Christina discovered that 

changes she made in a feature known as target gamma had 

a dramatic effec t on the derail in her images. She not iced that 

a high (2.2) target gamma made her images look washed out. 

A target gamma of 2.2 is optimal for preparing images for 
transparencies, but too hi gh for preparing images for the Web 

or print. Photos hop artists have the option of using curves to 
compensate for the decreased saturation (see Step 3). 

Gamma is a measure of the amount of neutralm idtone 
values displayed in an image. Although target gamma won' t 

be wrillen into the fi le, the value is signi ficant because it 

wi ll affect the adjustments an artist makes to a fi le when 

it's displayed. 

1. Try to match the target gamma of the output device you 
intend to use. For example, the target gamma of IBM 

PC monitors that display Web graphics is 1.8, and the 
target gamma of Macimosh moni tors that display Web 

graphics is 2.0. 
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2 . To control the target gamma settings on the Mac intosh, 

use the Knol l control panel that comes with Phoroshop; 

for the PC, usc the Monitor Setup dialog box under 

Preferences in Photoshop. 

Gamma 

Lo\v number 

High number 

Meaning 

A natTow midtone range provides high 

contrast. A lthough a low target gamma 

w ill result in dramatic blacks and bri l

liant whites, it can mean a loss o f detail 

in images that need a variation o f tones 

( for instance, sk in tones) . 

A target gamma that is too high may 

result in images that look washed out. 

3. To increase the saturation in an image, use curves in 

Photos hop. Open the Curves dialog box by selecting 

AdjustiCurves from the Image pu ll-clown menu . 

Instead of making the entire image darker by dragging 

the curve in the center. try dragging the handle on the 

curve from its starting point (Figure 3a) to the first 

gridline (Figure 3b). This technique causes darker 

areas to become more saturated . but cloesn ' t affect the 

light areas. 



Gail Garcia, 
New York, NY 

__ _,.._.,..,..,. .. ..,. ____ ........... .... 
........ _ .......... _ ........ _.,. .. .,... ......... . 
f .. ....,. ... ~-_...., .......... ..,. ... .... 

Above: Gail:1· Web ccualof? paRe was 

created for Elaine Arsenault, a handbag 

designer in New York City. 

II 11 p :llwww.ecflonyc .coml-arl I a rse 1 w ult I 

arsenault.lllml 

G raphic designer Gail Garc ia (gjgarcia@interport.net) 

specializes in produc t promotion and has a back

ground in print. W hen Gail's c lients approached her about 

designing Web pages, she experimented with software pro

grams a lready familiar to her from he r print work. 

Gail's design tips: 
1. Usc Quark XPre.ss as a layout tool. Use Quark X Press 

to build a layout, saving each page as a separate EPS file. 

2. Open the image in J>hotoshop. A Quark X Press EPS 

image wil l open as an EPS Pict Preview image in 

Photoshop 3.0+ on the Macintosh or EPS T IFF Preview 

on the Windows platform. 

3. Reduce the bit depth . H you 're designing splash 

screens, be careful of file size. Reduce the bi t depth by 

selecting Indexed Color from the Mode pull-down 

menu . (Note: ~/'you already have Indexed Color select

ed. select RGB, and reselect Indexed Color. Experimem 

with smaller bit depthsfor smal/erjile sizes.) 



Bran dee 
Amber Selck, 
Santa Cruz, CA 

•• ~J.t.:>.:l~ .•• b - · - · -

NakamiCI11 • -· - ·- ------ - · ·- -. 

Above and Above Right: Brandee :S· sam

ple Web pagesjimnlhe IUMA sile . Many 

of/he IUMApages provide Web visi1or.1· 

wilh a scrolli11g database wi11dolll thai 

I hey can use to access art isis or labels . 

Above: All of /he Web g raphics vn the 

JUMA sile have a 50s !heme . 

B randee A mber Selck 's art work is one of the most popu

lar Web sires on the Internet. The IUMA (Internet 

Underground Music Archive) si te at http://www.iuma.com is 

a home for over 500 independent, unsigned arti sts who want 

to reach people directly on the Internet. 

Brandee's design t ip: 
Brandee (brandee@iuma.com) encourages Web artists to go 

" hog wi ld" w ith thei r scanners. When Brandee and artist 

David Beach began designing for the 

I UMA Web pages, they scavenged for 

everyday items around the office, at 

home, and at thrift stores. Brandee 

explains, " A lot of the best stuff came 

from Beach's parents' kitchen and junk drawer: a cooking 

pot w ith a copper bottom.tin foil , a gas stove dial , a radio 

knob from a reproduction radio that David bought his dad ar 

K Mart when he was a k id , and various knobs from an old 

Zenith telev ision.' ' 



Shankweiler 
Nestor Desigri, 
New York, NY 

Above: A sample Web page.from a 

Shankwei/er Nestor Web site, art directed 

by Okey Nestor and designed by Lill(/sey 

Payne . 

hltp://www.echmJyc.cotJII-art/Nestor! 

Okey.llllnl 

Okcy Nestor (okey@interpOJt.nel), who taught corporate 

ident ity at Kent State University and owns Shankwcile r 

Nestor Desig n in New York City, feels Web graphics offer a 

graphic designe r broad new potentia ls in communication, 

with characte ristics such as sound , video , and animation. 

Okey's design tips: 
1 . Integr a te your Web site into you r corpor a te identity 

program . lnstead of treating your Web site as a tota lly 

different ent ity, integrate it into your identity program 

and make it work with the goals and strategies o f your 

company's marketing plans. 

2 . O ffer com pelling content within your design . Design 

is not the only part of the story. The Web is an interac

tive medium, so exploit the potentia l by offering your 

customers the abili ty to place orders, pose questions, or 

look up in fo rmation in a database . Be creative with both 

design and content. 



Merry Esparza, 
New York, NY 

Above: Sample imagesfrom the Mo!Jius 

Gallery Web site . 

http:/hvwlv.l/sers .iJIICip o rt .netl-merryl 

mohi1.ts .hlinl 

2. 

F or her work on Web pages, Me rry Esparza (merry 

@inte rpor1.ne t) uses Photoshop and Illustrator. Because 

these two programs have diffe re nt properties, she likes to 

transfer graphics from one program to the other. 

Merry's design tips: 
1. Begin an illus tration with a black and wh ite li ne art 

d rawing in lllustrator and import it into Photoshop. 

2 . O nce the drawing is in Photoshop, create channe ls for all 

the distinct areas in your drawing . Do this before apply

ing any color or tex tures. Channels provide a means to 

record selection areas and , with the various areas record

ed , an artist can easily reselect an area and experiment 

with color (and lex lUres) over and over. 

For example. Me rry creared the tiled floor in the Mobius 

Gallery splash screen (Figure 2) with straight lines in 

Illustrator. When she imported her black and white li ne 

art drawing into Photoshop , she used the Magic Wand 

tool with the Shift key he ld clown to select the ti les she 

wanted to fi ll with colo r. She made n channe l to record 

the selec tion and then experimented \N ith color fills. 



Kleber Santos, 
New York, NY 

Above: Kleber :1· Sjitzzi Web page was 

created.fiJr his virtual tour oft he World 

Financial Center. 

e, T~e Wo~ld Financial Center Virtual Tour . 

Graphic designer Kleber Santos (santos@slinyc.com) 

recommends that Web designers watch the 1-ITML 3.2 

dra ft at http://www.w3.org/hypertext/WWW to keep up with 

changes in the Hypertext Markup Language. 

Kleber's design tips: 
1 . To conserve bandwidth, consider black and 

white images. For his virtual tour of the World 

Financial Center, Kleber used black and white images 

instead of color. Because some of his images are large, 

black and wh ite means smaller file sizes. 

2. Use Adobe Illustrator to create type, rasterize it in 

Photoshop, and save it as a GJF or JPEG. Because 

HTML does not provide a large variation in type faces, 

Illustrator is the best tool to create original type. Save 

the file as EPS, open it in Photoshop, and save the type 

as a GlF or JPEG file. 



Above: Outside view of the World 

Financial Center designed by Cesar 

Palli & Associates and built in 1981. 

Above: The North Cove Harbor Marina 

is tucked behind the World Financial 

Center along the Hudson Rive~front. 

A text A text processor is required to bui ld Web 

processor pages. On the Macintosh, Simple Text 

(which comes with the Mac) is a good 

choice because it automatically saves files 

in the required ASCII format. (Note: See 

Creating a client-side image map 

HTML file later in this chapter.) 

A browser Browser software is used to view the 

Web and is also a tool that can be used 

locally (without a modem connection) to 

view Web pages throughout the design 

process. Web documents are ASCII text 

files that can be opened by selecting 

Open File from the File pull-down menu. 
---

Software Fetch is a popular Macintosh FfP 

to n·ansfer software program used to transfer fi les 

fi les over a over the Internet. Although files can also 

modem be transferred to your provider's server 

with popular communications programs, 

such as White Knight or MicroPhone, 

Fetch is useful because it has functions 

that allow you to create directories and 

delete fi lcs. 
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Finding 
coordinates for 
clickable regions 
with Photoshop 
Summary: Phoroshop's Info palette can 

be used to find coordinares for your map 

file. 

244., Chapter 7 
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1. Plan the hotspot areas. 
The hotspots on Kleber's image map are restaurant and rerail 
store logos (Figure 1). Although image maps can have click
able regions shaped as circles, polygons, rectangles, or 
points, Kleber decided to use rectangular areas to cover the 

various store and restaurant names. 

Photoshop's Info palette shows d1e coordinate position of 
the mouse pointer (measured from the upper-left corner of 
the image). Kleber recorded the palette's readings for a map 
textli I e. To obtain upper-left and lower-right coordinate read
ings for all the restaurant and store logos, he positioned the 

mouse pointer on the upper-left corners and the lower-right 
corners of each of the images. 

1. 

2. Open your image map in Photoshop. 
a. Open Photoshop, and select Open from the File 

pull-down menu. 
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b. Select a graphic in the dialog box that fo llows, and click 

on Open. 
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3. Open the Info palette. 

Deskt op 

rind ... 

( nn~ Aqoln I 

[DOCCI 

Open 

a. Select Show Info from the WindowiPaleltes pull-down 

menu. 

b. The Info palette will appear as a floating palette in the 

Photoshop work area. Press on the Info palette's pop-up 

menu, and select Palette Options. 

c. Press on the Mouse Coordinates Ruler Units pop-up 

menu, and select Pixels . Click on OK. 

a • 
Pole tie Options... II 

"' /,o, 

"' 

3b. 

1=-- ~·~ Info Options 

- rlrst Color Uct~dou t fCEJ r8J Shotu first Color llcodout 
( (DIICC I ) 

Mude: I nctunl Color ..-1 

-Second Color neodoul 

~ ShoUJ Second Color Aeodout 

Mode: I OGIJ Color ... I 

-Mouse Coordlnotes 

~Show Mouse Coordina tes 

Inches 
Centime ters f--
roinh 

3c. 
Plccu 

d. Select one of lhe rectangular areas on your image map 

and place Lhe mouse pointer (in the shape of a crosshair) 

in the upper-left comer. 
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e. Look at the Info palelle, and record the x andy readings 
(in a notebook) as follows: 

x: 210 

y : 257 

f. Place the mouse pointer (in the shape of a crosshair) in 

the lower-right corner. 

3f. 

g. Look at the Info palelle and record the x andy readings 
as follows: 

x: 295 

y : 305 

h. You will need to repeat these steps for all of your 
planned hotspots. 

4. Save t he image as a GIF. 
a. Select Save a Copy from the File pul l-down menu . 

b. Enter a fi le name for your image, and add GIF as the 
extension. 

lo Web / Kleber ?I C) APSOrW '"IIJ 

I!!! I L' iln lll' fhl\ 1 It ( (Jel l ) 
1! t hot wired 
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( New D) 
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SOIJ IJ 

ro rrna t: I I'ICT file ? ) 

4b. 



Tip: GIF and JPEG images can both be 

used in image maps. Although JPEG 

images cannot be seen by as many 

browsers, the file size is ve1y small com

pared to G!Fs. In this example, Kleber's 

montage was 70 K as a Gl F and only 

30 K as a JPEG. 

c. Press on the Format pop-up menu, and select 

CompuServe GIF. Click on Save. 

=-=:-:-~I:Oeli:=O::•:;:•k:::•::::!....l ----,.,= nrs Drlue•· # 1 
CJ flnl s hod pitts I r J•CI ) 
't;th hi Lle.gll 
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Crnte 
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Cancel 
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Creating a 
client-side 
image map 
HTMLfile 

Summary: Unlike se1ver-dependent 
image maps, IVhich rely on an HTML 

.file and a separate map file, client-side 

image maps combine the HTML infor

mation and map in one document. 

248. I Chapter 7 

1. Open Simple Text. a 
Yv Use S i mpleText or a word processor. If you 

use a word processor, be sure to save the 

document as Text Only. Simple Text 

2. Create a new HTML document. 
Start a new document with the fo llowing markup tags: 

<HTI1 L> 

<HEAD> 

<TITLE>The World Financi al Center </TITLE > 

<! HEAD> 

3. Add a <BODY> tag. 
Kleber wanted the browser background color to be whi te, 

which can be accomplished with a BGCOLOR attribute 

added to the <BODY> tag. 

<HTML> 

<HEAD> 

<T ITLE>The World Financial Center</TITLE> 

< / li EAD> 

<BODY BGCO LOR- #FFFFFF> 

4. Add a <CENTER> tag. 
To center the remaining elements, Kleber added a 

<CENTER> tag. 

<HTM L> 

<HEAD> 

<T IT LE>The World Fi nanc i al Center</TITLE> 

<!HEAD> 

<BODY BGCOLOR- #FFFFFF> 

<CE NT ER> 



5. Add an image tag for the banner graphic. 
The <IMG> tag contains an SRC parameter that contains 

the name of an image lile.ln this case, the image is a ban

ner graphic at the top of the page. 

<HHIL> 

<HEAD> 

<T ITLE>The World Financial Center</T!TLE> 

</HEAD > 

<BODY BGCOLOR-/IF FFFFF> 

<CEtHER> 

< HIG SRC- "vi rtua 1 . gif"> 

<!CE NTE R> 

6. Add an image tag for the map. 
Add an <lMG> tag with an SRC attribute, a USEMAP 

attribute, and a BORDER=O attribute. The USEMAP 

attribute indicates a client-side image map. It specifies 

which map to usc with the image, followed by a#, 

fo llowed by the name of the map. 

In this example, Kleber's map image is called WFC.gif. 

This HTML document, which also contains the map infor

mation, will be saved as map.htm, and WORLDTRADE is 

the name of the map. BORDER=O turns off the image 

border. 

<HHIL> 

<HEAD> 

<T IT LE>The World Fi nancial Cente r</TITLE> 

<!HEAD> 

<BODY BGCOLOR-#FFFFFF> 

<CENTER> 

<I MG SRC-"vi rtual.gif"> 

</CENTER> 

<I MG SRC-"W FC .gi f" USEMAP-"map.htm#WORLDTRAOE" 

BORDER-0> 

Client-Side Image Maps J249. 



250.1 Chapter 7 

7. Add a <MAP> tag. 
Inside the <MAP> tag, add a NAME attribute, which speci

fies the name of the map so that it can be referenced by the 

<IMG> tag. 

After the opening <MAP> tag, add an <AREA> tag specify

ing a single cl ickable area of the image. Inside the <AREA> 

tag, use a SHAPE attribute to give the shape of the area, a 

COORDS anribute to describe an upper-left and a lower

right set of coordinates, and an HREF att.ribute to specify 

where a click in that area should lead. Any number of 

<AREA> tags may be specified. This World Trade Center 

example uses nine <AREA> tags. 

<HTML> 

<HEAD> 

<T ITLE>The World Financial Center</TITLE> 

<!HEAD> 

<BODY BGCOLOR-IfFFFFFF> 

<CE NTER> 

<JMG SRC•"virtual . gif"> 

</CENTER> 

< IMG SRC• "WFC. gi f " USEMA P•"map . ht rn/IWORLDTRADE" 

BORDER·O> 

<MAP NAME-"WORLDTRADE"> 

<AREA SHAP E•RECT COOROS-"25.7, 127,84" 

HREF•"yacht .htm"> 

<AREA SHAPE-RECT COORDS-" 151 .8,217.84" 

HREF•"art.htm"> 

<AREA SHAPE•RECT COORDS•"233,6,368 ,84 " 

HREF•"r iver . htm"> 

<AREA SHAPE•RECT COORDS- "1 66 . 132.218.171" 

HREF-"gap.htm"> 

<AREA SHAPE•RECT COORDS-"22.224 ,132,246" 

HR EF•"river.htm" > 

<AREA SHAPE•RECT COORDS•"192.221.278.270" 

HREF•"sfuzz i .htm"> 



<AREA SHAPE-RECT COORDS-"16 ,338. 147 .388" 

HREF- "ataylor.htm" > 

<AREA SHAPE-RECT COORDS-"173 ,339 .235 ,392" 

HREF- "j david. ht m" > 

<AREA SHAPE-RECT COORDS-"266 . 339 .370,389" 

HREF- "rizzol i .ht m"> 

8. Close the <MAP> tag. 
Add a closing <IMA P> tag after the last <A REA> tag. 

<H TM L> 

<HEAD> 

<TITLE>The World Financial Center</TITLE> 

</HEAD> 

<BODY BGCOLOR-#FFFFFF> 

<CEUTE R> 

<IHG SRC-"virtual .gif"> 

<JCEUTER> 

<IMG SRC-"WFC.gif" USEMAP-"map. htmi/WORL DTRADE" 

BOROER- 0> 

<HAP NAME- "WORLDTRAD E" > 

<AREA SHAP E-RECT COORDS-"25 .7,127 ,84 " 

HREF-"yacht. htm"> 

<AREA SHAPE-RECT COORDS-"151.8.217 .84" 

HREF- "art.htm" > 

<AREA SHAPE-RECT COORDS-"233 .6.368,84 " 

HREF-"r i ver.htm"> 

<AREA SHAPE-RECT COOROS-"166 . 132 . 218.171 " 

HREF- "gap.htm"> 

<AREA SHAPE-RECT COORDS-"22 , 224 .132.246" 

HREF-"river.h tm"> 

<AREA SHAPE-RECT COOROS-"192 . 221 . 278 .270" 

HREF-"sfuzzi .h t m" > 

<AREA SHAPE-RECT COOROS- "16.338.147,388" 

HREF- "atay lor. ht m"> 
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<AREA SHAPE-RECT COORDS-"173 .339.235 ,392" 

HREF-"jdavid.htm"> 

<AREA SHAPE-RECT COORDS-"266,339 ,370,389" 

HREF- "ri zzol i. htm"> 

C/~1AP> 

9. Add line breaks. 
Line breaks add space below the image map graphic. Add 

two line breaks after the closing </MAP> tag. 

CHHI L> 

<HEAD> 

<TITLE>The World Financial Cen t erC/TI TLE> 

<!HEAD> 

<BODY BGCOLOR- UFFFFFF> 

<C ENTE R> 

<If.IG SRC-"vi rtual.gif"> 

<If.IG SRC-"WFC.gif" USEMAP-"map.htm#WORLDTRADE" 

BORDER- 0> 

<MAP NAHE- "WORLDTRADE"> 

<AREA SHAPE- RECT COORDS- "25,7 ,127 ,84" 

HREF- "yacht.htm" > 

<AREA SHA PE-RECT COO RDS-"151.8.217.84" 

HREF-"art .ht m"> 

<AREA SHAPE-RECT COORDS-"233.6 .368.84" 

HREF- "river.htm"> 

<AREA SHAPE-RECT COORDS-"166 , 132. 218.171" 

HREF- "gap .ht m"> 

<AREA SHAPE-RECT COORDS-"22.224, 132 .246" 

HREF-"river.htm"> 

<AREA SHAPE-RECT COORDS-"192.221 . 278 . 270" 

HREF-"sfuzzi .htm"> 

<AREA SHAPE-RECT COO RDS-"16 . 338 ,14 7. 388" 

HREF-"atayl or .htm"> 

<AREA SHAPE-RECT COORDS-"173,339,235,392" 

HREF- "jdavid . htm"> 



Tip: Bmwsers that supporr client-side 

image nwps include Netscape 2.0 and 

3.0, SpyGlass Mosaic, and Microso.fl 's 

Imemet Explore1: 

<AREA SHAPE-RECT COORDS-"266 ,339 . 370 . 389" 

HREF-"ri zzol i. htm"> 

<~NAP> 

<BR> 

<BR> 

10. Add text. 
Kleber added a line of text after Lhe line breaks to give Web 

visitors directions. 

<HTML> 

<HEAD> 

<TITLE>The Wo rld Financial Center</TITLE> 

<I HEAD> 

<BODY BGCOLOR-#FFFFFF> 

<CENTER> 

< ItiG SRC-"vi rtua 1 . gif"> 

<IMG SRC•"WFC.gif" USEMAP•"map .ht m#W ORLDTRADE" 

BORDER-0> 

<t·1AP NAME•"WOR LDTRADE"> 

<AREA SHAPE-RECT COORDS-"25 ,7,1 27 ,84" 

HRE F•"yacht . htm"> 

<AREA SHAPE-RECT COORDS-"151, 8,217 .84" 

HREF•"art. htm"> 

<AREA SHAPE-RECT COORDS-"233 .6 ,368 ,84" 

HREF-" river. htm"> 

<AREA SHAPE-RECT COORDS•" 166 ,132 . 218. 171" 

HREF• "gap .ht m" > 

<AREA SHAPE-RECT COORDS-"22.224 ,132 . 246" 

HREF-"ri ver. htm"> 

<AREA SHA PE-RECT COORDS•"l92.221 .278,270" 

HREF•"sfuzzi .htm" > 

<A REA SHAPE•RECT COORDS-"16.338 ,147. 388" 

HREF-"ataylor.htm"> 
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Tip: Kleber's email address has a 

MAILTO URLadded to the HREF 
attribute, which is part of cur anchor link. 

When a Web visitor clicks on the email 

link with a MA ILTO URL, a blank email 

form appears with the address already 

filled out (Figure I 1 ). 

Dl Send MoiVPDt.l NeUJ\ 
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Rliech ... 
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<AREA SHA PE-RECT COORDS-"173,339 , 235,392 " 

HREF-"j david.htm"> 

<AREA SHAPE-RECT COOROS-"266,339 ,370,389" 

HREF- "ri zzol i. htm"> 

<!MAP> 

<BR> 

<BR> 

Select individual elements of the above image to go 

on a virtual tour. 

11. Add the signature area. 
Although signature areas generally contain the 

<ADDRESS> tag, Kleber limited the signature area to an 
email address. He added a MAIL TO URL £0 the HREF 
attribute so that viewers get a blank email form when they 
click on the email address (Figure I I). 

<HH1 L> 

<HEAD> 

<TI TLE>The World Fi nancia l Center<IT ITLF> 

<! HEAD> 

<BODY BGCOLOR-/IFFFFFF> 

<CENTER> 

<I MG SRC-"vi rtual .gif"> 

<IMG SRC-"W FC .gif" USEHAP-"map . htmiJWORLOTRAOE" 

BORDER-0> 

<MAP NAME-"WORLOTRAOE"> 

<AREA SHAPE-RECT COOROS-"25,7,127.84" 

HR EF-"yacht.htm"> 

<AREA SHAPE-RECT COOROS-" 151.8.217 .84" 

HREF-"art.htm"> 

<AREA SHAPE-RECT COORDS-"233,6 ,368,84" 

HREF-"river.htm"> 

<AREA SHAPE-RECT COOROS- "1 66,132,218 ,171" 

HREF-"gap.htm"> 

<AREA SHAPE-RECT COORDS- "22 , 224 , 132,246" 

HREF- "river.htm"> 



<AREA SHAPE-RECT COORDS-"1 92 , 221 ,278 , 270" 

HREF- "sfuzzi . htm"> 

<AREA SHAPE-RECT COOROS-"16 , 338,147 ,388" 

HREF- "atay l or. ht m" > 

<AREA SHAPE- RECT CODRDS-"173 .339 , 235 ,392" 

HREF-" jdavid.htm"> 

<AREA SHAPE- RECT COORDS- "266 ,339 , 370, 389" 

HREF-"ri zzol i. htm"> 

<!MAP> 

<8R> 

<8R> 

Sel ect i ndi vidual elements of the above image t o go 

on a virtual tou r. 

<ADDRESS> 

<A HREF-"Ma i l t o: Ksantos@echonyc . com"> 

Ksantos@echonyc.com 

<lA> 

12. Add the ending tags. 
</ BODY> 

<I HH1L> 

13. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) renect 

the HTML 3.2 specification. 

<B> ... <IB> 
A rag used to apply boldfacing to text. 

<BR> 
A tag used to add a line break. This tag does not require 

an ending tag. 

<BODY> ... <IBODY> 
A tag used to open and close the body of a document. 

This tag uses the BGCOLOR attribute, which adds 

color to a browser page. For example: 

<BODY BGCOLOR-"IIFFF FFF" > 
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<CENTER> ... <!CENTER> 
A tag used to cemer elements on a page. 

<HEAD> ... <!HEAD> 
A tag used to open and close the header portio n of a 

document. 

<HTML> . .. <IHTML> 
A tag used to open and close an HTML document. 

<IMG> 
Used to refer to an inline image, this tag uses the SRC 

attribute, which represents the URL 

(location) of the image. For example: 

<IMG SRC-"vi rtua l .gif"> 

This lag also uses the USEMAP attribute, which indi

cates a client-side image map. £t specifies wh ich map to 

use with the image, fo llowed by a #, followed by the 

name of the map. For example: 

<IMG SRC- "WFC.gif" USEMAP- "map. htm#WORLDTRADE" 

BORDE R-0> 

MAILTOURL 
The MAIL TO URL is used in an email link inside the 

signature area of a document. Viewers who click on a 

link containing a MAIL TO URL will gel a blank emai l 

fo1m with the address filled out. 

<MAP> .. . <!MAP> 
A tag used to describe the reg ions in an image and 

where each region links. 

This tag uses the NAME attribute, which specifies the 

name of the map so that it can be referenced by the 

<IMG> tag. An <AREA> tag is used between the 

<MAP > ... <!MAP> tags. <AREA> tags specify a single 



Tip: Look f or an example of a client-side 

image map at hllp:l/www.mis.llccu.edu.twl 

- bibo//ablclielll_side_ilnage_IIIOp.lltlnl 

and hI tp :I l www.learned. coml-apex/ 

imagemap.html. 

clickable area of the image. This tag uses the SHAPE 

attribute to give the shape o f the area, a COORDS 

attribute to describe the coord inates o f an area, and an 

HREF attribute to specify where a click in that area 

should lead. 

<TITLE> ... <!TITLE> 
A tag used to describes the title of a document, which 

shows up inside a browser's title bar. 

Client-Side Image Maps 1 257. 



Use PhotoGIF 
with Photoshop 
to create a 
transparent GIF 
Summary: BoxTop Software's 

PhotoG IF plug-i11 added to your 

Photoshop folder gives you the ability to 

save tra11spare11t G!Fs and interlaced 

G/Fs. 

!I ..,ehrope: HU! Ulorld Jlnlntlll Cenl er W 

-~-tJ_;J LJ ~~_::j..2J _j II 
l-·~· lf'llfllft);('ll:rJIVf'fC:2U:4'0i'loM4o/)of ... '!l\l.c-.l I 
iliiM.'t...,._• l "'•l•'-1"( ~ I W.ltnr,._ ! .-,tOno:!MJJ~ 

~k1bL"'I"'o:uat t~.IIIOIC'w.._t"1111(11 

~to••~'Ulll.t:c 

J:.~Wrtu.os !HAILIII1!lW ~ 

~ 
PhotoG IF 
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.. 

W hen a Web visitor clicks on the Sf'uzzi logo (lop left), 

they branch to another HTML document wi th its 

own image map. On this page, the button choices are trans

parent GIF images, which Kleber created in Photoshop and 

saved using BoxTop Software's PhotoGJF plug-in. (Note: 

PhotoG IF is a shareware software program available on the 

CD-ROM in the back of this book.) 



1c. 

1. Open a Photoshop image. ~ldo l Mod• 

Before opening Pholoshop 3.0, Kleber placed 

the PhoLoGIF plug-in into the File Format 

folder inside Photoshop's plug-in folder. 

(Note: If you 're using Photoslwp 2.5, place 

the PhotoGJF plug-in into Photoshop's Plug

info/del:) 

a. Open Photoshop, and select Open from 

the File pull-down menu. 

NCIU... fJC N 
I 

Pldre.. "' 

(IO\ l ' Ill 
Souf' 1i'S 
')OUt• fh ... 

\IWt• d lOV!J ••• 
llf'UCI I 

Require 
ruporl 

ltl~ Info •.. 

I'DIJI' il'IUII.,, 
t' tml .. •r 

Preferences ~ 

Quit 1!0 b. Select an image from the dia log box, and 

click on Open. 1a. 

Thumbnail 

freatl.' 

1b. 

l '1up2 
1l Mop2.glr 
~nswe 

le oook •I 

1l OUTOODR.PS 

1l f'ork sign 
1)Piote 
1l Plo tc .glr 

Puzz le piece 

rormol: Pholushop 3.0 ~03K 

[8') Sh ow Thumbnail 0 SIIOIU 011 riles 

c::::) nrs Orlue'" • t 

LJet l 

Desk tot• 

find ... 

( J111d nq .. rn ) 

Con col 

Open 

c. The image opens in a Photoshop window. 

2. Open the Info palette. 
a. Select Show Info from tJ1e WindowiPalettes pull-down 

menu. 

b. The Info palette wi ll appear as a noating palette in the 

Photoshop work area. 

luom In •: 
loom Out -c-
t'oorn r.,, tnr ... 

~how nul (I I \ •• n 

2a. 

Show Brulhet 
Show Options 

Show Picker 
~how Sw a tches 
Show Scratch 

lllde t oyt!n 
Show Channeh 
Sl1ow Pnths 

Shoau Commb tds 

r:; ru 
I r Info"" 1~ 1 

R· 226 
/,G· 226 

' a 226 

+. ~: 210 
257 

2b. 
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Info 
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3c. 
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II 

I ~ 

Dllill £dll "'1ode 
,,ew ... ICN 
Open ... ICO 
rtuf f' ... 

Close li lU 
Soue XI 

SDIJC a [ Op!J ... 

Ot•UPI' 

Require 
hport 

rue Into ... 

Page Setup ... 
Print ... 3€P 

tlul l ItO 

4a. 

3. Test the RGB value of the background color. 
Kleber's image is a set of oval buttons that float on a green 

background. Because the background wi ll drop out as the 

transparent shade, he chose green because it's not in the 

image. 

a. Select the Eyedropper tool from Photoshop's 

Toolbox. 

b. Hold the Eyedropper over the backgro und. 

sruzzlps.plct ( 1:1) 

3b. 

c. Note the RGB value in the Info palette. 

3a. 

d. When the image is saved as a transparent GIF, the green 

background will drop out. 

4. Save the image as a transparent GIF. 
a. With the image open, choose Save As from the File pull

down menu. 

b. Select GIF89a from the Format pop-up menu. This is the 

extension for transparent GIFs. 

=-=,..,..,.~lo~o=o•=k=•::::!l ___ = = llPSDrk!e- " I 

I I lOll I 
I llo•klol• I 
I 'IPIOI c:::J I 

4b. 
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PhteiPalnt 
Row 

Cnntel 
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PttotoGif b OoHTop Sollwore 

(® Glf89oll Want Bells and Whistle s) 

0 Gif87o (No Bells and Whl•tlesl 

[

0 fHpl1a for Tntnspbr('nty: 

® Color forTranspnrcncy: fll!1 
O None ~ 
® Interlace Me. Bab!JI 

0 Strip Resources lloke It oil o f Ill 

I forget lt ... I fi Yeah lure ... ) 

5a, 5b, 5d, 5e. 

B: 0 

~ 

iLJOI 
5c. 

c. In the dialog box that fo llows, enter a file name and 

click on Save. 

= -:-:-:-:--,..!(:=el:=B::•::•k::•=-.1 -----.,., = Ill'S llltue'" # t 

D finished pit ts I 1 feet I 
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rorrnn t: I GIT09a •I 

4c. 

5. Make selections in the PhotoGIF dialog box. 
a. In the BoxTop Software dialog box, select the radio 

button next to GTF89a. 

b. Click on the color selection square to choose a transpar

ent color. 

c. In the dialog box that fo llows, choose a color, and cl ick 

OK. (Note: The PlwtoGIF plug-in will assume that the 

background color drops out as transparent. The RGB 

value displayed should match the value you tested with 

the Eyedropper tool.) 

d. Click to put an X in the box labeled Interlace Me, Baby! 

e. Click on Yeah Sure. 

f. When the image is loaded into Netscape, the green 

background wi ll be transparent. 

Client-Side Image Maps [ 261. 



Use Fetch to 
upload files to 
a provider's 
server 
Summary: Jim Mal/hews' Felch is a 

Macintosh shareware FTP utility that 

can be used to transferjiles to andjro111 

file se1vcrs on11le Internet. Look for 

Fetch on the CD-ROM in the back of 

this book. 

I 

:::.;;;. Open Connctllon •.. 

£n t er hos t nome. user name, and IJDuword 
(or choose f rom the Jflort cu t menu): 

Host: 

User 10: 

Password: 

Dlreclory: 

Sllor1cuts: 

3a. 

Fetch 

I www.cchonyt.rom I 
!circuli I 
I········ I 
I I 

El ( Cnncul ) CE:J 

hlth: IUIUIIJ. It<hOIIIC.,(Um ~ 

O•••t 

IJl ........ .,"' .. ,,., ... 
'"~' .. 

""""' , ........ 

lj.., ........ . O••.,IJ ., 

3b. 

• · Customlte 
Change Directory ... 

4a. 

£nter o nnme for the new dlrcciOitJ: 

l son1o~ 

4b. 
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To use Fetch to transfer li les to your provider's server, 

you' ll need to obtain a host name (the name of the serv

er), a user TD, and a password. 

1. Open your Internet connection. 
Click on the Open button in the ConfigPPP Control Panel to 

get on the Internet. 

2. Open Fetch. 
Open Fetch by double clicking on the Fetch icon. 

Fetch 

3. Log in to your provider's server. 
a. In the Open Connection dialog box, enter the host 

name, user ID, password, and directory name you 

obtained from your provider. This step is referred 

to as loggi11g in. Click on OK. 

b. You should be connected to your provider's server 

quickJy. Look closely at Fetch's principal dialog box 

and notice the word Connected under Status. 

c. Notice the name of the directory you 

obtained from your provider over the 
lile list window (Figure 3c). 

4. Create a directory. 

3c. 

art ~ I 

a. Select Create New Directory from the Directories pull
down menu. 

b. Enter a new directory name in the dialog box that 

follows. 

5. Upload a text file to your directory. 
a. Click on the Put File button. ( Put File .. . ~) 

b. Use the lile list window in !he dialog box 5a. 

that fo llows to select a text file that you would like to 

upload. Click on Open. 

lo lmn~emo(! l lo send.., I C) m•!. ortue' .. 111 

~~ santo~.h tml I [Je<1 I 
~ Snn1o•2.html 

I Deskt op I ••ru.gu 
• sluSbkg.gll -
~ s lubor.h1ml I Cnncel I f'-1 siUbOH.jpg 

I ) . Open 

5b. 



Soue file on www.echonyc.corn os: 

I s furnenu.html. lu ~ 

r ormot : I Teut 

Sc. 

SOUC fil e 00 WIUlU.C CIIDII!J C.COUI OS: 

j s rurnenu.htrnl 

rormol: ,_I ...;.T.;;.cH;.;.I ___ •_,I ( Cnnccl ) GJ} 

Sd. 

Se. ~ 

Fetch 

Sf. 

" .... 
" 

le> l rnogomoe/ to send ... I 
~~ snntos.html 

Sontos2.html 

1Q sfu5bkg.glr 
f!l sfuber.html 
'I s fuboss.jpg 
~ sfumenu.html 

6b. 
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6c. 
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6d. 

c. When you select a file, Fetch identifies the file format as 

Text. Notice the pop-up menu in the dia log box 

(Figure 5c). 

d. If you' re uploading map files or HTML files as text, 

only the .MAP and .HTML extensions are important. 

Delete the .TXT extensio n that Fetch adds to the end of 

the file name (Figure 5d). C lick on OK. 

e. Fetch 's dog will run while your fil e is uploading. 

f . When the file is uploaded, you will see the name 

djsplayed in the file list window in Fetch's principal 

dialog box. 

6. Upload a graphic file to your directory. 
a. Click on the Put File button. 

b. Use the file list >vindow in the dia log 

[ Put File ... ~) 
6a. 

box that follows to select a graphic file that you would 

like to upload. 

c. When you select a file, Fetch identi lies the file format as 

MacBinary II (Figure 6c). 

d. It is important that you do nol send a graphic file to a 

Urux server as a MacBinary fi le. Press on the pop-up 

menu next to Format, and se.lect Raw Data. Click on 

OK. 

e. When the file is uploaded, you wi ll see the name 

displayed in the file list window in Fetch's principal 

rualog box. 

Fetch 

D,,..,.,_ . 
D ,~.,. 
0 ....... , ... 
0••-"'"" 

Go. 
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® Automatic 
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Q IIIIUIIIJ 
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7c. 

(Close Connection 3CW) 
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D11en Bookmork .. . 
Open Shortcut 
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Bb. 
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fli 

7. Delete a file. 
a. Select a file in Fetch's principal dialog box. 

b. Select Delete Directory or File from the Remote pull

down menu. 

c. Click on Delete in the dialog box that follows to verify 
you want the file deleted. 

8. Exit Fetch. 
a. Click on the Close Connection button in Fetch's 

principal dialog box. 

b. Select Quit from the File pull down menu. 
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Video 
Streaming video is d1e latest technique for add ing a video clip to 

your Web page. Streaming means there's no waiting for a video fi le 

to download. The tile is instanlly transferred for viewing on Power 

Macimosh and Windows 95/NT machines. Of the options avai lable 

on the market, digital video expert Marc T horner recommends 

VivoActive, which does not require special software or hardware on 

the Web server. 

In tlus chapter, you' ll leam how to compress a video file using a trial 

copy ofYivoActive Producer software and leam facts about Apple's 

QuickTime Plug-in, which allows you to embed QuickTime movies 

on a Web page. You' ll also learn how Premiere's Movie Analysis 

Tool can be used to examine movies you download, plus Steven 

McGrew offers tips on capturing and compressing. 





Marc Thorner's 
tips on using 
VivoActive 
Producer to 
create streaming 
video 
Summary: Download a copy of 

VivoActive Producer to create a com

pressed video stream viewable with the 

VivoActive Playa Find both software 

programs at http://wwll'. vivo. com. 

ld. 

,livo Ac tivo? Producer (Tria 1) 

l a. 

Protriew 
ClMG( 2 

OJ!D 
~ 

~ 
~~~·•·•~'"~m~foJ~.,~· ----~ ~ 
C!] \ h(ltlj r uvll!w 

Tip: The film clip image in this section 

was provided by Fabulous Footage at 

http://www.FOOTAGE.IIet:2900. 

Take advantage of Vivo Software's trial download to 

experiment with VivoAclive Producer software, whkh 

compresses video at a ratio of200: I. Build a streaming video 

file for Web visitors to see with the VivoActive Player. 

1. Open a movie in VivoActive Producer. 
a. Start VivoActive Producer. 

b. The VivoActive software will be displayed. 

c. Select Open Movie from the Fi le pull-down menu. 

d. In the dialog box that follows, selec t a movie to be 

compressed, and c lick on Open. 

e. Your movie's file name will appear in a File List in 

the YivoActive Produce r wi ndow. 

(, I'IIIIIU. 

lluH 

1c. 

lb. 

1e. 

Video 1267. 
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Modem Ht&d i he' 

Vivo Active Guide 
1g. 

[Gene-r:ah Selection) 

2a. 

J• ) ] I C •l 1 
(lot 1 • . . ... httt I"Wl "' ' ' 
H• • II r ..-~, t..l tt. Ool\ 

2b. 

11·~ 

Tip: Follow the directionsfor using the 

<EMBED> tag in the next section as a 
guide for embedding a VIV file on a Web 

page. 
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statul'.mov 
3a. 

statul' .viv 
3b. 

f. SelectApplyiModem High Motion from the Seuings 
pull-down menu. Thi s wi ll apply a data rate and a 

frame rate that is suitable for a modem transfer. 

g. Documentation for VivoActive Producer is in the form 

of a VivoActive Guide. When you install the 

VivoActive software on a Power Macintosh, this 

document gets installed as an Apple Guide, which is 

accessible from the Guide pull-down menu in the 

Macintosh Finder. 

2. Compress the movie. 
a. Click on the Generate Selection button at the base of 

the VivoActive software window. (Note: Tile 

Generate Selection button will only be available if 
your movie 'sfile name is selected.) 

b. The software will display the original movie and the 

compressed version while it is being compressed. A 

VTV file will automatically be saved in the folder 

where your movie is located. 

c. Should you decide to generate another compressed 

movie with an alternate setting from the Seuings pull

down menu, a click on the Generate Selection button 

will display a Save As dialog box. You wil l need to 

save new movies under a di ffcrent file name. 

[
'] QE!I:J ~ 
~ 

'------"" 

2c. 

3. Compare file sizes. 
a. The original compressed movie file (compressed with 

Cinepak) is 1.3 MB. 

b. The VIV file following compression in VivoActivc is 

48 K. An Intranet High Motion setting produced a 
204 K file. 



Experiment 
with Apple's 
Quicklime Plug-in, 
and embed a QT 
movie on a Web 
page 

Summary: Build a page with an 

embedded QuickTime movie viewable 

with Apple's QuickTime plug-i11. 

Download a copy of the plug-in f rom 

http://www.quicktinle.apple.coJn. 

Also, look for dew ils on how to config

ure your browser to work with the 

plug-in at http://www.quicktime.apple 

. comlsw/browserconjig. htJnl. 

Tip: The film clip image on this page 

was provided by Fabulous Footage a t 

http://www.FOOTAGE.net:2900. 

Follow these steps to experi ment with Apple's QuickTime 

plug-in. Download the software, configure your browser, 

and create a Web page with an embedded QuickTime movie. 

1. Download an all·in·one Quicklime bundle . 
a. Visit http://www.quicktime.apple.com, and follow the 

links to A pple's "Easy Download" for Macintosh. 

One download includes QuickTime 2.5, MoviePlayer 

2.5, and the QuickTime plug- in for Netscape. 

b. (Optional) Download the MPEG Extension 1.0 for 

Lhe Power Macintosh at the same location. When the 

QuickTi me M PEG extension is installed in your 

Power Macintosh System folder, the MoviePiayer 

application will be able to play M PEG fil es. 

2. Add the Ql plug-in to the Plug-Ins folder. 
Drag the new QuickTime plug-in to the Netscape Plug-Ins 

folder inside the Netscape Navigator fo lder. You wi ll need 

to re-start the browser for the new plug- in to work , and 

you may need to visi t hllp:l/www.q uicktime.apple 

.com/sw/browserconfig.html for deta ils o n how to get 

your browser to recognize the new plug- in. 

3. Embed a Quicklime movie in a Web page. 
Q uickTime movies, QuickTime VR Pano ramas, and 

MPEG movies may a ll be embedded in a Web page using 

an <EMBED> tag. 

Video 1269. 



Tip: If you do not know the width and 

height of your QuickTtme movie, open 

the movie in the MovieP/ayer 2.5 appli

cation, and select Get Info ftvm the 

Movie pull-down menu. In the dialog 

box that follows, select Sizefrvm the 

File pop-up menu. The width and height 

will be displayed. 

= 

Normal : 160 x 120 pixels 

Current: 160 x 120 pixels (Normal) 
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a. Open SimpleText. Use SimpleText or your word 

processor. If you use a word processor, be sure to save 

the document as Text only. 

b. Create a new HTML document. Start a new docu

ment with the following markup tags: 

<HTHL> 

<HEAD> 

<TITLE>Sample Movie</TITLE> 

c. Create a body tag, and add color attributes. (Note: 

See the Online Tools chapterfordetails on how to 

select colorfor your Web page.) 

<HTHL> 

<HEAD> 

<TITLE>Sampl e Hovie</TITLE> 

<BODY BGCOLOR-"#000000"> 

d. Add a <CENTER> tag. The center tag will center 

the QuickTime movie on the page. 

<HTM L> 

<HEAD> 

<TITLE>Sample Mouie</TITL E> 

<BODY BGCOLOR- "#000000"> 

<CENTER> 

e. Add an <EMBED> tag. In this tag, the width and 

height of the embedded QuickTime window is 

defined in pixels. Add 24 pixels to the height of the 

movie for the de fault CONTROLLER. The width and 

height attributes are required for both QuickTime 

movies and QuickTime VR panoramas. 

Optional attributes include: 

• The CONTROLLER anribute, which may be 

set to TRUE or FALSE. The value contro ls its 

visibi lity. TRUE is the default setting for the 

CONTROLLER. 

• The LOOP attribute makes the movie play in a 

loop. Optional values include TRUE, FALSE, or 

PALINDROME, which makes the movie play 



alternately forwards and backwards. 

PALINDROM E should not be used with 

QuickTime VR panoramas. The default value for 

LOOP is FALSE. 

• AUTOPLAY causes the movie to play as soon as 

the plug-in est imates it has enough data to play the 

entire movie. Optional values include TRUE and 

FALSE. The default value for AUTOPLAY is 

FALSE. 

<HTML> 

<HEAD> 

<TITLE> Sampl e Movie</TlTLE> 

<BODY BGCOLOR- "//000000"> 

<CENTER> 

<EMBED SRC- " statue .mov" HEIGHT-144 WI OTH-160 

CON TROLLER- TRUE LOOP- TRUE AU TOPLAY- TRUE> 

f. Add closing tags. 

<!CENTER> 

<I BODY> 

<IHTML> 

g. Save your document, and test it in Netscape. Save 

your document. Open Netscape, and select Open File 

from the File pull-down menu. In the dialog box Lhat 

fo llows, select your HTML document, and click on 

Open. Make sure your movie file is in the same direc

tory as your HTML document. If you have the 

QuickTime plug- in installed, and you have the 

Netscape browser configured to identify the plug-in, 

the movie wi ll load and play. (Note: At the time of this 

writing, Apple Co111puter has not yet finished docu 

mel!ting and testing the Internet Explorer 3.x browser 

and the QuickTi111e plug-in. ) 

Video 1271. 
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Summary of HTML tags used in this section. 
T he tags you see in this list (in alphabetical order) reflect 

the HTML 3.2 specification. 

<B> ... <IB> 
A tag used to apply boldfacing to text. 

<BODY> ... <!BODY> 
A tag used to open and close the body of a document. This 

tag uses the BGCOLOR="#RRGGBB" or hexadecimal 

red-green-blue triplet attribute, which adds color to a 

browser page. For example: 

<BODY BGCOLOR•"#ffffff"> 

<CENTER> . .. <!CENTER> 
A tag used to center e lements on a page. 

<EMBED> 
A tag used to embed elements on a page. In this example, 

tl1e element is a movie fi le. This tag uses tlle SRC attribute 

to indicate tl1e source of the movie fi le. The WIDTH and 

HEIGHT attributes are used to describe tlle size of t11e 

movie in pixels with 24 pixels added to the height to 

accomodate the movie controller bar beneatll the movie. 

The CONTROLLER attribute controls the visibility of 

tlle controlle r and may be set to TRUE or FALSE. The 

LOOP attTibute makes the movie play in a loop and may 

be set to TRUE, FALSE, or PALINDROME, which 

makes the movie alternately play forwards and back

wards. TheAUTOPLAY attribute makes the movie 

begin playing as soon as the plug-in has enough data and 

may be set to TRUE or FALSE. For example: 

<EMB ED SRC•"statue.mov " HEIGHT-144 WIDTH-160 

CONTRO LL ER-TRUE LOO P-TRUE AUTOPLAY• TRUE> 

<HTML> .. . <IHTML> 
A tag used to open and close an HTML document. 

<HEAD> . .. <IHEAD> 
A tag used to open and close the header portion of a 

document. 

<TITLE> .. . <!TITLE> 
A tag used to describe tlle title of a document, which 

shows up inside the browser's title bar. 



Use Premiere's 
Movie Analysis 
Tool to learn 
about data rate 
and compression 
settings 

Summary: Familiarize yourself with the 

performance specs of movies you down

load.from the Web. 

Projec t Malee Clip Windows 
.--'------"-;~-, 

1. 

2. 

Op en... 3€0 
Import ~ 

Capture ~ 

Close 3€W 
Saue ;lilS 
Saue As ... 

~ ~~--~~-----. 
Conform Mouie •.. 

Euport 
Tools ~ 

Folder Cleaner ... 
Page Se tup... • · • • 
Pt int... 3€P 

Batch Mouie Maker ... 
Preferences ~ Miniatures ... 

Quit 3€0 
Project Trimmer ... 

RppleTal lc Control ... 
Ke board Shortcu ts ... 

Choose a tile or rolder to analyze: 

]ei! Mork •I f:::) nPS Urluc'" 

1 ~-!loy.,lce.qt 0 ( r Jeri I D lccCreom.mou 
D Lll Ooy.ort ( Ocskllll' I 
D ll ocompressed MooU 
D test.mou ( Cnncel I 

In ~ u,H.-n n 
( Select 'Mork' I Q§!i!~!J~I 

( rind ••. ) ( Fond Agaon J 

Tip: The film clip image on this page \Vas 

provided by The Image Bank, Inc., a 

source for still photographs, film footage, 

and illustrations (800-T/B-images). 

Adobe Premiere ' s Mov ie Analysis Tool provides a 

valuable means to learn about movie specs, inc luding 

average frame rate. data rate, compression 

settings, and audio quality. r:; 
Adobe P~e-mi e r e TM 

1 . Select the Movie Analysis Tool. 
Select ToolsiMovie Analysis from the File pull-down menu. 

2. Select a movie to analyze. 
Use the file list w indow in the dia log box to locate the movie 

you would li ke to analyze. Click on Analyze. 

3. Print the specs. 
Select Print from the File pull-down menu to print lhe specs. 

The Web is considered " low bandwidth". 

The World Wide Web is considered a "low-bandwidth" 

appl ication for d igital movies, considering that the aver

age Web visitor uses a 14.4 Kbps modem to download 

movie fi les. Compare this to an average hard drive, which 

can transfer data at only 300 Kbps. If you want Web vis i

tors to down load movie fil es, special attention should be 

g iven to fi le size. 

Capture settings. 

Nearly every item in this movie analys is report (except fo r 

the file name) can be traced back to the capture settings. 

Video 1273. 



§[B= Analysis of Boy_ice.qt ====!ill~ 

Movie: 
File nam• is "Boy _leo .qt " 

Q 
Filo siz• is 434.4K 
Averag~ data rat ~! is 4 1.9K per second 
II contains 1 vidoo track( s) and 0 aud io tracl:(s). 

Video : 
This movl• appoar s to havo DROPPED FRAMES. 
Thoro ar e 20 framos with a duration of 1 / loth. 
Thoro ar e 60 fr amos with a duration of2/ 15 ths. 

Vidoo tr acl: I : 
Duration is 0 :00 :10 :12 
Aver ago framo rat• is 8.07 fps 

Vidoo track I contains I typ•(s) of video data : 

Vid•o data block 0 1 : 
Framo Siz• = 160 x 120 
Compressor = Cineopak 
Quality = Nor mal (3 06) ~ 

B 

,o===- Analy sis of Secret.qt ~ ~0: 

Movie : ~ File- name is "Se cr e t .qt" 
Fil• siz• is 3.2M 
Average data ra te is 76.6K per second 
It contains I vidoo track(s) and I audio track(s). 

V1doo : 
Th• r·• ar • 4 3 1 fram•s with a duration of I I I Oth. 

Video track 1 : 
Durat ion is 0 :00:44 :05 
Av•r ag• fram• rate is 10.03 fps 

Video t rack I contains I typo(s) of v ideo data: 

Video data block 0 1 : 
Fram• Sizo = 160 x 120 
Compressor = Cint;;pak 
Quality = High (4 .00) 
T•mpor a l = High (4 .00) 

Audio: 
Audio traok I contains I type(s) of audio data : 

Audio data block •1 : 
Format= 8 bit- Mono tn; 
Ra t• = I I 127 Hz !;?;: m 

274. 1 Chapter 8 

The choices you make when you dig iti ze movie data will 

determine a movie's characteristics. Consider the following 

movie characteristics with respect to the World Wide Web: 

Movie spec 

file size 

If the movie is for the Web ... 

File size will affect lhe amount of 

time a Web visitor will have to wait 

for a download to be completed. 

To calculate the amount of time it 

will take to download a movie a t 

different modem speeds, div ide 

the modem speed ( 14,400 or 

28,800) by 8 because the re are 8 

bi ts to one byte o f da ta in this sit

uation. Divide the number that 

represents the size o f your movie 

fil e by this number, then div ide 

by 60 (60 seconds per minute). 

This will g ive the (theoretical) 

number of minutes required to 

download a mo vie fil e. 

(Note: When movie data is trans

f erred over telephone wire, even 

if a Web visitor has a 28.8 Kbps 

modem, this bandwidth may not 

be available everywhere. Certain 

areas have a maximum band

width of2.4 Kbps.) 

average data rate Data transfer inside a computer is 

measured in ki lobytes per second. 

Because a Web visitor downloads 

movies and then plays them on a 

hard drive, your movie's data rate 

should not exceed I 00 to 200 

Kbps, because the data rate of an 

average hard drive is only 300 

Kbps. If the movie data rate is too 

fast, the movie will drop frames. 



average frame rate When you capture a movie, frame 

rate is a function o f the computer's 

processing power or the speed of 

the hard drive depending on 

whether the movie is captured to 

RAM or to the hard drive. Ideally, 

the frame rate should be a function 

of the playback requirement. 

However, download time is an 

important factor when you create 

movie fi les for the Web, and a 

higher frame rate implies larger 

files. (Note: See Steven McGrew's 

tips on capturing and compressing.) 

frame s ize 

compressor 

audio format 

sample rate 

sample size 

number of 

channels 

Frame size affects file s ize, so 

Web movie frame size should be 

limited to 160x 120. 

QuickTime has seven software 

compressors built in: Animation, 

Cinepak, Component Video, 

Graphics, Photo-JPEG. None, 

and Video. 

Three sound compo nents affect 

sound data rate: 

the number of sound samples per 

second 

8-bit or 16-bit 

mono or stereo; choose mono 

because ste reo sound can only be 

heard on stereo-capable hardware 

Video j 275. 



Steven McGrew's 
tips on capturing 
and compressing 

Summary: When you 're creating 

movies for the World Wide Web, the 

choices you make during capture and 

compression set the file characteristics. 

Leam about the variables that will affect 

the size and quality of your movies. 

Tip: The film clip image on this page was 

provided by The Image Bank, Inc., a 

source for still photographs •. film fool age, 

and illustrations ( 800-Tl B-images). 
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Steven McGrew, who is a digital med ia designer/ani

mator at the University of Oregon, offers the following 
advice on capLUring and compressing. 

1. Evaluate your material. 
Before you capture a single frame, look at your material and 

think about issues such as frame size. Can the movie be cap

tured at 320x240 or is 160x 120 large enough? Is color neces

sary, or wi ll black and white be good enough? 

2. Uncompressed raw data. 
If disk space is not a problem and your capturing hardware 

supports uncompressed capturing, this is the best choice. 

When you stan with uncompressed footage, you' ll always 

get superior resul ts-especially if you post-produce your 
footage in a movie editor program such as Adobe Premiere. 

Compression adds artifacts such as jaggies and blurring, 

wh ich are always compounded by effects, transi tions, and 
filters in the editing software. 

3. Post-production blues. 
Limit the post-production process and remove as much 

material from the clip as possible. If the subject doesn't 
move, cut the frame! 

4. Compression is about compromise. 
For World Wide Web movies, use the lowest possible 
frame rate. You' II be able to get away with a very low 



Tip: The Media City Web page at 

http://www.MediaCity.com/-enveb 

is a good place to sample a variery of 

QuickTime movies, QuickTime VR 

panoramas, and Quicklime sou11ds that 

have been embedded 011 the page. 

frame rate if your subject is stat ic or doesn ' t move very 

much. Fast actio n requires a much higher frame rate. 

Because compression involves a tradeoff between frame 

rate and image quality, use a "give-a-little. take-a-little" 

philosophy when determin ing the final compression 

/frames per second settings. 

5. Selecting a type of compression. 
QuickTime and MPEG are currently the most widely used 

compression standards. QuickTime is easy to use and 

gives good performance. It can include sound and can be 

played on both Macintosh and IBM PCs. Of the software 

compressors built in to Qu ickTimc. the Cinepak codec 

(compressor decompressor) is the best. 

MPEG is difficult to use and is not well supported on 

Macs. However, MPEG can produce movies that arc sever

al times smaller than QuickTime movies. Use MPEG for 

longer movies that do not requ ire audio; this format gives 

the maximum amount of compressio n and the best final 

product. 

6. Apple's new MPEG extension. 
Apple's Qu ickTime MPEG extension gets installed in a 

Power Macintosh computer's System folder and provides 

playback and control of MPEG movies. The MoviePiaycr 

application can now be used to play QuickTime. QuickTime 

VR panoramas, and MPEG movies. Al though the 

QuickTime MPEG extension provides playback. it does not 

provide a compressor component. 

7. Conclusion. 
When you're creating a movie for the World Wide Web, 

make it as small as possible. Try to design your material 

around the Web's bandwidth limitation and be aware of the 

time required to download your movie. 

Each cl ip should be evaluated separately to determine the best 

compression method. When in doubt. use QuickTime 

Cinepak. 

Video 1277. 



Creating a link to 
a movie on your 
Web page 

Summary: Create HTML links to 

QuickTime movie.files. Include the .file 

type and .file size to help Web visitors 

make a decision whether to download. 

Tip: The .film clip image on this page was 

provided by The Image Bank, Inc., a 

source forst ill photographs, ft fm footage, 

and illustrations ( 800-TIE-images). 

~ 
mult ;co lor 1 _dots .g;f 
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Nested definiti on lis t tags can be used to create a "para

graph indent" again st a background GIF image that 

has been downloaded with the <BODY BACKGROUND> 

tag. To start the type down the page, begin with an < IMG> 

tag that re fe rences a small , clear GTF image. 

Try this example. which contains four links to movie fi les. 

1. Open SimpleText. 
Use Si mpleTexl or a word processor. If you 

usc a word processor, be sure to save the 

document as a Text O nly fi le. 

2. Create a new HTML document. 

4!3 
SknpleText 

Start a new documenL with the follow ing markup tags: 

<UH1L> 
<HEAD> 
<T ITLE>Kids</TITLE> 
(/HEAD> 

3. Try the <BODY BACKGROUND> tag. 
In this example, the multicolored background was down

loaded as a small tile from the Netscape's Background 

Samples page (htlp://home.netscape.com/assis t/net_sites/ 

bg/backgrounds.html). 

a. Open the tile called multicolorl _dots.gifin Photoshop 

as a CompuServe GIF image. 



3a. 

Composite Controls ... 
3d. 

Fill 

~ents 

iJ 
(1 OK B 

-'Foregrountl Color 
~ Oackgrountl Color 

, men 

Opocl ~LilJCd 

SnO(lSilOI 
Mo 

0 Prl 
Dlock 
50% Groy 

'-
Willie r-

3f. 

3j. 

b. Select RGB from the Mode pull-down menu. 

c. Choose A ll from the Select 

pull-down menu. 

d. Choose Define Pallern from 

the Edit pull-down menu. 

e. Open a New document, name 

it multi.gif, and make it 

603x3 17 pixels and 72 dpi. 

3c. 

f . Choose Fi ll from the Edit pull-down menu. Select 

Pattern from the Usc pop-up menu, l 00% Opacity, and 

Normal Mode. 

g. To create the "vellum" (to make the rype readable 

agajnst a busy background). drag to select an area of the 

backgro und art, and choose Fill from the Edit pull

down menu. 

h. Choose White from the Usc pop-up menu. 50% 

Opacity, and Normal Mode. 

i. Choose Indexed Color from the 

Mode pull -down menu, and c lick 

on OK. 

j. Choose Save As from the File 

pull-down menu , and select 

CompuServe GlF fTom the choices 

on the Format pop-up menu. The 

.._. 1 1 ~ Image 

Bi tmap 
Grayscale 
Duo tone 

I' • I I I 

-/ RGB Co lor 
CMYK Color 
Lab Co lor 
Multichannel 

Color TBb le ... 

result is shown in Figure 3j. 31. 

k. Refer to this image in the <BODY BACKGROUND> 

tag. 

<HTHL> 
<HEAD> 
<T ITLE >K ids</TITLE> 
</ HEAD> 
<BODY BACKGROUtW- "mul t i. gi f " > 

•. 

Video j 279. 



Tip: The MoviePiayer application 
ftvm Apple Compwer can now be used 

to play Quick Time movies, QuickTime 

VR panoramas, and M PEG movies. 
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4. Start the type down the page. 
To start the type down the page, use the <BR> tag to add line 

breaks. 

<HTHL> 
<HEAD> 
<TI TLE> Kids </T ITLE> 
<! HEAD> 
<BODY BACKGROUND- "multi .gi f "> 
<BR> 
<BR> 

5. Add a group of nested definition list tags. 
To create the equivalent of a paragraph indent, use the <DL> 

(definition list) tag. lJl this example, e ight opening tags arc 

used, and eight ending rags are used. Adding more than one is 

called nesting the tags. 

<HTML> 
<HEAD> 
<T ITLE> Kids</TITLE> 
</HEAD> 
<BODY BACKGRO UN D- "rnul t i .gif"> 
<BR> 
<BR> 
<DL><DL><DL><DL>< DL><DL>< DL> <DL> 
<IDL>< IDL><IDL>< IDL>< IDL><IDL><IDL><!DL> 

6. Add a headline between the <DL> tags. 
Once the required number of <DL> tags are in place, add the 

text in between the opening and ending tags. (Note: The 
<H2> .. . <IH2> tag is for headline rype.) 

<HTHL> 
<HEAD> 
<T ITLE>Kids</TITLE> 
<!HEAD> 
<BODY BACKGROU~ D-"multi . gi f "> 
<BR> 
<BR> 
<DL><DL><DL>< DL><DL><DL><DL>< DL><HZ>Videos :</ HZ><IDL>< 
/DL><I DL><I DL ><IDL><IDL>< IDL><IDL> 
</BODY> 
<IHH1 L> 



7. Add a paragraph tag. 
The <P> tag wi ll create a new paragraph. 

<HHI L> 
<HEAD> 
<Tl TLE>Kids</TITLE> 
</HEAD> 
<BODY BACKG ROUND- "multi .gi f"> 
<BR> 
<BR> 
<DL><DL><DL> <DL ><DL><DL><DL><DL><H2>Videos :</H2><P><I 
OL> 
</DL><IDL><IDL><IDL><IDL><IDL><ID L> 
<!BODY> 
</HH1L> 

8. Add the links to movie files. 
Create links to movie Ii les by opening with the link tag <A> in 

conjunction with Lhe HREF attribute. and placing text 

between the opening and closing tags. Th is text will serve as a 

clickable hotspot on the Web page and can be identified with 

an underline. (Note: End each line wi1h a paragraph tag, 

<P>.) 

<HTNL> 
<HEAD> 
<TITLE >Kids< / TJ TLE> 
</HEAD> 
<BODY BACKGROUND-"multi .gif"> 
<BR> 
<BR> 
<D L><D L>< DL> <DL><OL><DL><DL><DL><H2>V ideos :</H2><P> 
<A HREF-"Chi ldl.mov ">Boy with Ice Cream 1.4 HB . 
Ma cintosh QT <IA><P> 
<A HREF-"Chi ld2.mov">Little Gi r l 1.4MB, Ma ci ntosh QT 
<IA>< P> 
<A HR EF-"Chi ld3.mov">Kids with Gi ra ffe 1.4MB . 
Ma cin tosh QT <IA><P> 
<A HREF-"Child4.mov">Boy and El ephant t. 4 ~1B. ~1aci n tosh 

QT <I A>< P> 
</ DL><!DL></DL><IOL><!DL><IDL><I DL><IDL> 
<! BODY> 
</ HTt1L> 

\!ideo 1 281. 



Tip: Quick Time VR panoramas are 

usually IIIIIch smaller !han Quicklime 

movies. 

Eric Chen, !he compuler scientist who 

developed QuickTime VR at Apple 

Comp111e1; hasfonned his own company 

called Rea/Space hllp:llwww.rlspace 

.COIIl. 

His Vistographer Lite is software that 

CCIII be used to create a 360-degree 

panorama. 
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9. Add bolding to the underlined (link) text. 
In thi s example, the <B> and <IB> tags will bold the text that 

visitors will cl ick on. The text will appear underlined and 

boldfaced. 

<HTML> 
<HEAD> 
<TI TLE> Kid s</TITLE> 
<!HEAD> 
<BODY BACKGROUIW- "mu1 t i . gi f"> 
<BR> 
<BR> 
<DL><DL>< DL><DL><DL>< DL>< DL ><DL><H2>Vi deos:</H2><P> 
<A HRE F-"Chil dl. mov" ><B>Boy with Ice Cream 1. 4 MB. 
Macintosh QT <IB><IA><P> 
<A HREF-"Chi 1d2.mov"> <B>Litt1e Gi r l 1.4MB. Ma ci ntosh 
QT <IB><IA><P> 
<A HREF-"Chi 1 d3. mov">< B>Ki ds wi t h Giraffe 1. 4 MB, 
Macintosh OT <IB><IA><P> 
<A HREF- "Chi 1 d4. mov"><B>Boy and E1 ephant 1. 4 MB, 
Maci ntosh QT <IB><IA><P> 
<IDL><IDL><IDL><IDL><IDL><IDL></DL><IDL> 
<! BODY> 
<I HTI1 L> 



Tip: One oft he best ways to team how 

to use HTM L tags is to view the tags 

used in your favorite pages on the Web. 

To see the HTM L tags that make up a 

page, select Source from Netscape 's 

Vie11· pull-down menu. 

Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) renect the 

HTML 3.2 specification. 

<A> ... <./A> 

Referred to as an anchor, this tag uses the HREF attribute 

to link to an external sound fi le or anchor. For example: 

<A HREF- "Chi l d4.mov"><B>Boy and Elephant 1.4MB. 
Macintosh OT <IB><IA> 

(Note: The movie fife name must include the path name !f 
the .file is located in another direct01y). 

<B> .. . <IB> 

A tag used to apply boldfaci ng to text. 

<BODY> ... <.IBODY> 

A tag used to open and close the body of a document. 

<BR> 

A tag used to inserL a line break. 

<DL> ... <IDL> 

The delinilion list tag is usual ly used for definit ions or 

short paragraphs with no bullets or numbering . ln this 

chapte r, this tag is nested e ight times to indent the word 

Video a t the bono m o f each page. For example: 

<DL><DL><DL><DL><DL><DL><DL><DL>Vi deos<IDL> 
<IDL><IDL><IDL><IDL><IDL><DL><IDL> 

<HTML> ... <IHTML> 

A tag used to open and close an HTML document. 

<HEAD> ... <.JHEAD> 

A tag used to open and close the header portion of a 

document. 

<IMG> 
Used to refer to an inline image, this tag uses the SRC 

amibute, which represents the URL (location) o f the 

image. For example: 

<IHG SRC - "clear.gif"> 

<TITLE> .. . <./TITLE> 

A tag used to describe the title of a document, which 

appears inside a browser's title bar. 

Video 1283. 



Pick the best 
palette for an 
8-bit color 
Quicklime movie 
using 
DeBabelizer' s 
Super Palette, 
and create a 
script to remap 
your movie 

Summary: Use this example to learn 

how to create n Super Palette in 

DeBabelize1; hotv to use DeBabefizer 's 

.fimctions i11 Batch mode, and how to 

create a script. 

~ 
De Babe li2:er® 

Tip: The .film clip image on this page 

1vas provided by Fabulous Footage a/ 

ht tp:llwww. FOOTAGE. net: 2900. 
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D eBabe li zer, by David Theurer, is a ·'graphics process

ing . manipula tion, and translmion tool" that can be 

used to alter QuickTime movie pale ttes. DeBabe lizer's 

unique Super Pa lette feature is desig ned to c reate the best 

pa le tte (of 256 or fewer colors) for a series of images or, in 

this case, frames. 

1. The color tradeoff. 
When a 16- or 24-bit movie is played on an 8-bitmoni to r, the 

Macintosh computer's Color QuickDraw will do the color 

mapping to approximate a larger color palelle. In this case, 

DeBabelizer can be used to create a predictable 8-bit palette. 

AJthough the custom, 8-bit Super Pale tte wi ll look beuer 

than the approximate 8-bit palette drawn with Color 

QuickDraw, the only codecs that can save an 8-bit palette 

are Animation and None. Both of these compressors create 

much bigger movies than movies compressed with Cinepak, 

a codec that defaults to a 24-bit pale tte. As a result , you' II 

need to limit 8-bit QuickTime movies to very few frames to 

keep the fi le size small. 

2. Creating a Super Palette. 
You can create a Super Pa leue and manually remap a group 

of images wi th the new pale tte, but because a movie has so 

many frames, Greg Marr at Equilibrium recommends using 

DeBabelizer's Batch and Scripting fea tures to automate the 

job. Try the example in this sec tion to learn how 

De Babel izer can automate your work. 



Calalog ... 
Op en Channels ... 
Require 

Compare ••• 
EHport... 

<it[ saue .•. Place ... 
!' lace fltquire Saue Simple ... 
llet•et I to Ot tgmal Slideshow ... 

( IO$P 

Saue ns ... 
EKJIOI t 

Super Palette ..• 
oow--------------~ 
:li:S Place & Saue ••• 

Place Ocquire ll' Soue ... 

Page Se tup .•. 
Print .•. ~itP 

llelet l' 3GK 

Quit 

4a. 

![ Ne!0Y 

lis t:C:. 

Edit... ) [ Delete )' 

•I 
4b. 

3. Open DeBabelizer. 
Click open DeBabelizer. 

4. Begin a Super Palette in Batch mode. 
Instead of manually factoring in a movie's frames as votes 

to form a Super Palette of the best 256 colors, DeBabel izer's 

Batch feature can be used to open the entire movie and look 

at co lor in every frame. 

a . Select BatchiSuper Palelle from the File pull-down 

menu. 

b. Click on the New button in the Batch Super Palette dia

log box. 

c. Use the fi le Jist w indow in the dialog box that 

follm.vs to find your QuickTime movie. 

lei! Moules •I 
~ Oetlouins.qt 

~ Girl 
~ m on_boby 
! Stotue.qt 

c;::) APS Orlue"' Botch list 

o [ [J t•l:f 

[ Desklo11 

[ 0JH!fl 

Insert -> 

Show rue Type:rj ""nL:-;-L-----,~=>J i Cancel ~~~~;~:~~ ~;~~~::•ms: 0 

Fllt cr:l Fast: 11!1 File Type •Ill ~om• IM New Botch lis t Name 

4c. 

d. Click on the Append button. 

e. Ente r a name for this batch in the box labeled Batch 

List Name. 

[Check Missin!il '*itPm< · t 

Batch list Name: 

I Statue batch ~ 
4e. 

f. Click on the Save button . 

Video 128 5. 



. ~I nitia lize Super Pa lette before s tarting 

Sa. 

I tor eocn 1m I I 1 I 

• t oc tor m 
Stop ond wait 
Pause for I second 

~Imu:!lll v'Pau se for 2 seconds 
Pause lor I 0 seconds -

When oi l do Pause f or _ second s: 
10 the p01" ' U; VUVUV IIICIIU , 

\!)Coli II "The Super Palette " 

0 Coli II: I Super Pa lette Nome 

~colors In Super Palette. 

183 Moclnllze Super Polelte. 

f8] Oyp oss warning me~[i:j, 
U nuto OK In dlologs In u seconds 

[ 00 IT ] (concelj(EBII with se ttings )[llelp ... ) 

Sb. 

1 When all done, odd Super Palette 
to the polette popup menu: 

0 Ca ll i t "The Super Pole li e" 

@Coli It: I Statue pat ell~ 1\' 

~colors 10 ~uper l'ote ttM. 

5c. 

~Mocintize Super Palette. 

Sd. 

Se,Sf. 

3 Skip this dialog [OPTION ouerrides] 

6a1. 

[ OK ~J) 

6b. 

Slaluo.ql 
5of71 

8c. 
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5. Fill in the Batch Super Palette dialog box • 
a. Click to put an X in the box labeled lnitiali:.e Super 

Palelle Before Starting. 

b. Select Display Off from the Display pop-up menu. 

c. Click the radio button/box labeled Call It, and fill in 

your own palette name, replacing Super Palelle Name. 

d. Click to remove the X in the box labeled Macintize 

Super Palette because the movie wi ll need to be seen o n 

IBM PCs (on the Web). 

e. Click to put an X in the box labeled Bypass Warning 

Messages. 

f. Click to remove the X in the box labeled Auto OK In 

Dialogs In 8 Seconds. 

g. Click the DO IT button. (Note: The QuickTime Mo11ie 

Open dialog box will be displayed.) 

6. Poll the frames. 
a. Click to put an X in the box labeled Skip This Dialog at 

the bottom of the Qu ickTime Movie Open dialog box. 

(See Fig ures 6a 1 ami 6a2.) 

b. Click on the OK button. 

c. DeBabelizer wi ll begin "polli ng" a ll the frames in your 

movie to make a choice of the best 256 colors. 

6a2. 

...I 

Current f rome # ~ 
C~.t"r'tn\ umt• : 1 
0\.r~hoo units: 82 

:· 11 miiTtilri •] 

'"liiiltf.rld- --;) 

:!-.' •'-1Cdhl ~ompl('l 
(.1 \IJIH; ~omplf'l 
('} Mt'11IO f'ldit 
()114!k Plfil 

[j ltliJI' OK 
C J nnn• oc1h•c 



Delete 

EHecute RppleScript. .. 
EHp ort Bpple Scrlpt... ~ 

Watch Me 
~top Heconlluy ... 

Sa. 

8c,8d. 

7. Create the Super Palette. 
Click on the Create It button in the corner of the Create 

Super Palette dialog box. 

Number o f colors in Sutl er Palette: Jf.fjMj 

18] On creation or Super Palette, Maclntize II. 

0 Coli It 'The Super Polett e· 

®Coli it: I Statue pale tte 

![ Cr eo le II ~J ( Concel llelp ... 

7. 

8. Begin remapping by starting a script. 

I 

a. Select New from the Scripts pull-down menu. 

b. With the Edit Script dialog box open, select Set Palette 

& Remap Pixels from the Palette pull-down menu. 

.. ' Mise Script s 

Options ~ 

SELECT FUN[ Po lette Info ~ 
Polette ~ 1--

;,! 0 lnseJ1 ti<!IOI o liroo --- ---
[onuerl to Dll'W/ Groyscole ~ 

® Oppena ot end 

nemoue Unused ll' Oupllcot cs 
(se1 LhH~ PfifiHlH~tl~rs J Oeduce Col ors ... K T 

Change PhlCI Depth ~ ( Select 011 :ten I .. , 
( fll'11ll.W•' I. HIO I 

Background nemouo l ... 
Marinlize Pal ett e ~ 

- "' ( lleltJ. .. I Sort Palette ~ 

EHtro Funct 
Super Pole lle 

~~( Con eel ) 
- - ----

Nome:~ Dll'W Ordered Dither ~ S<~WH ~ Merge Palettes ... 

Sb. 

c. The function tJ1at you selected wiJI appear in the Edi t 

Scripts dialog box. A question mark will be visible 

because DeBabelizer does not yet have enough informa

tion to process your request. 

d. Double-click on the question mark, and the Set Palette 

& Remap Pixels dialog box wi ll appear. 

Video 1287. 



8e. 

8fthrougb 81. 

lllliii L 0 It l'alette MISC scn ph -· New ... :MI N 
Op en ... 880 .. Catalog ... 
Open Channels ... C UIIIIJUf u .. . 
Acquire EHport ... 
Plac e ... o; [ ' 
Plare nc qutre Soue Simple ... 
Rl'UPII to Ongmal Slldeshutv ... 

Super Polett .. ... 
( IOSP ' l -
Sdue R\ ... . \ l, lace U' ~uu~ 

EHpOII Place Requi re G ~uul! 

10a1. 
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e . Select the name you 'vc g iven to your palette from the 

Set Palette pop-up menu. 

f. Click to put an X in the box labeled Remap Pixels. 

g. Click to remove the X from the box labeled Dither 

When Remapping. 

h. Click to remove the X in the box labeled Do NOT 

Remap To Off-Limit Colors. 

i. Click on OK. (Note: The question mark has tumed into 

an "OK" symbol.) 

9. Name and save your script. 
a. Enter a name for your script in the box labeled Name 

at the bottom of the Edi t Script dialog box. 

b. Click on Save. 

I Name : [st o tue scrip t 

9a, 9b. 

10. Save each frame in Batch mode. 
When QuickT ime movies are saved in DeBabelizer, indi

v idual frames are appended to the end o f a movie. Like the 

poll ing required for creating a Super Palette, this i s another 

j ob that should be batched. 

a. Select BatchiSave (Figure 8a I) from the Fi le pull -down 

menu. The dialog box shown in Figure 8a2 will appear. 

Dolch Soue 

ll New ... J l Edit. .. J l De le te For coch lmogo In ll< l' 

lis t ~ Sta tue botch ... • Do Scrlpt :J NOliii NG 

CJ Sta tue.qt ' 1 • Oisp lo~: I Di•play orr ... I 
• Snue: I nuto Nomlng oe llons ... 

® To: lffi::J~~~~~~~~~~~,~=-
O l o: Folde r lmaqe como from 

0 lo: Manually <PIPrt 

Type: I PICT2 •JwM.a.1 
Colors :! '/~ill (0 lllh ) ... j[8J nut o se t 

O ls uce ... l [8J Uerify replace 

@ Open 1 nu ... 0 Picture Preulew 0 I lm<tgc:t iiP 
0 Pic ture Icon 0 t arolmatlon-'tll£' 

0 Require; ... [8J Dy1mss warning me~~' 
I ni.io.mntit: ... 0 nuto OK In dluloys In o second~ 

... 

0 Don' t go Into s ub fo lders ~(cnnce l)(Euit with settings)~ 

10a 2 . 

I 



lror coch Image In li st: 

0UfiJmtmiJNOTIII" 6 
• Dis play: Bedouin set pale tte script 

Dithe r to Stas hed Pa le tt e 
• Soue: Oil her to Super Pa le tte 

(.i) To:(EI Omgll'Orop To PICT 
0 To: rot Mos k Original with ntpha Chonnel 

Q To: Mo ~~~: ~::: ~~ ~~~ ~~ : ~~~~/;;~n\e;r 
Tttpe: Q Print Bes t on Color tmogc w riter 
Colors( ~ 

OrsiiCil... Trim to Solid Edges ~ 
0 Picture Preuiew 0 I l11109<l . .-lilt> I 
0 Picture Icon 0 1 .muu<~Hon'fill' 

10b. 
I 

b. Select the name of your script from the Do Script pop-up 

menu . 

c. Select Display Off from the D isplay pop-up menu. 

d. Cl ick on the Auto Naming Options button. 

For each image in Li st: 
• Do Script:rl-s"'t,...a-,.t_u_e_s_c_r..,.ip""'t,...-------.... -,1 

• Display: I Dis play off 

• Sa ue: [fiuto ~aming Op t ions . .. ~ 
@ To: r S 8 t .~ foPS Dnve"" Oebablhzor · 

~D•Babelu:<r(B) 1.61 Fold•• 

10c,10d. 

e. Click on the Original Name and the Extension For Save 

Type radio buttons. (Note: Disregard the extension if it is 

incorrect: DeBabeli-::.er will fill in the co/ncr extension.) 

f. Cl ick to put an X in the box labeled Don 't Duplicate 

Extension. 

~ 

~ nuto Nemer 
"""-
Soue fi lename -

0 Use this: I I 
0 Use this & add 1 before .eutension 
0 lise this If ildd 1 ill P.ntl 

@ Orig inal nam e • 

18] Strip .eHtension first 

n Athl cell number 

0 No eHtension 

0 Eutens ion : 1m. I }18l Don' t dupl ica t e eH ten sion 
@ En tension fo r Sau e Typ e: PICT ~ 

{( OK ~ ( Cancel l ( ll el p ... l 
10e, 10f. 
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@ To: !Set. .. );::~!':~"':"w'ob Book/McGrtw .11ovits 

0 To: Folder Image c~me from 
0 To: Manually selec t 

llc. 
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11. Set the path. 
DeBabelizer will need to know where it should save the 

new movie. Greg Marr at Equilibrium recommends that the 

movie be saved in a folder other than the folder that con

tains the original (to prevent accidental file overwrite). 

a . Click on the Set button on the Batch Save dialog box. 

® To· I Se t ~ APS Drive,... :O.babih<•r·. 
• •• DeBabtliz•r® 1.61 Fold•r . 

0 To: Folder 1mage came from 

0 To: Ma nually se lect 

11a. 

b. Usc the fi le list window in the dialog box that fo llows 

to select a destination folder. (Note: As a11 optio11, cre

ate a New Folder to keep your 11ew movie separate 

from your old movie.) 

Selec t des tination folder: 

!ell Moules ,.. I = llPS Uriue"' 

~ Bedouins.qt Jj Free: 2B7BB53 12 
(:1 Glr I r lo.- t 

13! man_batly 
Name of new folder: fl Statue.qt 

l staLnet4 I 
[Cance l ] ~ Create J) 

lol H Open J] 

[ Se lec t "Mouies" l 
Ub. 

c. Click on the Select (folder 11ame here) button. (Note: 

DeBabelizer will display the path i11 small type 11 ext to 

the Set burton, as shmvn i11 Figure 9c.) 



Type: I Quicklime Mo ...... l ~lovie 
Colors:[ (.>~j(, '{il "tli·i~)"· · :.;.; 118l~uto set 

0 !Slice ... ! !8J Uerlfy replace 
0 Picture Preuiew 0 I image/file 
0 Picture Icon 0 I animation/ file 

18] Bypass warning messages 
0 Ruto OK in dialogs in [:]seconds 

s~[EHit with se ttings)~ 
12b. 

Olsllce ... l 0 Uerify reploce 
0 Picture Preuiew Clti Image/ file 
0 Picture Icon 0 1 animation/ file 

12c. 

12d, 12e, 12f. 

12. Indicate the file type. 
a. Select QuickTime MovieiMovie from the Type pop-up 

menu in the Batch Save dialog box. 

Batch S8L Or. llo lo CUT 

ll New ... J l Edit... J l Delete For each IMG • 
lis t:[ Statue batch • Do Scr JPEG . • lfl r ... 

IFF.LDM 
[) St otue.qt :Q • Displo MacPainl 

• soue: MSP tU~P I 

®ro: C NEO 

O ro: I 
OMF'" Inte r change ~ 
PCH 

oro:~ Photoshop' " 

t:mD PICT2 • 
Colors: Picture Icon & Preuimll Onl y 

0 ~~ 
Pillat 
QDU 

@ Open I ' I ' 
0 Acqulre'""t Color Table ONLY to or Moot! I Quicklime Still 

, •.. iloitoioniotio:··--·· -·· O Au 
Row AGil ... 
ALE Comrui ~P.rup"• 

0 Don't go in to sub folder s I(Q!!!J] SG I 
( _nftimii.OP 

12a. 

b. Click to put an X in the box labeled Auto Set. 

c. Click to remove the X in each of the six check boxes 

beneath the Auto Set box. 

d. Click w put an X in the box labeled Bypass Waming 

Messages. 

e. Click to remove the X in the box labeled Auto OK In 

Dialogs In 8 Seconds. 

f. Click on the DO IT button. 

• 
~ 
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Compression Sailings 

[

Compressor----

1 Onimotlon ... 1 

I Dest Dep th • I 
~~---~ .. ----~~h-·~~---M-

( More ... J Cancel J fi OK )J 

13a through 13d. 

lleBabelizer 

~~1~1;1° I 
Statu• qt 
8 of71 

llrigml C\rTMI 
Yide: 160 
111 : 120 
Color : 32768 
OP l : 72 

13o. 
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13. Select a compressor. 
The only two codecs that support 256 colors are Animation 

and None. Selecting any other codec will create a 24-bit 

movie, not an 8-bit movie. 

a. Select A nimation and Best Depth from the 

Compressor pop-up menus in the Compression 

Settings dialog box. 

b. Use the slider to select a compression quali ty. 

c. Use the default setting of I frame per second and Key 

frame every I 00 frames. 

d. Click on OK. 

e. DeBabelizer wi ll display the progress of the batch 

operation in the toolbox window. 

14. Test your movie. 
Click to open your movie. I f you have the MoviePlayer or 

some other QuickTime player on your hard drive, the 

movie will begin to play. 



File conversion: 
Preparing 
Quicklime files 
for Windows 

Summary: Use Patrick Hennessey's 

flat tenMooV utility to "jlarren the 

forks" of a Macintosh Quick Time movie 

for playback on the Windows pla~form. 

Lookforj lallenMoo\f on the CD-ROM 

in the back of this book. 

(~ Web Oook/ MtGo ow .,.. I c=:~ APS Orluc'H 

0 uroog.mo" • ( r ~"'' I 0 liiOog.rnou copy 
0 Little Ght "2 ( Des k top I 
D Secrcl.mr•eg --
0 Secre l. rnpy 
0 Secret.q l ( Cance l ) 
D ~euenthscel.rnou COJl!J 

n Ollell D CJ Uniu MI' EG 2.0 Moe ue .. ion 0.1 5 ~ 

0 Show Preulcw 

2 . 

tlat.tE'nt"1oo:oV 

0 n the Macintosh platform, a ll fil es have what are 

called a data fork and a resource fo rk. These must be 

rolled into one for playback on the Windows platform 

because Windows will not "see" two forks. Patrick 

Hennessey's fla ttenMooY is a utili ty that nattens a movie. 

1. Open flattenMooV. 
Double-click on the flattenMooV application to open it. 

2. Select a movie. 
Use the file list window to se lect a movie. 

3. Run the movie. 
Ru n the movie to review it. 

4. Close the movie. 
Close the movie window by clicking on the d ose box . 

5. Save the movie. 
When you close the movie w indow, you wi ll be prompted to 

save the movie (with the extension .FLAT). Locate the folder 

where you would like the movie saved , and click on Save. 

I ffi Oes l: t o p ""' I = 110 

= APS Oriue '" '\) [ Jeri 
= HU 
= Num ber 10 Oe ~l:lop 

C' uui - lo Ql - tont•eoter 
0 ) (.) dH IS New 

0 f oi Muil ~ 
Whe r e do you w anl t h e ( Ca ncel ) 

ILIIUJ!,!I-fTIOU.fiDI n Saue l 
5 . 

Video 
1 
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File conversion: 
Converting 
Quicklime files 
toAVI 

Summary: Use tile Video.for Windows 

Converter (developed by CoSA and Vital 

for Microsoft) to convert Quick Time 

movies to AV!movies. 

u 
\•/indo>.•ls Compressor s 

Uldeo forWII'Idoau• C•nurttf'r 

~ourc.e foldf'r: Ot•~llnetll on fohle.: 

506K byle 'J \tle cted 10MB nuollnble 
1R ·Maule\ • In .. UfWI.IUIIIItUI\ .. 

I Op en SourUJ ... } fcllnm IJO\IInntlrm ... ) 

{ ~elef iOII ~ "'cw fohiL•r ... 

3a, 3c,3d. 
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Vf\11 Conveder 

AVI (Audio/Video Interleave) is the Microsoft stan

dard for digital video. This standard is also known as 

Video for Windows, although the movie files have an .AVI 

extension. Some Web sites offer QuickTime and AV£ movie 

formats to accommodate Web visitors on both the 
Macintosh and IBM platforms; AVl is more common than 

QuickTime on the PC pl atform. 

Before you convert a QuickTime movie to an AVI movie. 

install the Windows Compressors in the Extensions folder 

on your Macintosh. 

1. Install the Windows Compressors. 
a . Drag the Windows Compressors icon on top of your 

closed System fo lder. 

b. Restart your computer. 

2. Open the VfW converter. 
Click to open the VfW converter utili ty. 

3. Use the Video For Windows Converter 
dialog box. 

a. Click on the Open Source button in the Video For 

Windows Converter dialog box. 

b. Look through the Source Folder window, and click on 

a fi le to convert. 

IB Lilli" Ghl 
mnn_ bobu.q 1 

Preview 

Update 

3b. 

" 

c::::) ll PS Urlue'" 

( ljro I J 

I DcsklOil ) 

LDt••Dl 
( Cnncc l ) 

c. Click on the Open Destination buLLon to select a destina
tion folder for the convened Iiles. SelecL New Folder if 
you 'd like Lo create a New Folder. 



Source rue ·'In me: Oes11notlon rtlc Nome: 

st .. w.~t ISTniU(QT.OUI I 
- Uideo: nudio: 

S.C¥ot 16 :ut YtJ.o lto..Wt.)hSCU'U 

...... uncompreuctl Dr otw rot t 111u11u . 
( \et llnqs ... ) Direct Trnnsfcr 

rrome note: llliiJ~ 

lrtch rormotllng 
@ Uunq Ul) tlluiOII 0 ~l~1n to1 ln~~l lornhlt 

I Qlhf'tlll'i· lflfl llll l 

CD~ ~ l OK Jl 

3e. 

source rt le Nornc: Oestlnntlon fllo Nnme: 

Stthwqt I STnTUCQT.OU I I 
- Uideo: Ondlo: 

Sowc• l 6 b1t\'..,.. Uo• . .:tior. s~r~• 
D.•· t6tu t'tlcf'ot~n v,o .. 1 

I Com11resscd ... I 0 (OOIWI t nufliO 

( Set11n9s ... ) ( \e iiiiiiJI ... ) 

rrorne nato: IIlii I~ 

li"t cl1 rormolllng 

I 
@ Onnq up tll t1hHI Q\t .lfl tnt lu•s l t•umul 

QU\e lhe' rtHm tll 

CD~ ~ ~ 
3g. 

Compression Settings 
·Compressor 

I Microsoft Uldeo I 

L I_ ~~~-~-o lors 
Quolity-- --- ...... - - ---, 

~I 
lust l o-w t-'ttJtutn High MJst I 

..... ---... .. .. ... ... .. .. _____ .] 
Motion-- · 

Fromes per second: \k 113 
[g) Key frnme euery ~ frames 

OLutlll ddla ralP tu q K. ~etu~u j 

Concel J ({ OK ~ 

4a,4b,4c,4d,4e. 

d. Click on the Convert button. 

e. Click on the Compression Method pop-up menu and 

select Uncompressed, Compressed, or Direct Transfer. 

(Note: You will wall/to select Compressed if the movie 

is a raw file or if the movie is already compressed with 

a non-IBM-compatible compress01: Select Direct 

Transfer if the movie is already compressed and the 

compressor is available on the IBM comp11te1: ) 

f. Selecting Uncompressed displays a video format pop

up menu, which allows you to specify the image depth 

of the converted QuickTime file. Choose 8-. 16-. or 24-

bit. 

g. Selecting Compressed displays a Settings bunon. 

Click on this buLLon to display a Compression Settings 

dialog box. 

4. Compression settings . 
a. In the Settings dialog box, display the Compressor pop-

up menu, and select an IBM-compatible compressor. 

b. Drag the Quality slider to select an image quality. 

c. Fill in a number in the Frame Rate fi eld. 

d. Fill in a number for Key frames. Key frames don 't 

depend on previous frames to be drawn. Higher values 

for the Key frame field make the converted file smaller, 

but performance may suffer. 

e. If the setting is available, specify a low data rate for Web 

movies. Playback will be on a hard drive, so make the 

data rate between 1 00 and 200 Kbps. 

5. Audio options. 
a. If audio is included in the QuickTime movie, the 

Convert Audio checkbox will be available. Click on the 

box to fill in an X if you want audio converted. 

b. Click on the Settings button. 

6. Audio settings. 
a. Select the number of channels; either mono or stereo. 

(Note: Stereo 1vill only be heard on stereo-equipped 

hardware.) 

Video 295. 



Tip: The Animation, Graphics, 

Microsoft RLE, and None Compressors 

are loss less compression schemes. That 

is, no data is lost during compression. In 

contrast, data is thrown away during 

lossy compression. Be careful Hot to 

apply lossy compression more than 

once. 

When you nm the Converte1; you may 
need to increase rhe amount of RAM 

assigned to the program by increasing 
the minimum and pref erred memOJ)' val

ues inrhe Finder's Gerlnfo dialog box. 

Video for Windows interleaves audio 

with eve1y ft'ame of video. When you 

convert a QuickTtme file to AVI with the 

Video for Windows Converte1; the.files 

are not interleaved. The authors sugges1 
interleaving the files again with Vic/Edit. 

296. j Clwprer 8 

b. Select the sample size. (Note: 8-bit samples provide a 

range o.f256 sound tmits, and 16-bit samples provide a 

range o.f65,536 sound units.) 

c. Select the frequency. (Note: Frequency is the number of 

audio samples per second. 44. 1 kHz is CO-audio quality, 

22.056 kHz is AM-radio quality, and 11.025 kliz is voice 

quality. Web developers should consider 11.025 for voice 

and 22.056 kHzfor music.) 



File conversion: 
Converting AVI 
movies to 
Quicklime movies 

Summary: Use !he i1 Vl!o Quick Time 

uri/if)• (developed by Vi la! and Media 

Vision for Microsoji) 10 COllver/ AVI 

movies 10 QuickTi111e 111ovies. 

'w'indo\•/s Cc•mpre-sseors 

T heAV l to QT Uti lity creates a resource fork so an AVI 

file can be recognized by QuickTime. 

Before you convert a QuickTime movie to an AVI movie, 

install the Windows Compressors in the Ex tensions fo lder 

on your Macintosh. 

1. Install the Windows Compressors. 
a. Drag the Windows Compressors icon on top of your 

closed System folder. 

b. Restart your computer. 

2. Open the AVI to QT utility. 
Click to open lhe AVl to QT uti lity. 

3. Use the Conversion window. 
a. Use the file list window on the left half of the 

Conversion window to find the AVI fi le you would l ike 

to convet1. 

b. Select the AVI fi le, and click on the Add button. 

rreulew: (ei UfW I. IUIIIItles • I c:::> IIO File• l o Conuert: 

~ 
,. I Q ( ( )O< t I ~~ 

( Desktop I 

~ Add» !t] 
.n. ( Ad d All » j tn 

rile Types: I PC nul Files ... I OK Oy tes Selecled 

( Cancel ) ( r onut•rt ) 

3b. 

c. Click on the Convert button. 

Video 1297. 
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Preulew: le urUJI . IUtllltlcs ... I = 110 Files to Conucrt : 

~ ( £jc<t ) ,. I ,Q c:J ( Desktop ) 

~ « Remoue 11 

·':' (nemoue nu ) r, 

rue rw~es: I PC AUI files .,..I 262K Bytes Sel ec ted 

I Cancel ) ( Conuc r t ) 

3c. 

4. Select a destination folder. 
a. Click on Save Sel f-Contained Movie. 

b. Use the lite l ist window in the next dialog box to select a 

destination fo lder. 

c. Click on the Choose (folder name here) bullon to choose 

the fo lder you've selected and to start the conversion. 

(Note: lfyou selected Save Self-Contained Movie, the 

movie may be opened by a Quick Time movie player such 

as the MoviePiaye1: ) 

Selec t Uestlnotlon follter: 

I~ UfiUI.t UIItllles .... J = IHl 

IJJ-

: .~:::. 
_. (New folder) 

L---------l:o.J ( COIICCI ) 

Choose " UfW 1. t Utilitie s•· I( Open n 
0 Soue Norm oily ldCilendency to AUI file) 

® Snue Self- Contnlned Moule 

2&e»:: BJtf'S fti'QU"f"fd 

1~ 91)tUAVill4b\t 

4a,4b,4c. 



Artist featured in this 
chapter: 

Tom Cipolla is a writer 
and producer of audio
visual educational materi
als. In this chapter: he 
teaches how to "hear with 
your mind." 

cipolla@eclwnyc.com 

Computer specialist 
featured In this 
chapter: 

Greg Hess, a.k.a. "Red 
Dog. " is a compurer 
electronics instructor in 
Ulkeland. Florida. The 
home page he created 10 

support his Palace site 
opens with a background 
sound created with 
Netscape 's new LiveAudio 
HTM L syntax. 

ghe.u@ gte.net 

Cha r 

Sound 
This chapter begins wi th a tour of some well-known Web sites 

that offer sound. You' ll learn technical Lips from the developers 

who created the sites, including Modem Media (Zimn), Fry 

Multimedia (Ragu), and Roben Lord (IUMA). To m Cipolla 

offers tips on selecting sound effects for your images. In this 

chapter, he \VOrks with clip sounds to c reate sound effects for 

phoros fro m Pacific Coast Software (http://www.pacilic

coasL.com). Using Alberto Ricci's SoundEffec ts software (avail

able on the CD-ROM in the back of this book), Tom alters, mixes, 

records, and reformats the sampled sound for use on other plat

forms. There's also a how-to section on using SoundApp to convert 

sound fi le formats (also available on the CD-ROM). 

Now that Netscape's LiveAudio technology plays WAY, AU, and 

MTDI fi les, you' ll no longer need a separate helper application to 

play sound. In fac t, Greg Hess, a computer e lectronics instructor, 

demonstrates how to add a MIDI background sound to a Web page 

using Nctscape's new LiveAudio HTML syntax. As electronic 

MID! music continues to blend with computer technology. it 

makes sense to use this sound format on the Web because MIDI 

files arc tiny.lfyou've never worked with MLDI sound Iiles, you'll 

want to visit Heini Wilhagen's MIDl home page (http://www.eeb 

.tuc.nl/midi/index.html). He has created links to articles and tech 

tips, MLDI sound archives, MIDI software util ities. and specia l 

inte rest group links. 





Web sites 
with sound 

Summary: Visit pages with sou11d to 

gather ideas for your ow11 pages. The 

artists who have created the Web pages 

you see i11 this chapter are amo11g the 

first to take adva11tage of tire Web's 

multimedia characteristics. 

I!IR D 
I . 

. .... ... ....... . 

Tip: Charles Marelli, the writer who cre

caed the Dunca11 character a11d 

DuiiCG/1 •. \. sou11d effects, uses clip sow1d 

ej]ectsfrom a variety of public domain 

sound arc/rives, as well as a sound effects 

CD-ROM. (See Creating sound effects 

with cl ip media for addresses of publ ic 

sound archi ves .) Charles also creates 

sou11d ej]ectsji'OIII scratch using a 1 6-bit 

sound card and a microplr01re. 

¥. 

~
·-

Adult A CQI\1 human1 
on I}: 

21m"'·'""" 21. 

re: zima write to us what's new 

T he Zima site, developed by Modem Media in Westport, 

Connecticut, uses sound effects the same way sound 

was once used on radio. Visit hltp://www.zima.com and 

fo llow soap-opera-like installments about Duncan. the si te's 

fictional Genermion X character. 

Weekly episodes contain inline audio l inks to sound effects. 

For example, in th is segment, Duncan is dropping his date 

off at her door. He swings open an iron gate in front of her 

apartment, and the word swung has an audio link attached. 

A mouse click on the word swung will automatically play 

the sound of a gate sw inging open. 

"Duncan. I had a wonderful t ime ." 
Duncan' s bountiful pool of cliches immediately evaporated. 

" Urn ..... me too. " he stammered. 
Duncan swung open the small iron gate in front of her 

apa r tment. 

5'tt8!ght through hnn. 

'h:-t-····" r.. •' 
- ~' . 
' 

•oiiilCon, I had e. wnderfuhime.'' 

Olll'lC&II's bounuful pool of cliche'~ immedJ.ately evapomed 

"Urn, .. me too," he stammered. 

Dune.m ~ open the smell ~:ton gse m from of her 'f'MID~I\1 
It 
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Tip: Download the latest version of 

Netscape to take advantage of the 

LiveAudio technology built imo the 

browser ( http://home.netscape.com 

/comprodlm inv rlindex. h t ml). 

302. Chapter 9 

At the Zima site, you' ll also find sound fi les in the "fridge." 

Click on the Earwacks bowl inside the refrigerator, and 

you' ll visit a page of sound icons with links to AU fi les for 

Macintosh and Unix or WAY files for Windows, including: 

Smooch.datc.au ( 18 K) I date. wav (36 K) 

Batter up! ball.au (2 J K) I ball. wav (42 K) 

Ding.clcvator.au ( 14 K) I elevator. wav (37 K) 

A slight drizzle ... rain.au (23 K) I rain.wav (62 K) 



"I made a lasagna so 
good the other day, I 
swear it would have 
made Michelangelo cry 
from joy." 

Tip: F1y Multimedia records Professor 

Antonio (8 bit at22 kHz) on a Macintosh 

Quadra 650 using SoundEd it Pro and 

the Plaintalk microphone thai Apple pro

vides will! some newer Macs. 

Using SoundEdil, !he F1y team edits the 

sound bites imo "righ1-sized" chunks. 

Files range.fmm 16 K ("Hotel") to 95 K. 

( " I would like a hotel1vom.facin.g the 

Grand Canal, please.") They estimate it 

takes a boll/ one second to download one 

kilobyte of data over a 14.4 Kbps 

modem. 711ey prefer to holdfile sizes 

under 40 K so that visitors never have to 

wail more than 40 seconds.for sound lO 

download. 

To convert the sounds into AU, WAV, and 

AIFF file formats, Fry Web sile develop

ers use SoundApp, a shareware program 

for Macilllosh. (SoundApp can be found 

on/he CD-ROM in1he back of this book. 

Note: SoundApp lists the AU format as 

the "NeXTformm.") 

R agu's Web site (http://www 

.eat.com/index.hunl), produced by 

Fry Multimed ia in Ann Arbor, 

Michigan, has a clever theme called 

Mama's C ucina (or Mama's kitchen). 

Included are Mama's Cookbook, Contests, Mama's Secrets, 

Italian Lessons, Cooking/Pasta Glossaries, Stories Around 

the Family Table, and Mama's Favorite Places. 

Professor Antonio teaches Italian. A mouse click on the 

appropriate file type (AU, A.JFF, or WAY) will play a phrase 

in Hal ian. The idea for the site came from David Ft)' 

(dfry@ft)'multi.com) and Michael Clemens. Writer Tom 

Cunniff creates much of the content for the site, and "Professor 

Antonio" is AntonioAntiochia, a software engineer with Fry 

Multimedia. 

Travel 

Hctel 
albeig12 
{mfl:m:l~ 

··1 would like a hotel room facing the Gtend Canal. ple~e " 
Yorre1 una c8Illela con unama sui Cwal Gtande •. p~ 
[alffl-..wl~ 
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l lalus: Playing 

Tip: Visit Netscape 's plug-in page to 

download a copy ofthe Rea/Audio 

plug-in ( http://home.netscape. com/com

prod/productslnavigaror/version_2.0/pl 

ug ins/audio-video. II t111l ). 

304. , Chapter 9 

Netscepe: neofAudio's llol , Cool & New! 

_;j~11J ~~~_g_JJ:U _j II 
P'ietsft.. I http ://bri'lklty rt.a lludio.com/conttntpJtroteoointv .html I 
"'I» I'$ Htw? I 'ollat's Cool? I Hondu>Oi< I tltl S.r<h ] Ntll>rootorq( " •"'Sjjro'f' f 

I Hot·Cooi· New j J J!;j•, 
-=-=---:-==---=----==~--=-------c:-- ==-=------= 

0 ne of the most exciting developments on 

Web pages is Real Audio, by Progressive 

Networks, Inc . (http://www.realaudio.com). I 
This inte resting new technology allows you to 

simul taneo us ly download and play sound. The Progressive 

Network Web site hosts pages that contain ABC, Nationa l 

Public Radio, and Radio Yesteryear radio programs. 

Progressive Networks, Inc. sells ReaiAudio server software 

to sites that wish to offer streaming audio files or realtime 

playback. Web site visitors who have a Real Audio player 

installed will have only a two-second delay compared to the 

longe r delays required for AU or WAY fi les. 



~ Ll~~~ = :;gj~_j 
...... F· ~,_-_,, .... .,.,_, .... , 

Tip: Netscape and Internet Explorer both 

can guess at a Web site 's protocol, which 

means you don'tneed to type hllp:l/. For 

example, try www.iwna.com. 

T he IUMA site at http://iuma.com (Internet Underground 

Music Arch ive) is the ep ito me of organiza tion, 

advanced sound technology, and beautiful g raphics. 

Founders Robe11 Lord and Jeff Patterson are recent computer 

science graduates from the U nivers ity of Californ ia at Santa 

Cruz. Created in 1993, the site is intended for independent, 

unsigned artists who want to reach the estimated 30 mil lion 

people on the fn te rnet. ln ] 994, IUMA was awarded "Best 

of the Web" by Inte rnet book publisher O'Reilly & 

Associates for "contributions that have signi ficantly 

improved the Internet." 

For musicians, "base service" on IDMA is $ 120 per year and 

includes one song, one logo, two band or other images, up to 

two pages of text, and cross- indexing by artist, song title. 

location, and genre. 

Songs submitted on OAT tape or C D are d ig itized and com

pressed to disk using MPEG2 audio compression tech

niques. MPEG (Motion Picture Experts Group) is a high

fidel ity sound format (cassette quali ty) that o ffers beuer 

compression than AIFF or ).I- law (pronou nced IIlli law) . 

On the Macintosh platform, Web s ite visitors w il l need the 

MPEG/CD player application to hear .MP2 files. 

IUMA artists Bran dee Amber Selck and David Beach create 

graphics with Macintosh computers, but create sound on 

Silicon Graphics Tndys. Upon ente ring the site, the database 

of over 500 musicians can be viewed in five different ways. 

Sound jaos. 



1. 

A tt.<l o c a lled Fred 
Ab:lirazak 
Aboufadel, Edwarcl 
Action F i.gures 
loDSR 

2. 

3. 

4. 
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s. 

II 

l!i 

1. New arrivals. 
A list of the newest bands on fUM A. 

2. By artist. 
An alphabetical listing of all IUMA bands. 

3. By genre. 
A listing of musical genres or styles. Note that bands may be 

under mul tiple categories. 

4. By location. 
Bands can be sorted by country, state, and city. 

5. By label (from the IUMA home page). 
Several record labds have their own home page on IUMA. To 

access this section, click on the washing machine pictured on 

the JUMA home page. 



1Yp: When you discover a site you /ike, 

select Add Bookmark from the Bookmarks 

pu/1-downmenu in Netscape. This will 

record the site address so you don 't have 

to ew er it the next time you want to visit. 

To view the list, select View Bookmarks 

j iv m the Bookmarks pull-down menu. 

Click on the Export bun on if you want a 

copy of the list. Netscape will create a .file, 

which you might email to a}i"iend. 

lt:J@I a. mu.lder . a.u 

The Van Hafen sound samples (hllp://vanhalcn.wamer

rcrds.com/Balance) are arranged on a beautiful page of 

wallpaper graphics and half bullons, which is the anist's 

clever scheme to use sound excerpts rather than full songs. 

Visitors have their choice of AlFF (Macintosh), WAY 

(Windows), or AU (Unix) fi les. 

Enter X-Fi/es on the Yahoo! search page (http://www 

.yahoo.com/search.html) and you ' ll gel a list of several Web 

sites and several newsgroups. Charles McGrew's Web site 

has the best sound (hllp://www.rutgers.edu/x- filcs.html). 
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Tip: Although DigiPiwne by Electric 

Magic does not have as high a pmfile as 

the new Coo/Talk telephone tool devel

oped by Apple Compute1; it does not 

require as ntuch hardware and software. 

Coo!Tctlk requires a Power Macintosh 

running System 7.5.3 or late1; Open 

Transport /.1.1 or late1; and QuickTime 

2.5. These compOiten/.1' may be down

loaded from Apple at hllp:/lwww 

.qttickTillte.apple.colnlslv!qtlnac.htlnf. 

Digiphone For Mac 

308. , Chapter 9 

D igiPhone (formerly NetPhone), introduced in 1995 by 

Electric Magic (http://www.emagic.com), provides 

realtime voice communication over the Internet on 68030-

based Macintosh machines and Power Macs. (Note: 

Net Phone was sold to Third Planet Publishing, makers of 

DigiPhonefor the PC.) Apple has introduced an Internet 
telephone tool called CooiTalk, which requires a Power 

Macintosh. 

DigiPhone allows calls to be made between Macintosh 

Internet users over a minimum 14.4 Kbps phone connection, 

anywhere in the world. As [nternet connections become 

more powerful in the next few years, Internet telephones 

could rival conventional phones. 

Electric Magic, the maker of DigiPhone, provides a trial 
version of the software, which can be downloaded from 

their Web site (http://www.emagic.com). The demo is fully 

functional but terminates the call after 90 seconds. 

Andrew Green, the British computer programmer who 

invented DigiPhone, compares the software-which uses a 
modem-based connection to send a maximum of 1,800 

bytes of data per second- to telephone-quality speech 

(which c01isists of 8,000 bytes per second). To compensate, 

DigiPhone compresses the data before transmitting it over 

the Internet. At the receiving end, DigiPhone decompresses 

the data and sends it to the computer's speaker. 

Although DigiPhone presents an interesting no-charge alter
native to traditional fee-based long distance calling, 

America's Caniers Telecommunications Association, 
representing America's small- to medium-sized can·iers, 

have filed a request with the FCC asking for a regulation or 
Internet phone products. fnrerestingly, the major can·iers 

do not want regulation, and GATT (General Agreement of 
Trade and Tariffs) forbids individual governments from 
regulating computer networks. 
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Coo lT a lk fo:ot· t'·la o~ n-1 OS lnst.:.ll 

Tip: Although Apple has tried to make 

Coo/Talk a video cOJ~ferencing tool in 

addition to an internet telephone tool, 

their product excludes non-Power Mac 

users. 

CU-SeeMefrom Cornell University 

is a free video conferencing so.fiware pro

gram for Macintosh/Windows machines 

and is not limited to Power Macintosh 

equipment. The software may be found at 

lwp:/!cu-seeme. edu/#GEI. Multiple

party conferencing is also available with 

Cornell 's Re.flector program (Unix) or a 

Windows NT Reflectorfrom White Pine 

Software. For more information, visit 

http://goliath. wpine.com!cu-seeme.hunl. 

lJ Nehcnpe: Nelscapc Haul a lor 3.0 I t oollelk ~ 

I~ I .. ~J ~ I I .~. I ~" I !. I ~. I ;~ I~ II 
r.ttJih IMtp /lhortw MUUI,...comleorr.pro-:i/r-rN.~t•lr.i'"\:)lttf/n.-n,n.JD/uti'W:'iU'Iicil "n/eoo~dc/~.WXIIll'l'l I 
l~t·._r;t•?JI ~r.~~·.coo1?ll o.-stlhitioM II NttSun.h 1~1 SoflwaN I 

CooL TALK 
Coor:'at'f. U lll. tnli!:mrt ~rt~Dm t)OI itclul.d ....,11 lteXtJ;t ll~~am J 0 'lbo..t pw.rw!es hJeh·qW.I)'au!» 
co:.ftnn::bl;, a CU.C·fu.r&e( vtJletoud, 6Jld tttt-bueoe. comnur.b!ioas c=b& 1be dc.t tx~l_ \'.'lC:IOoerfdk )Oil Can 
:.ov I.))); e:w:! '1rmlt. CGDd o=alivdy vaO trltc..t s liM eoiiUCUJ at.yvbeft Ul 0e ~ •:it mt lt.lemtl AnJ \.e(:)u.te 
C®fr&I);"'W!IU.alt.J:l::'-,C. Ihiv~so:JO,)'OI:.Cil'!st~WM'tMt'.)]b. d:act)yt:oC'Ilti}'Y,'tbPQ:e ~ 
CC.::Ifl'tn OOV Coorrtr'\ !utJ:"U :«luJe. 

r. . 

• Alldlo collfenad~ • Ta:t. ~-
, .,tb fdtrJ3 t.r-.1 u:oc~ eoc:ron t1t 
lr.~vil'\!ulldufk:t-'Octod ,1f't.i:h 
en,~lu }'tl\.1 t1 =~U.elld be~ 
S!mW'tA...-ot:-'1}' CooiT!t.&. U u e:~~:~y t1 
c:e ~ &phone,lnt ..r..thoutuy 
8Xfl-8tiSIVl!loJ'C·d~t!m('e (he,'itS. 
CoolT&lJt tiClc.dn a.~peed dlalet. callet 
10 Cu.~UOMl.l':y.ca!J :~~erter~, $1\d mu~ 
t,u~r.!. 

• llfeh~ aallly eudio · Multrp)r 
cot:~.pl'tJSiontonruuer.Jtle 
klv·W.d.vio!ttl oprn.OOn ~tr.e !.:!1'1:1."4 
ll:!'O'Vltb!&3~:nttvoo"k~tql"a·3Pfed 
rr.:ldem.c:cMtetD~ bl.ee . .h-en~eof 
lb hl&hen~r.dio4i,wll\Y 

• CooJTeU.pboD.Ctloot.·A~r~~iteuyoiOc::e.~clhetCO)mtr.wers 

• AA.snn.a.c [U(;')iu: · CooiT.:.t.'Jen.s'11'1Tt:JC lr.!C~ fK'(Db~qdD:I callertt1o:JMDO:.wtilt )Clu'rt 
&.vay 

• Sbored ., •. hebou4 • Wtnt yoo-.B. 
'Wl.Ci aooUt~ce -.""-CoorNk. )tl'-lcU\ 
bota b( 'Mvt.'"'l& Vie ,,.7.,. &: 1'1~tuc tne&e 
w! t;JI~ltltlrealti:nt v.th. e. CuD 
:qeofdrn'ltl(,toom,~mulwp 
ools. Impon, ,,.~. mt prlttt11PP , 
OU', JPHO, E MP . EPS , TA.~A. 
RA!:T!R. u.i :xE file' 

• CUI IDol· 1lru ~%t·ba!.!d 'DOl ... b }'0\.1 
~ndatJl~el\'tiJPe,d~$3.~ '\'tU 
.., ta'tlft: text t~. 1ftlU am: CoolThlk 

• Scla p W&Uul • Cu up ud run:uc 
f.).1t, W.b o eoorro.·.z i.unci'.-. 
::ttql Wl:.US m! rolhe h!lp. 

e Olal·up JP SllJ poll ·CoorTall. --.:~~"'::•:: .. :!i<:::::::=::..=::.::=.J 
(JO'n!tsfuJ:up,anforbo-:hd~ • 
itl'd n,QC IP C'OtoeeOON C..-oq:b d U:·\.1, 
PPP W SLIP ccn."'tCUCR.1 
_,pcorr.inz l.MIMedb.~p-phceWu Wt -.'ill be to;!:eJ on lha te«mJyintlOducN H 323 'u.~trd 

• Moldp lat!orm-rnd}' • coorren. b ~'l$ll.)'Cik 'Wlth Ue.'fi.lam 3 0 !orVII£'~o.,:~ 95, W".ndow ttT, Wb1ow 
3 1 , !1~0!:, SUnOS , .£olm3, HP·UX, O~ IW Ur.Jx, ~ IRJX:. Verswm !cr &::diior.el U:Ux pbr!o~m:~ V"Jl 
~e·~l..le$10C n 

Arpla ot!e.rs ~ com,lll:~~t~ fiU:l!Jyorn:.roccnftrtitW.r~ tt-.,, bW:ro~~" ",th N(~ara·~ 
CoJITelt... 

Cor~~"• Sdu · ~ ~193'~. ~uJ lfl.J ~~ ~l7-37n, r.wu u..zu ~~~'9J7-31fH 
1';-o•U. .. a:.y~P-. , J "'Ut"\::.t~. 

Ce tl'filU e 19?~ cwuu.r.;uy;.hte·l!$ c ""rJ:!!f_..;J. 

,.. . 

CooiTalk fo r Macintosh (http://home.netscape.com/ 

comprod/products/navigator/version_3.0/communica

tio n/cooltalk/index.hLml) is an Internet te lephone tool creat

ed by Apple Computer. Versions are available for Windows 

3. 1/3.1 L, Windows 95, Windows NT, and Unix machi nes. 
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The compact 
MIDI file format 

Summary: MIDI (Musical Instrument 

Digitallnteljace) was.first developed in 

the 1980s. Although MIDI data trans

mission was originally developed for 

hardware sequencers, computer soft

ware sequencers and synthesizers have 

expanded MIDI's capabilities. 

1 .. ..._ _ _ .. _... _f#Jo!r.II..O:Joi:;OI ... f .... ,.....(i ....... •MC!f~4"- .. , 

~-'- _w_,.., .,. 
:-'""':'~~,:..~:.~~~~~ . ... .... "-.. ~--, ...... h, ...... j .. ' ~ 

Tip: Heini Wit hagen 's MIDI home 

page at hllp:llwww.eeb.tue.nl 

lmidi/index.html has links to articles 

and tech tips, MIDI sound archives, 

MIDI software wilities, and special

interest group links. 

310. j Chapter 9 

~ Netscope: a_ ~ 

1!1 1111 Ill 
I . 

'········ ···· 

Netscape's new LiveAudio technology plays WAY, 

AU, and MIDI fi les either through a floating sound 
controller or as background sound. (Note: For details on 

background sounds, see Greg Hess' tips on adding a back

ground sound to your Web page.) 

1. What is MIDI? 
MIDI (Musical Instrument Digital Interface) refers to 

digital information passed between two MIDI-capable 

devices. The information is created with a music synthe
sizer. Although MIDI hardware sequencers predate 

computer-driven MIDI software, the transition to micro

computers has provided many more features. For example, 

not only can computers record and replay, but they can 

provide storage, editing capibilities, and elaborate syn

chronization, including MTC (MIDI Time Code) and 
SMPTE (Society of Motion Picture and Television 

Engineers). 

2. MIDI file size is ideal for the Web. 
MIDI music has been widely cri ticized by traditional 

instrumentalists. Some critics have described MIDI as 

having "little performance fire or fl air, no musically sensi

tive timing, and lacking in subtlety." 

In spite of this type of criticism, the format is ideal for the 

Web. File size is very small, and relative duration of play is 
very long compared to sampled sound. 

File Type 

africa.mid MIDI 

seagull.au AU 

File Size 

50 K 

56K 

Duration 

2 minutes 

II seconds 



Set Netscape's 
Preferences to 
download music 
files 

Summary : Once you 've found.free-of

rights M I Dl or sampled sound on tire 

Web, you '//need to adjust Netscape's 

Preferences to make the browser down

load a file and not play it. 

2a. 

~:,~: .. :~~ ~~~~:.':!'::ena~•··· 
~•unny "'"'"'•"H"' .. 

... sr.ow1oolblf 

.,.. ,r.cwlontkHt 
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l a. 
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u- .... ..._ ·-·-~ :::::::::.:· . ..... _ .... ..-
:=~-_j 

W hen you click on a sound li nk in the Netscape 

browser window, Netscape's new sound controller 

wi ll appear, and the sound will begin to play. If you want 

to save the file to your hard drive, alter the Preferences 

settings. 

1. Open Preferences and select Helpers. 
a. Choose Preferences from the Options pull-down 

menu. 

b. In the dialog box that fo llows, click on the Helpers tab. 

l b . 

2. Edit MIDI file type handling. 
a. In the Helpers d ialog area, scro ll to the LiveAudio 

section. 

b. Click to select the audio/midi file type. 

c. Click on the Edit button . 

r:::: ·- •-- r- t ........ J-...~~ - -
.... -~· .. . ........ ., .. 
ill ;..-A ..... . 

-·-·---· .. -· - .. __ 
~ :::: I w•••- I 

~!!!_~-- ~d_,i!!!l __ -~d 

2 b. 

I( Edit .. . 

2c • 
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3c. 
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d. In the dialog box that fo llows, select the Save To Disk 

radio button. 

e. Click on Ok. The next time you c lick on a sound link in 

the browser window. Netscape will save the file to your 

hard drive. 

2e. 

3. Rearrange where your files will be saved. 
a. Choose Prefe rences from Lhe Options pull-down 

menu to display the General Preferences dialog box . 

b. Click on the Applications tab. 

1- .. - 1 , .... l u:. • • I -1 .... ,.,_ l ·· ~·1 .... - 1 

3b. 

c. fn the d ialog box that fo llows, click on the Browse 

button. 

d. Use the file lis t w indow to select a drive or folder where 

you would like Netscape to save your Ii les. 

e. Cl ick on the Select. .. button at the bottom of the dialog 

box to select the drive or folder. and c lick on OK. 

h '" ' •4111f l ll f 
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Greg Hess' 
tips on adding a 
background sound 
toaWebpage 

Summary: Netscape 's new LiveAudio 

HTML syntax added to the <EMBED> 

tag causes the browser to process a 

soundfile and deliver it to your com

puter as a backgound sound. 

Above: A room inside The Castle Red 

Dog. 

Above Right: Greg Hess 'The Castle 

Red Dog Web site, which provides sup

port for his Palace site, is a virtual chat 

environme111 comprised ofbeaurijitf 3D 

images. To obtain Greg's Palace site 

address, go to the Palace direct01y at 

http:/!IJiansion.thepalace.cont! 

cgi-bin!directory.pl and /ookfor "The 

Castle Red Dog." 

I n this example, Greg Hess uses the <EMBED> tag and 

Netscape's new LiveAudio HTML syntax to add a back

ground MIDI sound to his home page at hnp://www.geoci

ties.com/-thecastle. (Note: Look for Greg's MID/files on 

the companion CD-ROM.) 

1. Open SimpleText. 
Use SimpleTex.t or your word processor. If you use a word 

processor, be sure to save the document as Text Only. 

2. Create a new HTML document. 
Start a new document with the fo llowing markup tags: 

<HH1L> 

<HEAD> 

<TITLE>The Castle</TITL E> 

<! HEAD> 

3. Add an <EMBED> tag. 
Use the SRC attribute to indicate the source of your sound 

file, the HTDDEN="TRUE" attribute to hide the sound 

controller, the AUTOSTART="TRUE" attribute to begin 

playing the sound automatica lly, the VOLUME="] 00" 

Sound 1313. 



Above: A scene from The Castle Red 

Dog palace site. Visitors Jane and Les 

are represented as avatars against a 3D 

scene. Text entered in the Message box 

at the boflom of the screen causes a talk 

balloon to appear over an avatar 's 

head. For more information on how to 

download a free palace client program 

or how to create your own palace site, 

visit hllp:l/www.thepalace.com. 
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attribute to set the sound volume to the maximum level, 
and the LOOP="TRUE" attribute to play the sound con
tinuously until the Stop button is pressed or the user goes 
to another page. 

<HTML> 

<HEAD> 

<TITLE>The Castl e</TITLE> 

</HEAD> 

<EMBED SRC- "al binon i. mid" HIDDEN- "TRUE" 

AUTOSTART- "TRUE" VOLUME- "100" LOO P-"TRUE"> 

4. Add a <BODY> tag. 
Use the BACKGROUND attribute to add a background 
image, the BGCOLOR attribute to add a background 
color, and TEXT, LINK, VLINK, and ALINK attributes to 
add color to body text, link text, visited link text, and 

active link text. (Note: See the Online Tools chapterfor 

details on how to locate hexadecimal triplets to add color 

information to these a/tributes.) 

<HHlL> 

<HEAD> 

<TI TLE>The Cast l e</TITL E> 

< lllEAD> 

<EMBED SRC- "albinoni .mid" HIDDEN-"TRUE" 

AUTOSTART- "TRUE" VOLU~iE-" 100" LOOP-"TRUE"> 

<BODY BACKGROU ND- "a052.jpg " BGCOLOR- "1/00B9B9" 

TEXT- "1/FFFFFF" LINK- "f/OOFFOO" VLINK- "1/0lFFFF" 

AL IN K- "IEEOOOO"> 

5. Add centered text. 
<HTML> 

<HEAD> 

<T!TLE>The Castle</TITLE> 



Above: A roorn inside The Castle Red 

Dog. 

<!HEAD> 

<EMBED SRC•" a1bi noni .mid" HIDDEN•"TRUE" 

AUTDSTART- " TRUE" VOLUI·IE- " 100" LOOP• "TRUE"> 

<BODY BACKGROUtlO• " a052. j pg" BGCOLOR• " IJOOB9B9" 

TEXT•" /IFFFFFF" UNK•"i/OOFFOO" VLINK• " {JOl FFFF" 

ALI tlK- "i/EEOOOO"> 

<CE tH ER><B><FONT SIZE-+4>The Cast1 e Red 

Dog</ FONT><IB><ICENTER> 

6. Add a centered image. 
<HH1L> 

<HEAD> 

<T I TLE>The Cast1e</TIT LE> 

<!HEAD> 

<H1BED SRC-" a1bi noni .mid" HIDDEN- " TRUE" 

AUTOSTART• "TRUE" VOLU~IE-"100 " LOOP- " TRUE " > 

<BO DY BACKGROUtlO• " a052 . j pg" BGCOLOR· " IJOOB9B9" 

TEXT• "I/FFFFFF" L1 NK- " #OOFFOO" VLI NK· " i/Ol FFFF" 

ALI NK• "i/EEOOOO" > 

<CEIITER><B>< FONT S I ZE-+4> The Cast 1 e Red 

Dog</ FONT><!B><ICE NT ER> 

<C ENTER><A HREF•" i ndex2 . h tm " >< Ir~G SRC• "1 ot hern. gi f " 

BORDER- O><IA></CENTER> 

7. Add additional centered text. 
<HTML> 

<HEAD> 

<T lTLE>The Cast1e</T ITLE> 

</ HEAD> 

<EMBED SRC• " al binoni .mi d" fi! DDEN• " TRUE" 

AUTOSTART• " TRUE" VOLUME• " IOO" LOOP- " TRUE" > 

<BODY BAC KGROUND•" a052. j pg" BGCOLOR• "//OOB9B9 " 

TEXT• " IJFFFFFF" LI NK• " I/OOFFOO" VLitiK• " /JOlFFFF" 

ALINK• " IJEEOOOO" > 

<CENTER><B>< FONT S!ZE- +4>The Castle Red 

Dog</FONT><IB></CENTER> 
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Above: A room inside The Castle Red 

Dog. 

316. , Chapler 9 

<C ENTER><A HR EF-i ndex2. htm>< IMG SRC- "lo t hern.gif" 

BOR DER-0></A></CE NT ER> 

<CENTER><FONT SIZE-+l>Out of t he fog of night, comes 

an oas i s for the wea ry. Come and enjoy Castle Red Dog 

·A Pa lace virtual cha t site with no commerci al 

interests. just good art. good fun. and good people. 

So if you are ready to enter, cl i ck on the Cast l e and 

head inside to expl ore the many 

delights.</FONT></CENTER> 
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Tip: MIDI Web at http://www.midiweb 

.com has an assortment ofMIDJ files to 

download. 

8. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) reflect the 

HTML 3.2 spccitication. 

<BODY> .. . <IBODY> 

This tag uses the BACKGROUND attribute to add an 

image to the background, and the BGCOLOR, TEXT, 

LINK, VLINK, and ALINK attributes to add color to the 

background and text. (Note: See the Online Tools chapter 

for directions on how to add hexadecimal triplet values to 

these allributes.) 

<CENTER> .. . <!CENTER> 

A lag used to center an element on a page. 

<EMBED> 

This tag uses the SRC attribute to indicate the source of 

your sound file, the 1-!IDDEN="TRUE" attribute to hide 

the sound controller, the AUTOSTART="TRUE" 

attribute to begin play ing the sound automatically. the 

VOLUME=" I 00" attri bute to set the sound volume to the 

maxium level, and the LOOP="TRUE" attribute to play 

the sound continuo usly unti l the S top button is pressed o r 

the user goes to another page. For exa1 nplt:: 

<EMBED SRC- " albinoni . mid" HIDDEN- " TRUE" 

AUTOSTART- " TRUE " VOLUHE- " 100" LOOP- " TRUE " > 

<HTML> ... <IHTML> 

A tag used to open and close an HTML document. 

<HEAD> .. . <IHEAD> 
A tag used to open and close the header portion of a 

document. 

<IMG> 
Used to refer to an in line image, th is tag uses the SRC 

attribute, which represents the URL (location) of the 

image. For example: 

<H1G SRC - " lothern.gif" > 

<TITLE> ... <ITITLE> 
Used under the <HEAD> tag, the <TITLE> tag describes 

the title of a document, which shows up inside a docu

ment's Litle bar. 
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Creating a link to 
sound files on 
your Web page 

Summary: Create HTML fi11ks to A IFF, 

AU (Mac a11d U11ix J.J-Iaw, pronounced 

nwlaw), WAV (\Vi11dows), MP2 (MPEG 

audio), RA (Rea/Audio), and MIDI 

SOIIIldfl/es. 

318. j Chapter 9 

The Van Halen Soundbytes page offers AIFF, WAV, 

and AU fi les for downloading. To see the I-ITM L tags 

that make up a page in Netscape, select Source from the 

View pull-down menu. T his is a practical way to learn 

how to use I-ITML tags. For example, the HTML tags for 

the links to the Van Halen "Amsterdam" sound bytes 

include: 

<DL><DL><DL><DL><DL> 
<DD><JHG ALT- "Amste rdam" 
WJDTH-118 HEIGHT-50 
SRC-"/Bala nce/audio/ba l ance-amsterdam.gif"> 
<BR> 
<OL> 
<OD><FO~ T SIZE-2> 
<If.IG ALT-"" WIDTH-58 HEIGIH-58 AUG~- BOTTOH 
SRC-"butt_play.gif"> <J>Excerpt<IJ> 
<A HREF- "/Balance/sounds/amstrdm .a iff">aiff</A> 700k . 
<A HREF-"/Balance/sounds/amstrdm .wav" >wav<IA> 700k. 
<A HREF-"/ Balance/sound s/amstrdm .au" >au<IA> 250k . 
<IDL><IFOUT> 
<IDL><IDL><IDL><IDL><IDL> 
<P> 



CJ~~ Net scope: Mother Mory:So I 

_;j~~.:J~lij ror rd Homo Rolood lmagts ep.., 

Location: llil• :II /HO/Dosktop%20folder /Mo ther~~larv%20S 

\>'hat's Nt'ol? I \lhat's Cool? I Ha11 dbcol; I Ntt Soarch I !! 
Ex:e!p! 

91 
~-®1 Oooumoot Done. 

3 . 

DE ~ Net scop e: Mother Mory:SoL 

~~~.:J~ ~ roo· I ·d Homt Roload 1m•9•• Op•' 
Loootion: I file :///HD/Desktop'11120Folder/Van9020Halen%20 

\t'hat's l<ow? I \!'hat's Cool? f Handbook I N• t Soar<:h 

Exce1p1 

ICJ I 
l l:zl~ [ 

4. 

Follow these steps to get an understanding of the effect 

these tags have on a Web page: 

1. Open SimpleText. 
Use SimpleText or your word processor. If you use a word 

processor, be sure to save the document as Text Only. 

2. Create a new HTML document. 
Start a new document with the following markup tags: 

<HmL> 
<HEAD> 
<TITLE>Mother Mary: Soundbytes<IT ITLE> 
<! HEAD> 
<BODY> 

3. Try the definition list tag <DL>. 
Add < DL>, followed by lhe word Excerpt. Add an ending 

<IDL> tag . 

<HTHL> 
<HEAD> 
<TITLE>Mother Mary:Soundbytes<IT ITLE> 
</HEAD> 
<BODY> 
<DL>Excerp t</DL> 

Save thi s document as Definition List Sample, and open it in 

Netscape. Select Open File from the File pull-down menu to 

view your HTML document. 

4. Try nesting two <DL> tags. 
Add another <DL> and another <IDL> tag around the word 

Exce1pt. 

<HTHL> 
<HEAD> 
<T ITLE>Mother Mary: So undbytes<ITI TLE> 
<!HEAD > 
<BODY> 
<DL><DL> Excerp t<I DL><IDL> 
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5. Try nesting four <DL> tags. 
Add two more <DL> and two more <IDL> tags around the 

word Excerpt. 

<HTML> 
<HEAD> 
<TITLE>Mother Mary:Soundbytes< /TITLE> 
<! HEAD> 
<BODY> 
<DL><DL><DL><DL>Excerpt </ DL><I DL><!DL><IDL> 

6. Add an inline image. 
Insert an <IMG> tag after the opening definition list tags in 

the form <IMG SRC="apple.gir'>. The SRC attribute indi

cates the file name of the image. (Note: The fi le name alone, 

without a path name, indicates that the image file is in the 

same directory as the HTML document. ) 

<HTML> 
<HEAD> 
<TI TLE>t·1other Mary: Soundby tes</TITLE> 
<!HEAD> 
<BODY> 
<DL><DL>< DL><DL> 
<IM G SRC- "appl e .g i f"> 
Excerpt 
</ DL><IDL><IDL><IDL> 

7. Add an ALT attribute to the image tag. 
TheALT attribute in an <lMG> tag is an accommodation for 

people with text browsers. In this example, they see the word 

Apple instead of the GIF image. 

<HH1L> 
<HEAD> 
<T ITLE>Mother Mary:Soundbytes</TITLE> 
<!HEA D> 
<BODY > 
<DL><DL><D L> <DL> 
<IMG ALT-"App l e" 
SRC- "apple .gif"> 
Excerpt 
<IDL><IDL>< IDL><IDL> 
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8. Add an italic tag around Excerpt. 
Add a set of ita lic tags around the word Excerpt with the pair 

<l> and <II>. 

<HH1L> 
<HEAD > 
<TI TLE>Mother Mary :Soundbytes</TI TLE> 
<! HEAD> 
<BODY> 
<DL><DL><DL><DL> 
< II~G ALT-"Apple" WIDTH -100 HEIGHT- 102 

SRC- "apple . gi f"> 
<!>Excerpt</ I> 

<IDL><JDL><JDL><JDL> 

9. Specify the height and width. 
Insert WIDTH= LOO and HEIG HT= I 02 in Lhe <lMG> tag. 

This information may be obtained from the Image Size dia

log box in Photoshop. Specifying the H EIGI-lT and WIDTH 

as attributes of Lhe <IMG> tag speeds the loading of the 

image on the Web page. 

<HTML> 
<HEAD> 
<TJ TLE>Mother Mary : Soundbytes <ITITLE> 
</HEAD> 
<BODY> 
<D L>< DL><DL><DL> 
< lf~G ALT-"Apple" WIDTH- 100 HEIGHT - 102 
SRC- "apple .gif"> 
<I>Excerpt<II > 
<IDL><IDL><IDL><I DL > 

10. Add links to sound files. 
Creare Li nks to sound fil es by opening with the link tag <A> 

and the HREF attribute, entering text, and then the closing 

<I A> tag. Thjs text serves as the c lickable ho tspot o n the 

Web page and can be identified wiLh an underline. 

<HTML> 
<HEAD> 
<T ITLE>Mo t her Mary : Soundbytes</TITLE> 
<! HEAD> 
<BODY> 
<DL><DL><D L>< DL> 
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Tip: Keyboard Magazine's Web site is a 

great resource f or musicians who are 

interested in electronic sound. Visit 

http://lvlvw.keyboardmag.com. 

322. J Chapter 9 

<I MG i nsert IMG att ributes shown i n previous steps 
(see Step 9) 

SRC- "apple.gif" > 
<I>Excerpt<JI> 
<A HREF- "/sounds/"garden.a iff">aiff <IA> 700k. 
<A HREF-"/sounds/"garden.wav">wav< IA> 700k . 
<A HREF-"/sounds/ "garden.au" >au<IA> 250k, 
<A HREF-"/sounds/"garden. mp 2">mp2<1A> 250k, 
<A HREF•"/sou nds/"garden . RA ">RA<IA> 250k. 
</ DL><IDL><IDL><IDL> 

File Format 

AIFF 

WAY 

AU 

MP2 

MIDI 

RA 

Notes 

An audio fi le format used on the 

Macintosh platform. 

An audio fi le format used on the 

Windows platform. 

An audio file format read by Sun 

Spare, NeXT workstations, and 

Macintosh computers. 

A hi -tidelity lite format used on the 

Macintosh, Windows, and Unix 

platforms. 

A digital sound file format devel

oped in the J 980s that has recently 

become popu lar on the Web because 

of its small ti le size and long play 

duration. 

An audio file format developed by 

Progressive Techno logy, Inc. for 

instant playback or audio 

streaming. rnstant playback is only 

ava ilable from servers equipped 

with ReaiAudio server soft ware, 

although the RA !ile will do a nor

mal download to Macintosh, 

Windows, and Unix machines. 



Tip: The ultimate band list at 

http://www.ubl.com is the Web 's largest 

list of music links wlzere a Web visitor 

can add music links for new bands. 

Browse the site alphabetical!)~ by genre, 

by resource (newsgroups, mailing fists, 

FAQjiles, lyrics, guitar tablatures, dig i

tized songs, or Web pages), or view the 

complete fist. 

11. Summary of HTML tags used in this section. 
The tags you see in thi s li st (in a lphabetical order) reflect the 

HTML 3.2 specification. 

<A> .. . <.JA> 

Referred to as an anchor, th is tag uses the HREF attribute 

to link to an external sound file. For example: 

<A HREF• " /sounds/"garden.aiff">aiff</A> 

(Note: The sound file IIWI/e must include the path name if 
the fi le is located i11 anotherdirectOI}'.) 

<BODY> .. . <./BODY> 
A tag used to open and c lose the body of a document. 

<DL> ... <.JDL> 
The definition list tag is usually used for definitions or 

short paragraphs wi th no bullets or numbering. In this 

section, this tag is nested four times to indent the word 

Excerpt . For example: 

<DL><DL><DL><DL>Excerpt</OL><IDL></ DL></ OL> 

<HTML> ... <.JHTML> 
A tag used to open and c lose an HTML document. 

<HEAD> ... <!HEAD> 
A tag used to open and close the header portion of a 

document. 

<l> .. . <.Jl> 
A tag used to format with italics. 

<IMG> 
Used to refer to an in line image, this tag uses the SRC 

attribute, which represents the URL (location) of the image. 

In this section, the <IMG> tag also uses the WIDTH and 

HEIGHT attributes, which speed up the downloading of the 

image, and the ALT attribute, which accommodates users 

limited to text browsers. For example: 

<IHG ALT•"Apple" WIDTH •100 HEIGHT- 102 
SRC- "a pple.gif"> 

<TITLE> .. . <./TITLE> 
Used unde r the <HEAD> tag, the <TITLE> tag describes 

the title or a document, which shows up inside a docu

ment 's title bar. 
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Creating 
sound effects 
with clip media 

Summary: By usingfree-of-rights clip 

media from public sound archive.\' on 

the Web, you can add sound effects to 

photographic images. 

Tip: Look for sow1d effects at hllp://info 

.fi.IIV. edu. pllmult i media/sounds/anima Is. 

1/p: The images on this page arejivm 

Pacific Coast Software's collection of 

stock photography at http://www 

.pacific-coast.com. 

I 
324. Chapter 9 

I 

A pplying what he learned when working with an ana

log sound medium, Tom Cipol la selected electronic 

images from Paci fie Coast Software's collection of stock 

photography, used A lberto Ricci's SoundEffects software 

to shape the sound, and converted fi les to formats for play

back on Unix and Windows machines. 

1. Select your photographs. 
When selecting photographs to combine with sound effects, 

look for shots with elements that evoke sounds. Pictures w ith 

human content offer the greatest range of potential sounds. 

2. How many sounds? 
When sound waves are mixed in an 8-bit environment, there 

seems to be too little infonnation for individual sounds to 

maintain their integrity. Clip sounds from the Web or sound 

effect CD-ROMs are usually 8-bit. Try to limit your selec

tion lO two sounds unless you start with 16-bit sound. 



~ 
L1Eill 

Short Country #2. A IFF 

hOt"SI? .aiff 
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Play Rll X R 
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Elosped Time 
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3. "Ustening" with your mind. 
Put yourself in the picture, and try to imagine what you 

would hear. Look for sounds that are strong enough to con

vey what's happening in the photo. You cannot expect to 

ho ld a viewer's atlention for long-15 or 20 seconds should 

be the maximum duration for your sound clips. 

4. Compare clip sound format, sample rate, 
and other characteristics. 
SoundMachine can be used to compare sound fi le character

istics such as file formats, number of channels, sample rate 

(Figure 4a), sample size, compression, and total time. 

SoundMachine displays each of these characteristics on the 

Control Panel as the choices are selected (Figure 4b ). Tom 

Cipolla noted the following information about the fi Ie's short 

country.aiff and horse.aiff: 

short country.aifl' 

Format: AIFF 

Sample S ize: 8 bits 

Number of Channels: Stereo 

Total Time: 7 seconds 

Sample Rate: 22.3 kHz 

horse.aiff 

Format: AIFF 

Sample Size: 8 bits 

Nu mber of Channels: Mono 

Total Time: I second 

Sample Rate: 22.3 kHz 

SoundMachine Progress 

~h=o=r;se=·=a=if=f~~~===.,...~l l~l~lml ~l 
22.3 l<Hz .,...I I 8 bits ~ j..,. lg llnl 1 

4a. 
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File conversion: 
AU to AIFF or WAY 
to AIFF 

Summary: Use SoundApp to convert 

AU files to AIFF. (Note: Sowu/Effects, 

the sotmd editor used in the next section, 

will be needed to read AI FF files.) 

1. 

· Edit Options 

New Play li s t 
Open •.• 

:JGN 
aGO 

l~po~t To Quici<Ti~e ... 00 1 
Close Sl! W 
Saue 3CS 
Saue As ... 

Quit 3€0 

~ 
SoundApp 

Tip: When converting to AU, use the selec

tion called NeXT on the Sounc/App pu/1-

downmenu. 

3. 

lel Sound £Hee ls ... I 
0 Hrol.oirr 
D op;Jia use .au 
D ntJtllnu•e.ou- 1 ~00 
D clgure tte .ou 
0 cll t k t.ou 
D t ll<k2.ou 
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( ll~t t I 
( Oosktn;1 I 
( New CJ) 

( Con eel ) 

n Soue J) 

T he clip sound tiles found on numerous sites across 

the Web may need to be converted to a lile format 

that your sound ed itor software can read. For example, 

Windows WAY ti les can be converted to AIFF with a 

Macintosh sound utility called SoundApp (look for 

SoundApp on I he CD-ROM in the back of this book). 

SoundApp can also be used to convert edited Iiies to WAY 
format for Windows visitors and AU for Unix visitors. 

1. Select the file you'd like to convert. 
Open the SoundApp software, and select Convert fro m the 

File pull-down menu. 

2. Identify the file and format you need. 
Use the convert dia log box to locate the file you need to con
vert. Choose the file format you need on the pop-up menu 

beneath the window. 

Ia Sound Effects ,.. I G:::l APS Driue'M 

2. 

D SoundApp Conuerted trek 
D SoundApp Conuerted t 
D SoundApp Conuerted t 2 
D speaker/Tag Heuer #1 O.AIFF 
D thunder.au 
D tom.hi.au 
D trelcdoor.wau 
D Water#B.A IFF 

./ System 7 Sound 
Sound Suitcase 

( 

~ 

3. Select a folder for the new file. 

Ejec t 

Desktop 

Ca ncel ) 

Open ~ 

EiU1er create a new destination folder for the converted file or 

select the default folder by clicking on Save. 



Mixing clip music 
with sound effects 
in SoundEffects 

Summary: Use Alberto Ricci's 

SoundEffects software to alter and mix 

SOli/IdS. 

Tip: Use Adobe Premiere to convert free

of-rights CD sotu1ds toAIFF files. Open a 

ne11·pmject, import, then open a CD 

sotmd, and export it as an AI FF file. 

+Selec t Eococtly 

1 . 

Select eococtly 

Ia 
of s ound 

0 Defore 

0 Centered on 

® Arter 

the selection. 

Seconds 

Tip: The Music Bakery Sound CD col

lection is myalty-free music available 

through a buy-out license. For more 

il(/'ormation, callB00-229-03 12. 

T om Cipolla gathered 

a country music clip 

from The Music Bakery's 

Sound CD, which contains 

a large selection of pro

duction-quality music sold 

with a royalty-free buy

out license. He also locat

ed the sound of a horse 

whinneying on a public 

domain archive on the 

Web. The sound sampling rates of the sounds Tom intended 

to mix were 8.8 kHz and 22. 1 kHz. This d iscrepancy is not 

a problem easi ly straightened out in SoundEffects because 

the software ide ntifi es the d ifferences and prompts the user 

about resampli ng sounds. 

1. Clip a portion of a CD country music file. 
Open a music lile in SoundEffects, play the file, and deter

mine the duration of the cl ip you'd like to use. Choose Select 

Exactly from the Selection pull-down menu to open the dia

log box shown in Figure I. Select minutes from the pop-up 

menu, and type in the number of minutes you'd like selected. 

(Note: Sections of the wave pattern may also be altered with 

the Cut, Copy, and Paste commands. Start by drag-selecting 

a section of the tvave pattern, and then use the Cur, Copy, or 

Paste commands.) 

2. Save the music clip. 
Select Save from the File pull-down menu. and save this 

music clip to your hard drive. 
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~ lligh Pass t 111 
~ lligh Pass 11 n 
~ I 

Low Pass II R "' 
SheiUIIIY 

I 

Amplify 

Amplify by: ~% 

(Cancel J n OK ll 

3. Create more horse sound. 
Open the horse sound in SoundEffects, select the wave pat

tern, copy it, and paste two more wave patterns at the end of 

the existing pattern. 

4. Paste the horse sound into the music file. 
Copy the new horse wave paltern to the clipboard. Open the 

music file, and paste the horse sound into channel 2. Click on 

Resample when the message in Figure 4a appears. 

4a. 

~ 
tt:J 

You are trying to paste a sound sampl ed at 
B.DDD kllz into a sound sampled at 22.050 kHz. 
Do you w ant me to r esample the sound yo u 
are inserting at 22.050 kHz? 

( Cancel J n Resample J) 

(Note: If you need to creme a second or third channel, drag 

the channel icon above or below the existing channel, as 

shown in Figure 4b. If you need to delete a channel. drag a 

channel icon to the /rash, as shown in Figure 4c.) 

5. Resampling. 
According to Alberto Ricci. resampling sound from 8 to 22 

k.Hz introduces a little distortion. To remove some of the 
distortion, select the wave pattern of the sound that was 

resampled, and then select Low PassiFIR from the 
EffectsiFIRII !R pull-down menu. 

6. Test the sound. 
Click on the Play button to review the sound. 

7. Amplify the music. 
At this point. the horse's whinneying sound overwhelms the 

sound of the music. Select the music wave pattern, and select 
Amplif'y from the Effects pull-down menu. Enter !50 to 
increase the sound or the music. 



~11 Leaue Sil ence 

Sa. 
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oytes 

I I 
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(Cancel ) ~ OK 
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Mise 
Resampling 
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Fade Out 
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Quick MiH 
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Smooth 

~ 

8. Leave two seconds of silence. 
To balance the sound a little more (so d1at the horse doesn' t 

overwhelm I he music). select the horse .. vave pattern, then 

select Leave Si lence from the Edit pull-down menu. Select 

seconds from the pop-up menu (shown in Figure 8a). enter 2, 

and click on OK. The result is shown in Figure 8b. 

<? )22.254~H<, 8 bfts 
\1)() I Stor•R 
B) !603~69bvtH-

8b. 

twlus lc.n IFF 

Chirmtl 2: u ) <SJT-52 B ump 
, . )4'!;508 

• 1301760 ' 

9. Mix the music and the horse sound. 
Start by selecting both channels, then: 

a. Choose Quick M ix from the Effects pull-down menu. 

b. Choose New Document and Mono in the dialog box that 

fo llows. C lick on OK. 

(Note: When you mix smmd, the respective pmportions qf each 

oft he sow Ids are reduced. For example, if you have three chan

nels andyoumix theji1:1·ttlro. then mix the owpw with a third 

9b. 

Quick Mill 

Mill to: 

0 New Cltonnel 

® New Document 

Usc: 

@ Mono 

0 St ereo 

[81 Usc eoch clmnnel 's pon 

channel, the pmportions 

become .25 . . 25, and .50. 

If you mix all three 10gethe1; 

the pmportions ll"ill be .33. 

.33, and .33.) 

10. Save the new 
sound file. 
Select Save from the Fi le 

pull -down menu , and name 

the file Music/horse.aiff. 
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Recording and 
mixing sound in 
Sound Effects 

Summary: Use Alberto Ricci's 

SoundE./Jects soft ware to record and 

mix SOtllldS. 

330. j Chapter 9 

Occasionally, you' ll 

want to record your 
own sound effects when 

clip sounds are not avai l

able. For the crowd photo, 

Tom used the sound of a 

crowd on a tape cassette 

he had recorded at a sports 
event. Your tape recorder 

can be hooked up to your 

Macintosh with a cable 

that runs from your tape 

recorder's output jack to the Macintosh microphone jack. 

You' ll need a 1/8-inch plug on the Macintosh end. You 

should be able to find the proper cable at your local Radio 

Shack store. Buy a cable designed for a mono signal. Even if 

your Macintosh can handle stereo sound, your recording 

should be mono to keep fi le sizes smal l. 

1. Open a new sound document. 
Open Sound Effects. Use the default blank sound docu
ment or select New from the File pull-down menu. 

untitled sound 

? rm~Hz;Sbtts - : [Cii.oliOiSTTQ-2- .. (0 -~ -- - Eh""4> 
~t><• 15..-;;:;:;;--~ l o nmptts ;:::ll • I o 

BJ rob~1,. , (.OO ••~nds ~ • fO -~ 
1------- - - a 
llBK+· ······ ····· ························································· ·· ·18 

Glf~ll ............. .. ........... ··--·--·-··············································· 83 

-:-: 

1 . 

2. Click the Record button. 
Click on the circular red Record button at the 

bottom of the document. (Note: This record button 

does 1101 srarrthe sound recording.) 

m 



Input Source: 

Microphone- Internal CO 

0 

0 Play through 

[Cancel ] [ OK 

3b. 
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4. 

3. The Record dialog box. 
To see more of the record dialog box: 

a. Cl ick on the small triangle to the left of General 

Settings. 

b. Click on Device Seuings to make sure the microphone 

is selected as your sound input source. 

c. I f your Macintosh can record at 16 bits, select this 

option from the Sampling Size pop-up box. 

d. Set the the Play-Through Volume to Off i f you're using 

a microphone hooked up to your Mac, otherwise feed

back w ill occur. (Note: if your external sound source is 

a CD playe1; you can tum up the Play-Through Volu111e 

to hear 1vhat is being recorded.) 

I,._ Record ~ 

~ [ij II ~ s~ 

Annablt S.mplts 780:1952 

Aval!.blt S.C:Onds 350.7 
R .. orcltd S.,..plu: 0 

(tanctl )~ R.cordtd SfCO"ds: 0 

V Gent r .al S•«ings 

u .. : I Mono ~I 
S4mplin9 Rate : I 22.2 kHz - Standard ~ I 
Somplln9 S izt: I 88its .. I 
Ploy-Ttv·ough Yolumt. ~ I Dtvlct Stttings .. ) 

(8) Auto Oaln 

t> Vox Parameters 

3c,3d. 

4. Click on the Record button. 
When your tape recorder is hooked up to your 

Macintosh. queue up your tape so that i t is ready to 

play. When you're ready to begin, press Play on your tape 

recorder. and cl ick on the circular record buuon at the top 

of the dialog box. When you're happy w ith the recording. 

click on Save. Figure 4 shows the result of Tom Cipolla's 

crowd recordings. 
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5. Save the new sound file. 
Select Save from the Fi le pu ll-down menu, and name this 

fi le Crowd.ai ff. 

6. Create a new channel for a music sound. 
Tom wanLed to mi x the sound of the National A nthem he 

found on a sound effects CD w i th the sound of the crowd. 

To do this, he dragged the exist ing channel icon to create a 

second channel. 

eJ Crow d.AIFF ~ 

? 2~ OSOI<Hz; 8 bits t 'Ch.lnno12: .. ro- - ffi -s,amp 
·~<) Stt rto- 276253 .. ~ ~ ro- _, 

~ r :553279 byt .. :::. 1252 t tco<>ls -· ro--:-:- = 
E3 

[ffi[l 
. . .\ · · • ·• 'I - IE! .. ' ·~;T ---r-. ' . . . 

(]ISlJ 
, .. . . .-

lEI _. 
~ 

;:,.., 
•. m 

d~=l ~ 2.1 
~ 

:!1 ri !!J JJ ~ ~ :0 

6. 

7. Paste a music sound into the crowd file. 
Tom opened the National A nthem ti le, selected the wave pat

tern, and copied it to the c lipboard. H e then pasted the music 

sound into channel 2. 

8. Mix the two sounds. 
Start be selecting both channels, then: 

a. Choose Quick Mix from the Effects pull-down menu. 

b. Choose New D ocument and Mono in the dialog box that 

follows. C lick on OK. 

9. Resave the new sound file. 
Select Save from the File pull-down menu, and name this fi le 

crowd.ai ff. 



File optimization: 
Resample and 
downsample sound 
files for playback 
on the Web 

Summary : Take an inventory o.ffile 

sizes. and use downsampling techniques 

to reduce them. 

After mix ing sound for 

each of the pho

tographs, Tom Cipolla took 

an account of Lhe file compo

nents and total file sizes to 

see whether the fi les would 

be appropriate for the Web. 

F ile size is related to d ura

tion and sampling rate. 

Larger files can be scaled down by resampli ng, a lthough 

there is a loss o f quality. 

Picture: Horse 

music (country) 

horse 

Mix 

Picture: Crowd 

crowd 

National Anthem 

M ix 

Picture: Cruise Ship 

steamship whistle 

P icture: Waterfall 

music (orchestral) 

waterfa ll 

Mix 

File Size 

330 K 

110 K 

605 K 

2861< 

lOOK 

561 K 

330 K 

1276 K 

33 K 

649 K 

Characteristics 

Stereo, 8-bit, 
22.254 kHz 

Mono, 8-bit, 
22.050 kHz 

Stereo, 8-bit, 
22.3 kHz 

Stereo, 8-bit, 
22.3 kHz 

Mono, 8-bit, 
22.3 kHz 

Stereo, 8-b it, 
22.3 kHz 

Mono, 8-bit , 
22.3 kHz 

Stereo, 8-bit, 
22.3 kHz 

Stereo, 8-bit, 
22.3 kHz 

Stereo, 8-bit, 
22.3 kHz 
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Resample Rate 

Resample the sound (preuiously 
at 22254 Hz) at 

IL11127.272]1EJ Hz 

(Cancel ) ~ OK J) 

Tip: Alberto explains that if you must 

halve tlze size of a 44kHz, 16-bit sound, 

it is better to down sample it to 22 kHz, 

16 bits, instead of44 kHz, 8 bits. 

Depending on how small you need to 

make the file, you could do wnsample 

both the rate and the size. 

Jfyou down sample a 22kHz, 16-bit sound 

to 22kHz, 8 bit, only the Macs with 16-bir 

output (Power Macs and AV Macs) will 

notice the difference. Jfyou downsample 

the sound to 11 kHz, 16 bit, it will sound 

better on the 16-bir Macs, but the 8-bit 

Macs will "hear" the sound as if it was 11 

kHz, 8 bit. 

For music, it is best to keep sound to 

16 bits. Howevet;Jor speech, 8 bit is 

suitable. 
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A1be110 Ricci, the author of SoundEffects, recommends lhc 
foUowing steps to reduce a sound's fi le size: 

1. Remove trailing silence. 
Remove any following silence paris. This often reduces the file 

as much as l 00 K. 

a. Drag-select the silence in the wave pattern. 

b. Press Delete. 

---'----' !iKIIter s.tlltt 

; I Chtnnt11 : 

I ~2 1633-tlmRIH 
n 4.45steoJI4J 

•• [6360~ E! u mp 
•• I25SOZ4 

·• ·~·~~ -= 
- E3 

= = = -- = -::-== ~ -= "' = '--- "'· 
d~..:J ~ l l~ 
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2. Resample the sound. 
Downsample 16-bit sounds to 8 bit. 

a. Select the sound wave. 

b. SelectDownsample from the EffectslResampling pull

down menu. 

3. Mix the channels to a mono sound. 
If stereo sound is not essential, this step will reduce the rile 

size. 

a. Select the sound wave. 

b. Choose Quick Mix from the Effects pull-down menu. 

c. Choose New Document and Mono in the dialog box that 

follows. Click on OK. 



Tip: Look for the commercial release of 

SoundEffects, which will be called 

SoundMake1: 

4. Resample to 11 kHz or 8 kHz. 
If the sound sti ll sounds good, resampling to ll kHz or 8 kHz 

will reduce the file size. 

a. Select the sound wave. 

b. Select Resample from the EffectsiResampling pull-down 

menu. 

c. Select 11127.27 from the popup menu, or enter 8. C lick 

on OK. 

After trailing silence was removed, stereo sounds were mixed 

as mono, and the sounds were res~unpled to ll kHz, the result

ing sounds were substantially smaller. To reduce the sounds 

even further would require shortening the sound duration. 

Picture File Size (Mix) New File Size 
- - -------

Horse 605 K 99K 

Crowd 56 1 K 154K 
----

Cruise ship 660K 176K 
------ ---- - - -

Waterfall 649K 143K 
--- -- -- ---- ---
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File conversion: 
Preparing sound 
files for other 
platforms 

Summary: Use SoundApp to convert 

files for downloading on other plat

forms. 

IIIJlll Ed i t Options 
New Play List 3€N 
Open ... 3€0 

I ll~ : 

Import To QuickTi ~le ... 3€1 
Close ~w 

Saue 31JS 
Soue ns ... 

Qui t 3€Q 

1. 

\e<J SoundApp Conucrled ( w ... • I = APS Drlue'" 

D w nte r/ ph,ned i! ( [jNI J 

( lle s k iUII ) 

( New CJ J 

Creol e Dlrecl oru: ( Cancel J 

lsoundApp Conuerl od l ouJU ([ soue D 

3, 4. 
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F ile conversion comes at 

the end o f your sound 

project when you' re prepar

ing fi les for your Web server. 

You ' ll need WAY fi les for 

Windows v isitors and AU 

files for Unix visitors . Note 

that SoundApp refers to the 

AU formal as NeXT. 

1. Start SoundApp. 
Start SoundApp, and select Convert from 

the File pull-down menu. ··,•Eat.et- / phased 

2. Identify the target file format. 
Locate the ftle to be converted in the fi le list window. Press on 

the pop-up menu (Figure 2) beneath the window, and identify the 

target fi le fonnat, which is Windows WAVE and NeXT (or AU). 

Ia Sound Effect s "' I = APS Driue'M 

D thunder.au fr [ Ej ect ) 
D to m.h i.au i D trel<door.w au [ Desktop ) 
D Wat er#B.A IFF 
D Water.A IFF mrj 

u:: [ Cancel ) D woter/phased.R IFF - ~ D welcome 
System 7 Sound n l) D K-fi les.au Open 
Sound Suitcase 

Rill I l l ., •• Iilii ./A IFF -Il l" I I 111-~IIJ' 

NeHT ~I 

2. 

3. Create a destination folder. 
SoundApp will create a folder for your convened fi les. 

Accept U1e folder name or create a new one. Decide where 

you'd like the new folder to be saved. For example , c lick on 

Desktop if you'd like to see the folder saved to the desktop. 

4. Save and convert. 
Saving wi ll starl the conversion process. Look for your 

newly created folder; your new fi les wil l be inside. 



Artist featured in this 
chapter: 

Curtis Eberhardt has 
a B.A.fromtheArt 
lnstitwe of Chicago 
and an M.A.ji·om New 
York University. Curtis 
specializes in 
Macromedia Direc101; 
Strata Studio Pro, 
Softimage, Electric 
Image, FormZ, and 
Photos hop. His clients 
include Messner 
Advertising, Web 
TV/Philips Magna vox, 
and Young and Rubicam. 

CurtisAE@aol.com 

/utp:l/www.new-kewl 
. com/curt i scape 

GIF Animation 
And Shockwave 
GIF animation and Shockwave have become the two most 

popular forms of ani mation on the Web. This chapter opens 

with several examples of both and then covers tips on how to 

create your own animation projects. By fo llowing examples 

created by new media artist Curtis Eberhardt, you' II gather 

valuable infomat.ion on how to use P hotoshop to create ani

mation stills , optirrilze color GIF images using GIF Wizard, 

assemble a GIF animation in GIFBuilder, assemble a 

Macromed ia Director animation, and created a "Shocked" 

version of a Macromedia Director movie for the Web. 





Curtis Eberhardt's 
GIF animation 

Summary: Follow the URLs mentioned 

in this section to view Curtis Eberlwrdt's 

G!F animations on the Web. 

Above: A close-up of the spaceship G!F 

animation. 

Above Right: Curtis Eberhardt's 

portfolio page contains a tiny 

spaceship G!F animation in the lower

right com er (http://www.new-kewl 

. comlcurtiscape/ main.htlnl). 

::.i.~.J ~ ~ I~ I.!. I !TiT~ i 00 -
u.;.-1-,.··--·-::r:· 
1-·-·11....,..- 11._-11 ~-.... .. ICE:JI - .... I 

L\.~Enlur CurUoc up<>.CQffi • ' 
-~~:nnttll~t::oo:' ~- I 

A bove: Curtis Eberhardt's home page, 

containing a GIF animation 

(http :l!www.new-kewl. com/curt i.~·cape). 

GIF ~nimati on is easy to i~p~ement because the animat

ed 1mage may be placed mime-or embedded in a 

Netscape page using the <lMG> tag. No scripting or plug

in is required. 

This page and the nex t page contain GIF animation exam

ples created by Curtis Eberhardt. For artists who are think

ing about creating their own G IF animation, Curtis offers 

the following suggestions. 

1. Create stills in Photoshop or GIFBuilder . 
Use Photoshop to create animation stills for your "flip-book" 

animation, and save your animation stills as GIF or PICT 

images. GIFBuilder, by Yves Pig uet, is an easy-to-usc tool 

for building GIF animations. For simple animations that 

include only movement. start with one image in GIFBuilder, 

move the art, and save successive new stills. 

2. Be conservative with GIF file sizes. 
Try to limit the number of stills in your GIF animation as well 

as the physical size. Here are some examples: 

Animation File 

Curtis Spaceshjp (this page) 

Bumpy Head (next page) 

Bumpy Arrows (next page) 

File Size 

9K 

18 K 

5 K 
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Bumpy, king of 
the Internet 

A bove: Curtis Eberhardt's rotating car

too/1 head created with GI FBuilde1: To 

see Bumpy, visit http://www.new-

kewl. com/curt iscape/ bwnp.html. 

Right: Curtis created his Bumpy char

acter using 3D software. 

Above: Curtis Eberhardt 's animated 

arrows, created with GIFBuilde!: 

340. 1 Chapter 10 

rJ NoUc ftpe: les t 
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3. Use GIF Wizard to reduce GIF file size. 
GIF Wizard on the Raspberry Hi ll Web site (http://www 

.raspbcrryhill.com/g ifwizard.html) is an o nline tool that can 

be used to reduce the size of your GIF images. (Note: For 

step-by-step instructions on how to use Gl F Wizard, see GJF 
Wizard at Raspberry Hill in this chaptu) 



Animation and 
interactive 
Web games that 
use Shockwave, 
Java, live video, 
andQTVR 

Summary: Visit Web sites with 

Shockwave and Java to gather ideas 

for your ow11 pages. 

Above: Web visitors who want to con

tact "the spirits of the Dominion" can 

play a WeeJee board game wrillen in 

Java. 

l'no,~\ ........ _._....a.tl_ ,.. ___ .. ,.d .. • ktL -
-..uoq.,.,~d..,.oP:..M •-•- .. .c.u'MIII.u.,. .... ,.JOII ~ ...... """"' ..... ~--.._, ..... ., .... ., ... ~.,. .... .,,;, 
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Above: The SciFi Channel's Lost in 

Space pages contain a Virtual D1: Smith 

Shockwave movie. 

T he SciFi Channel's Dominion site (USA Network) at 

hllp:/ /www.sci li .com is one o f the most technical I y 

advanced sites on the Web. Visitors will Find games and inter

active pages created with Shockwave, Java, and CGI scripts. 

A live video feed accessed through a link on this site 's home 

page displays what is cur

rently being shown on the 

SciFi Channel. (Note: 

Visitors call see video frames 

update eve/)' 30 seconds. To 

see new.frames. they must 

click on the Netscape Reload 

button.) 

The SciFi Channel's Web 

site is produced by the fol

lowing creative team: 

Creative Director Sharleen 

Smith, Senior Internet 

Producer Gary Markowitz, 

Online Projects Manager 

Sean Redlitz, and Lead 

Programmer Jamie Biggar. 
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"No designers 
were harmed in 
the production of 
this Web site." 

Above: Visitors who explore the links 

on The Arrival site discover an interac

tive console. It opens in an extra win

dow over the Netscape browse1: 

Above: The content of the console's 

largest frame changes in response to 

mouse clicks on folder tabs. 

342. 1 Chapter 10 

The A~Tiva l s~ te was cr~ated for lhe.Li~e Enterta~nment's 
movte stamng Charhe Sheen. Thts stte has an mterac

tivc "console" created with Shockwave and Livesctipt. The 

button panel is a Shockwave movie with flickering lights and 

machine sound effects. The folder tabs are clickable hotspots 
lhat branch to pages with movie sti lls, movie clips, and a 

movie synopsis. You can reach The Arrival site at 
http://www.thearrival.com. 

Movie fans interested in movie sli lls can use Netscape's built

in downloading image 

feature. To download a 

JPEG image: 

• Position your mouse 
over an image. Then 

press and hold the 

mouse button until a 

pop-up menu 
appears. 

• Select Save This 

Image in the pop-up 
menu. 

• In lhedialog box 
that follows, click 

on Save. 

• The JPEG image wi ll be saved to your hard drive. 



Shockwave 
movies with 
moveable parts 

Above: The Ben & Jeny 's Hair Game 

imirates a real-life game rhat uses a 

magner and iron filings to move hair 

around. 

... ,. .... !_, -· ~· ..... · •1>'.14~-~, .... ~,-....... ·-ot~o·•·-· .... -., • 
• - . ... \ ...... l;l<ft>"C .. ••"l--·· ..... ~ 

A bove: The Disguise-0-Rama game 

from Marlow Publica/ions imiw res a 

real-life paper cut-out game. 

l ... l hnl http //W'tfflott\.i'"''VUrniM/b}'ll•n, 1'1trr l 

~··,:2.·.:J~Cuo11 ~ 1 ·~I ''-IC.~~~~.JJ~J 

ro••tut•nr~IUI.J.cru.d~. 

IW).lJto~ 

~ 
mum 

Place yoor cursor 
over the hair material 
and press the mouse 
button. Hair will cling 
to your cursor&' can 
be moved In place as 
moustache, beard, 
sideburns, eyebrows 
and hair. Let go of the 
mouse button to d rop 
hair ln place. 

To start over, click on 
the "Clear" button. 

Ill 

T he Disguise-0-Rama game, the Ben & Jerry's Hair 

game, and tJ1e Build Your Own Bug game make innova

tive use of Director's moveable sprite option. This feature, 

which can be implemented in the Score or through Lingo, 

allows viewers to slide cast members around while a movie is 

playing. VisitlJle followi ng sites to see Shockwave movies 

with moveable patts: 

• Disguisc-0-Rama (http://www.marlowpub.com/ 

Marlowe/cl isguise2.html) is based on Marlow 

PublicaLion's cartoon characters Sam and Max. The 

Shockwave game was art directed by Pauline Neuwirth 
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Above: To build a bug, players select 

bug partsfivm a co/lee/ion at the 

bo//o/11 of the screen and drag them/a 

the bug "stage." 

344. I Chapler 10 

ll Nelsrope: Jamet and the Giani Peact1: Online Game 
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(redkit@aol.com) and created by Chris Kingsley 

(webmaster@romdog.com). 

• Ben & Jerry's Hair Game (http://www.benjerry 

.com/fun/bj-hairy.html) is based on a magnet hair 

game available in the Ben & Jerry's gift shop in 

Waterbury, Vermont. 

• Build Your Own Bug (http://www.bcnjerry.com/ 

fun/bj-hairy.html) was created for Disney's movie 

Ja111es and the Giant Peach. 



Tip: Quicklime VR authoring tools are 

available.from the Apple Developer's 

Association (APDA) at 

apda@applelink .apple. com. 

t¥'11l.J ~~ lhO'o"o'C fed 

w.ctP., tf ~· hao;oo oot 

Pontlo1c 
GmndArn 

Cadillac 
S.VIIh! SJS 

• 

General Motor's Product Line Web page has a small 

Shockwave movie and interesting QuickTime VR 

movie downloads of car exteriors and interiors. You can reach 

General Motor's Web site at http://www.gm.com/ shock

wav/spin/eaOO.htm. 

QuickTirne VR is Apple's cross platform movie format that 

offers a virtual reality experience in the form of a 320 by 

240 (or full -screen size), 360 degree panoramic image. The 

movie can be p layed on a Macintosh or a Windows comput

er using the QuickTime VR Player. To download the QTVR 

Player. visit A pple Computer's Web site at hllp://qtvr.quick

timc.applc.com/archive/index.html. Viewers can rotate the 

scene by positioning the mouse pointer to the lert or right 

edge of the movie and pressing down on the mouse buuon. 

To Zoom in, press the mouse button and hold down the 

Option key. To Zoom out, press the mouse button and hold 

down the Control key. 

QuickTimc VR movies may be formed from either still 

photographs or computer generated images. The movie cor

rects the distortion ordinarily associated with a panoramic 

image by incorporating a distOJ1ion correction algori thm. 

The distortion con-ection occurs on the fly wh ile a viewer is 

panning a scene. 
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Promotional 
game previews
created with 
Shockwave 

346.1 Chapter 10 

A Shockwave preview ofD, a CD-ROM game created by 

Acclaim Entertainment can be found at http:// 
www. acclaimnation.com/0. The D site was created by 

Enginc.RDA, a multimedia start-up inside RDA International. 

Enginc.RDA is a 20-year old New York City advertising 

agency owned 

by Michael Racz and Gail 

Dessimoz. Engine.RDA's 

client, Acclaim 

Entertainment. is well

known for their Mortal 

Kombat game, the most 
successful CD-ROM 

game ever produced. 

Pan of the nine-member 
Enginc.RDA team, Web 

anisl, animator, and pro
grammer Curtis 

Eberhardt can be reached 
at CurtisAE@aol.com. 



"Until all 
digital media 
blends into one 
medium, design 
professionals 
must adapt 
their skills to 
several different 
formats." 

Above: A QuickTtme movie preview of 

Dis available on Acclaim 

Entertainment 's Web site as a movie. 

He created most of the art and Shockwave movies on the Web 

site. The Engine.RDA team is led by digital media creative 

director. Regina Joseph. Regina is a multimedia content 

developer who frequent ly speaks at design and entertainment 

conferences. She is well-known for her creation of Blender, 

the pop-cu lture dig iz ine launched in I 994. 

Regina ·s other team members include: 3D and animation 

artist Alex Ostroy. digital designer Chris Capuozzo, digital 

designer and recordable media artist John Hil l, digital video 

spec ialists Claude Borenzweig and Damien C layton, pro

grammer Yin eel Shah, Web maste r Rob Keenan, and online 

media technical director Rob Molcha n. When asked about 

the rapid changes in digital design, Regina explains that mul

timedia artis ts must constantly reorient themselves to the 

changes in digita l media. Until a ll digital media blend into 

one medium. creative desig n pro fessionals must adapt their 

skills to several different formats such as CD-ROM, 

enhanced CD, and the World Wide Web. A fourth, digital 

versatile disc (DVD) is expected to be available soon. 
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"Killer Klowns, 
the band that 
produced the 
game's sound 
track, reports 
the song goes 
over very well 
in New York's 
downtown clubs." 

Above: Razorsnails pokesfi m a1 drag 

racing and California skateboard art. 

You can reach the Tlwnk site at 

http://www .tlwnk. com (No1e: look.for 

Razorsnails and other Shoc/.:lvave SC/111-

ples on the companion CD-ROM in the 

back of this book). 

348. I Chap1er 10 
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The Thunk site (http://www.thunk.com) contains a 

humorous digital game prototype called Razorsnai ls. 

The Shockwave movie was art directed by Larry Rosenthal 

and created by artist/animator Jason Fmchter. When the green 
light goes on, the snail runs over a razorblade. During tJ1e 

race, "snailjumps" include obstacles such as thumb tacks, a 
ginzu kni fe, salt, and broken glass. A teflon patch and a gaso

line slick makes the snail feel good. The objective is to get the 

snail to the finish li ne wi th a minimal amount of damage. 

J(jller Klowns, the 

heavy metal band 
that produced t.he 
·'Razorsnails" sound 

track, reports that the 

song is very popular 
in New York's down

town clubs. 



Curtis Eberhardt's 
tips on creating 
GIF animation 
frames in 
Photoshop 

Summary: Flip-book animat.ion ca11 be 

created.from a series offrames comain

ing 2D images. 

~~ 
11dobe Photoshop"'"' 

la. 

lb. 

Two-dimensional images with implied motion can be 

adapted to form a nip-book type of animation known 

as G lF animation. ln this exampl e, Curtis Eberhard t s tag

gers the position o f an a lien spaceship and a viewfinder that 

tracks the alien ship. Once the ind ividua l GlF frames are 

c rea ted in Photoshop, the GIF animation can be bui lt in 

GIFBuilder. (N01e: Readers who 111ish rofollow the steps in 

this sectio11 may look for Curtis ' images 0 11 the companion 

CD-ROM. ) 

1. Create a flip-book image in Photoshop. 
a. Open Photoshop. 

b. Select Open from the File pu ll -down menu. 

c. In the dialog box that follows, select curlis_l .gif, and 

cl ick on Open. 

d. The a lien image will open in a Photoshop window. 

lc. 

ld. 
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2a. 

2b. 

2. Make changes to imply movement. 
a. Select the Rectangle Marquee tool. 

b. Click on the double-headed arrow in Photoshop's 

Foreground/Background color box to make the 

background color black, as shown. 

c. Drag-select the alien ship. 

2c. 

d. Reposition the alien ship slightly to the right. 

e. Deselect the " marching ants" by selecting None from the 

2d. Select pull-down menu. 

350. 1 Chapter 10 
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2e. 

3. Place the viewfinder image. 
(Note: Use the Place command in Photoshop to add the 

view.findeJ: The Place command wi/1 only work if you have 

RGB Color Mode selected.) 

a. Select RGB Color from the Mode pull-down menu. 

3a. 
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4a. 

. ' 

b. Select Place from the File pull-down menu. 

c. In tJ1e dialog box that follows, select view.eps, and click 

on Open. 

3c. 
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d. The viewfinder image will appear in the center of the 

Photoshop window surrounded by selection handles. 

e. Move your mouse over the placed image until your 

pointe r arrow turns into a mallet. When you see the 

mallet, click your mouse. 

f . The selection handles will disappear, leaving a select ion 

surTounded by marching ants. 

~ 

I -~.._ TIH! - -, 
.~ . I 

3d. 

Ill 
3e. 

3f. 

4. Adjust the color of the viewfinder image. 
Make the viewfinde r image less bright by using Photoshop 's 

Curves. 

a. Select Hide Edges from the Select pull-down menu. 

This wi ll make the marching ants disappear but the 

image will still be se lected. 
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4b. 
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b. SclectAdjustiCurves from the fmage pull -down menu. 

c. A Curves dialog box wi ll appear. 

d. Make sure the Preview box on the Curves dialog box has 

an "X" in it. Use your mouse to drag d1e curve down

ward, as shown. 

e. With tJ1e marching ants hidden, you wi ll see d1e 

viewfinder image become darker when you move the 

curve. 

4c. 

4e. 
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4d. 

5. Move the viewfinder image. 

QD 
( C•ncol I 

~ 
~ 
~ 

t=: PrfoUIIU' 

Curtis made dle viewfinder fi rst appear in the extreme upper

left corner. Only a small portion of it appears in tJ1e slide 

where iL is introduced. 

a. Select Show Edges from the Select pull-down menu. 

b. Wi th the viewfinder image still selected, position your 

mouse over the marching ants unti l you see your selec

tion arrow . 

.. 
[ . II 

--~--- i~:j f 
~~Ill!" 

5b. 
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7a. 

c. Drag the image up and to the left as shown. 

d. Select Hide Edges from the Select pull-down menu. 
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Sd. 

6. Duplicate the viewfinder image. 
(Note: Two viewfinders slightly off center give the impres

sion of movement. An Option-drag will make a duplicate.) 

a. Hold down the Option key, and drag the viewfinder 

image slightly to the left and down. 

b. A new duplicate will appear. 

7. Save the image as a GIF file. 
(Note: lndexed Color Mode must be selected in order to 

save the image as a Gl F file.) 

a. Select Indexed Color from the Mode pull-down menu. 

b. In the Indexed Color clialog box that follows, click on 

OK. 

c . Select Save As from d1e File pull-down menu. 

7b. 
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Gl F Animation And Shochvave / 353. 



7d. 

8. 

9. 

10. 

354. I Chapter 10 

d. In tl1e Save As dialog box that follows, select 
CompuServe GIF from tl1e Format pop-up menu. 

e. Edit tlle li te name so that it reads curtis_2.gif instead of 
curtis_ l .gif, and then click on Save. 

1
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7e. 

8. Make the viewfinder chase the alien ship. 
Repeal Steps 2 through 7, and create screens to make the 
view Iinder chase the alien ship across the screen. 

9. Make the viewfinder "lock on" its target. 
At the far right of the screen, create an image showing the 

viewfinder superimposed on the alien ship. 

10. Create an explosion. 
To create tlle effect of an explosion, Curtis painted a ball of 

lire behind tlle viewfinder using yellow, orange, and red. 
(Note: To see Curtis ' explosion, open Netscape, and then 

open alienhtmlfrom the CD to view Curtis' completed ani

mation in co/01:) 

The ball of fi re grows over four to five slides and then sub

sides. The viewfinder is shown in the final slide, and tl1e 
alien ship is missing. 



Curtis Eberhardt's 
tips on 
assembling a GIF 
animation in 
GIFBuilder 

Summary: GIFBuilde!; by Yves Piguet, 

is a prOK IV/'11 that combines several 

PICTor GIF images imo one multiple 

image GIF file. 

GifBuilder 

la. 

Assembling the GIF animation in GlFBuilder involves 

very few steps. In this example. Curtis creates a nick

er effect by adding a black slide between images. 

1. Open GIFBuilder and add frames. 
a. Open GfFBuilder. 

b. The Frames window will appear. 

c. Select Add Frame from the File pull -down menu. 

d. Ln the dialog box that follows, select the first of your 

animation frames, and click on Open. 
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3a. 

e. Rc-selectAdcl Frame from the File pull-clown menu. 

f. In the dialog box thm follows, select curtis_black.gif, 

and click on Open. 

ieputrn &lh •I c.:~ MD 

u. 

g. Repeat Steps c through f until you have added all of your 

images. (Note: Remember to altemate the black slide 

be/IVeen images.) 

2. Add a loop to the animation (optional). 
(Note: Adding a loop to your animation will cause it to play 

over and over ontlte Netscape page.) 

a. Select Loop from the Options pull-down menu. 

b. Click on the radio button next to the fi eld labeled times, 

and enter a number to indicate the number of times you 

would like the animation to loop. 

looplag 

O•• 
Q rorr11rt 
@li::j lltHI! \ 

2b. 

3. Build the GIF89a file. 
a. Select Save As from the File pull -down menu. 



3b. 
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b. In rhe dialog box that follows, name the animation 
alien.gif. and click on Save. 

4. Quit GIFBuilder and locate the GIF89a file. 
a. Select Quit from the File pull-down menu. 

b. Locate the GTF89a image in the Macintosh Finder. 
You' ll need to drag the image to the djrectory where you 

plan to store your HTML document. (Note: See Curtis 
Eberhardt's tips on creating an HTML file to test your 

GIF animation.) 
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Curtis Eberhardt's 
tips on creating 
an HTML file to 
test your GIF 
animation 

Summary: Use the <fMC> tag in an 

HTML document to test your GIF 

animation. 

358. I Chapter /0 

Simple Text 

U se SimpleText or your word processor to create an 
HTML document. If you use a word processor, be 

sure to save the document as Text Only. 

1. Create an HTML document. 
a. Open SimpleText. 

b. Start a new document. Use the fo llowing markup rags: 

<HTML> 

<HEAD> 

<T ITLE> GIF Ani mation</TITLE> 

</ HEAD> 

<BODY> 

c. Add an image tag. The image tag contains a SRC 

parameter, which contains the name of the image file. 

<HTML> 

<HEAD> 

<T ITLE> GIF Animation</TITLE> 

<! HEAD> 

<BODY> 

<lt4G SRC- "al i en. gi f " > 

d. Add ending tags. 

<HTM L> 

<HEAD> 

<TITLE> GIF Animation</TITLE> 

<!HEAD> 

<BODY> 

<JI.1G SRC-"alien.gif"> 

<!BODY > 

<IHTML> 
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2. Save the file. 
a. Select Save As from the File pull -down menu. 

b. [n the dialog box that follows, name the document and 

add an .HTM extension. 

0 
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2b. 
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3. Test the HTML file in Netscape. 
(Note: Make sure your GIF image and your HTML docu

ment are in the same directory.) 

a. Open Netscape. 

b. Select Open File from the File pull-down menu. 

c. In the dialog box that follows, select your HTML 

document, and click on Open. 

3c. 

d. YourGIF animation will load and begin to play. 
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GIF Wizard at 
Raspberry Hill 

Summary: Use GIF Wi::.ard at the 

Raspbeny Hill Web site to reduce a GIF 

file size up to 90 perce/11. 

360. j Chapter I 0 

GJF Wizard a t hnp://www.raspberryhill.com/ 

g ifwizard.html is an online tool tJ1aL reduces the size 

of your G £F images either on a Web server or on your com

puter hard drive. Curtis Eberhardt learned about the tool 

and gave me the URL just before this second edition went 

to press. Here's how it works. 

1. Go to the Raspberry Hill Web site. 
a. Open Netscape or the Internet Explorer browser. 

b. Go to http://www.raspberryhill.com/gifwizard.html. 

lb. 
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2. Identify your GIF image. 
a. Type the URL of your GJF image if it resides on a Web 

server. 

2a. 



2d. 

f( Browse .. J: 

2b. 

2o. 

b. Alternatively. you can click on the Browse button to 

locate the file on your hard drive. 

c. If the image is on your hard drive and you've c licked 

on the Browse button, use the F ile List window in the 

dialog box that fo llows to locate your file, and cuck on 

Open. 
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I 
2c:. 

d. The file name will appear in the fi eld to the left of the 

Browse bullon, as shown. 

e. Click on the Magic butto n 

f . Click OK in the warning dialog box that fo llows. 

2f. 
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g. A status page will appear. notifying you tha t the fi le 

reduc tion is in process. 
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2g. 
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2h. 

362. j Chapter 10 

h. When the image has been processed, it will appear on 

a Web page containing the original image and opti

mized versions. 

i. Scroll down the page, and click on the link that reads 

Optimized versions with mod(fied colors. 

l
Oplumzed 
Palelle/Siza 
Ven1oDS 

21. 

Stup So liPJJ-..nn.w.*~.,,CUif~ <P.I91ll 

Slap Sb l1t11111Ui.nlll<>aa.ntlll<!Ut.t.«>IOII 

j. A page will be d isplayed, containing images made up 

of several different palette combinations. In this 

example, artist Jane Greenbaum 's Marilyn Monroe 

icon is displayed with palettes ranging from 96 colors 

to 2 colors. 

2j. 
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3c,3d. 

3. Save one or more GIF images. 
a . When you see an image you like, press and hold down 

the mouse button on the image. 

b. Select Save This Image As in the pop-up menu that 

appears. 

c. Select a folder on your hard dtive in the dialog box that 

follows. 

d. Either accept the default file name of the new GIF 

image or type a new name and click on Save. 

4. Process a new image. 
a . To process another image, click on the link that says 

New GIF Wizard Request. 

4a. 

b . The GIF Wizard home page will be retumed, and you 

can process another GIF image. 
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Create an 
interactive 
animation with 
Macromedia 
Director 

Summary: A self-running Macm111edia 

Director Player movie can be added to 

your Web pages fo r downloading to 

Maci11tosh or Windows 111achines. 

-

364. I Chapter 10 

Art 

Web Design 

Multimedia 

I n this example, Curtis Eberhardt creates an animated, 

interacti ve resume in Macromedia Di rector. (Note: A 

more advanced version of the interactive movie is on the 

CD-ROM in the back of this book.) By creating a small 
stage and limiting the color palette, Curtis was able to keep 

the movie to a reasonable size for Web downloading. 

1. Plan your animation. 
a. Type of art Director is a powerful authoring program 

that has limited m1 tools. Expect to create the art for 

your movie in progn-1ms such as Photoshop or KPT 

Bryce, known for their advanced graphics. 

For this interactive self-promotion, Curtis created his 
background and I-lclios logo in KPT Bryce. He wanted 

an ethereal atmospheric effect, which he was able to 
create wi th shaders in KPT Bryce. Shaders arc used to 

configure aunosphcric conditions, such as the amount 

of sun and the amount of cloud cover. His goal was to 
create a Lady-in-the-Lake Arthurian legend-type feel

ing with a logo emerging out of clouds. 

b. Animation. Director can be used to create 2D anima

tions and to assemble 3D animations created in other 
software programs. 

Curtis' movie begins with a 3D "camera ny-through" 

animation. which zooms in on the I-lel ios logo. This ani

mation effect has its oligins in cinematography and can 
be achieved in KPT Bryce by starting with a long shot 
and stepping the software to render each new scene. 



Director requires that art elements be imported in the 

form ofPICT images; therefore, each rendered frame 

would be a separate PICT image for the Director cast. To 

conserve on memory, Curtis kept the total number of 

frames to a minimum. 

Cwtis' robot and cone animations were created in Strata 

Studio . He used the robot to add a ret:ro, high-tech look 

to the movie and chose gold, chrome, and sil ver colors to 

coordinate with the purvle shades in the background. 

The cone was rendered against a black background in 

Strata Swdio because he needed the solid color back

ground to drop out in Director. 

Artists who create 3D animations in Strata Studio save 

their tiles as QuickTime movies and then use Adobe 

Premiere to save the animation as single frame PICT 

images required for importing into Macromedia 

Director. 

c. lnteractivity. The hypertext scripting feature in 

Macromedia Director (called Lingo) is an optional tool 

for creating highly interactive presentations. When you're 

planning your presentation, decide how much interactivity 

or how much scripting you would like built in. 

Curtis has an unusual combination o f ski lls-he's a 

painter and a Lingo programmer. He can use both skills 

to design and build an e ntire Director project. Artists 

who don ' t know Lingo should team up with a program

mer who does because Lingo is the key to creating inter

active elements. Working in tandem with a programmer, 

an artist can work on a visual interface whi le a program

mer develops Lingo scripts with minimal graphics. The 

in tetface and Lingo scripts can then be stitched together 

when both are complete. 

Most of Curtis' la rger p rojects require more Lingo 

programming than the scripts he built for his self

promotion. lnteractivity in this chapter's movie sam

ple is limi ted to butto n scripts, which di splay his 

portfolio e lements o n screen. 

Scripts can often make a movie more efficient and more 

interesting. As Curtis explains, "Lingo can be used to 
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extend animation. For example, instead of building lin
ear, pre-described motion using Director's Score, Lingo 
scripts can be used to create random motion." 

2. Begin by collecting your art. 
a. Create a folder, and name it Cast Members. 

b. Move your an and sound fi les into the folder. 

3. Define a movie stage size in pixels. 
a. Select Preferences from the Edit pull-down menu. 

b. In the Stage size section of the preferences dialog box, 
enter the width and height for your stage. Ctutis chose a 
400 pixel by 200 pixel stage area. You can also position 

the stage size onscreen by entering a number in the 
Centered and Left boxes. 

Pr efer e n11U 
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3b. 

4. Import the cast into the Cast window. 
a. Select Cast from the Window pull-down menu. This will 

open the Cast window. 

b. Click on the Cast window to select it. 

4b. 
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c. Select Import from the File pull-down menu. Director 

wi ll djsplay PICT files in a fi le list window. 

d. You can either import each cast member one at a time, or 

click on the Import All button to import several cast 

members at once. 

Import 

r•rculcw 

4d. 

1ID_m~legE.co~s~t l"'l"mlblelrs~~~~l ~fij e=» tiO 
~ 1 , -+ [Jcct 
I! Djur k:s.002 Desk: IOIJ 
"; Ujur ks.OUl 
"; Ujor ks.004 
"; Djol'ks.OOS 
"; Ujork$.006 

r! Ojor ks.007 
1111 Ujorks.OOO 

D Unk To file 

[8J Sho111 Prcui ew 

I Import J 
( Import All ) 

( Cancel ) 

ttetp 

e . To select files other than PICT, select a file format fi·om 

the Type pop-up menu. Each file format may be impOit

ed separately into the Cast window as sing le cast mem

bers or in groups. 

f . Curtis imported si ngle frames from 3D animations he 

created in Strata Studio Pro. Next, he imported sound 

files he created using a Korg X-5 music synthesizer. 

With the cast members imported, Curtis was ready to 

begin the process of authoring the movie in the Cast 

window. 

4f. 
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5. Save and compact your Director file. 

a. Select Save And Compact from the File pull-down menu. 

b. Name your Director file, and click on Save. 

lo Director Mouio • I ~ 110 

[ Do•k top I 
(New D I ~ 

ljoot 

'-------= 

Sb. 

6. Plan the construction of the Score. 
The Director Score window is where a Director movie is 

assembled. ft consists of 48 rows and hundreds of columns. 

To assemble a movie, cast members are dragged from the 

Cast window into various positions in the Score. (Note: See 

Step 7 fo r instructions on how to move cast members i11to the 

Score window.) Note the elements of the Score window, 

below: 

6. 



~I.J 

I Script 
_I 

ITI 

~ 
Fram•- I I ' I I 

'i 
8e. " ~ 

l ink ~. J~ 
Copy 1-* ~ 

6d. · ~ >:• 
Off I 1._. 2~ i>.l 
fT.-,.ik IE 

1 
!Moy~~l 1 ... 2 
!Editable 1~ 3 
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Review the elements of Curtis' movie to understand how to 

construct your own. His plan for the Score window included: 

a. Background single frame elements that comprise a fly

through animation produced in KPT Bryce. These cast 

members occupy cells I through 24 in channel I in the 

Score window. In the Score window, low numbered chan

nels contain background images. Elements in 

higher-number channels " layer" up in front of elements 

in lower-number channels. 

CUJt is placed the frame he produced with the long shot 

in cell I and the other images that "stepped" in cells 2 

through 24. Because Director is based on a movie 

metaphor, animation occurs when the playback head 

moves from le ft to right , and frames are presented on 

stage in this time-based medium. (Note: The playback 

head is the black cell-shaped object to the right of the 

word Frame in the figure below.) 

lnteractiue Resume Score 

II 

I ~ 

F 

E!'! 

1 1 rr I 111 11: ; Tl 1 r l 
[ ,. ., 

41 4~ 

I~ 

I! I~ ~ ~' 

6b. 

6c. 

'-' -'ll':il~l ~.'I ( 

UF!i!;: .. :.:' :l!! .. .. . .. I!!!: i . ; : . !1¢ 1 P-JI 

b. Curtis chose channel 3 for the cone animation so 

it would be in front of the background. He started the 

cone at ce ll 36, eight cells after the conclusion of the 

fly-through animation. Similar to the fly-through 

Gl F Animation And Shockwave 1369. 
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animation, the cone animation consists of single frame 

"stepped" images, created in Strata Studio and occupy

ing cells 36 through 139. 

c. Channel 5 ho lds the robot animation, which occupies 

cells 28 through 139. 

d. The music fi les that Curtis created with his music synthe

sizer occupy cells I through 139 in the Sound channel. 

e. Director is a time-based medium. The Tempo channel 

contains instructions that Cwtis added to control the 

movie's timing. (Note: See Step 12for insrructions on 

how to adjust a movie's tempo.) 

7. Move cast members to the Score window. 
a. Click on a cast member in the Cast window to select the 

cast member. 

b. Press and drag the cast member to a desired cell position in 

the Score window (the mouse pointer will tum into a hand 

whi le you drag). When the cast member is positioned over 

the desired cell position, release the mouse button. 

7b. 

c. The cell where you dropped the cast member will contain 

an abbreviated number representing the cast member's 

number from the Cast window. (Note: Cast membe 1:1· that 

occupy a cell position are no longer referred to as cast 

members. When you drag a cast member to the Score, it 

becomes a sprite.) 



7d. 

d. To see more inf01mation about a particular sprite than 

what can be seen in a cell , click on a cell to select it. 

Director wi ll display the contents in the upper- left corner 

of the Score window. 

8. Use I.Setween Unear to duplicate a sprite. 
To copy a spri te into a group or contiguous cells, use 

Director's In-Between command. 

a. Click on the cell in the Score window tJ1at contains a 

sprite you would like to duplicate. This will select the 

cell and its contents. 

Sa. 

b. Drag to select the contiguous group of cells where you 

would like the sprite to be repeated. 

ln ,erottlue Resume Score 

&b. 
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c. Select In-Between Linear from the Score pull-down 

menu (Figure 8c I) to fill the group of contiguous cells 
wi th the sprite (Figure 8c2). 

Bc2. 

9. Try playing your movie. 
Once you have moved cast members to the Score and used 

In-Between Linear to duplicate sprites into channels, play 

your movie. Move the Score window to one side of the 

screen so you can see Director's stage, where the movie is 

played. When you press Play, notice the playback head move 
from left to right. 

a. Select Control Panel from the Window pull-down menu 

(Figure 9a I ) and the Director's Control Panel (Figure 
9a2) window will appear. 

9a2. 

b. Click on the Rewind button to rewind the movie. 
9b. 

c. Click on the Play button to play your movie. 

9c. 



10. Plan interactive areas in the Score. 
When you played your movie, you probably noticed that the 

playback head moved su·aight across the Score from left to 

right and then kept on going. When you plan an interactive 

mov ie, you' llnecd to gel the playback head to loop in sec

tions, or move past a group of frames over and over, so the 

movie wi ll appear to stop for viewer interaction. To create 

this section, you will need: 

a. A main interactive area. Sometimes refeJTed to as a 

menu area. this section can provide a viewer wi th cho ic

es concerning where to branch in a movie. The action is 

usually a mouse click on a bullon. 

b. Interactive areas where viewe1·s branch. These are 

areas in the Score where the viewer can branch to see 

something new. In this sample. the viewer branches to 

areas of the Score containing attwork. 

c. Frame markers to label areas in the Score. 

lnteractivity requires Lingo scripts. Frame markers help 

make scripting clear and easy to understand. (Note: The 

frame markers are labeled Art, Web, and Multimedia in 

lhe.fi.gure below.) 

10c. 

!---- 10d. 

10a. 10b. 
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11b. 
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d. Navigation buttons. Buttons were not req uired when 

the movie opened; they don' t show up in the Score win

dow until frame 140. Rows 6 through I I contain button 

sprites and the ir labels. 

Buttons have Lingo "button scripts" attached that will 

cause Director to branch to a predesignated area in the 

Score. (Note: See Step 14 for instructions on how to cre

ate bu11on scripts.) rn the figure on the previous page, 

Curtis has added go loop commands in the Scripting 

channel in frame positions 145, 155, 162, and 169. 

(Note: See Step 15 f or instructions on how to create 

loops with Lingo 's go loop command.) 

Curtis also added an image of a CD-ROM cover he 

desig ned as an item to branch to in the A rt category. 

Notice the sprite for the CD-ROM cover occupies 

frames 150 through 155 in row 13 (sec figure on previ

ous page). Other art will be added to the Web and 

Multimedia sections, which are adjacent to the Art sec

tion. Notice these sections can be identified by their 

frame markers at the top of the Score window. 

(Sec figure on previous page.) 

Art 

.i'f?Cif 
Web Design 

-rrrl 
Multimedia 

11. Position buttons in the Score. 
Drag your button cast members (Figure I I a) into high

numbered channels (Figure I I b) in the areas you've 

planned for viewer interaction. Curtis designed Art, Web 

Design, and Multimed ia buttons to branch to parts of the 

Score containing his portfolio pieces, and moved them into 

rows 6 through I I. (Note: See the figure on the previous 

page and Step 7 for instructions on how to move cast 

members to the Score window.) 



Tip: The simplest way to make buuons 

interactive is to add a Lingo button 

script to bull on cast members and direct 

Lingo to branch to an alternate part of 

the Score. Although more elaborate 

schemes can be used, this method is the 

easiest f or beginners. (Note: See Step 14 

for instructions on how to create Lingo 

bulton scripts.) 

14a. 

12. Create frame markers. 
a. Drag markers from the marker well , and place them 

above the first frame in each of your interactive areas. 

(Note: The marker well is the triangle above the mw 

numbers over the word Frame.) 

b. After you have positioned a frame marker, let go of the 

mouse and enter a label. 

:w~ lnteroctiue Resume o Score ~f;!i~ 
Sortpt 

Hl-.£!.r·~;rJ'!!.;•~~~~~~~~Y=In_t•-7~ ~~~ • ! r r ., , 1 : 1 -~ • I' 
-ll 130 135 1'1 0 145 <0-

~~~ ·~ · l _l ~ 

• Trails -• 4 I I I I I I I I I I I I I I I 
12b. 

13. Resave your movie. 
a. Select Save And Compact from the File pull-down menu. 
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Print 

_ Quit -~ 

13a. 

b. Notice Director does not display a Save dialog box the 

second time you save. 

14. Add button scripts. 
a. Click to select a button cast member in the Cast window. 
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14b. 

b. Select Cast Member Tn fo from the Cast pull-down menu. 

c. Click on the Script button in the Bitmap Cast Member 

Info dialog box. 

Bi tmap Cntl M ember Info 

Cost Member: 51 

Polcltc: I Sttstorn - Moe 

Purgo Prlorl1y: I l ·Normal I 
(OIOI'S! 0 hits 

Size: 1. 1 K 

0 Rulo 111111c 

14c. 
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OK 

Cancel 
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d. Clicking on the Script button will open a Script window. 
Bullon scripts are so common that Lingo will provide 

you with on mouse Up and end. (No/e: end is just end 

MouseUp abbrevialed as end. ) 

.::or Script of Cast Member 5 1 ~ ""'""fill" = 

+ II • I + I. i J[ 5~ 
on mouseUp 

go to -A~l "l ~ 
end r:rr 

~ 
~ 

14e. 

e.l'ype 

on mouseUp 
go to ''Art" 

end 

(N01e: Use Director'sframe markers to label cell posi

lions. This makes scripting easie1; and Direc/ol·wi/1 

remember I he cell position even ifmws are inserted into 

the Score. For every unique but/Oil script, you will need a 

unique cast membe1: Cast members may be duplicated in 

I he cast window and will have a unique cas/member 

numbe1:) 



Tip: To learn Lingo, the hypertext 

scripting language that comes with 

Macromedia Direct01: Jolm "J. T " 

Thompson and Sam Goulieb ·s 

Macromedia Director Lingo 

Workshop is an excellent book. John 

Thompson wrote Lingo, so the infor

lnation is right from the source. Jolm 

Thompson teaches at New York 

University. His book is published by 

Hayden Books. 

Lingo is a hypertext computer language that comes with 

Director. The language is comprised of English-like sen

tences, called scripts, which may be placed in a sprite, a cast 

member, a frame. or a movie. As a result, scripts arc 

described as sprite scripts, cast member scripts, frame 

scrip1s, or movie scripts. 

An even/ handler is the most common Lingo script. It is used 

to tell Director what to do when an event occurs. Events are 

mouse and key actions, described below: 

mouseDown mouse button is pressed 

mouse Up mouse button is released 

keyDown a key is pressed 

keyUp a key is released 

Event handlers, like all Lingo scripts, must be written with a 

required structure known as syntax. For example, in the fol

lowing go 10 command, it is customary to put the name of the 

frame marker in quotation marks: 

on mouseUp 
go to "Art " 

end 

15. Create loops with Ungo's go loop command. 
Notice in the figure below that each of the cells at the end of 

each interactive sectio n has an e lement in the script channel. 

These cells contain the Lingo command go loop. When the 

p layback head reaches a go loop command as it travels from 

left to right, the pl ayback head will loop to the prev ious 

marker and keep looping until Director receives some other 

command, such as directions in a button scripL. 
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a. Position your mouse in the Script channel on the last 

cell in an interactive section. 

b. Double-click your mouse to open a Script w indow. 

c. Type go loop. 

=o- Score Script 56 P-i 

+I +I •I iII :16~ 
on ex i lFraa'le Q 

go loci'! 
end -

~ 
~ 

15c. 

d. Click on the Close box in the Script window. 

e. Repeat this or copy and paste the coments of this cel l into 

other cells at the end of any other interactive sections. 

16. Adjust the tempo of your movie. 
When you play your movie for the fi rst time, you' ll notice 

that some sections play too rast. To adjust the Liming or the 

movie, timing elements can be added to the Tempo channel. 

a. To set the tempo of his movie, Curtis opened the Tempo 

dialog box in frame one. T his can be done by double

clicking cell I in the Tempo channel. 

b. To set the tempo, move the Tempo sl ider (Curtis used I 0 

fps-frames per second), and click on OK. 

set tempo 

@Tempo: ¢~ 

1101~ 

16b. 

c. You can also use Tempo commands to pause a movie 

while a sound or video finishes playing. 
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17. Resave and create a movie projector. 
When you have completed your movie, save it as a self-run 

ning projector. 

a. Sclecl C reate Projector from the File pull -down menu . 

b. Director wi ll warn you that creating a projector will 

close the movie fi le you' re working on. Cli ck on Save to 

save any changes. 

Crea ting 11 projector will cl ose the mouie file 
you are cur rently working on . 

Saue changes to the mouie " lnteractiue 
Resume" b e fore proceeding? 

[ Don' t Saue I Cancel I fi Saue JJ 

17b. 

c. In the dialog box that follows. locale your movie tile in 

the lile list window on the left. 

rr cnle Pmjeclnr 

Source Mnt•lfH: 

It;; Oc•klop • I 
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CJtSIIIIml 
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M ot•lc Size: 1. 1 MU 

17c. 

d. Click on Add. 

• 

e. C lick on Create. 
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f. Select a location for your movie in the dialog box that 

follows. 

g. Click on Save. 

Ia Curtis Eberhardt •I 

~ 
Soue projector os: 

I Projec tor.resum e I 
17f, 17g. 

h. The projector that you create 

will be a self-running Director 

movie playable on any 

Macintosh computer. 

= liD 

EJCCt 

Desk top 

New LJ ) 

[ Cancel ) 

n Soue J) 

Pr ojector .resume 



Creating a 
Director movie 
for use with 
the Shockwave 
Director Internet 
Player 
Sum mary: Macromedia 's new 10ol Jnr 

playing Director movies on the Internet 

includes a 11ew Player technology that 

will be integrated illlo the next release of 

the Netscape browse1: 

~ ~ 
I 

T he Director Interne t Player descri bed in th is section is 

one step on the way to integrating Director's multi

med ia authoring with Netscape. As a he lper application, the 

new player technology provides sound. animat ion. and 

interactivity. W hen the Directo r P layer is integrated into 

Netscape, movies can be played from the Web. 

Director movies for the Web are created wi th Macromedia 

Director's software, but the size should be li mited to 200 K. 

"Preprocessing" a movie with Macromedia'sAfterbumer 

software compresses a movie, and the Director Internet Player 

decompresses the tile contents. (Note: See Compressing a 

Director movie with Afterburner later in this chapte1:) In this 

section. Curtis Eberhardt offers Li ps on how to limit the size o f 

your Director movies. 

1. Colorize one-bit cast members. 
Limiting the bi t depth of cast members substantia lly reduces 

the tile size. One-bit cast members, which are black and 

white, can be colorized on the Director stage to conserve on 

file size. 

a. Import one-bit images (b lack and white) into the Cast 

window. (Note: See C reate an interactive animation 

with Macromedia DirecLOr, earlier in this chapte1;.for 

instructions 011 how to import the cast into the Cast 

windo w.) 
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b. Move the cast member to t11e stage. (Note: See Create an 

interactive animation with Macromedia Director/or 

instructions 0 11 how to move cast membersf!Vm tire Cast 

window to tire Score.) 

c. Click on an on stage cast member to select it. A bounding 

box will signi fy that the cast member is selected. 

d. Select Tools from the Window pull-down menu . 

e. With the cast member (or sprite) selected, cljck on the 

foreground color in the Tools window to open the 

palette. Drag to select a color. 

1e. 

f. When you release the mouse button, the cast member 

will take on the co lor you selected. 

1f. 
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2. Use tiles to fill a background or other shape. 
Tiles can be used to create a wallpaper effect on the Director 

stage. Because they are based on one small cast member, 

tiling is a way to conserve on fil e size. Use the Fi liiPattem 

command in Photoshop to experiment with the tile patrern. 

a. Star t by selecting an area of a Photoshop document you 

would like to see tiled. In Photoshop, this is referred to as 

a pattern. 

b. Select Define Pattern from the Edit menu. 

c. To test the pattern, open a new document by selecting 

New from the File pull -down menu. 

d. Enter 200 pLxels in the Width box and 200 pixels in the 

Height box. 

Snue 3ts 
Sauo fh ..• 
Rtl•£'fl 

fl cnulre 
hcport 

P3ge Se tup •.. 
Prin t ... XI' 

r r c ren:mces ~ 

2e. 

New 

1 l meqe Slz.e: 1 IOK -------, 

UUdl h: ~I piHeh •I 
lltllyht:~~ 

Re,olu llon: ~ I PIHels/inOI •I 
"1ode: I RttO Calm ..,.j 

'

Con IenlS 
Q Whlto 
(!: Und:grountJ Color 

2d. 

e. With the new test document open, select A ll from the 

Select pull-down menu. 

f. You' ll notice the document is selected when you see a 

trail of marching ants around the perimeter. 

g. Select Fi ll from d1e Edit pull-down Da Mode l rnogo 
Undo All liZ 

menu. 
Cut 
Cop y 
Pnst e 
Pa'i l e Into 
tJostc Oehlnd 
CICftf 

Stroke ... 
(lOll 

Crea te Publisher ... 
Publl~hN OttUon~ .. 

De line Poltern 
rake Snapshot 

lUI 
IIIC 
XII 

(Orn po\H I' (Oil i !OI \ •.. 

2g. 
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2h. 

ll!!llii!D Co <l 
Sloge Il l 

"'t goiUU CiUlCI X 2 
Cast !Ill 
Store 11·1 

JeK1 !t6 
.I fools IC7 

Color Pnlettes l!O 
Olgilnl Uldeo 119 
Scrlpl lllO 

-
Meuoge !(M 

lmenk 
Morlc e r'' 
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ltlt:le Paint Tonh 
llllJe Rulers 
Zoom In 
loom Ou t 

Pnttcrns ... 
Orush Shopcs ... 
nlr urushes ... 
Gradients ... 

II • •.. 

Point Window OptlonJ ... 

21. 

This tile is: 

0 Built - in 
®Cast Member: 85 

¢:'.:::> 

2m. 

I 

I 

I 

1 I 
I 

I 

I 

I 

h. Select Pattern from the pop-up menu in the Fill dialog 

box. 

i. Your document wi ll be fi Ued with the pattern you're 

testing. 

"' 

21. 

Unlllle d· 3 (AGU, l :ll Iii 

i]11.-:; !::"::: ~;( ::" 
111 r=: >AT ~"'~ fj,~ .. ~ 
1:;.' .!.r: ~:l' ·.·~ 

~~~ ~ ~ ~~~ ~J: ![ 
~·'": ~i'' io.'i< 

~ ~;; ~~ •. 1 
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~~ ·,'!":~;~ ?r. ~J 
""" ·-
j. lf you'rc satisfied with the tile and would like it to be 

available in Director, import the tile into Director's Cast 

window. (Note: See Create an interactive animation with 

Macromedia Director.for instructions on hoiV to import 

the cast into the Cast window. ) 

k. Open Director's Paint window by selecting Paint from 

the Window pull-down menu. 

I. With the Paint window open, select Ti les from the Paint 

menu. 

m. Click on the Cast Member radio button, and click on d1e 

right and left arrows to locate the cast member you wish 

to ti le. 

n. Use the Width and Height pop-up menus to pick a size 

for the t i I c. 

Width: ~ p txfls 

1 

Height:~ ptx t ls 

2n. 



2o. 

o. A small dotted rectangle will re flect the size of your tile in 

the Tile window. Drag the small dotted outline to the area 

you would like to use as your tile. 

p. C lick on OK. 

Select nru 
10 £~11: 

Width;~ r•·•h 

lle1gtll:~ 1)!1(•'' 

2p. 

this tile h : 
Q nulll - ln 
@ Co!. l MelllhCI : 8 5 

¢'¢ 

u=:tJLJI 
I Cancel ) 

ll elp ) 

q. Your tile will become a pattem on the pattern selector 

chip at the base of the Tools window. 

2q. 

r. To create a tiled background, select the shaded hal f of 

rectangle tool from the Tools window. 

s. Then usc the tool's crosshai r to drag a rectangle large 

enough to cover the stage. 

2r. 

2s. 
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~ 
3a. I 

3b. 
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t. With the rectangle selected, select the pattem selec tor 

chip, and drag-select the new pattem. 

u. When you le t go of the mouse, the new pattem wi ll !ill 

the rectangle. 

r. J.--.. v-:t- JT ~ rT rv- ~v-: -~v-: 

I<·~:>.: ~ :· ~.: ~.: ~: ~ :· ~.: ~.: ~. ~- ~ ~~~ 
. ~BH!J: ~
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,~.J.) .. , ~. J. 11 ...... ~. ~. ~--~- ~. ~- •. ._; · 

i·. ~ •. •. . ~-. f.. ~-.· ~ . '· .. ~.. ~- ~-. ~-. ~ ,, . . 
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2u. 

3. Check on cast member size. 
The Bitmap Cast Member Info dialog box will provide valu

able information about cast member sizes as you are build

ing your movie. 

a. Click on a cast member in the Cast window. 

b. Select Cast Member Info from the Cast pull -down menu. 

c. Notice the size is indicated in the d ialog box that opens. 

Oltmnp Cut Member Info 

3c. 

Cns1 Mcrnhor. 2-1 

r•nletle: I Stjt tem - MDC I 
ruqJc Priotlt!J: I 3- P...ormnr I 
Colort: 0 0' tu 
Sl2o: ·1.7 K 

O llulo unuo 

OK 

Cancel 

Stri(Jt ... 

llelp 



Tip: For information and ins1ructiom 

on how to upload files to your lntem et 

provider 's servet; see the Image Map 

chaptu 

4a. 

4. Try remapping a color cast member. 
Director's Transform Bitmap command allows you to alter 

the bit depth of a color cast member and, as a result, reduce 

the file size. This command cannot be undone, so ah.vays test 

the remap on a copy of the cast member. 

a. Click on a color cast member in the Cast window to 

select it. 

b. Select Copy Cast Members fro m the Edit pull-down 

menu. 

c. Click on an empty cast member positio n in the Cast 

window. 

lmli.Window Cast 
IIndo •l 

--
Cui Cost '1embcn Ill. II 

'' ' llos lo ·rc ut xu 
(ICOI [a~ I M embl!n 
Select All x n 
-
Ploy lei' 4c. 
SlOJJ IC. 
nowtnd xn 
Step Dncktvor d 
Step ron uunl 
- -- --
Disable SoundJ x-
Loop lll 
\P IN l l'd ll "llte\ Onllj •·' OlsntJ ic lingo 
lock: rreme Durn lions 

4 b. 

d. Select Paste B iunap from U1e Edit pull-down menu. 

lmii. Wlndotu Cost I 
Un<IO __ .•.?J 
Cut C.u t ""1embt•l \ II 
(OPII ( tH I Mem her.s ( 

I 

firer Cn51 "'fembt~s I 
Seletl 011 1101 

Pln!J 3el' 
SIOtJ IC. 
flewlnd ICR 
Slep UatkWG(d 
Step rorwortl 

Ohnblu Sound\ :tc-
l OUJl Ml 
\rh• t l f~d I rllllll"\ OIIIIJ • 
Dbollle lingo 
lock frame Our allons 

4d. 
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Open Sulpl ,. 
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Record \ ound ... 
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Duplicate Cast MCIIl tJCI I!U 
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e. With the cast member copy still selected, select 

Transfonn Bitmap from the Cast pull-down menu to dis
play Lhe Transform Bitmap dialog box. 

f. Select a smaller bit depth fTorn the Color Depth pop-u p 

menu. Click on OK to remap the cast member to a 

smaller bit depth. 

4f. 

Tronsrorm OltmOJl 

Cost Member: Cos t M ember 00 
Size:--- ----, 

® Stole: \IliUM\ % 

0 Width: ~plx•ls 
r;;-; I 011 

llelght: ~ 2 Oils 
I 

Co lors: o Bits 
Color Dept h: _, 16 Oils 

rolett e: 32 Oils ~ 

@ Dithe1 
0 nemop to Closest Colors 

[! OK I 
Con eel 

D 
Help 

g. Double-click on the cast member to examine the color in 

Director's Paint window. 

h. Sometimes the color is acceptable at a smaller bi t depth; 

other times, it is not. 

4h. 



Sa. 

Night City 

177 :Niqht Ci 

Sb. 

ncu n1 :,ouno 
Pns.l £1 "' 1•rr r 
Conuerl to DltmlW 
ff'"Of1SfOflll IJIImop,,. 

n11gr1 Dltmnps 

Cus:t 10 T1111~ 
Ouplitftlc Ces: t Mcmue r • u 
Find Cu t Member ,,.. M; 
~or-1 ( uu '1embl'r \ ... 

Sc. 

Tip: To conserve on file size, try to use 

sow1d sampled at 11 kH'l rather than 

22 kHz. 

5. Use small sound snips and loop one or two. 
a. Curtis used several small 2 K to 4 K sound snips 

throughout his movie (Fig ure Sa). 

b. To loop a sound, start by selecting a sound in the Cast 

window. 

c. Select Cast Member In fo from the Cast pull-down menu 

to display the Cast lnfo dialog box. 

d. Click to put an "X" in the box labeled Loop. This wi ll 

extend a sound without adding to the file size. 

Sound Cost Member Info 

Cos t Member: 177 

t8J looped 

Purge Priority: J 3 - Normal I 

Size: 19.1 K 

Sd. 

(r 
( 

OK l) 
Concel J 

PIO!J 

llelp 
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Compressing a 
Director movie 
with Afterburner 
Summary: Preprocess Cl Director movie 

with Macromedia 's Afterbumer before 

placing it 011 a Web serve1: This com

pression step makes the movie small and 

compact, so that it moves quickly over 

the Web. 

~ BumlnQ IID: ... :Sideshow ~· 

-
Stop 

1e. 

390. 1 Chapter 10 

Macromedia's Afterburner adds 

a compression step to building 

movies for the Web. Afterburner is an 

easy-to-usc drag-and-drop applica

tion that wi II create a file with a. OCR 

Afterburner 

extension. The compressed movie will be decompressed by 

the Director Internet Player as it is received over the Web. 

1. Drag and drop your Director movie. 
a. Locate your Afterburner software. 

b. Drag and drop the Director 

movie on top of the 

Afterburner icon. 

c. Release the mouse button. 

This step automatically 

launches the Afterburner 1b. 

application. When the software is 

launched, you' ll see an Output dialog box. 

d. Use the default file name or type in some other name. but 

keep the .OCR extension. 

CJ America Online u2.5 Fo l der ~ 

CJ Applicat ions """ 
LJ DrooStuff 
LJfotch ' 
D ronts ~ 

1c,1d. 

[ 

n 

c::::> IID 

£ject 

Desktop 

New Ll) 

Cancel ) 

~aue l] 

e. You ' ll see a progress box as the movie is processed. 

f. The compressed file is the file you wi ll place on a 

Web server. 

Sideshow .dcr· 

u. 



The "Father of VRML" 

Mark Pesce initiated the 
developme/11 ofVRML 
(Virwal Reality Modeling 
Language), the language 
that describes 3D space 
on the lnlernet. Lookfora 
clwpter.fivm his book 
published IJy New Riders, 
VRML Browsing and 
Building Cyberspace, at 
hup:/lwww.mcp.com/geJI· 
eral/news 7/chap2. html. 

Artist featured in this 
chapter: 

Alex Shamsou has 
a B.S. in industrial Design 
from the Philadelphia 
Uuiversily of Arl. 

alex@ vrmil/.com 

/lltp://IVIV\\I.l'l'llli/1. COlli 
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VRML World 
Building 
VRML or, Vi t1ual Reality Modeling Language, is the lan

g uage that describes 3D space on the Internet. Designers 

who are interested in creating VRML discover there are 

three ways to create these new 3D files. Traditional 3D mod

eling manufacturers have added VR.ML fi le writing features 

to 3D software programs, and several new, low-cost world

building tools have emerged. Hand coding VRML in a text 

processor is a lso an option. 

[n this chapter, industrial designer Alex Shamson shares tips 

on how to create a dinosaur head in Virtus WalkThrough Pro. 

a 3D visualization tool popular with architects and 

Hollywood film directors. Virtus Corporation, founded by 

David Smith, was the first 30 software manufacturer to add 

a VRML fi le-writing feature to their software. Also included 

in this chapter are tips on how to navigate yourVRM L file in 

the Vi nus Voyager VRML browser, how to open your 

VRML fi le in a word processor and adjust the VRML code, 

and how to use the <EMBED> tag to add a VRML window 

to a Web page. 





VRML on the 
Internet 

Summary : Highly creative and 

far-sighted 3D world builders have 

taken Mark Pesce 's vision and created 

imaginative new VRM L worlds 011 the 

Intem et. 

Above: A Virtual Reality Shopping Mall 

is the cente1p iece of Alex's VRML port

folio. 

A bove Right: Alex Sham son 's home 

page contains 1111111erous linksf or world 

builders imerested in VRML. 

Above: A "scooter''jiv m Alex 's tradi

tional 3D portfolio. 

Alex Shamso n (alex@vnn ill.com). who teaches 30 

design at New York's Pratt Manhattan. is a painter and 

an industria l designer. Industrial Desig n is the specia lty tha t 

teaches the design of everyday objects and 30 space. 

Although his industrial design background has g iven Alex a 

broad background in 30 des ign, Alex has aggressively pur

sued 30 world building on the Inte rne t. Li ke a handful of 

design professionals nationw ide, A lex feels the Internet 

ho lds enormous opportunities for 30 world builders. 

Although Alex has used VirlUs WalkThrough Pro and has 

built most of his models on the Macintosh, recent develop

ments in VRML have required him to make changes. For 

example, he recently bought a Windows NT machine 

because of Apple Compute r's fa ilure to e mbrace VRML as a 

fil e standard. Although aspec ts of Apple 's alLernative 3DMF 

format have been added to VRM L 2.0, the ir less-than-enthu

siastic support ofVRML has made it impossib le to develop 

VRML worlds on a Macintosh because there are so few 

tools. 

Even though there are many more VRML tools available on 

the Windows platform, Alex has a lso started to add VRML 

to his models by hand in a word processor. 
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A bove: Alllo showmom display f rom 

Alex's traditional 3D portfolio. 

A bo1'e Right: Alex 's "Metato111n ''from 

his traditional 3D portfolio. 
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At this time, no 3D applications support the multimedia fea

tures available in VRML 2.0. As Alex explains, "3D artists 

who want to adjust lighting, or add camera perspectives or 

any other new feature will need to learn how to hand code 
VRML. Until 3D software programs can write the new fea

tures into a YRML lile, I recommend that artists use 

resources on the Web to learn about hand coding." Alex has 

generously prepared a very large number of links on his 

Web site (http://\vww. vrmill.com). These links are helpful 

for his clients and students who are new to VRML. 

1. Assistance to surfers. 
Besides providing links to the latest versions of Netscape 
Navigator witJ1 Live3D and the Internet Explorer browser, 

Alex has created a concise overview ofVRML and has 

answered such questions as: 

• WhatisYRML? 

• What can you do with VRML? 

• What do you need to see VRML Iiles? 

• What is YRML 2.0? 

• What are multiuser virtual worlds? 

• What's an avatar? 



3. 

2. Resources. 
In this section. Alex has organized a set of links £0 such 

famous sites as VAG (YRML Architectura l Group) and 

The VRM L Repository. This section also contains numerous 

valuable links Lhat Alex used to learn YRML, including 

links to: 

• YRMLArchitecw ral Group 

• The VRML Repository 

• NYYRMLS IG 

• ARTNETWEB 

• VRML tutorials 

• Authoring software 

• VRML browsers 

• Compression utilities 

• Books on VRML and 3D design 

3. Alex's design and training and services. 
Alex is a self-employed creative director/design consultant 

specializing in multimedia and Web development. As a pio

neer in the area of c reating 30 virtual worlds on the Internet 

and as a founding member of New York's NYYRMLSIG, 

Alex built his Web site to promote his 30 design business 

and to share the knowledge he has acquired in 30 modeling 

and virtual world construction. 
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Visit Starbase C3 
toseeaVRML 
adventure, 
shop for VRML 
spaceships, and 
participate in 3D 
chat 

Above: The Starbase C3 Flight 

Operations Center contains live VRML 

animations. In this VRML adventure, the 

USSC3 Talon leaves the.flight dock, trav

els into em asteroid field, orbits a planet, 

and travels to anotherflight dock. 

Above Right: Larry Rosenthal's 

Starbase C3 site. 

http://www.cttbe3.collt!starbase.htm 
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L arry Rosenthal, industrial designer and founder of 

New York's NYVRMLSIG, has created Sta rbase C3 

(http://www.cube3.com/starbase.htm), one of the most 

innovative new VRML sites on the Internet. 

Larry has packaged his starship models as construc tion kits 

for interested VRML model builders who wish to assemble 

the ir own models. He's also built animated VRML adven

tures with the help o f "Chief Engineer" Frederic Gontie r and 

"Flightdock Engineer" Marc Thorner. For Web-initia ted 

spaceship adventure fans, these animations represent a form 

of electronic entertainment that will soon be very popula r 

among the compute r gaming generation. 

For his most devoted following, LaiTy has created a 

Starbase C3 Membership. For $29.95 per year, members 

receive monthly "extras," includ ing a model that is not 

available on the Starbase C3 site, a custom "Conbot" avatar, 

extra model parts not offe red on the site, about a half dozen 

high-resolution renderings of spaceships. and a monthly 

HTML newsle tter containing VRML building Lips. Larry 

will a lso launch the BlackSun CyberHub 3D cha t engine, 

where he'll o ffe r members private VRML chat that will be 

closed to the public. 

In lat e 1996, Larry worked wi th New York develo pers Matt 

and Dan 0 ' Donne ll on his Starbase C3 3 D chat site . Malt 

and Dan a rc identica l twin brothers who arc well known for 



Above: The USSC3 Talon entering the 

flight dock. 

their Web development ski lls. Nicknamed by their New York 

YRML and programmer colleagues as the "Cicada tv1ins," 

Man and Dan own Cicada Web Development and often get a 

room 111mbling with energetic talk about new technology dur

ing Internet meetings in New York. When asked to demonstrate 

their latest project at the NYYRMLSIG meeting in January, the 

Cicada team unveiJed their 3D chat engine written in Java. 

Worki ng with Larry Rosenthal, who built the starbase model in 

YRML, the 0' Donnell brothers developed their Java-based 

chat engine. which works in a Java-enabled Netscape Navigator 

window without any extra plug- ins or client software. 

1. The CyberCash system. 
LaJTy is a Cybe~ash merchant, which means customers who 

have a "CyberCash Cybe~oin Wallet" can purchase a 

YRML model online and instantly download it to their com

puter's hard drive. CyberCoin walle ts are programs that may 

be obtained free at the Cybe~ash s ite (http://www.cyber

cash.com). Once a Wallet program is downloaded, cash can 

be transferred from a consumer's credit card or checking 

account. 

CyberCoin services are distributed through banks that offer 

online merchants the CyberCoin service and offer con

sumers co-branded wallets. Consumers and merchants each 

obtain free wallet software, and the merchants pay the bank 

a per-transaction fee to use CyberCoin. The bank pays 

CyberCash a transaction fee for providing the technology 

and processing service. Merchants find new revenue chan

nels with CyberCoin because they can now offer services 

and goods at low and inc remental costs t.hat were previously 

prohibitive because the pric ing models of credit cards were 

ineffective with low-cost items. 

CyberCoin uses the most advanced securi ty features for 

consumers, banks, and merchants. When consumers bi nd, or 

connect, their checking accounts to their wallets, Cybe~ash 

confirms three th ings: that the people are who they say they 

are, that the accounts are valid and are acti ve accounts with 
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Above: Close-up of a "Con bot" or 

Construction Robot. 

2a, 2b. 
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money in them, and that each person is connected legally to a 

specilic account. After the account is confirmed, CyberCash 

protects the consumer through the use of 768-bit RSA 

encryption with the password-protected wallet. CyberCash is 

also working with VeriSign to incorporate Digita l IDs for 

instantaneous validation of individuals' and merchants' iden

tities. rn addition, funds in the CyberCoin system are FDIC 

insured. This guarantees that, if the CyberCoin issuing bank 

goes out of business, the consumer's money is insured by the 

federal government. 

CyberCash currently offers purchases made only with U.S. 

dollars and at online merchants who have a U.S. bank 

account. Eventually, CyberCoin will be able to be used out

side the United States with any foreign or international bank 

that is a CyberCoin issuing banlc When a consumer buys a 

good or service on the Internet tisted in foreign currency, the 

system will translate the currency on-the-fly with the 

exchange rate guaranteed by a bank, and the debit will occur 

in the consumer's domestic currency. Consumers will also be 

able to hold a number of different currencies in thei r wallet, 

similar to the way funds are held in the physical world. 

2. Steps to order a construction kit online. 
a. Visit the CyberCash site at http://www.cybercash.com 

and download a free CyberCoin wallet. (Note: The 

Windows 95/NT platform is required at this time.) 

b. Add either credit card or checking account funds to your 

CyberCoin wallet. 

c. Click on the New VRML Ships on the Starbase C3 home 

page to link to the Online Datak.i t Directory and Sales 

page. 

2c. 



2d. 

3a. 

3b. 

MEMBERSHIP INFORMATION 

4a. 

d. On the Datakit Directory and Sales page that follows, 

scroll the page to find a model. 

e. Click on a gold coin under the il lustTation of d1e space

ship you 'd like to purchase . 

• CUCI( UN COIN 10 BU¥ THE CJ Mll!KlT ~WW 

2e. 

f. The CyberCoi n vvaiiet launches a transaction, and a 

datakit in a compressed ZIP format is downloaded to 

your computer. 

3. Steps to view the VRML adventures. 
a. Click on the Fighter F light VRML on ilie S t.arbase C3 

home page to lin k to the F light Operations Cente r. 

b. On the Flight Operations Center Web page that fol lows, 

click on a VRML live feed. 

c. If you have Netscape Navigator with Live3D, you' ll see 

a VR1vfL 3D animation. 

3c. 

4. Steps to become a Starbase C3 member. 
a. Click on Membership Information on Larry's Starbase 

C3 home page. 

VRML World Building 1399. 
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b. On the Starbase Command Center Web page that 

follows, cl ick on the Official Membership Form link. 

c. A Membership Form will appear on the Web page that 

follows. 

d. Press and hold down your mouse button, and select Save 

This Image As from the pop-up menu. 

Bock 
Jnrwnrtl 

Open I hit l mol)e 

Copy this lmogc 
Copu I his I moue Locntlon 
l oad thr<o lrnt.uw 

4d. 

e. In the dialog box that follows, save the fonn to your hard 

disk by clicking on Save . 

Saue I ma ge ns: 

li#ilillid¢@1W 

4e. 

Concel ) 

Soue IJ 

f. Alternatively, you can click on the Print button at the top 

of your Netscape Navigator w indow to print the fonn. 

g. If you have saved the form to your hard disk, open it in a 

paint software program, and print it on your printer. 

5. Steps to visit the 3D chat area. 
a. On the Flight Operations Center Web page, click on the 

Enter 3DVRML Flightdock Chat link. 

ENTER 3DVRML PLIGHTDOCIC CHAT 

Sa. 
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b. On the Web page that follows, scroll to the Avatar 

Selection area. 

c. Select one o f the available avatars by cl icking on an 

avatar image. (Note: The field labeled Avatar URL will 

jill in automatically when you select an avauu:) 

d. Enter a Con bot name in the fie ld labeled Con bot Na111e, 

and click on Submit. 

e. Enter an optional avatar URL in the field labeled Avatar 

URL. (Note: Thisfield is designed for people who want 

to add their own VRML avatars. If you've selected a 

Conbot, the field will already be filled in.) Click on 

Submit. 

f. To enter the 3D chat area, click on the Live 3D version 

link. 

g. The Starbase C3 chat window will appear and float over 

your Web page. A VRML window wi 11 appear on the top 

half of the floating vvindow, and a text-based chat area 

will appear in the bottom half. To pruticipate, type a 

comment in the text window at the bottom of the noating 

screen, and press Return. 

sg. 
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Live comedy in a 
VRMLworld
at Mom's Truck 
Stop 

Above: Argle, host ofMetaPiay's 

Simprov. 

Above Right: The Meta Play Web site at 

http://www.metaplay.com. 

Above: Waitress at Mom's Truck Stop. 

Tip: The Meta Play team has posted 

cartoons and logs of the live ep isodes 

ar their Web site. The Web site is 

enhanced with MID/ tunes and 

QuickTime movies. 

402. 1 Chapter 11 

S improv. That's what the MetaPlay comedy team calls 

the multiuser improvisational comedy performance that 

Internet users experience at Mom's Truck Stop. The setting 

is a' 50s diner, and the comedy team is Matt Dominianni 

(nose@echonyc.com), Paul Marino (havoc@interport.net), 

Frank Dellario, Matt Duhan, and Matt Hapke. Paul Marino 

is the 3D artist who created the VRML diner in 3D 

Studio Max. 

Although you can access the VRML diner via Netscape 

Navigator with Live3D (http://www.metaplay.com), the 

MetaPlay comedy performances are performed live in a 

MOO. MOOs are social MUDs (multiuser domains), or 

places on the Internet where people interact and create their 

own worlds. MUDs have been traditionally text-based, but 

Chaco's Pueblo cl ient software turns a text-based MOO into 

a multimedia experience. 

Pueblo users who visit Mom's Truck Stop experience a spli t 

screen, with the 3D diner on one side and 3D chat or the 

performance on the other. There's also music and 2D 

images of the people who interact in the diner. At scheduled 

intervals, which are announced on the MetaPiay Web site 

(hllp://www.rnetaplay.com), visitors can atTive at Mom 's 

and take part in a live performance. 



"Don't be fooled 
by my cute smile, 
I'm actually 
planning to take 
over the world." 

-Argle, host of 
MetaPiay's 
Simprov 

Above: Mom 's Truck Stop through the 

Pueblo browser window. 

Above Right: Mom's Tmck Stop 

through Netscape's Live3D window. 

1. Getting to Mom's Truck Stop. 
a. Download and install the Pueblo client from the Chaco 

Web site at http://www.chaco.com. (Note: The Windows 

95/NT platfonn is required. Alternatively, Mom 's Truck 

Stop may be experienced with a Telnet eli em on a 

Macintosh compute1; but this will be a text-only 

experience.) 

b. H you have the Pueblo client software installed on your 

hard d1ivc, click on the Mom's Truck Stop link on the 

MetaPlay Web site at http://www.metaplay.com. This 

will launch Pueblo i f it's available on your computer and 

take you direclly to Mom's. 

c. A lternati ve ly, you can launch the Pueblo client software 

and select Quick Connect from the Worlds pull-down 

menu. 

d. In Ll1e dialog box that follows. click in the field labeled 

Host, and type: 

simprov. chaco.com 

Tn the field labeled Port, type: 

4444 

Click on Connect 

e. The Mom's Truck Stop screen wi II appear. 

f. Drag on the w indow pane that separates the VRlviL w in

dow fTOm the chat screen, and make the VRML window 

occupy one-third of your screen. 
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Above: As you navigate a VRML 

browser window and come into 

Mom's Truck Stop, you discover the 

diner is located on the swface of a 

bowl of soup. 

Above Right: The Pueblo window is 

an adjustable split screen Users can 

drag the window pane to make the 

VRML window occupy one-third of 

the screen during show time. 

Above: Emote buttons at the top of the 

Pueblo window p1vvide a quick way to 

make your character smile, bow, wave, 

nod, wink, laugh, clap, or.frown. 

404. , Chapter 1 I 

2. Participating in the improv. 
Plan to an·ive at Mom's Truck Stop 30 minutes before 

show time to explore the 30 diner through the VRML win

dow in Pueblo's split screen or through the Netscape 

Navigator Live3D window at http://www.metaplay.com. 

a. To partic ipate as a character during a perfonnance, c lick 

in the Message box at the bottom of the screen, and type: 

Connect Guest 

This wi ll generate a Guest character. 

b. Click on an emote button at the top of the Pueblo screen 

to see what your face looks li ke. 

c. To speak, type: 

"your comment here 

and press Return. 

d. At show time, you' ll hear music if your computer is 

equipped with speakers, and t11e comedy team will fi ll 

the text half of the chat window, inviting you to partk i

pate via Lhe Message box. For example, the Meta Play 

cast wi ll ask t11e audience for a suggestion to get Lhe 

show started. 

Argle, the show's host, may say, "Before we start today's 

show, would someone please suggest an important piece 



Above: During a Meta Play improv 

show, 2D images of guests and the char

acters at Mom's get added to the text 

chat. 

of information the Cook finds out today ... .'' Visitors are 

guests in the diner during the show and may jump in with 

a line or two at any time. For example, a guest might 

throw out, "The fryer is broken!" Another character 

might add, "Uh, oh ... soggy fri es." and the plot begins! 

3. Why Pueblo? 
MetaPiay chose a MOO for their performances because 

Moos are programmable. Although they have investigated 

other 30 chat environments, they've found that the program

mable characteristics help during performances. For exam

ple, the performers can clear everyone's screen 

simultaneously and plant text, such as "Meanwhile ... " 

4. VRML design issues. 
When you visit Mom's Truck Stop and experience the YRML 

30 diner, you realize a traditional diner is built on the surface 

of a bowl of soup. The environment is much more enticing to 

explore than a classic room with four walls. YRML allows a 

30 designer to let go of reality and bui ld surprises into the 

surroundings-and you wi ll find surprises navigating 

through Mom's. 

Live30's viewpoints provide a means to display camera 

shots that viewers can access with a right mouse button and a 

pop-up menu. A Control key and a right arrow take a viewer 

through the viewpoints in a slideshow fashion. Much like a 

filmmaker, 30 artist Paul Marino took advantage of Live30's 

viewpoints and has set up several cinematic viewpoints that 

users can access through the Netscape Navigator Live30 

window. 

In VRML, camera shots are called PerspectiveCamera 

position views. Althoug h 30 applications that write VRML 

fi les c reate an opening PerspectivcCamera view, several 

PerspectiveCamera views may be added to a YRML file. 

(Note: See Open a YRML file in a word processor and alte r 

the Perspect.i veCamera in this chapte1: ) 
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The NYVRMLSIG's 
Coney Island 
Project 

Summary: S!Gs, or Special Interest 

Gmups, have helped compwer users 

accelerate learning for almost two 

decades. 

406. 1 Chapter I I 

Tech tip from 
NYVRMLSIG member, 
Marc Thorner: 

"A project /ike the 

Coney Island VRM L site 

is historically signifi
cant since it represents 

a radical depart11re 
fmm the restraillfs 

imposed by 19th centu

'Y ideas, and it pmvides 
a means for 3D design
ers to share technical 

information. As Mark 
Pesce has said, 'infor

mation shared is il~{or

mation sq11ared.'" 

Yo11 can reach Marc at: 
mthorner@pipeline.com. 

0 nee a month, the New York VRML Special Interest 

Group (NYVRMLSIG) meets in the back room at 

Alt.Coffee to discuss the development ofVRML and virtual 

worlds on the Web. T he gro up was formed in February 1996 

and attracts industrial designers, archi tects, and 3D graph

ics professionals who want to adapt their knowledge to fit 

the Web. There is no fee to attend the meetings and anyone 

can attend. 

Larry Rosenthal and Alex Shamson, both industrial design

ers, are the most technically advanced members. Lan·y 

Rosenthal, who founded the SIG, is the unofficial chairman 

and the most aggressive user of 3D software. Shortly after 

Lan·y founded the NYVRMLSlG , he suggested a STG group 

project. And in March, the members responded by creating 

Marc Thorner's suggestion of re-creating New York's Coney 

Island Amusement Park. 

1. Coney Island at the turn of the century. 
At the LUrn of the century, Coney L'iland, on the southwestern 

end of Long Island, was the largest amusement park in the 

United States. Amusement parks lured hundreds of thou

sands of visitors (some reports say millions) to Coney Island 

by ferry, rai lroad, e lectric trolley, subway, hackney carriage, 

automobile, and bicycle. 
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Above: Luna Park Tower at the 

entrance to Luna Park. 

. 
' J •• 

Much like a smal l city, the original Coney Island was 

arranged around a main promenade called the Bowery that 

was lined with carnival attractions. Canopied booths intro

duced elephants, camels, and "orienta l beauties" to resorl 

visitors. 

• In J 897, George Til you opened Steeplechase Park, one 

of the three enclosed amusement parks to open at Coney 

Island. Occupying 15 acres, Steeplechase park was lined 

by a gravity-powered steeplechase ride. 

• In 1902, Frederic Thompson and Skip Dundy, both 

employed by George Til you. planned what was to 

become the grandest enclosed park at Coney Island

Luna Park, which later opened in May 1903. 

Frederic Thompson was a former architectural student 

who indulged in ornaments, flags, towers, and turrets. 

At night, Luna park was illumjnated with a quarter mi I

lion electric lights. When it opened, Luna Park offered 

visitors a Venetian city with gondoliers, a Japanese gar

den, an Irish vi llage, an Eskimo vill age, a Dutch wind

mill , and a Chinese theater. A rocket trip to the moon 

was the most popular attraction. 

• In 1903, Coney Island's third enclosed park rivaled Luna 

Park with jts massive proportions. Dreamland was 

planned and built by a group of politic ians organized by 

Will iam H. Reynolds, a former New York state Senator. 

The designers of Dreamland installed one million elcc-
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Above: A statue called The Creation at 

the entrance to Dreamland. 

408. 1 Chapter 11 

lric lights and an enormous nude sculpture called The 

Creation at its gates-both meant to overshadow Luna 

Park. 

2. The Coney Island VRML Project. 
Anyone can participate in the Coney Island project. Virtus 

WalkThrough Pro is the recommended software prog ram 

because it is an inexpensive, easy-to-use 3D application 

that can write a YRML tile wi th textures and links. 

The project requires that participants build two models. 

The first model can be any ride, canopied s ide show, or 

building at Coney fsland. The second model is a personal 

trai ler that wi ll be placed along Coney Island's Bowery, 

once the Amusement Park's mai n street. The trailer exteri

ors will be uniform because the NYVRMLSIG provides a 

template download on the NYVRML Web site at 

http://www.cube3.com/downloads/NYVRMLSIG. Inside, 

each trai ler wi ll have the model bu ilder's own world or 

unique space with furniture, textures, or any objects of 

his/her choice. Here are a few recommended steps to get 

acquainted with the Coney Lsland project: 

a. Visit Larry Rosenthal's extruded 3D map of Coney 

Island that contains existing models at http://www 

.cube3.com. This will give you an idea of what models 

have already been created. 

b. Download one or more models from Larry's si te and 

take them apart in Yi rtus WalkThrough Pro to see how 

they are constructed. 

c. Look for photos and project tips on the NYVRMLSIG 

pages m Larry's Web site at http://www.cube3.com/ 

downloads/NYYRMLSTB. 

d. Step through the construction of the Luna Park Tower 

in this section to learn about building, scaling, and 

adding texture maps. 

e. Download the traile r template from http://www.cube3 

.com/downloads/NYYRMLSIG to build your own 

room m Coney Island. 
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35 feet 

15 feet 

15 feet 

35 feet 

3. Planning a model. 
a. Make a rough sketch of your model on paper to plan 

components and their dimensions. 

b. I n this example. the Luna Park Tower is approx imately 

I 00 feet high. T his i s I 00 inches in Yirtus Walk

Through Pro. 

4. Open an image or texture in Photoshop. 
a. Open Photoshop. T hen, select Open from the Fi le pull

down menu. 

b. Select a graphic in the dialog box that follows, and 

click on Open. 

\t~·• l l .. 
\,01'fo0 ifii,I\J. 
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h H lnlu ., 4b. 

4a. 

c. Your image wi ll open in a Photoshop window. 

4c. 
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• Sa. 

5. Copy /paste a texture to a new document. 
a. Select the Rectangle Marquee tool. 

b. Drag-select an area of a photo you would like to usc as 

a texture. 

c. Select Copy from the Edit pul l-down menu. 

d. Select New from the File pull-down menu 
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e. The dialog box that fol lows wi 11 display the dimen

sions of your selection. Click on OK. 

f. An Untitled new document will be displayed . 

Sf. 

g. Select Paste from the Edit pul l-down menu. 
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5h. 

Above: Luna Park 's venetian city. 

~~~~~ MI-:N 
ctprn.. ~0 

h. Your selection will fill the Untitled new document. 

6. Resize the texture. 
a. Select Image Size from the Image pull -down menu. 

b. Although I foot = I inch in Virtus WalkThrough Pro, 

you shou ld be very conservative when you resize your 

texture. Large texture Ii les wi ll make your model diffi

cult to download. 

In this example, although the base of the Luna Park 

Tower will be 35 feet high, enter 15 or 20 in the field 

labeled Height. Photoshop will resize the w idth pro

portionally, and Virtus will resize the texture to fit your 

model. Enter72 in the field labeled Resolution, and 

click on OK. 

c. The texture w ill be resized in a Photoshop window. 
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7. Save your texture. 
"''"'" a. Select Save As from the File pu ll -down menu. 
l •fJO•' 
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7a. 
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Above: Dreamland, the third enclosed 

park to open at Coney Island, was 

never as popular as Luna Park. Many 

f eel the architecture was less success

ful. Frederick Thompson, the creator of 

Luna Park, thought the "park's archi

tecfl/re should be a departure from all 

that is traditional." 

9a. 

412. J Chapter 11 

b. In the dialog box that follows, name the texture 
te.xture_1, and click on Save. 

8. Add the texture to WalkThrough Pro. 
a. Open the WalkThrough Pro software. 

b. Select Textures Window from the Windows pull-down 
menu. 

c. A Textures paleue wi II be displayed. 
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d. Select Add Textures from the pop-up menu on the 
Textures palette. 

e. In the dialog box that follows, select texture_ I, and 

click on Add. 

f. The texture will be added to the Textures palelle. 

Sd. 

Sf. 

Se. 

9. Building a model (the Luna Park Tower). 
Work in a Left or Right View to make drawing easier. 

a. Select New View! Left from the View pull-down menu. 



9b. 
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10c. 

I 

I 

I 

b. Drag the Observer out of the way before you begin 

your drawing. 

c. Select the Rectang le Tool. 

d. Drag a rectangle to form the bottom portion o f the Luna 

Park Tower. 

I 11 
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I 

~ 
9c. 
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9d. 

I 10. Applying textures. 
a. In th is example, you· ll add the Luna Park Tower tex-

Lure to the four sides of the tower base. 

b. Select the Tumble Editor Tool. 

c. Click on Luna Park Tower base in the Design View 

window. 

d. A Tumble Editor window will open. 

e. When the Tumble Editor window opens, the Grabber 

Hand Tool will be selected. 

I 10e. 

[J 
10d. 
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f. Refer to the Orientation Cube at the base o f the Tools 

w indow and rotate the rectangle to djsplay the four sur

faces where textures are to be appl ied. 

g. Select the Pointer A rrow Tool. 

h. Click on a sur face to select it. 

i. Select Textures Window from the W indows pull -down 

menu. 

j. Double-click on the texture labeled texture_/ to apply 

the texture to any of the surfaces. 

10g. 
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10j. 

k. Repeat Steps f through j to apply the texture to four 

sides of the tower base. (Note: You will need to re-se/ect 

the Grabber Hand Tool to IV tate the rower base.) 
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11a. 

I. Click on the Close Box in the Tumble Editor window. 

101. 

11. View your room in the Walk View. 
As you complete your model, navigate around each compo

nent in the Walk View to inspect the texture you applied. 

a. Level the Observer by selecting Level Observer from 

the View pull-down menu. 

b. The line of sight on the Observer will be aligned at a 

3:00 position. 

c. Select New ViewiWalk View from the View pull-down 

menu. 

d. Navigate around your model. 

11c. 

11d. 
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416. 1 Chapter II 

12. Complete your model. 
Use the drawing techniques described in this section to 

complete d1e Luna Park Tower. 

a. Plan each section of your model, and copy a texture 

map from a photograph to make your model look 

realistic. 

b. Build each section separately. 

c. As you're creating each section, access the Top View 

by selecting New ViewiTop from the View pull-down 

menu. 

d. With the Top View selected, you can determine if the 

sections of your model are lined up. 
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12c. 

l 
12d. 

e. Check the Walk View as you comple te each section to 

view the appearance o f your model. 

12e. 



14a. 

,., .. lll I€,., 
OpPn... KO 
Cl01e K UJ 

~lll'ft At.
n eiUUI IO h llfld 

r ose '•tup._ ,,.,,._ 

l ll'l jtOit lrere IIIIJU 
l HIIfl 

\n••••ot 
..... t ..... . ". 
l lbrtry .. . 

"' 

Ol.IU 11'0 

13a. 

13. Save your model. 
a. Select Save from the File pull-down menu. 

b. In the dialog box that follows, name th is model 

Luna. virtus, and click on Save. 
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13b. 

14. Exporting the model as a VRML file. 
a. Select ExportiYRML from the File pull-down menu. 

b . In the dialog box that follows, c lick on the box labeled 

Include Tex ture Li11ks. T hen, c lick on OK. 

c . In the dialog box that follows, name the fi le Luna. 1vr/, 

and cJjck o n Save. (Note: VRML.ftles must end in a 

. WRLJile extensio11.) 
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Alex Shamson's 
tips on creating 
aVRMLmodel 
in Virtus 
WalkThrough Pro 

Summary: Use Vi rills Wa/kTiuvugh Pro 

to create a 3D model, and then save it as 

a WRLji/e for viewing on the Web. 

418. 1 Chapter I I 

'!I a lkThrough Pro 

1a. 

A lex Shamson 's dinosaur ("Dino") is created with 2D 

polygons in the Virtus WalkThrough Pro Design View, 

which then get edited and colored as 3D objects in the soft

ware's Tumbler Editor. 

1. Open Virtus WalkThrough Pro. 
a. Open Virtus WalkThrough Pro. 

b. An Umitled:Top View window and an Untitled: Walk 

View window will open. (Note: Alex Shamson recom

mends saving the model immediately. See Steps Ba and 

8b for details on how to save your model in Virtus 

WalkTluv ugh Pro.) 
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I 

2. Change the Design View. 
Design View is where you wi II draw a 2D image o f the 

dinosaur's head. 

a. Select Change ViewiLeft from the View pull-down 

menu. 

b. The Untitled:Top View window will change to an 

U ntitled Design: Left View window. 

+ 

1· 1 

2b. 

3. Begin a 2D drawing of the dino head. 
a. Select the Irregul ar Object Tool. (Note: The lrreglllar 

Object Tool is used to draw irregular-shaped polygons 

by clicking on each vertex.) 

b. Move le rt to right wi th three successive clicks to begin 

the irregular-shaped polygon, as shown in Figure 3b. 

Fo llow the grid marking in Figure 3b, and try to make 

your drawi ng approximate ly the same size. 

c. Continue to create venices by c licking to form the poly

gon shown in Fig ure 3b. Fini sh by c licking on your 

starting point to close the polygon. The polygon should 

look ro ughly like a dinosaur sku ll facing left. 

t,~-

1 
/."'--, 

I ·_; 

3c. 
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420. I Chapter 11 

. 

d. The closed polygon will display a black handle at each 

vertex. You may drag on any of these handles to alter the 

polygon's shape. 

4. Change views, and alter the inflation. 
a. In Virtus WalkThrough Pro, an art ist draws in 2D, and 

the object is instantly rendered as a 3D object in the 

Walk View window. 

b. Your ability to see a 3D object in the Walk View window 

is dependent on t11e position of the Observer. Details on 

how to control the Observer will be presented later. The 

Observer may be dragged out of the way if it's in the way 

while you're working with your 20 polygon. 

4a. 

~ --~-r-

4b. 

c. When you draw a 20 shape, you create two dimensions, 

and the missing "third dimension" is referred to as the 

inflation distance. 

The in nation distance is represented as a gray bar in 

each of the rulers along the Design View Window. 

The default value for the inflation distance is e ight feel. 

This distance may be adjusted prior to drawing. Follow 

the next steps to check the front view of your object to 

see the model's proportions. 



4d. 

d. Select Change ViewiFront from the View pull-down 

menu. 

e. The Untitled: Left View will change to an Untitled: Front 

View. 

f. You may need to adjust the width of the dinosaur's head 

in the Front View by dragging on a handle as shown. J 

dragged a polygon handle in the Front View to make the 

model slightly wider. 

_p,_ ==I 
. -~ -

I 
i 

4e. 4f. 

5. Open the object in the Tumbler Editor. 
a. Select the Tumbler Editor Tool. 

b. Double-click on the polygon in your Front View 

window. 

Sa. a r--- -·-
1 

Sb. 

VRML World Building 1421. 



Sc. 

Ga. 6b. 6c. 

Tip: The Rotation Constraint Tools will 

help you comrol rotation when you edit 

objects in the Tumbler Editor window. 

422. 1 Chapter I 1 

c. A Tumbler Editor window will open. This view will 

allow you to rotate an object in 3D and edit a surface. 

d. When the Tumbler Editor window opens, lhe Grabber 

Hand Tool wi ll be selected. 

e. Use the Grabber Hand Tool, and try rotating the object 

in the Tumbler Editor window. Notice that, as you 

rotate the object, lhe orientation cube at the base of the 

Tools window will reflect the object's position in lhe 

Tumbler Editor window (T=Top, B=Bottom, F=Front, 

B=Back, L=Left, and R=Right). 

Sd. 

Se. 

6. Try the Rotation Constraint Tools. 
Rotntion Constraint Tools affect how the object in the 

Tumbler Editor window can be rotated. Clicking o n a tool 

wi ll cause the tool to become activated. 

You may turn on more than one tool at one time. You will 

know a particular tool is "on" because it wi ll appear shaded. 

At least one tool must be selected at any time. The tools may 

be turned "ofr ' with a second click, causing lhe shad ing to 

turn light. 

a. X -Y Motion Tool. This tool allows rotation in an X-Y 

plane. 

b. X-Z Motion Tool. This tool allows rotation in an X-Z 

plane. 

c. Y-Z Motion Tool. T his tool allows rotation in a Y-Z 

plane. 
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7a. 
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7b. 

Tip: Alex Shamson recommends that 

you always slice in a clockwise direc

tion. By doing this, you always lose the 

left side of the slice. 

7. Reshape the head with the Slice Tool. 
Alex used the Slice tool in the Tumbler Editor window to 

taper the from of the dinosaur's nose. You' II need to work on 

the model looking down at the d inosaur's head from a Top 

Yiew.ln this position, the nose wi ll be pointing to the bot

tom of your screen. 

a. Rotate your model in the Tumbler Editor window so 

thaL it is oriented with the lop and bottom sides, as 

shown in Figure 7a. Refer to the orientation cube at the 

base of the Tools palette for help. 

b. Select the Slice Tool. 

c. Using the Slice Tool, drag a slice down the right side of 

the model, as shown in Figure 7c. 

d. When you release your mouse button, a triangular seg

ment will have been "sl iced" off, leaving a set of han

dles where you placed the slice. These handles a llow 

you to edit the slice if necessary. To edit a slice, drag on 

one of the handles. (Note: To edit a slice by its handles, 

you need the Selection Tool.) 

u- Unllllllld l:Iu .. lll• Ultlf • ur: lJAlllled l:lutnO\e l dllor a 

I 

IEJ I : 

I 

7c. 7d. 

e . Using the Slice Tool, drag a slice up the left side o f the 

model, as shown in Figure 7e. 

:J U•IIUed .l~ l•••lll• l dllor ,.. 

II 
I 

I' E! 
I I . 

1 

7e. 
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424. I Chapter I 1 

f. When you release your mouse button, a triangular seg
ment will have been sliced off, leaving a set of handles 

where you placed the slice. 

g. Taper the nose even further by dragging a slice down the 
right side of the front snout area, as shown in Figure 7g. 

h. Again, a set of handles will remain when you release 

your mouse button. 

-.. hiiUd l:lumble [diiH " I n lllld l :I••W• lditor 

I 

·11 

p - ju--
7g. 7h. 

i. Drag a similar slice down the left side of the front snout 
area, as shown in Figure 7i. 

j. Again, a set of handles wi ll remain when you release 

your mouse button. 

" l n111114l:IUJnllll[lllt11 

71. 7). 



7k. 

k. Your slices have been recorded in the Tool palette. If 

you wish to see where the slices have been placed or if 

you wish to further edit o ne of the slices, you may 

select a slice by name in the Too l palette window. The 

respective set of handles wi ll then appear in the Tumble 

Editor window. 

I. To taper the end of the dinosaur's snout even further, 

position your model in the Tumbler Editor window, 

as shown in Figure 71. Use the Orientation Cube 

as a g uide. 

71. 

m. With the front of the dinosaur's snout facing away from 

you, drag another slice off the right fro nt of his snout, as 

shown in Figure 7m. 

n. Drag a similar slice off the left front of his snout. 

Unllll• d J:l umble tdil or • 'Q UftiiUe d l :l untbl• l cJIIOt 

;I 
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I 

7m. 7n. 
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I 

o. When you've completed your slices, rotate your 

dinosaur's head to see how the slices have tapered the 

snout Notice the slices will be listed in the Tool paleue. 

p. Put the Tumbler Editor away by clicking on the close 

box in the upper-left corner. 

7p. 

8. Save your model. 
U' you have not yet saved your model, save it as a Virtus 

WalkThrough Pro file. Later, you will be saving it as a WRL 

file to be viewed on the Web. 

a. Select Save from the File pull-down menu. 

b. In the dialog box that follows. type a fil e name, and 

click on Save. 
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9. Create the lower jaw from a duplicate. 
Return to the Left View to create the lower jaw, 

creme a duplicate, and then open the Tumbler Editor to 

remove the top portion of the head. A remaining lower sec

tion will form the lower jaw. 

a. Select Change ViewiLeft from the View pull-down 

menu. 
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9c. 

9b. 

9f. 

91. 

b. A Left View window will be displayed. 

c. Select Duplicate from the Edit pull-down menu. 

d. A duplicate o f your model will appear. 

e . Drag the duplicate polygon away from the original, as 

shown in Figure 9e. 

Ji 

9d. 9e. 

~> 
-~__'y 

f . Select the Tumbler Editor Too l. 

g. Double-click on the duplicate polygon in your Left 

Vi ew window. 

h. A Tumbler Editor window will open. 

:;i AleN \ lllnotom :LIIfl III I W ;.II 

9g. 

9h. 

I , 
i. When the Tumbler Edito r window opens, the Grabber 

Hand Tool will be selected. 
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9J. 

91. 

10o. 

428. 1 Chapter II 

j. Use the Grabber Hand Tool to orient your model, as 

shown in Figure 9j . Use the orientation cube at the base 

of the Tools pale tte as a reference. 

k. Select the Slice Tool. 

I. Using lhe Slice Tool, drag the head from left to right, as 

shown in Figure 91. 

m. When you release the mouse button, the upper portion of 

the head will have been sliced o ff, leaving a set o f han

d les where you placed the slice. 

n. You may want to rotate the new lower jaw in the 

Tumbler Editor window using the Grabber Hand Tool. 

o. Put the Tumbler Editor window away by clicking on the 

close box in the upper-left corner. 

Q 111M'' cliftOIIIIr.hftllllfl l dUOr 

9o. 

r 
9m. 9n. 

10. Create a neck. 
Create a neck by drawing a new polygon in the Left View 

window. 

a. Select the Irreg ular Object Tool. 



10b. 

11a. 

b. Draw a four-sided polygon to form a neck, as shown in 

Figure LOb. 

c. Drag the comple ted neck polygon to line up with the 

head, as shown in Figure I Oc. You may need to drag on 

one of the neck polygon handles so that it lines up prop

erly with the dinosaur head . 

.. • 

10c. 

11. Rotate the jaw. 
Alex's dinosaur has a lower j aw that is open, showing a 

mouth full of teeth and a tongue. In order for the jaw to 

appear open, the lower j aw must be rotated. 

c 

a. Select the Rotate Tool. 

b. Click inside the lower jaw polygon, and drag your 

mouse away from the polygon to the right as shown. As 

you move your mouse with the mouse button held 

down, you' ll notice that the lower jaw segment can be 

rotated. When you are happy with the angle of rotation 

or, when the angle of rotatio n approximates what is 

shown in Figure I I b, let go of the mouse button. 

c. Drag the lower jaw .into position, as shown in 

Figure li e. 

Ub. 11c. 
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12d. 
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12. Color the dinosaur polygons. 
The surfaces of your polygons may be colored in the Tumble 

Editor or the Surface Editor. Alex chose a bright green shade 

for the dinosaur head and a pink shade for the inside of the 

mouth. 

Start by coloring the dinosaur's neck. However, before you 

go into the Tumble Editor, check the Front View to see if the 

head and neck a re approximately the same width. 

a. Select Change ViewiFront from the View pull-down 

menu. 

b. The Front View window wil l be displayed. 

c. Adjust the neck polygon width so that it matches the 

width of the dinosaur head in this view. 

IIIPifS Q'InOnur:ftOhiUii! l ll~ 

12b, 12c. 

d. Select Change ViewiLeft fTom the View pull-down 

menu. 

e. The Left View window wil l be displayed. 

f. Select the Tumbler Editor Tool shown in Figure 12fl . 

(Note: Alternatively, you may select the Swface Editor 

Tool shown in Figure 12j2 and fo llow similar directions 

to color an object in the Swface Editor.) 

II 

9=:J 
I 

12f1. 12f2. 

12e. 





13a. 

13b. 

432. I Chapter 11 

o. Open the remaining polygons you've created and the 

lower jaw in the Tumbler Editor. Follow Steps g through 

l to apply green to all but the underside surface of the 

dinosaur's head and the upper surface of the dinosaur's 

lower jaw. Apply pink to these two surfaces. 

p. Close the Tumbler Editor window by clicking on the 

close box in the upper-left corner. 

12p. 

13. Create horns. 
Alex gave the dinosaur a crown of horns, which he 

colored red. 

a. Select lJTegular Object Tool. 

b. Select the Jntlate Pointed Modifier Tool. This tool will 

in11ate an object with sides that converge to a point. 

c. Draw a three-sided polygon to form a horn polygon, as 

shown in Figure 13c. 

d. Before duplicating the horn, check on the horn's 

proportions in the Front View window. Select Change 

ViewiFront from the View pull-down menu. 

13d. 

13c. 



13e, 13f. 
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13h. 

e. The Front View window will be displayed. 

f. Adjust the horn polygon so that irs width is almost as 

wide as the dinosaur's head. 

g. Drag the hom into position on the right side of the head, 

as shown in Figure l 3g. 

~ III•K'Jdlnouaur.fnntUiew ~· 

=-

IL:J 
13g. 

h. With the horn still selected, select Duplicate from the 

Edit pull-down menu. 

i. A duplicate horn will appear. 

j. Select the Rotate Tool. 

131. 

§F= 
I 

• 

13j. 
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k. Click inside the horn polygon, and drag your mouse 

away from the polygon to the righL. As you move your 

mouse wi th the mouse button he ld down, you'JJ notice 

the horn can be rotated. Rotate the horn s lightly and let 

go of the mouse button. 

I. Drag the duplicate into position on the right side of the 

head. 

m. Repeat Steps h through k to create five more horns, as 

shown in Figure 13 m. 
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13k. 131,13m. 

14. Create eyes. 
Alex gave the dinosaur small yellow pyramids for eyes. 

a. Select Change ViewiLeft from the View pull-down 

menu. 

b. The Left View window will be displayed. 

c. Select the Irregular Object Tool. 

d. Select the [nflate Pointed Modifier Tool. This tool will 

inflate an object wi th sides that converge to a point. 

14c. 14d. 

14b. 
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14e. 

141. 

e. Draw a three-sided polygon ro form an eye, as shown in 

Figure 14e. 

f. Select Change ViewiFront from the View pull-down 

menu. 

g. The Front View window will be displayed. 

h. Adjust the width of the eye, as shown in Figure 14 b. 
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14g,14h. 

i. Select Change ViewiLeft from the View pull-down 

menu. 

j. The Left View window will be displayed. 

k. Drag the le ft eye into position on the dinosaur's head. 

14j,14k. 

I. Follow Steps 14i and 14j to duplicate the eye. 

m. Change to the Front View, and position the right eye on 

the right side of the dinosaur's head. 
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15. Create a tongue. 
Give the dinosaur a dark red tongue. 

a. Select Change ViewlLeft from the View pull-down 

menu. 

b. The Left View window will be displayed. 

c. Select the Jrregular Object Tool. 

d. Select the Innate Pointed Modifier Tool. This tool will 

inflate an object with sides that converge to a point 

15c. lSd. 

15b. 

e. Draw a three-sided polygon to form a tongue, as shown 

in Figure 15e. 

f. Select Change ViewiFront from the View pull-down 

menu. 

g. The Front View window will be displayed. 

h. Adjust the width of the tongue, as shown in Figure ISh . 

.. 

15f. 

1Sg,1Sh. 
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16b. 

i. Select Change View!Left from the View pull-down 

menu. 

j . The Left View window will be displayed. 

k. Drag the tongue into position inside the dinosaur's 

mouth, as shown in F igure l5k. 

... 

15J, 15k. 

16. View the model in the Walk View. 
a. Drag the Observer in front of your model, as shown in 

Figure 16a. 

b. The black line in the middle of the Observer shou ld be 

pointing toward the dinosaur. This represents the direc

tion of the Observer or the line of sight. 

To manually change the line of sight, posi tion the tip of 

the mouse pointer arrow in the center of the Observer, 

hold down the Option key, and cl ick and drag in a new 

direction. A dolled line will appear. Release the mouse 

button, and the line of sight wi ll be repositioned. 

c. Select New View! Walk View from the View pull-down 

menu. 
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16g. 
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d. The Walk V iew w i ll be d isplayed. 

e. Posit ion your mouse on ei ther side of the center cross

hair, and cl ick on the mouse button a few times. This 

action causes you to navigate in the Walk View window 

Lo the right or to the left. 

(Note: If you position your mouse to the left of the cen

ter crosshair and click, you wiiiiLirnleft. You will tum 

right ({you position your mouse to the right oft he cen

ter crosshair and click. If you position your mouse 

above the center crosshair and click, you will move .for

ward. You will move backward if you position your 

mouse bull on below the center crosslwir and click.) 

f. In Lhe Walk View window, you can see i f your model 

needs adj ustment. 

g. The background color of the Walk V iew w indow may be 

changed by pressing on the Color bar in the Tool palette 

and selecting an aiLernate color, as shown in Figure 16g. 

h. A lex Shamson changed the background color from the 

default l ighL blue to black. (Note: The dinosaur you see 

in the step-by-step examples is the dinosaur I created f or 

this section. Figure 16h is is the dinosaur Alex created. ) 

16h. 



17a. 

17. Repositioning the dinosaur's eyes. 
The Walk View revealed that my dinosaur's eyes needed to 

be moved toward the head. The Front View is the best view 

to do thi s. 

a. Select Change ViewiFront from the View pull-down 

menu. 

b. The Front View window will be displayed. 

c. Click on o ne of the eye polygons, and press the down 

arrow on your keyboard to move the cyt:: down. 

d. Repeat this step to move the other eye polygon to line it 

up with the first eye polygon you moved. 

e. Follow Steps 16c and 16d to change to the Walk View 

and check on this adjustment. 

17b, 17c. 17d. 

+ 

17e. 
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18. Adjust the World Lighting. 
The World Lighting Editor may be used to adjust the light

ing on or around your model. The objects you create in 

Virtus WalkThrough Pro have four default light sources. 

One of these is an ambient light source (light from all direc

tions simultaneously) and three are directional light sources 

(light from a single d irection). 

All oft he default light sources have a neutral gray color, 

which may be changed. Lights may be added or dele ted, 

turned on or off, and designated as eitl1cr ambient or 

directional. 

To add brighter I ight to the dinosaur, change the color of the 

lights from gray to white. 

a. Select New ViewiWorld Lighting from tlle View 

pull -down menu. 

b. The World Lighting Editor will be opened. 

c. A Lights li st, containing the four default light sources, 

wi ll appear in tl1e Tools palette. Each light has a(n): 

• On/Off switch. Click to turn a light source on or off. 

• Ambient/Directional icon. C lick to toggle between 

these two types of light sources. 

• Color bar. Press and hold down the Color Bar to 

select a light color. 

d. To change the light color from gray to white, press and 

hold down the Color bar, drag the pointer to select 

white, and re lease the mouse button. 

18d. 
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18f. 

e. Repeat this step to change the light co lor of L11e remain

ing lights from gray to white. 

f. To observe tJ1e e ffects of the change in the light color, 

open the Walk View. Select New ViewiWalk View from 

the View pull-down menu . 

g. Note the change in the model. Besides the change in the 

background colo r, the light is brighte r. 

18g. 

19. Create a duplicate jaw to hold teeth. 
a . Select Change ViewiLe ft from the View pull-down 

menu. 

b. The Lel't View w indow wi ll be displayed. 

c . C lick on the lower jaw to select it. 

19a. d. Select Duplicate From the Edi t pull-down menu. 
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19e . 

19h. 191. 
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19j. 

442. 1 Chapter II 

j 

e . A duplicate lower jaw will appear. 

f . Use the down arrow key on your keyboard to move the 

duplicate away from your model. 

g. When you've moved the duplicate away from your 

model, use your mouse pointer anow to move the jaw in 

rront of your model. 

19f. 19g. 

h. Select the Irregular Object Tool. 

i. Select the Inflate PoinLed Modifier Tool. 

j. Draw a three-sided polygon to form a tooth, as shown in 

Figure L 9j . 

k. Select Change ViewiFront from the View pull-down 

menu. 

I. The Front View window wi ll be displayed. 

m. Adjust the width of the tongue, as shown in Figure 19m . 
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19q. 

I 

n. Select Change ViewiLeft fTom the View pull-down 

menu. 

o. The Left View window will be displayed. 

p. Drag the tooth and line it up on the jaw, as shown in 

Figure 19p. 

II 

19o. 

19p. 

q. With the tooth still selected. selec t Duplicate from the 

Edit pull -down menu. 

r. A duplicate tooth will appear. 

s. Move the duplicate tooth and line it up on the jaw, as 

shown in Figure 19s. 

"' R~M rdii\Oltut:l • ll Uloew .. ~ lie"' el•o•our:ll ll lllrUI . . 

~ ~ ~~:. 
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~ I 1 ~ 

. .,. 
19r. 19s. 

II 
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20a. 

t. Reselect Duplicate from the Edit pull-clown menu. 

u. A new duplicate will appear and Virtus WalkThrough 

Pro wi ll remember where you moved the original. 

v. Continue to select Duplicate from the Edit pull-down 

menu until you have filled in the jaw with teeth, as 

shown in Figure 19v. 

19u. 19v. 

20. Adjust the teeth in the Top View. 
a . Select Change ViewlTop from the View pull-down 

menu. 

b. The Top View will be displayed . 

20b. 

• 

. 
' 
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20c. 

I 

~ ~rt · 
20f. 

c. Drag a selection marquee around the teeth, as shown in 

Figure 20c, and then let go o f the mouse. 

d. When you release the mouse, the teetJ1 will display 

selection handles, indicating that they are selected. 

e. Drag the teeth inside the j aw, as shown in Figure 20e . 

.. 

r / l 
I 

w-· ~ 
20e. 

f. Move the front teeth around to the front of the jaw, one 

at a time. To do this, cl ick on a tooth, and move it to the 

left using the left arrow key o n your keyboard. 

g. Use the drag-select and duplicate techniques presented 

in this section to create a row of teeth on the ri ght side 

of the j aw. 

h. When you have completed a fu ll set o f teeth us ing the 

jaw as a guide, move the jaw away from the teeth, as 

shown in Figure 20h. 

20g. 20h. 
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21a. 

I 

21b. 

21e. 

21f. 

446. J Chapter II 

21. Group the teeth. 
a. Drag a selection marquee around the teeth, and then let 

go of the mouse. 

b. When you release the mouse, the teeth will display 

selection handles, indicating that they are selected. 

c. Select Group from the Design pull-down menu. 

d. The teeth will become one object, and the new object 

wil l be surrounded with a new set of selection handles. 
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21c. 
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21d. 

e. Select Change ViewiLeft from the View pull-down 

menu. 

f. The Left View will be displayed. 

g. Select the duplicate jaw. 

h. Press the Delete key on your keyboard to delete the 

duplicate jaw. The jaw was used as a guide to create 

teeth and is no longer needed. 

l 
21g. 21h. 



211. 

22a. 

i. Select the teeth, which are now one object. 

j. Select Duplicate from the Edit pull -down menu. 

k. A duplicate set of teeth wi ll appear superimposed on the 

orig inal. 

lllr w Df'ilqn ··~ ,•••«~.r.t•l ....... 
' 
. 

Undo az 

c .. •• 

I 
(O illj NC 

' PIUe • •• Clu r 

"1001fyh1Kifd • Ill'~: \IIU I IIII •• 
1111'f' IM1 1Ul l.p;~: Mnttt \t:IUif d •• \ho.J IIIII 
I IM. k \rl ttlfd :, -~ unkut 1111 

PrefP.I t'acn._ 
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21k. 

I. Move the new duplicaLe set of teeth away from the 

oti ginal. 

m. Drag the duplicate set of teeth into the dinosaur's mouth, 

as shown in Figure 2 1m. 

211. 21m. 

22. Rotate the original set of teeth. 
a. Select the Rotate Tool. 
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b. Click inside the grouped object, and drag your mouse 

down and to the left. As you move your mouse with the 

button held down, you' ll notice that the teeth can be 

rotated. 

c. Rotate the teeth so they are facing down, as shown in 

Figure 22b. You may need to rotate the teeth a few times 
to gel them to line up horizontally . 

.. 

22b. 22c. 

d. Select Change ViewiTop from the View pull-down 

menu . 

e. The Top View will be displayed. 

f. Select the Rotate Tool. 

g. You've rotated the teeth in the Left View so that they 

point down. Now, rotate the teeth so that the set faces in 

the same di rection as the Lop row. Click inside the 

remaining set of teeth, drag your mouse to the right, and 

rotate the row so that it faces the opposite direction. 

22f . 

22g. 



23o. 

24a. 

24b. 

23. Drag the upper teeth inside the mouth. 
a. Drag the duplicate row of teeth inside the dinosaur's 

mouth, as shown in Figure 23a. 

b. Select New ViewiWalk View from the View pull-down 

menu. (Note: See Steps 16a and J6b in this section for 

details on hoiV to position the Observe1: ) 

c. The Walk View wi ll be displayed. Both rows of teeth 

have extra teeth that need to be deleted. 
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23b. 

23c. 

24. Delete extra teeth. 
a. Select Change ViewiLe fl from the View pull-down 

menu. 

b. The Left View wi ll be displayed. 

c. With the upper row of teeth selected, select Ungroup 

from the Design pull-down menu. 

d. Although individual handles may not appear around 

each tooth, you' ll discover that the teeth are no longer 

one object by clicking on one of the rear teeth. 
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24c. 

24d. 
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.,r 

e. Click to select individual teeth , and press the Delete key 
on the keyboard to remove the extra teeth. 

f. Repeat Step 24c to ungroup the lower set of teeth. 

g. Click to select individual teeth along the lower jaw, and 

press the Delete key on the keyboard to remove extra 

teeth. 

24g. 

h. Select New ViewiWalk View from the View pull-down 

menu. 

i. The Walk View wi II be displayed. 

241. 
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26b. 

25. Resave your model. 
a. Select Save from the File pull-down menu. 
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25a. 

b. Your file will be updated. 

26. Export the model as a VRML file. 
a. Select ExportiVRML from the File pull-down menu. 

b. In the dia log box that fo llows, click OK. (Note: The 

dinosaur has no textures. ) 

c. In the dialog box that fo llows, lype a name with a WRL 

extension, and cl ick o n Save. 

d. A file-writing st.atus bar will appear as the .WRL fi le is 

written lo your hard drive. 

Ukiii,.!J:If•nourr t .. c=========~ t··~~ ] 

26d. 

26c. 
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Open your WRL 
file in a VRML 
browser 
Summary: Use the Virtus Voyager 

\IRML browser to open your WRLfile. 

Voyager 82 68k 

l a. 

452. 1 Chapter 11 

I 
dino.wr l 

0 pen your WRL fi le in a browser that can see VRML 
files. Examples include Netscape Navigator with 

Live3D plug-in, the Virtus Voyager browser, or Brad 
Anderson's ExpressVR browser. SGI has announced that 
they intend to provide a version of their Cosmo browser for 
the Macintosh. (Note: The dino. wrl model in this example is 

available on the book's companion CD-ROM. The model 

was created by Alex Shamson of VRmill, Inc. Look for his 

sire at http://www. vrmill.com. ) 

1. Open a VRML file in Virtus Voyager. 
a. Open the Voyager software that corresponds to your 

hardware (Macintosh Power PC or 68 K Macintosh). 

b. The Voyager browser window will open. (Note: Look 

for t he Virtus Voyager browser on tl1e companion 

CD-ROM. The Voyager browser may be used as a 

standalone application, or it may be COJ!fig ured as a 

Netscape helper appplication.) 

c. Select Open File from the File pull-down menu. 

lb. 
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1d. 

2a. 

2c. 

2e. 

2g. 

~·· 
~ 
~ 

2b. 

2d. 

2f. 

d. ln the dialog box that follows, open a WRL file and 

click on Open. 

e. The VRML model will open in the browser window. 

1e. 

2. Navigate your VRML file. 
a. Press on the Forward navigation button to move 

forward. 

b. Press on the Backward navigation button to move 

backward. 

c. Press on the Left navigation button to move len . 

d. Press on the Right nav igation button to move right. 

e. Press on the Up navigat ion button to move up. 

f. Press on the Down navigation button to move down. 

g. Press on the Home navigation button to reposition the 

model to its opening position. 
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OpenaVRML 
file in a word 
processor and 
alter the 
Perspective· 
Camera 
Summary: Follow this example to 

change the PerspectiveCamera node's 

parameters by making changes to a WRL 

file in a word process01: 

454. I Chapter 11 
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dino.wrl 

M any people who create VRML models use a word 

processor to create "hand coded" VRML. These files 

and the files you expon fro m a 3D application program are 

text fil es that may be opened and modified in a word 

processor. 

As VRML changes, hand coding provides a means to make 

changes in a VRML model that applications may not be 

able to add. In thi s example, changes in XYZ position val

ues in the PerspectiveCamera node parameters will al ter the 

position of the dinosaur head when the mode l opens. 

1. Open a VRML file in a word processor. 
a. Open Microsoft Word or some other word processor. 

(Note: SimpleTextmay be used, although the software's 

document size is limited, and some VRML models may 

not open.) 

b. Select Open from the Fi le pull-down menu. 

c. In the dialog box that follows, select a WRL li le, and 

click on Open. 

~tlec t •DIIumenl : 
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1d. 

2b. 

2d. 

"" Persp
1
ectiveCamera 

positions 

d. The WRL file wi ll open in a document window. 

e. The file may not have a neat column of VRML code 

that you'd expect it to have. For example. the YRML 
code you' re looking for is most readable in the column 

format: 

Pe r specti veCamera 

posi tion · 14.7574 · 5.9690 ·1 . 3716 JfSFVec3f 

orienta t i on 0 1 0 4.4438 #SFRotati on 

foe a 1 Oi stance 2 1/SFFl oa t 

heightAngle 1.0486 

Although the text fi le looks scrambled in a Microsoft 

Word window, it does not need to be cleaned up or 

formatted. 

2. Change the XYZ position values. 
a. The XYZ position values in the file that opens are: 

· 1. 8034 

· 0.1524 

3 . 3528 

b. These values correspond to the location of the camera. 

See Figure 2b. 

c. To reposition the cameras entry view, change these 

values to: 

I . 2034 

• 0 5524 

3.3528 

(Note: The Netscape Navigator browser window with 

Live3D has a pop-up menu that accomodates several 

PerspectiveCamera position views. These extra camera 

position views are a11 example ofVRML that needs to be 

hand coded.) 

d. The new XYZ values correspond to the position of the 

camera view. See Figure 2d. (Note: The dinosaur's 

head does not move; the camera does.) 
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3a. 

3. Save your WRL file and view changes. 
a. Select Save As from the File pull-down menu. 

b. In the dialog box that follows, selec t Text Only from the 

Save File As Type pop-up menu. 

3b. 

c. Alter the file name by adding an alphanumeric charac

ter, make sure the file has a WRL extension, and click 

on Save. 

"-"' ............ ~·····: , . ..., ... . 
('.:':~:.·· '"'' 1· 1 0 .. 1 .. 11 1 ... 111• 

3c. 

d. Follows Steps l a through I e in the previous section to 

view the position changes. 

4. Create a Camera Switch (a Live3D option). 
Live30 's viewpoints provide a means to display several 

camera shots that you can access through the View pop-up 

menu in the Netscape Navigator window. To write these 

extra viewpoints into a YRML file, you' ll need to create a 

Camera Switch node. You can then add as many viewpoints 

as you'd like. 

a. The following example is from Alex Shamson's 

Plaza. wrlli le , which can be v iewed at his Web site 

(http://www.vnnill.com). Each new viewpoint's 



4a. 

description follows each line, begi11ning with DEF. 

(Note: \liewpoim descriptions appear in the Live 3D 

pop-up.) Alex Shamson warns that spaces between 

words in a description are not a llowed. For example, 

notice he has closed the space in Entry View and 

LeftRear: 

DEF Cameras Switch 

whi chChild - 1 

DEF EntryView PerspectiveCame ra 

posit i on 0 3.6 159 #SFVec3 f 

or ientation 1 0 0 0.2 (JSFRotation 

focal Di stance 678. 69 IJSFFloat 

heightAngle 1.3 

DEF Lef tRea r Perspec t i veCame r a 

posit ion -80 5. 5 25 

ori enta tion 0 1 0 4 . 5 #SFRo tat ion 

foc al Distance 678 .69 

hei gh t Angl e l. 3 

DEF Bird 's EyeView Per spectiveCamera 

pos i t ion 7 0 50 15 

or ientat i on 0 1 0 -4 IJS FRotat ion 

foca l Distance 500 

heigh tAngle -3 

DEF Directo ryPa nel Pe r spectiveCamera 

pos i ti on -10 4 45 

orientation 0 1 0 -6 IJSFRotation 

focal Di s t ance 500 

heightAngle -3 
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EmbedaVRML 
window in a 
Web page 
Summary: Use the <EMBED> tag to 

add a VRMLji/e to a Web page. 

Tip : The BBS ColorEditor has moved a 

f ew times. If you have tmublefinding the 

site, visit the Alta Vista search engine at 

http://www.a/tavista.digita/. com. Do a 

search 0 11 ColorEditor for HTML. Do 

not include a space between Color and 

Editor. 

458 . I Chapter 11 

VRML fi les can be added to a Web page using the 

<EMBED> tag. This tag defines an inline window that 

is part of the page. 

1 . Create an HTML document. 
a. Open SimpleText or your word processor. rr you use 

a word processor, be sure to save the text as Text Only. 

b. Create a new HTML document. Start a new document 

with the following mar kup tags: 

<HH1L> 

<HEAD > 

<TITLE> Alex · s di nosaur 

</TITLE> 

</ HEAD> 

c. Create a body tag, a nd add color att r ibu tes. Adding 

color to a Netscape background requires placing a hexa

decimal red-green-blue triple t in U1e body tag. Best 

Business Solut ions' Color Editor provides an online tool 

to locate a hexadecimal triplet for your page at 

http://uccnitk.edu.tw/html.courses/colorEditor.html. 

<HTML> 

<HEAD> 

<TITLE> Al ex ' s dinosau r 

<!TI TLE> 



</HEAD> 

<BODY BGCOLOR-"//000000"> 

d . Add a <CENTER> tag 

<HTMD 

<HEAD> 

<TITLE> Alex ' s dinosa ur 

<!TITLE> 

<!HEAD> 

<BODY BGCOLOR-"#000000"> 

<CENTER> 

e. Add an <EMBED> tag. In this tag, the width and 

height of the embedded VRML window is defined in 

pixels. In this example, the width is 400, and the height 

is 300. 

<HH1 L> 

<HEAD> 

<T ITLE> Alex ' s di nosaur 

<!TITLE> 

<!HEAD> 

<BODY BGCOLOR-"#000000"> 

<CENTER> 

<EMBED SRC-"dino.wrl " WIDTH-400 HE IGHT-300> 

<ICEfHER> 

f. Add the ending tags. 

<!BODY> 
<tHm L> 

g. Save the file. Save the document in SimpleText or 

your word processor.lf you' re working in a word 

processor, save the text as Text Only. G ive the fil e an 

.HThl extension. 

h . Test the frame document. Open Netscape or 

Microsoft 's Internet Explorer browser. Open your 

document by selecting Open File from the File pull

down menu. 
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2. Summary of HTML tags used in this section. 
The tags you see in this list (in alphabetical order) re flect the 

HTML 3.2 specification. 

<BODY> .•. </BODY> 

A tag used to open and close the body of a document. 

T his tag uses the BGCOLOR=#RRGGBB or hexadeci

mal red-green-blue triple t attribute, which adds color to a 

browser page. Fo r example: 

<BODY BGCOLOR-11000000> 

<CENTER> ... </CENTER> 

A tag used to center e lements on a page. 

<EMBED> 

A Lag used to add an embedded object to a Web page. 

This tag uses the SRC attribute, which represents the 

name of the source data. This tag also uses the WIDTH 

and HEIGHT attributes to indicate the width and height 

of an object in pixels. For example: 

<EMBED SRC- ''dlno.wr l " WI DTH- 400 HEIGHT- 300> 

<HEAD> ... </HEAD> 

A tag used to open and close the header portion of a 

document. 

<HTML> ... <lHTML> 

A tag used to open and close an HTML document. 

<TITLE> .. . <!I'ITLE> 

A tag used to describes the title of a document, which 

shows up inside a browser's title bar. 



Artist featured in 
this chapter: 

Frank DeCrescenzo is 
a graphic designer at 
Simon & Schuster in 
New York City and n 
new media artist spe
cializing in Web site 
design, 3D animation, 
and digital video. He is 
also a musician with the 
band Mantus. 
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Forms 
A Web page form is an advanced feature because it requires 

a user to type data into the form's fields, select from multi

ple-choice-type data fields using radio buttons, or drag

select from multiple-choice-type data in pop-up menus. 

These responses must then be routed from the Web page to 

some destination on the Internet. The designer who builds 

the form must either create a strategy for routing the data or 

turn this task over to a programmer. TypicaUy, data is routed 

from a form to some destination with a CGI script (Common 

Gateway Interface) written in a computer language such as 

PERL, Java, or C++. 

[n this chapter, new media artist Frank DeCrescenzo demon

strates how to design a form using NetObjects Fusion. The 

routing of data is handled with a simple MAIL TO command 

and avoids the use of CGI scripts. By using a MAIL TO, the 

designer who creates the form may have the form data 

mailed to an email address. Even though th is method is IJ1e 

least sophisticated technique for routing form data, it 's 

generic enough for any Web server. (Note: For details on 

CCI directol)• access, see Before you design a form for your 

Web site . . .. ) Special thanks to Web specialist Peter Chowka 

for his tips on how to use a MArL TO to route form data. 





The Slappers 
Website 
Summary: Learn how to design a 

Web site with a form by following 

Frank DeCrescenzo's step-by-step 

example. 
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Above: The site 's Wh ere page contains 

a form. 

A bove Right: The Slc1ppers home page. 
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S tappers are nat drumsticks created by percussionist 

Billy Amendola. Billy and Frank DeCrescenzo arc both 

members of a New York City-based band called Mantus. 

(Note: Readers who wish to follow Frank 's sample step-by

step may look for both art and text files on the companion 

CD-ROM. ) 

1. Overview. 
Th is chapter presents readers with the techniques used to 

create a form with NctObjects Fusion. Visit http://www 

.netobjects.com to download a 30-day trial copy of the 

software. 
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2. The site's structure. 
The structure Frank designed for the S lappers site is a simple 

hierarchy. 

a. Splash page. When visitors load the first Slappers page 

into their browser, the first thing that appears is a GfF 

animation of a rotating 3D logo. 

b. Home page. Frank's ho me page contains a transparent 

GlF image of the Slappers drumsticks and an image map 

panel. 

c. Who. Frank's Who page includes background informa

tjon about Billy Amendola, who developed the Slappers 

drumsticks. Included are endorsements from fellow 

artists and magazines, such as Drum!, Modern 

Drummer; and Rip Magazine. The Who branch contains 

another branch to a Mantus page, which in turn contains 

details about Frank's band. 

d. How. The How page explains how to use Slappers drum

sticks. The links on this page load QuickTime video 

demonstration clips. 

e. Where. This page answers the question, "Where can I 

get them?" Frank's form is included on this page. 

2d. 

2o. 



2f. 

3a. 3b. 

f. Hot Links. This page contains links to related percus

sion pages on the Web. 

3. Image maps as a navigation device. 
Frank chose image maps as a navigation device. He designed 

image map panels containing percussion instrument icons 

for each of the pages. These include a fu ll drum set, a set of 

cow bells, a timbale, and a set of bongos. 

a. Home page. Frank's icons on the home page are all 

visible, and they're clickable hotspots that branch to 

related Web pages. 

b. Branch pages. On a branch page, a related icon is a 

ghosted representation of the original. This is a visual 

device meant to confirm that the user is on the right page. 

4. Data collection with forms. 
Frank's fmm on the Where page collects personal data such 

as name, address, ci ty, state, ZIP, country, and email. He has 

also created fields for a business transaction for visitors who 

wish to purchase a set of "Slappers." 

1\ltiii"D&te vay to Ycrl(y orhr. Pbooe ntlDl•er 

1'.000 

VIOl ... 

4. 
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Using 
NetObjects Fusion 
to create a 
client-side 
image map 

Summary: Form design in NetObjects 

Fusion couldn 't be simple!: To down

load a30-day trial version of the soft

ware, visit hltp:l/www.netobjects.com. 

Nt?tob jt?cts Fusion 
1a. 

........ [EI§;;;;,..;:;:.=====::J 
t,...Utn 

Ia..... •I 

1b, 1c. 

466. j Chapter 12 

NetObjects 
FUSIONN 
Version 1.0 

0 1996 N etObj@Ct S, Inc. All Ri ghts Reserved 

Nn~ 

N etObjeets Fusion is a wonderful tool for designers 

who do not want to write HTML tags. This simple 

introduction uses single-line text fields for data entry. 

For detai ls on how to add multiple-line text fields, radio 

dials, checkboxes, and combo boxes, visit the NetObjects 

Web site at hup://www.netobjec ts.com and download the 

software 's documentation. To follow this step-by-step sam

ple. look for re lated art and text files on the companion 

CD-ROM . 

1. Start NetObjects Fusion. 
The step-by-step sample in this section assumes you have 

learned the basic Web page techniques using Net Objects 

Fusion presented in Chapter 3. 

a. Start NetObjccts Fusion. 

b. A New site d ia log box will appear on your screen . 

(Note: If the New Site dialog box did 110t appea1; select 

New Sitejivm the File pull-down me1111.) 

c. Type a name for your si te in the field labeled Site Name 

at the top of the New Site dialog box, and click on OK. 

The site name will serve as a fi le name, which is given 

an .NOD extension. The site name wi ll also be used as 

the sub folder name that stores the NOD file and the 

site's assets. (Note: See Chapter 3 for details 011 how to 

create a path to your pmject folder ifyou do not want 

your.file to be stored in the Net Objects Fusionjolde1:) 



Home page icon 

IEl 

1d,2a. 

New page button 

2b. 
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d. A NetObjects Fusion Site view will be displayed. (Note: 

The Site view will be where you create pages and a 

structure for your site.) 

e. (Option) Review Chapter 3 to learn about NetObject 

Fusion 's preferences and selecting a browser to preview 

your Web pages. 

2. Create Web pages and label them. 
a. In NetObjects Fusion's Site view, locate the New Page 

button at the top of the screen. Notice the Home Page 

icon is highlighted, indicating that it is selected. 

b. For the Slappers site, Frank created a preliminary splash 

page that contains a small GIF animation, a home page, 

and four pri ncipal branches named Who, How, Where, 

and Hot Links. The Mantus page, which branches from 

the Who page, is devoted to Frank's band. 

Follow Figure 2b to create these pages. (Note: Review 

Chapter 3 for details 0 11 how to create pages and label 

them.) 

3. Change views and add art to a page. 
The NetObjects Fusion Page view is the layout area where 

Web pages are created. 

a. Double-cl ick the Slappers page in the Site view to go to 

the Slappers Page view. 

-S~•n 

EJ 
I ...................... 

Y"rwt H~ ~'ft-. Htlli'U 

..L ....... 

3a. 
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Default page banner 

Default navigation buttons 

3e. 

3f. 
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b. NetObjccts Fusion's Page view will be displayed. 
Notice the screen contains a default page banner labeled 

Slappers. 

c. Select the Selection Tool. 

d. Use the Selection Tool to select the default page banner. 

Delete the default page banner by pressing the Delete 
key. Also, delete the default navigation buuons in the 
page footer. 

e. Use the Selection Tool to drag the page divider that sepa
rates the header from the body and move it up to make 
more room. Also, drag the page divider that separates 
the footer from the body and move it down. 

':tr-&..1-1 

f. Select the Picture Tool. 

g. Draw picture boxes on the Slappers page, as shown in 
Figure 3g. Import Frank's an into these boxes. (Note: 

Review Chapter 3.for details on how to import art into 
picture boxes.) 

Flle name: Slapper_logo.gif 

I 

3g. 



4a. 

4b. 

4e. 

4. Add text to a page. 
a. Select the Text Tool. 

b. Draw a text box, as shown in Figure 4b. 

c. Launch SimplcText. 

d. Open the text file named Welcome.txr in SimpleText. 

e. Copy the text, and paste it into the NetObjects Fusion 

text box, as shown in Figure 4e. 

f. Add boldfacing and center the text, as shown in Figure 

4f. (Note: Review Chapter 3 for details on how to ce/ller 

text and add boldfacing.) 

... ··:%~~ ·<:// 
........ 

Sirnp lo? T o?Xt 

4c. 

4f. 

welcome. btl 

We lc(lmo to lho 
Steppers home page . 

4d. 

File name:Welcome.txt 

Ji 
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First text box 
File name: Welcome.txt 

Second text box 
File name: the only place.txt 

First text box Second text box 

Third text box 
File name: textlinks.txt 
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g. Create a second text box, open a text fi le named tlte only 

place. txt in SimpleText, copy the text, and paste it into 

the NetObjccts Fusion text box. 

h. Center the text, as shown in Figure 4h. 

5. Lengthen the page. 
a. Click on the Layout tab in the Properties dialog box to 

select the Layout page. 

b. In the fie ld labeled Width, type: 

800 

In the ~ie ld labeled Height, type: 

800 

Press Return. 
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Sa, Sb. 

Layout tab 

c. The page wil l be lengthened, g iving you more space to 

create another text box. 

6. Add more text. 
a. Create a third text box, open a text file named text 

links. txt in SimpleText, copy the text, and paste it into 

the NetObjects Fusion text box. 

b. Insert a li ne break after the words Hot Links, and center 

the text, as shown in Figure 6b. (Note: Review Chapter 3 

for details about line breaks.) 
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7. Add a tiled background. 
Frank created embossed tiles in Photoshop using the instru

ment shapes he used to create the image map panel. He dupli

cated the ti les and added colors to match the page color 

schemes. 

a. Click on the Picture radio dial on the Layout page of the 

Properties dialog box. 

- l!!Ll (!)•··· 
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7a. 

Picture radio dial 

b. In the dialog box that follows, select the fi le named 

Purple_bkgrd.gif, and cl ick on Open. 

c. Your ti le will fi ll the back of the page in the Page view to 

form a wallpaper pattern. 
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8. Create an image map. 
a. Double-click the Picture Tool. 

b. A set of secondary Picture tools wi ll appear at the base 

of the Toolbox. 

c. Click to select the Rectangle Hotspot tool. 

d. Drag a rectangle over the drum set in Frank's image map 

panel. 

e. When you release the mouse button, a Link dialog box 

will be displayed. Type the name of the page you would 

like to link to in the field labeled Page Name, and click 

on Find. (Note: Review Chapter 3 for details on page 

finks, smart/inks, and external/inks.) 

&e. 

8d. 

f. A dialog box will appear wi th the message Successfully 

linked to Who Page. Click on OK. 

g. Repeat Steps Sa through 8f to create hotspot boxes 

around the remaining percussion icons in Frank's image 
map panel. A set of rectangles will be vis ible when you 

have completed d1e set of rectangular hOLspots. 



Before you design 
a form for your 
Web site ... 

Summary: Before you design a form, 

determine where the fo rm data will be 

sellt. 

1:--.. -r. .. ,_ 

- -t__ , ~ 

---------=-=-

Before you design a form for your Web site, develop a 

strategy for routing the data from the form to some 

destinatio n on the Internet. 

1. Options for routing data. 
a. A CGI script to route data to a text file. Several d iffer

ent types of COT scripts may be used to route the data 

that's entered on your form to some destination on the 

Internet. Many scripts write form data to a text file on the 

Web server. These scripts may be custom-written in 

computer languages such as Perl, Java, or C++. 

Alternatively, you may consider using a CGI script that 

exists in the public domain. For example, visit the 

Dreamcatchers site at http://dreamcatchersweb 

.com/scripts to download a form script. Most CGI scripts 

are created for Unix Web servers, and this strategy also 

assumes that you have access to the COl-BIN or the CGI 

folder on the Web server you're using. 

Contact your I ntemet service provider and inquire 

whether you have access to the server's COT directory. 

Access may be allowed to commercial account users and 

not users with personal accounts. 

b. A CGI script to route data to a database. If you run 

your own server or you rent from an ISP that is wil ling to 

aUow you to run software on the server, consider setting 

up a database soft ware program that wi II store the form 

data. For Macintosh users, FileMaker from Claris 

Corporation is an easy-to-use option. Everyware 

Development Corporation's Tango for FileMaker will 

create a CGI script to route form data from your Web 

page into FileMaker. (Note: Claris is planning to add 

increased Web.functionality to FileMaker in the next 

release. Watch .for this development.) 

c. MAILTO. Using a MAILTO command to route data 

allows you to avoid the use of a CGI script. Use the fol

lowing tags if you are creating your own HTML tags: 

<FORM t>I ETHOO•PO ST ACT!Oil• "I1AI L TO: 

your_e · mail@address.com"> 

<P> 
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Name <INPUT TYPE-" TEXT" NAHE- "NAME"> 

<P> 

Address <IUPUT TYPE- " TEXT" UAI1E- " ADDRESS"> 

<P> 

City <INPUT TYPE-"TEXT" IIAHE-" CITY"> 

<P> 

State <INPUT TYPE-" TEXT" NAI1E-" STATE"> 

<P> 

Zip <INPUT TY PE- "TEXT" NAI1E- " ZIP"> 

<P> 

Country <INPUT TYPE- "TEXT" NAHE-"CDUNTRY" > 

<P> 

E-mail <INPUT TYPE-" TEXT" IIAME- "EHAI L"> 

<P> 

<Itt PUT TYPE-"SUBHIT" VALUE- " SUBI11T FDR~I"> 

<P> 

<INPUT TY PE- " RESET" VALUE- " CLEAR FORM"> 

<!FORM> 

(Note: Format the form as a table to create even 

columns.) 

2. Examples of commerciaiiSP service in NYC. 
a. aJt.coffee. This Internet cafe in New York's East Vi llage 

is also an lmernet provider. Owner John Scott is lhe 

Webmaster and offers commercial Web accounts (no 

personal PPP accounts). lncluded in a commercial 

account is a private CGJ directory (CGT-BIN) where 

customers can place a CGT script. The alt.coffee 

commercial services include: 

Single Commercial Web Account: 

• S I 00 per month, $ 1 00 setup fee 

• I virtual domain (JP address on host machine) 

• I email account with multiple aliases ($ 1 0 each 

additional per momh) 



• 20 MB of storage space ($.50 each additional per 

month) 

• I FT'P account ($ 1 0 each additional per month) 

• I private CGI-BIN directory 

• 500MB of data transfer per monU1 ($. 1 0 each 

additional per month) 

• 1 monthly statistics report ($1 0 each additional per 

month) 

• Weekly tape backup 

• SSL secure server (must provide own cert ificate) 

• Full T I direct to Netcom 's T3 backbone 

• ISDN redundant backup line 

Developer 's Discount: 

• 4 Commercial Web accounts for $300 per month, 

$300 setup fee 

Conract: John Scott, 212.529.2233, 

jetsam @jlotsam. com 

b. The Internet Channel. The Internet Channel is one of 

New York's larger Internet providers, offering personal 

PPP accounts and commercial Web accounts. A small 

library of CGI scripts is avai lable to users with personal 

PPP accounts, but users cannot upload thei r own CGI 

scripts to the server. A commercial Web account does 

include a private CGI d irectory (CGI-BIN). Call for cur

rent prices. 

Con lac/: Beth Haviland, Director of Technical Support, 

2 I 2.243.5200, support@ inch. com 
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NetObjects Fusion 
to design a form 
{with a MAILTO for 
routing data) 
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Notsco e: Where 
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Foil ow this step-by-step sample if you have completed 
the previous section. Review basic Net Objects Fusion 

Web page creation techniques in Chapter 3 before starLing 
this section. Readers who wish Lo follow this example 
should look for Frank DeCrescenzo's art and text files on 
the companion CO-ROM. 

1. Change views. 
a. If you have completed Lhe previous sample, switch to Lhe 

Site view by clicking on the Site button. 

1a. 
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2a, 2b. 

b. In the Net Objects Fusion S ite view that fo llows, double

cl ick the Where page to go to the Where Page view. 

c. (Option) Alternately, you may select Go To from the Go 

pull-down menu. 

d. (Option) If you selected Go To from the Go pull-down 

menu, type Where in the fie ld labeled Go To, and c lick 

on OK. 

e. The Where Page view wi ll be d isplayed. 

lliew 

:,11 '" .. . , 
"'rull'411j~ :a.H11111t 
I'II'"ICU, I 'CIII,e 1"llfl 

f'CIIC"III •U• 
111\l UUICI ;)Jeuh 

lui X l 
llr(enl .~ X II 

1c. 

1e. 

' D ICI 

1d. 

2. Change the page size. 
a. Click in the Width field on the Layout page of the 

Properties d ialog box, and type: 

1066 

b. Click in the Height field on the Layout page of the 

Properties dialog box , and type: 

1066 
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3. Add art to the page. 
a. Select the Picture Tool. 

b. Draw picture boxes on the Web page, as shown in Figure 

3b. [mport Frank's art fi les into these boxes. 

File name: Silver _head.glf 

File name: Slappers_silver_button.gif 

File name: Where_lmagemap.gif 

4. Scale an image. 
The Slappers button needs to be scaled proportionately so 

that it is a smalle r buLLon. 

a. Because you have been working with picture boxes, the 

Picture page on the Properties dialog box should be 

selected. If it is not selected, click the Picture tab at the 

top of the dialog box to select the Picture page in the 

Properties dialog box. 

b. Click to select the Stretch radio dial. 

c. Hold down the Shift key and drag the lower-right 

handle on the Slappers button. Move your mouse up and 

to the left to scale the Slappers button. This wi ll create a 

smaller button. 



Sa. 
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Sd. 

File name: Where_intro.text 

6a. 

5. Add text. 
a. Select the Text Tool. 

b. Draw a text box, as shown in Figure 5b. 

c. Launch SimpleText. 

~ 
Simp leo TE-Xt 
Sc. 

d. Open a text fi le named Where_intro. text, copy the text, 

and paste it into the Net Objects Fusion text box, as 

shown in Figure 5d. 

e. Create a second text box, open a text file namedfields.txt 

in SimpleText, copy the text, and paste it into the 

NetObjects Fusion text box, as shown in Figure Se. 

Se. 
File name: flelds.txt 

6. Create single-line text fields. 
a. Double-cl ick the Form Tool. 
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b. A set o f secondary form tools wi II appear at the base of 

the Toolbox. 

c. Click to select the Single- line Form Tool. 

d. Draw a form text box, as shown in Figure 6d. (Note: 

6d. 

Although you' If need a long text box for this field, the 

length will need to be comroffedftvm the Properties dia

log box. ) 

J ' 

e. When you draw a single- line text fie ld, the Single Li ne 

page on the Prope1ties dialog box is displayed. Label 

each of the single-line text fields numerically. In the 

field labeled Name, type: 

1 

f. Drag-select the number in the field labeled Visible 

Length, and type: 

38 

Drag-select the the number in the field labeled Max 

Length , and type: 

38 

Press Re turn. 



&g. 

Tip: Use the arrow keys on your key

board to position a single-line text field. 

To align the fields, select the Selection 

Tool, drag a marquee around the fields, 

and select Align Elements/Left from the 

Page pull-down menu. 

7a. 
7b. 

7c. 

g. The length of the text box wi ll change in response to the 

new field length numbers you entered in the Properties 

dialog box. 

h. Repeat Steps 6a through 6e to create six more single

line text fields, as shown in Figure 6h. Label them 2, 3, 

4, 5, 6, and 7. 

Where can I get thom? 

6h. 

7. Create a Submit button. 
A Submit button functions to submit form data. Although 

Frank's fonn contains several more fields, the Submit button 

will be added here for the purpose of this example. 

a. Double-click the Form Tool. 

b. A set of secondary Form tools will appear at the base of 

the Toolbox. 

c. Select the Button tool. 

d. Draw a Button box. 

7d. 
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e. When you draw a button, the Button page on the 

Properties dialog box will be displayed. In the fie ld 

labeled Name, type: 

Submit 

f. Select the Text radio dial, and in the field next to the 

radio dial, type: 

Submit 

g. The button you create will contain the word Submit in 

response to your typing. (Note: You can use your own 

bull on image by selecting the Image radio dial, clicking 

on the Select button, and selecting an image from your 

hard drive.) 

~ Slll>mil 

• • 
7g. 

h. Select the Submi t radio dial. 

8. Create a Reset button. 
a. Double-cl ick the Form Tool. 

b. A set of secondary Form tools wi ll appear at the base of 

the Toolbox. 

c. Select the Button Tool. 

d. Draw a Button box. 

8d. 



Se, 8f,8h. 

9a. 

e. When you draw a button, the Button page on the 

Properties dialog box wi ll be displayed. In the field 

labeled Name, type: 

Reset 

f . Select the Text radio dial, and in the field next to the 

radio dial, type: 

Reset 

g. The button you create wi ll contain the word Reset in 

response to yourtyping. (Note: You can use your own 

button image by selecting t.he Image radio dial, clicking 

on the Select button, and selecting an image from your 

hard drive.) 

sg. 

h. Select the Reset radio dial. 

9. Assign a MAILTO action to the form. 
A NetObjects Fusion page can contain one form. You may 

have noticed a Form Settings option each time you accessed 

the Properties dialog box while you were build ing the form's 

fields. Even though you have access to the Settings option 

each time you build a field, you only need to fi ll it in once for 

the entire form. 

a. Select the first text field you created for your fonn. 
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484. , Chapter 12 

b. When you select any single-line text fie lds on your form, 

the Single Line page on the Properties dialog box will be 

displayed. 

c. Click on the Settings button. 

d. ln the Fonn Settings dialog box that follows, cl ick in the 

field labeled Action, and type: 

mailto :<your_emai l@address . com> 

Click on OK. 

hllll S• t 1 

9c. 

9d. 

10. Publish your site. 
Follow the directions for pub lishing a site in Chapter 3. 

11. Test your form. 
Your form will need to be tested online. Move your newly 

published pages to your Web site with the FrP client that is 

buil t into NetObjects Fusion or use Jim Matthews' Fe tch. 

Fetch is a Macintosh FTP shareware uti lity. (Note: For 

details on how 10 use Fetch, see Use Fetch to upload your 

files to a provider's server in the Client-Side Image Maps 

chapter.) 

Using a MAIL TO command to route form data provides a 

simple solution for designers who do not want to get 

involved with CGJ scripts. However, you'll find that the data 

that is mailed to an email address wi ll need to be cleaned up 

in a word processor (Figure II and following). 

l-Hary+Jo+Fahey&2-233+Lexington+Avenue+%23603&3-~ew+York& 

4-NY&5-10021&6-USA&7-mjfahey 
@inte rpor t .net&Submit• Submi t 
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30MF, 30-3 1, 35, 393 

A 
Active I ink, changing color of, 132 
ActiveX, I 
Adobe Illustrator. creating type in, 18 1-1 82 
Adobe Systems, OpenType initiative, 95, 99, 106, 

107, 11 3, 125 
Afterburner (software), 381, 390 
AJFF files, 307,322, 326 
Alawusa, Peju, 69, 72, 88 
alt .coffee commercial service, 474-475 
alt.coffee Web site, 54-68 
Amendola, Billy, 463, 464 
America Online, 195 
Anchors, 31, 35, 40, 52, 60, 66,283, 323 
Animation. 337-390 

nip-book animation, 349-354 
games, 34 1 
GIFanimation, 337,339-340, 349-363 
interactive, 34 1, 364-380 
loops, 356, 377-378 
reducing fi le size, 340, 360-363 
Shockwave, 337,341-348,38 1 

Antiochia, Antonio, 303 
Apple Computer 

PC enabling hardware, 5 
VRML. 393 

Applets, 35 
Arizona Macintosh Users Group, 37 
The Arrival Web site, 342 
Arrows, 39 
Art. See Graphics, Images. 
Associative indexing, 34 
Audio. See Sound. 
Audio streaming, 322 
AU Iiles, 299, 302, 307, 322, 326, 336 

AVT Iiles, 294-298 

B 
Background , 133 
colo~63, 10 1, 109- 110, 203,213,260 
fading an image into the browser background, 

202-203 
full-bleed images, 13, 206 
HTML coding, 13, 45-5 1, 136, 166,208-21 I, 

278-273, 314, 3 17 
Internet Explorer style sheet, 10 I 
in Netscape, 45, 133-1 35,202-212 
samples, 133- 135 
sound, 3 13-323 
tiled, 204-206, 383-386,471 

Back Web (software), 9 
Banding, GIF images, 158- 159 
Banner graphics, 178-1 87 
BBS Color Editor. See Online Color Editor. 
Beach, David, 305 
Ben & Jerry's Hair Game, 343, 344 
Berners-Lee, Tim, 33 
Best Business Solutions (BBS), 127, 129 
Biggar, Jamie, 34 1 
BIN fi les, 145 
Bin-Hex format, 19 
Bitdepth, 15 1, 155, 157, 182, 185-186, 217-21 8 
B lackSun International 

CyberHub, 30, 396 
virtual scavenger hunt, 63 

Blender (digizine), 347 
Bookmarks, 307 
Borders, 39 
Borenzweig, Claude, 347 
Browsers 

30, 27, 35, 243 
cascading style sheets, 95 
client-side image maps, 253 
color paleue, 157, 179 
Fetch, 36, 94, 243, 262-264, 484 
image quality on, 153- 154 
Internet Explorer, 95 
NetObjects Fus ion Web page preview, 75, 90-92 
offl ine browsers, I, 9 
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style sheets, 98 
for VRML fi les, 452-453 

Build Your Own Bug (game), 344 
Bush, Vannevar, 34 
Buttons 

animated, 342 
borders, 39 
cropping graphics, 42-44 
HTML rable to hold, 42-53 
interactive movies, 344 
Lingo buttons, 374-377 
outline turned off, 14 
Reset butlon, 482-483 
Submit button, 481 -482 

c 
Cameron, Ewan, 99 
Capuozzo, Chris, 347 
Cascading style sheets (CSS I), 95, 98 
Castle Red Dog Web site, 313-3 16 
CO-ROMs, 7-8 
CGI script, 46 1, 473,474 
Character entities, 163 
Chat, 8, 3 1, 396, 397, 400-40 I 
Chen, Eric, 282 
Chowka, Peter B., 95, 97,46 1 
Cicada Web Development, 397 
Cinepak (software), 277 
Cipolla, Tom, 299, 324, 325, 333 
ClarisWorks (software), 20 I 
Classes, in HTML tags, I 03 
Clayton, Damien, 347 
Clemens, Michael, 303 
Client-side image maps, 239, 242 

components, 242-243 
creating, 24 1-257, 466-473 
planning, 244-247 

Clip media, sound effects, 324-325,327-329 
clnet, Shareware.com site, 144 
Color 

background, 63, I 0 l , 109-1 I 0, 203, 2 13, 260 
di thering, 15 1-152 
offont, 101 , 122- 123 
grayscale, 152 
images, 150, 151 , 157, 179- 18 1 
r nternet Explorer style sheet, I 0 I 
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movies, 284-292, 38 1-382 
Super Palette, 236-238, 284-292 
text, 63 
text links, 39 

Color codes 
adding, 129- 136 
hex code for, 127, 129- 131 
Pantonecolor, 129, 130 
RGB color, 123, 129-136 

Color duotone, 152, 232-234 
Comment tags, to embed style sheet, 99, 105-108 
Compression. See File compression. 
CompuServe, G[F file format patent, 16 1 
Coney Island Project Web site, 406-4 17 
Confcrencing software, 309 
CoolTalk (Apple), 308,309 
Cosmo browser, 452 
CSS li le, I 00 
Cunniff, Tom, 303 
CU-SceMe (software), 309 
CyberCash CyberCoin Wallet (soft ware), 397-398 
CyberHub (BlackSun Interactive), 30 

D 
Data, forms and, 46 1, 465,473-475 
Data fork. 293 
Data transfer, video, 274-275 
DeBabelizer (Equilibrium Technologies), 284 

bit depth, ISO 
number of colors, 156 
pixel depth, 186 
Super Palette, 147, 157,236-238,284-282 
text offset, 170, 192, 193 
transparent GIF, 197, 207, 2 19 

DeBabelizer Lite (Equilibrium Technologies), 
159 

Decompression, of shareware from the Web, 145 
DeCrescenzo, Frank, 53, 69, 46 1, 476 
Dellario, Frank, 402 
Dessimoz, Gail , 346 
DigiPhone (Eiecu-ic Magic), 308 
Digital media, 347 
Digital versat ile disc (DVD), 347 
Director (Macromedia) , 337, 38 1 
Director lnternet Player (Macromedia), 32, 35, 

38 1-390 



Director Player (Macromeclia), 364-380 
Disguise-0-Rama game, 343-344 
Dithering, 151- 152 
Domain names, 36-37 
Domain Name Service (DNS), 36 
Dominianni, Matt, 402 
Download speed, 153, 157-158 
Drop shadow, 14 7, 213-220 
Duhan, Matt, 402 
Duotones, 152, 232-235 
DVD,347 
D Web site, 346 

E 
Eberhardt, Curti s, 338,339-341 ,346,364-366 
Elbert, Mark, 147, 175, 178, 188,202 
Email addresses 

Alawusa, Peju, 69 
Apple Developer's Association, 345 
Chowka, Peter B., 95 
Cipolla, Tom, 249, 299 
DeCrescenzo, Frank, 461 
Dominianni , Matt, 402 
Eberhardt, Curtis, 337, 346 
Elbert, Mark, 142 
Esparza, Mary, 27, 29 
Greenbaum, Jane, 147 
Haviland, Beth, 475 
Hess, Greg, 299 
Hughes, Kevin, 241 
Kingsley, Chris, 344 
Marino, Paul, 402 
McGrew, Steven, 265 
Neuwirth, Pauline, 343-344 
Reinfurt, David, I 
Santos, Kleber, 239 
Scott, John L., 27.475 
Shamson, Alex, 39 1, 393 
Tekserve, 6 
Thorner, Marc, 265, 406 

Embedded fonts, 95, 125 
Embedded style sheet, 99, I 02 
Empyrean (game), 30,41 
The Engine.RDA, 346-347 
Environmental designers, 11 
EPS file, 18 1 
Esparza, Guillermo, 29, 31 

Esparza, Merry, 27, 29, 31, 32, 39,41 
Event handlers (script), 377 
Express VR browser, 452 
External images, 158 
External links, NetObjects Fusion, 87 

F 
Fetch (software), 36, 94, 243, 262-264,484 
File compression 

audio, 295-296 
formats, 145 
GJF fi les, 157- 160 
GIF patent, I 61 
JPEG files, 157- 160, 161 
movies, 38 1, 390 
video,267,276-277, 295-296 

File compression algorithms, JPEG, 159 
File compression formats, 145 
File conversion, sound fi les, 326, 336 
FileMaker (Ciaris), 473 
Filo, David, 127, 137 
FLAT files, 293 
FlattenMooV (software), 293 
Flowcharting, 4 1 
Fonts. See also Typography. 

boldface, 163 
changing in a headline, 116-1 17 
color, 10 I , 122- 123 
embedded fonts, 95, 125 
family, 100, 122- 123 
HTML,63,67 
Internet Explorer style sheet, I 00 
italic, 163 
OpenType initiative,95,97,99, 106, 107, 11 3, 

125 
style sheets, 99 
TrueType fonts, 102, 105, 108-112, 124- 125 
underline, 163 

Forn1s, 46 L 
client-side image map, 466-472 
data and, 461, 465,473-475 
designing, 467-484 
MAIL TO URL, 46 1, 473-474, 483-484 
Reset button, 482-483 
Submit button, 481-482 

Frame layout, 54-68 
Freeloader (software), 9 
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Frequency, 296 
Fruchter, Jason, 348 
Fry, David, 303 
FrP, 36 
Full bleed images, 13, 206 

G 
Games, 30, 34 1, 343-344, 348 
General Motor's Product Line Web page, 345 
Ghosting image, 204 
GTF animation, 337, 339-340,349-363 
GlFBuilder (software), 339, 340, 349, 355-357 
GIFConverter (software), 186 
GIFfiles,3 1, 157-16 1, 198 

download speed, 157- 158 
interlaced GIF, 158- 16 1, 186, 2 18 
reducing size, 360 
transparent GIF, 158- 16 1, 258-26 1 

GTFimages, 158-159,247 
animation, 337, 339-340,349-363 
banding, 158- 159 
di rect01y for, 190, 359 
linking to, 188- 191 , 278 
NetObjects Fusion software, 80 
posterization, 160 
transparent GIF, 207 

GJF Wizard (software), 340, 360-363 
Giles, Aaron, 192 
Gontier, Frederic, 396 
Gottlieb, Sam, 377 
Graphics, 147-238. See also Buttons, Images. 

animation, 337-390 
aJTOWS, 39 
banner graphics, 178- 187 
color duotone, 232-235 
drop shadow, 147,2 13-23 1 
fading an image into the browser background, 

202 
linking thumbnail GTF to external JPEG, 

188- 191 
silhouettes, 207-2 12 
tiled background, 204-206, 383-386, 47 1 
uploading fi le to server, 263 
VRML, 39 1-460 
wrapping text around a photo, 192- 197 

Grayscale, 152 
Green, Andrew, 308 
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Greenbaum, Jane, 147,221 
Grouped formatting, text, J 02- 103 

H 
Hale, Tom, 8 
Hapke, Matt, 402 
Haviland, Beth, 475 
Hennessey, Patrick, 293 
Hess. Greg, 299, 3 13 
Hexadecimal codes, for color, 39, 123, 127, 129-

13 1 
Hill , John, 347 
Histograms, Photoshop, ISO 
Home page, 33, 35 
HotJava, 35 
Hotspots, 31 , 35, 239, 24 1 
.HTM extension, 190 
HTML. See also HTML attributes, HTML 

documents, HTML tags. 
acronym, 162 
creating 20 navigation contm ls with, 39 
locating images on Web page, 165- 177 
NetObjects Fusion and, 69, 88 
Netscape Navigator reference material, 140-14 1 
typographic controls, 47 
updates posted to Netscape, 153 
World Wide Web Consortium, 95 

HTML attributes 
align=, 14, 64, 169, 173- 175, 177, 192, 195, 197 
alink=, 6 1, 132, 133, 136,3 14,3 17 
alt=, 60, 6 1 , 62 
area=, 250-254 
au top lay=, 271, 272 
autostart=, 3 13, 3 17 
background=, 13,45-5 1, 136, 166, 208-2 11, 

278-283, 3 14, 3 17 
base=, 60 
base target=, 64, 66, 67 
bgcolor=,60-64, 67, 120, 123, 129, 131, 

133- 136,248-254,255,272,314,3 17, 460 
border=, 49-5 1, 60, 62, 249 
color=, l 22- 123 
cols=, 56, 58, 68, 120, 257 
controller=, 270, 272 
coords=, 250-254, 257 
face=, 122- I 23 
height=, 32 1 



hidden, 313,317 
href=,39,47-5 1,60, 6 1.,64,67, 123, 190, 19 1, 

250-254, 28 1' 318, 32 1-323 
hspace=, 165, 170-171 , 177, 198- 199 
link=, 132, 133, 136,314,317 
loop=,270,272,314,3 17 
marginheight=. 57, 58 
marginwidth=, 57, 58,67 
method=, 473 
name=, 57, 58, 250-254,256-257 
noresize=, 57 , 58 
rows=, 56 
scroll=, 57, 58 
shape=,250-254,257 
size=, 163, 173, 196,200 
src=,46-51 ,57,60,62,64,68, 11 3, 167,177, 

187, 191, 199-200,208-212,249-254,256, 
3 13.3 17, 320, 460 

style=, 101-104, 114 
target=, 57, 60, 6 1 · 
text=, 13 1, 136,314,3 17 
type=, 102-104, 474 
usemap=, 249 
vlink=, 60, 6 1, 132, 133, 136,3 14,3 17 
volume=, 313-314,3 17 
vspace=, 171, 175, 198-1 99 
width=, 48-5 1,321 

HTML documents 
borders, 39 
buttons, 14, 39, 42-44 
client-side image map, 242-257 
column format, 11 9- 121 
comment lines, 196 
completing, 59 
creating,45,59-60, LOS, 166, 187, 189, 194, 198 
ending link tag, 39, 164 
fading an image into browser background, 

202-203 
GIF animation testing, 360-36 1 
linking thumbnail GIF to exernal JPEG, 188-191 
link text, 38-39 
margins, 97, 100 
paragraph, 168 
style block, 105-107, 108- 109 
style sheets, 98-102 
styling, 98- 11 8 
subheads,68, 102, 104 
table for buttons and text links, 42-53 

text wrap, 198-200 
type size, 195- 196 
typography,98- 103, 162 
VRML window, 458-460 
wrapping text around a photo, 192-197 

HTMLfiles, 19, 187, 190 
cross-platform, 8 
save as SimpleText, 45, 55, 62, 63, 66, 105, 1 14 
testing an image, 187 
uploading to server, 262-264 
viewed onli ne or offline, 7 

HTML tags, 34, 162, 163 
<A>, 39-40. 52, 60-61 , 67. 123, 189, 282, 3 18, 

322,323 
<ADDRESS>, 52, 254 
<AMG>, 195, 197 
<AREA>, 250-254 
<B>, 163, 176,255, 272, 282,283 
<BASE>, 57 
<BLOCKQUOTE>, 97, 100, 171 -172, 176 
<BODY>, 13, 39, 45-5 1, 52, 6 1-64, 66, 67, 

103-104, 120,123, 129,1 31, 133-136, 163, 
166, 176,187, 189, 198-201,208-212, 
248-256,272,278-283,3 14,315,3 17, 
458-460 

<BR>, 50-52, 6 1,62,67, 104, L 13, 123, 163, 
172, 175,176,255,280-283 

<CENTER>, 60, 61 , 163, 172, 248-254, 256, 
270,272,3 17, 459, 460 

<DL>, 97, 169-170, 17 1, 176,209,278-283, 
3 19-321, 323 

<EMBED>, 268-272, 3 13-314, 3 L 7, 458-461 
<FONT>, 63, 67, 95, 122- 123, 163, 173, 176, 

196, 198-200, 200 
<FONTFACE>, 99 
<FORM>, 473-474 
<FRAME>, 55, 57, 67 
<FRAMESET>, 55-56, 58, 68 
<H I>, 11 3, 120, 123, 195 
<H2>,68, 102, 104, 11 3, 120, 195, 196, 

198-200, 209-211 
<H3>, 68, I 02, I 04, 198-200, 211 
<l-16>, 195 
<HEAD>, 45-51 , 52, 56, 58, 60-64, 68, 

105- 106, 120, 123, 133-136, 176, 187, 189, 
198-200, 208-2 1 I, 248-254, 256, 272, 
278-283, 3 17. 3 19-32 1, 323, 458-460 

<HR>, 51,52 
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<1-JTML>, 45-5 1, 52, 56, 58-63, 68, I 05-106, 
120, 123, 133- 136, 176, 187, 189, 198-200, 
208-211 , 248-254, 256, 272, 278-283,3 17, 
3 19-32 1, 323,458-460 

<I>, 163, 32 1, 323 
<IMG>, 14, 39,46-5 1,53,60, 6 1, 64, 11 3, 135, 

167, 169, 177, 187, 188, 195, 197, 198-201, 
208-2 11 ' 249-254,256,278-283, 317, 318, 
320-323, 358, 399 

<INPUT>, 474 
<MA fLTO>, 254, 256.473-474 
<MAP>, 250-254, 256-257 
<MULTJCOL>, 95, 11 9- 12 1 
<NOBR>, 163 
<NOFRAMES>, 55, 58, 68 
<P>,68. 104, 163, 168, 175,177, 198- 199, 201, 

281 
<PRE>, 154, 164 
<STYLE>, 102- 104, 106- 111 
<TABLE>, 46-51 , 53 
<TD>,47,53 
<TH>, 47-5 1, 53 
<TITLE>, 45-5 1, 53, 56, 58, 60, 6 1, 63, 64, 68, 

105- 106, 120, 123, 133- 136, 177, 187, 189, 
20 I, 208-2 10, 208-2 1 I, 2 12, 248-254, 256, 
257,272,278-283,317,458-460 

<TR>, 46-5 1, 53 
<U>, 163 
with classes, I 03 
nesting, 164. 319-320 
NetObjects Fusion and, 69, 88 
Quark XPress tags compared to, 162, 163 
special characters, 163, 196 
start ing and ending tags, 164 
viewing on a Web site, 3 18 

HTTP,36 
Hughes, Kevin, 24 1 
Hybrid CD-ROM, 8 
HyperCard, 34 
Hyperlinking, 27, 33,40 
Hypermedia, 33-34 

I 
Image maps, 32,239,465. See also Client-side 

image maps. 
Images, 147 

animation, 337-390 

490. j lnde.x: 

bitdepth, 15 1, 155, 157, 182, 185- 186 
color, 150, 157, 179-18 1 
color duotone, 232-235 
dithering, 15 1-152 
download speed, 153 
drop shadow, 147,2 13-231 
duotones, 152,232-235 
external images, 158 
fading an image into browser background, 

202-203 
file format, 158-161, 186 
file naming, 152- 153 
fi le size, 150, 156 
full bleed images, 13 
ghosting, 204 
GIFiiles, 157-16 1 
grayscale, I 52 
inl ine images, 158 
JPEG Iiles, 157- 16 1 
linking thumbnail GIF to external JPEG, 

I 88- 191 
locating on Web pages, 165-177 
resizing, 411 
scaling, 478 
scanning, 150, 179 
silhouettes, 207-2 12 
size of, 149, 155- 156, 178 
wrapping text around a photo, 192-197 

Images GIF, 158-159 
Inflat ion distance, 420 
InUne graphics links, 27, 39 
Tnline images, 158 
Inlinestyletags,99, 101, I 15 
Insignia Solutions, Win95 emulation program, 6 
Interactive movie, 364-380 
Interlaced GIF, 158- 16 1, 186,218 
Internet Assistant (Microsoft), 209 
Internet Channel, 475 
Internet Explorer (Microsoft), 95 

client-side image maps, 253 
1-JTML tags specific for, 158 
style sheets, 95, 97, 99- 1 0 I 

Internet Phone (Vocaltec), 3 1 
Internet Protocol (Microsoft), 35 
Internet service providers (TSPs), 474-475 
Internet telephone, 3 I , 308 
InterNJC, 36-37 
Inverted perspective, 30 



IUMA site, 305-306 

J 
Joseph, Regina, 347 
JPEG,31, 157-160,161 

downloading, 342 
images, 159, 190, 247, 342 
linking thumbnail GIF toJPEG file, 188- J 91 
saving, 159 

K 
Keenan, Rob, 347 
Keyboard Magazine Web site, 322 
KPT Bryce (software), 364 

L 
Lerner, David, 6 
Linear perspective, 30 
Linear slide shows, 37-38 
Line-height, Internet Explorer style sheet, I 0 I 
Lingo (software), 365, 373-377 
Linked style sheet, 99 
Linking. See Hyper! inking. 
Links 

to movie, 278-282 
to sound files, 318-323 

Link text, 38-39 
Live3D (software), 402, 405, 456-467 
LiveAudio, Netscape, 299. 302, 3 10, 313 
Livescript (software), 342 
Long distance calling, 31, 308 
Loops, animation, 356, 377-378 
Lord, Robert, 305 
LZW patent, 16 I 

M 
Mac, PC cards for, 5-6 
Mac Binary fi le, 145,263 
MacLink!Plus (Dataviz), 208 
Macromedia, 30, 32 
Macromedia Directory Lingo Workshop 

(Thompson and Gottlieb), 377 
MAlLTO URL, 52,64 

forms, 461,473-474, 483-484 

HTML tags, 254,256 
Marelli , Charles, 30 I 
Margins, 97, 100, 10 1 
Marino, Paul, 402 
Markowitz, Gary, 34 1 
Marr, Greg, I 51 , 284, 290 
Matthews, Jim, 36,484 
McGrew, Charles, 307 
McGrew, Steven, 265, 276 
Memex system, 34 
MetaPiay Web site, 402 
Microsoft 

browser "war" with Netscape, 1 
Open Type initiative, 95, 99, I 06, I 07, 113, 125 
TrueType fonts, I 02, I 05, I 08-112, 124- 125 

MIDI files. 3 I 0, 322 
acronym, 3 10 
for downloading, 3 17 

Milktruck (Traveling Software), 9 
Mitchell , Kevin, 186 
Mobius Gallery s ite, 29-32,42 
Molcha n, Rob, 347 
Mom 's Truck Stop Web s ite, 402-405 
Moos, 402, 405 
Mona! Kombat (game), 346 
Mosaic (Spyglass), client-side image map, 253 
Motion Picture Experts Group. See MPEG. 
Movie Analysis Tool (Adobe Premiere), 265, 

273-275 
Movies 

animation, 345-348, 364-380 
characteristics, 274-275 
color, 284-292, 38 1-382 
create a movie projector, 379-38 I 
performance specs, 273-274 
photography, 267-298 
video compressor, 292 

MP2 1iles, 305, 322 
MPEG files, 269,277,305 
MUDs (multiuser domains), 402 
Multi-party conferencing, 309 
Music. See also Sound . 

clip music mixed wi th sound effects, 327 
downloading on Netscape, 3 11 -3 12 
interesting links, 322-323 
MTDI files, 3 10 
royalty-free, 327 
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N 
Navigation, 27-68 

2D, 27, 34-35, 37-39 
3D, 27,30-32, 35,40 
buttons, HTML table to hold, 42-53 
flowcharting, 4 1 
frame layout, 54-68 
hypermedia, 33-34 
image maps, 32 
interactive movies, 374 
storyboarding, 41 
text links, HTML table to hold, 42-53 
URLs, 35-37 
VRML file, 453 

Nelson, Ted, 34 
Nesting tags, 164, 3 19-320 
Net Attache Light (Tympani Software), 9 
Net Objects Fusion (software), 69, 7 1, 2 10, 466 

<MULTTCOL> tag, 95, I 19- 12 1 
creating client-side image map, 466-473 
creating Web pages with, 76-88 
design a form, 476-484 
hardware and software requirements, 7 1 
HTML and, 69, 88 
publishing the site, 92-94 
selecting browser for, 75 
staging the site, 88-90 
starting, 72-75 
testing the site, 90-9 1 

NetPhone, 308 
Netscape, 307 

background, 45, 202-2 12 
background samples, 133- 135 
bookmark, 307 
browser " war" with Microsoft, I 
cl ient-side image map, 253 
Director Internet Player and, 38 1 
HTML tags viewed, 3 18 
HTML updates posted, 153 
images, 149 
LivcAudio, 299, 302, 3 10, 3 13 
music files, 3 11 -3 12 
text wrap, 198-200 
ti ps, 13, 14 
using, 305 

Netscape features 
active link, 39 
Body Background tag, 45 
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inline images as links, 39 
link text, 38-39 
tables, 42 
visited link, 39 

Netscape Navigator, 140- 141 
HTML tags specific for, 158 
style sheets, 95, 97, 99 

Network anchors. See Anchors. 
Neuwirth, Pauline, 343 
Node pointers, 40 
NOD files, 73 
Number entities, 163 
NYVRMLSIG, 6 1,395,396, 406,408 

0 
O'Donnell , Dan, 396-397 
O' Donnell , Matt, 396-397 
Offl ine browsers, I , 9 
Online Color Editor (BBS), 122, 123, 129- 136, 

458 
Online publications, 3 
OpenType initiative, 95, 99, 106, 107, 11 3, 125 
Optical illusion art, 30 
Orange Micro, PC enabling hardware, 5-6 
Ostroy, Alex, 347 

p 
Page links, NetObjects Fusion software, 87 
Painter 4.0, drop shadow, 147, 22 1-23 1 
Pantonecolor,39, 129, 130 
Paradigm, for Web site, 17 
Patterson, Jeff, 305 
Pauling, Linus, 95, 97- 100 
PC cards, for Macs, 5-6 
Pesce, Mark, 39 1, 393, 406 
Phone links, 3 1, 308 
PhotoGIF (BoxTop Software), 193, 258, 26 1 
Photographs. See [mages. 
Photoshop (so ftware), 364,409 

animation, 337, 339 
banner graphics, 178-185 
blue duotone with, 232-235 
color codes, 129- 130 
cropping button graphics, 42-44 
drop shadow, 2 13-220, 225 
GIF animation, 349-354 



gradient tool, 202 
histograms, 150 
image quality, 150 
Info palette, 244 
palettes, 15 1, 244 
PICT image, 178 
pixel depth, 217-2 18 
saving image, 188 
text offset, 170, 192- 193 
text wrap, 192- 197, 198 
ti led background, 47 1 
transparent GIF, 258 
wrapping tex t around photo, 192-197 

Piguet, Yves, 339, 355 
Pixels, 149, 155 
Planning Web pages, 26 

concept development, 17 
development team, 16- I 7 
flowchart ing, 4 1 
graphic design, 2 1 
Reuters Web site as model, I I -15, 23-25 
schematic development, 18-19 
schematic prototype, 20-21 
story boarding, 4 1 
wayfinding, I I , 22-25 

Plug- ins, 140, 265, 269-27 1 
Posterization, 160 
Print publications, 3 

augmented by CO-ROMs, 7-8 
PC Novice, 3 
T!te Net, 3, 7-8 
Web Techniques, 3 
Webweek, 3 

Pueblo (Chaco), 402-404 

Q 
Quark XPress (software), 162- 163, 165 
QuickTime (Apple), 277,297 

files, 293, 294-296 
plug-ins, 265, 269-271 

QuickTime VR (Apple), 31-32,40,282,345 
QuickTime VR Player, 345 

R 
Racz, Michael, 346 
RA Ii les, 322 

Ragu Web site, 303 
Rasterized type, 182 
Razorsnails (game), 348 
Real Audio (Progressive Technologies), 304, 322 
Realtime voice communication, 31 
Redlitz, Sean, 34 1 
Redundancy, in waylinding, 25 
Reflector (software), 309 
Reinfurt, David, I , I 1-12 
Reply Corp., PC cards, 6 
Resampling, sound files, 333-335 
Resource fork, 293, 297 
Reuters 

Business Alert, 13 
Business Briefing, 13 
Business Information Products site, 13- 15, 17, 

19,23,25 
News Machine site, 12- 13, 17- 19, 23-25 

RGB color, 123, 129- 136, 151 
Ricci, Albe1to, 299, 328, 330 
Rosenthal, Larry, 6 1, 62, 65, 348,396, 397, 406, 

408 
Rubber bands, 40 

s 
Santos, Kleber, 239, 24 1 
Scaling, images, 4 78 
Scanning, 150, 179 
Schematic prototype, 20-21 
SciFi Channel Web site, 34 1 
Scon, John L., 27, 54, 55 , 474,475 
Search engines, 127 

extending the search beyond Yahoo!, 139 
Yahoo!, 127, 137- 139 

Selamohlu, Handan, 98-99 
Selck, Brandee Amber, 305 
Shaders, 364 
Shah, Vineel, 347 
Shamson, Alex, 64, 39 1, 406, 4 18, 423, 438, 452, 

456, 457 
Shareware, 144- 145 
Shockwave (software), 337, 34 1-348.38 1 
Silhouettes, 207-220 
SimpleText, 45, 55,62,63,66, 105, 11 4, 166, 177, 

194,208,243 
Simprov, 402-405 
Site Mill (Adobe), 10 
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Slappers, 53 
Slappers Web site, 463-465 
Smart links, NetObjects Fusion, 87 
Smith, David, 391 
Smith, Derrick, 53 
Smith, Sharleen, 34 1 
SoftWindows (Insignia), 6 
Sound 

background sound, 3 13-323 
clip media, 324-326, 327-329 
data rate, 275 
file conversion, 326, 336 
file formats, 322 
file optimization, 333 
Internet telephone, 31 , 308-309 
links to, 318-323 
MIDI files, 3JO 
recording and mixing, 330-332 
resampling and downsampling, 333-335 
sample Web sites, 30 1-307 
streaming, 322 
video conferencing, 309 

SoundApp (software), 303, 326, 336 
SoundEd it (software), 303 
SoundEffects (software), 299, 324,327-332 
Sound files, 322 

compression, 295-296 
optimization, 333 
resampling, 333-335 

SoundMachine (software), 325 
Sound Maker (software), 335 
Spatial problem solving, in wayfinding, 23 
Special characters, 163, 196 
Spike Lee's Web site, 4 
Splash screen, 30, 178 
Starbase C3 Web site, 396-40 I 
Storyboarding, 41 
Strata Studio (software), 365 
Strata Studio Pro (software), 3 1, 367 
Streaming audio, 304, 322 
Streaming video, 265, 267-268 
Stufflt Expander (software), 145 
Style sheets 

adding style sheet properties to a tag, lO l-102 
comment tag, 99, I 05-108 
defined, 98 
embedded, 99, 102 
FAQ, 98-100 
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fonts, 99 
inlinestyletags,99, 101,115 
Internet Explorer, 95, 97, 99-10 I 
linked, 99 
Netscape Navigator, 95, 97,99 
properties, I 00-101 
W3C proposal, 95, 98, 107 

Sumex-Aim mirror sites 
ftp://ftp.amug.org/pub/mirrors/info-mac, 37 
ftp://mirror.apple.com/mirrors/ 

lnfo-Mac.Archive/, 36 
gopher;//gopher.cnuce.cnr.it/ J I /pub/info-mac, 

36 
http://mirror.apple.com, 36 

Surfbot 3.0 (Surllogic LLC), 9 

T 
Tables, formatting form as, 474 
Tango for FileMaker (Everyware Development), 

473 
Tekserve, 6 
Telephone links, 31,308 
Text 

adding to Web page, 469,479 
in client-side image maps, 253-254 
color, 63 
formatting in columns, 119- 12 1 
grouped formatting, I 02-103 
Internet Explorer style sheet properties, J 00- 10 I 
styling, 98- 11 8 
wrapping text around a photo, 192-197 

Text links, 27,38-39 
color, 39 
HTML table to hold, 42-53 
NetObjects Fusion software, 85-88 

Text offset, 170, 192-193 
Text processor, 243 
Text wrap, J 98-200 
Theurer, David, 284 
Thompson, John (J.T.), 377 
Thorner, Marc, 265, 396,406 
tHUNK, 6 1, 348 
tHUNKWORLD VRML, 65 
Tiled background, 204-206, 383-386,471 
Transparency (software), 192, J 93, 207, 218 
Transparent GfF, 158-161 , 197,207, 258-261 
Traveling Software, Milktmck, 9 



True Type fonts, I 02, I 05, I 08- 112, J 24-125 
TrueType Open Version 2, I 06 
Two-dimensional HTML. 34-35 
Two Twelve Associates, I I 
Typography. See also Fonts. 

adding to Web pages, I 03 
HTML font sizes, 195. 196 
rasterized. 182 
style sheets. 98- 102 

True Type fonts, I 02, I 05, I 08- 11 2, 124-125 

u 
Unisys, 16 1 
URL, 133 

delined,35 
directory and tile name information, 37 
domain name information, 36-37 
function, 35,40 
protocol in formation, 35-36 
replacing file name in Netscape URL field, 134 
submitting to Yahoo!, 142- 143 

URLs 
ftp://flp.amug.org/pub/mirrors/info-mac, 37 
ftp:// ftp.m i crosoft.com/devel opr/d rg/truetype, 

11 2 
http://cu-secme.edu/#GET, 309 
http://d reamcatchersweb.com/scripts, 473 
http://goliath. wpine.com/cu-seeme.html, 309 
http://home.netscape.com/assistlnet_sites/ 

bg/backgrounds.hrml, 133, 135 
http://home.netscapc.com/comprod/ 

mi rror/index.html, 302 
http://horne.netscapc.com/cornprod/ 

products/navigato r/version_2.0/plugins/ 
audio-video.html, 304 

http://home.netscape.com/comprod/ 
products/navigator/version_3.0/ 
communication/cooltalk/index.html. 309 

hup://i n fo. fuw.edu. pl/mul t i media/ 
sounds/animals, 324 

http://mansion. Lhepalace.corn/cgi-bi n/ 
directory.pl, 3 13 

http://members.aol.com/alawusa/intro.html, 69, 
88 

http://members.aol.comlflatsticks/splash.htrnl, 
46 1 

http://rnembers.aol.com/iforward/imagcl.htrnl. 
147 

http://members.aol.com/mediumcool, 95, 98 
http://qtvr.qu ickti me.apple.com/arch i vc/ 

index.htmJ, 345 
http://uccni tk.edu.tw/htrnl.courses/colorEditor 

.html, 458 
http://www.acclaimnation.com/D, 346 
http://www.adobe.corn, I 0 
http://www.altavista.d ig itaJ.com, 458 
http://www.altdotcoffee.com, 27 
http://www.backweb.com, 9 
http://www.bbsinc.com, J 23 
http://www.bbsinc.cornlbbs-

cgi-bin/colorEditor.egi, 129 
http://www.benjerry.com/fun/bj-hairy.html, 344 
http://w.,vw.blackamericaonline.com/ 

bus/index.htm l, 4 
http://www.blacksun.com, 30 
http://www.ceLObjects.com, 210 
http://www.chaco.com, 403 
http://www.claris.com/products/claris/ 

clarispagc20/clarispage20.html), 20 I 
http://www.cube3.com/downJoads/ 

NYVRMLSIG, 408 
http://www.cube3.com/starbase.htm, 396 
http://www.cybcrcash.com, 397, 398 
http://www.datav iz.com, 9 
http://www.dataviz.com/Upgrade/upgmlp_ 

home.htm l, 208 
http://www.eat.com/index.html. 303 
http://www.eeb.tue.nl/midi/index.html, 299, 3 10 
http://www.emagic.com, 3 1, 308 
http://www.equil.com., 155 
http://www.ffg.com, 9 
http://www. fi rst floor.com , 9 
http://www.FOOTAGE.net:2900, 267,269,284 
http://www.freeloader.com, 9 
http://www.geoci ties.cornl-thecastlc, 3 13 
http://www.gm.com/shockwav/spin/eaOO.htm, 

345 
http://www.hotwired.com, 239 
http://www.incontexr.com, I 0 
http://www.insignia.com, 9 
http://www.internic.net/ds, 36, 37 
http://www.iuma.com, 35, 239, 305 
http://www.iworld.com. 3 
http://www.keyboardmag.com, 322 
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http://www.learned.com/-apex/imagemap.html, 
257 

http://www.marlowpub.com/Marlowe/ 
d isguise2.html, 343 

http://www.mcp .com/ generaJ/news7 /cha p2 
.html, 39 1 

http://www/McdiaCity.com/-erweb, 277 
http://www.metaplay.com, 402 
http://www.microsoft.com/gallery, 10 I, 158 
http://www.microsoft.com/gallery/fi les/ 

styles/default.htm, 99 
http://www.microsoft.com/ msexcel/ 

internetlia, 209 
http://www.microsofr.com/truetype/faq/faq8 

.hun, 105 
http://www.microsoft.com/truetype/ 

fontpack/default.htm, I 02 
http://www.microsoft.com/truetype/ 

iexplor/quick.htm, I 03 
http://www. microsoft.com/word/fs_ wd.htm, 209 
http://www.microsoft.com/workshop/ 

author/howto/css-f.htm, 98-99, 100 
http://www.microsoft.com/workshop/ 

design/desgen/ss/css-des.htm, I 00 
http://www. midiwcb.com, 317 
http://www.mis.nccu.cdu.tw/-bibo/lab/ 

c lient_side_image_map.html, 210, 257 
http://www.netobjects.com, 7 1, 463 
http://www.netscape.com, 153 
http://www.new-kewl.com/curtiscape, 337, 339 
http://www.new-kcwl.corn/curtiscape/ 

bump.htm l, 340 
http://www.new-kewl.com/curtiscape/ 

main.html, 339 
http://www.orangemicro. inter.net, 6 
http://www.pacilic-coast.com, 160, 299, 324 
http://www.quickTime.apple.com, 269 
http://www.quickTime.apple.com/sw/ 

browscrconfig.html, 269 
http://www.quickTimc.apple.com/sw/ 

qtmac.html , 308 
http://www.raspberryhi ll.com/gifw izard.html, 

340,360 
http://www.realaudio.com, 304 
http://www.reply.com, 6 
http://www.reutcrs.com, 12, 13 
http://www.rlspace.com, 282 
http://www.rutgers.edu/x-fi les.html, 307 
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http://www.scifi.com, 34 1 
http://www.shareware.com, 144 
http://www.sony.com, 239 
http://www.submi t-i t.com, 142 
http://www.submit-it.pennalink.com/submit-it, 

220 
http://www.surOogic.com, 9 
http://www. thearriva l.com, 342 
http://www.thenet-usa.com, 3, 7 
http://www.thepalace.com, 314 
http://www. Lhespot.com, 239 
http://www.thunk.com, 348 
http://www.travsoft.com, 9 
http://www.tympani.com, 9 
http://www.ubl.com, 323 
http://www.users.interport.netlmerry/ 

mobius.html, 27, 29 
http://www.vivo.com, 267 
http://www. vnni ll.com, 39 1, 394, 452,456 
http://www. vnni ll.com/Shopping.htm, 64 
http://www. w3 .org/hypertex LIWWW I 

Arenalsty le.html, 47 
http://www. w3 .org/pub/WWW [fRJ 

WD-css l .html, 98 
http://www. webtv.net, 4 
http://www.webweek.com, 3 
http://www.yahoo.com, 36, 137, 142,307 
http://www.zdnet.com/intweek, 3 
http://www.zima.com, 301 

User group SIGs, 4 
User's Guide to Style Sheets, A (Selamohlu), 98 

v 
Van Halen Web site, 307, 3 18 
VBScript, I 
Vellum, 279 
VidEdit (software), 296 
Video 

data transfer, 274, 275 
streaming video, 265, 267-268 

Video compression, 267, 276-277, 292, 295-296 
Video conferencing, 309 
Video for Windows (software), 294 
Video for Windows Converter (CoSA), 293 
Vi11ual Reality Modeling Language. See VRML. 
Virtual reali ty Web sites 

Coney Island project, 406-4 17 



Mom 's Truck Stop, 402-405 
Starbase C3, 396-40 I 

Yirtus Voyager browser, 39 1,452 
Yirtus Walkthrough Pro (software), 3 1, 408-4 17, 

41 8 
Yistographer Lite (Real Space), 282 
vrv fi le, 268 
VivoActive Player, 267 
VivoActive Producer (software), 265, 267-268 
Voice communication, 3 1, 308 
YRML, 30-3 1, 35, 39 1-460 

creating VR1vtl. model , 4 18-45 1 
embedding a YRML window in a Web page, 

458-460 
hand coding, 454 
network anchors, 40 
PerspectiveCamera, 405 
Web sites, 396-417 
WRL Iiles, 4 18,45 1-457 

YRML Archi tectural Group, 395 
YRML files, hand coding, 39 1 
YRMSLIG,65 

w 
W3C (World Wide Web Consortium), sty le sheet 

proposal, 95, 98, 107 
Walkabout 3D World Browser (Duet 

Development Corp.), 30, 3 1, 40 
Walkthrough environment, 3 1 
Wallpaper effect, J 33, 204-205 
WAY fi les, 299, 302,307,322,326,336 
Way finding 

cognitive mapping, 22 
color, 25 
conditions, 23-24 
decision making, 23, 24 
defined, II , 22-23 
design process, 24-25 
graphic landmarks, 25 
iteration , 25 
redundancy, 25 
spatial problem solving, 23 

WebAnalyzer (lnContext), I 0 
Web Buddy (Dataviz), 9 
Web pages 

banner graphics, 178-187 
color codes, 123, 129-1 36 

drop shadow, 147 , 2 13-23 1 
fading an image in to browser background, 

202-203 
forms, 46 1-484 
home page, 33, 35 
HTML for design. See [mages. 
MAfLTO URL, 52, 64, 254 
movies, 267-298 
NetObjects Fusion for design. See Net Objects 

Fusion. 
Pan tone color, converting, 39 
planning. See Planning Web pages. 
signature area, 5 I, 52, 254 
silhouettes, 207-2 12 
sound, 313-323 
style sheets, 98- 102 
text, 469-4 70, 479 
text wrap, 198-200 
tiled backgrou nd, 204-206, 383-386,47 1 
type size, 195, 196 
typography, 98- 1 03 
uploading to server, 262-264 
video, 265-297 
YRML windows, 458-460 

Web site analysis so ftware, 10 
Web site development. See Planning. 
Web sites 

browsers. See Browsers. 
flowcharting, 4 1 
frame layout, 54-68 
free submittal service, 220 
home page, 33, 35 
image maps, 32.239-264 
images. See Images. 
navigation. See Navigation. 
with sound , 299, 30 1-336 
storyboarding, 41 
submitting, free service, 220 

Web trends 
CD-ROMs augmenting a Web site, 7-8 
emulation software, 6 
games, 30 
Internet magazines for, 3 
offl ine browsing, I, 9 
PC cards, 5-6 
PC-related, I, 4 
user groups, 3 
Web site analysis software, lO 
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Webtv,4 
Webtv,4 
Web Whacker (Forefront), 9 
Welch, Terry, 1 6 1 
Windows95 software, use on Mac platform, 4, 5-6 
Withagen, Heini, 299 
World Wide Web Consortium (W3C), 95, 98, 107 
WRL fi le, 418, 451-457 
WSmart Bookmarks (First Floor), 9 

y 
Yahoo! 

search techniques, 137-139 
U RL submission process, 127, 142- 143 

Yang, Jcrry, 127, 137 

z 
Zima Web site, 301-302 
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